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Scope of this Guide
This guide provides a general reference for Spartan’10 for Windows, 
Macintosh and Linux. It is divided into 22 chapters grouped into three 
sections, along with several appendices.

Section I (Introduction, Chapter 1) introduces Spartan as a tool for 
exploring organic, bioorganic, inorganic and organometallic chemistry 
by way of molecular mechanics and quantum chemical calculations, 
together with an array of graphical models for conveying the results 
of these calculations. The section ends with a brief discussion of new 
capabilities in Spartan’10 as well as changes and improvements over 
previous versions.

Section II (Getting Started, Chapters 2 to 11) describes the overall 
operating environment of Spartan, and then provides an extensive set 
of hands-on tutorials. This section is the place to start for new users 
of the program and should also be examined by users of previous 
versions of Spartan.

Section III (Features and Functions, Chapters 12 to 22) describes 
in detail the functions available from the menus and dialogs 
incorporated into the graphical user interface for Spartan. The focus 
is on graphical input and manipulation of structure, input of other 
required information and text, spectral and graphical output resulting 
from molecular mechanics and quantum chemical calculations, and 
on use of databases of previously-calculated structures, energies, 
properties and spectra accessible from Spartan. This section is 
intended as a general reference to Spartan’10.

What this guide does not do is document the performance and cost (in 
computation time) of the different molecular mechanics and quantum 
chemical models available in Spartan’10, or recommend specific 
models or combinations of models for use on chemical problems. 
Nor does it show the utility of graphical models in presenting and 
interpreting the results of the calculations. These topics, among 
several others, are touched on in Appendix A (also available under 
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Topics from the Activities menu). They are also covered in depth 
in A Guide to Molecular Mechanics and Quantum Chemical 
Calculations included as a PDF under the Help menu and available 
from Wavefunction as a hardbound volume. The guide also provides 
a collection of illustrative examples.

Additional appendices provide an overview of the program’s overall 
architecture as well as its present capabilities and limitations (B), a 
directory of functions under its menus (C), a listing of commonly-
used options (D), a listing of units (E), the proper citation for the 
program (F), instructions for installing the Cambridge Structural 
Database (G), directions for making databases from Spartan 
calculations (H), examples of pharmacophore input (I), input of 
experimental infrared, UV/visible and NMR spectra (J), directions 
for installing a network HASP (K) and a listing of NMR chemical 
shift standards (L). Additional materials relating to several of 
these appendices may be found as PDFs under the Help menu.

An up-to-date version of this Tutorial and User’s Guide is available on 
Wavefunction’s website (directly accessible from the Help menu).
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Section I
Introduction

Molecular mechanics calculations and quantum chemical calculations 
play an ever-increasing role in modern chemistry. Primary functions 
are to supply information about structures, relative stabilities and 
other properties of isolated molecules. Because of their inherent 
simplicity, molecular mechanics calculations on complex molecules 
are widespread throughout the chemical community. Quantum 
chemical calculations, including Hartree-Fock molecular orbital 
calculations, but especially calculations that take account of electron 
correlation, are much more time demanding. Only recently, have fast 
enough computers become widely available to make their application 
routine among mainstream chemists.

Quantum chemical calculations may also be called upon to furnish 
information about the mechanisms and product distributions of 
chemical reactions, either directly by calculations on transition states, 
or indirectly based on the Hammond Postulate, by modeling the steric 
and electronic demands of the reactants. Quantitative calculations, 
leading directly to information about the geometries of transition 
states, and about reaction mechanisms in general, are becoming more 
and more common, while qualitative models are still needed for 
systems that are too large or too complicated to be subjected to the 
more rigorous treatments. Finally, quantum chemical calculations can 
supply information to complement existing experimental data or to 
replace it altogether, for example, atomic charges for QSAR analyses, 
and intermolecular potentials for molecular mechanics and molecular 
dynamics calculations.

Spartan’10 (“Spartan”) has been designed to address the ever 
increasing role that calculations play in chemistry and related fields. 
It represents a continuing collaboration between Wavefunction, 
Inc., and Q-Chem, Inc. Q-Chem codes supplement and extend the 
traditional strengths of Spartan as an easy to learn and use tool for 
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molecular mechanics, semi-empirical and Hartree-Fock molecular 
orbital calculations, as well as a wide variety of graphical models, 
with a full range of density functional models and a broad selection of 
wavefunction-based post-Hartree-Fock models. All models have been 
implemented using what we believe are the most robust algorithms 
currently available, and have been tuned for high performance on 
Intel and AMD processors including multi-core processors.

Spartan is intended to be utilized by chemists, not only computational 
chemists who are already familiar with the capabilities of molecular 
mechanics and quantum chemical methods, but also experimental 
chemists who may have little or no prior experience, but who want 
to use calculations much in the same way as experimental techniques 
such as NMR spectroscopy. This ambitious goal is directly reflected in 
the program’s overall design criteria: “convenient access both to a full 
range of modern molecular mechanics and quantum chemical models 
and tools for interpretation of the results of calculations”, and clearly 
distinguishes Spartan from other molecular modeling packages.

Spartan is supported under Windows (XP, XP 64, Vista and 7, 32 
and 64 bit), Macintosh (OS X 10.5 and 10.6), Linux (Linux Kernel 
2.6 or later). The Linux version (only) may be used in a server mode 
with Windows, Macintosh or Linux acting as a front end, and can 
also perform calculations locally. The appearance and functionality 
of the different versions of Spartan are nearly identical.

New features in Spartan’10 include the following:

Infrastructure

Tabs. Each open molecule is now given a tab, any or all of which 
may either be turned on or off. All tabs on mimics Spartan’s previous 
display paradigm (all open molecules are displayed). Turning tabs 
off simplifies screen clutter.

64-Bit Implementation (Windows only). The graphical user interface 
now supports 64 bit chip architectures (64 bit versions of back-
end codes were released with Spartan’08). This allows Spartan 
documents in excess of 2 GB, meaning that very large molecule lists 
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may now be handled. Choice between 32 and 64 bit architectures is 
automatic and made at the time of installation. 

File Compression. Files generated from Spartan (.spartan files) have 
been significantly reduced in size due to elimination of the part of 
the wavefunction that is not used, to file compression and  reduction 
of precision of data used for construction of graphical displays. This 
reduction ranges from a factor of five to between one and two orders 
of magnitude.

Monitor. The Spartan job monitor has been extended to allow real-
time visualization of molecular structure. This means that progress of 
a geometry/transition-state geometry optimization can be followed.

Color Palette. A new color palette has been provided.

Customizable Icons. Spartan’s icons may now be individually 
selected for display.

Graphical User Interface

Simplified Graphics Requests. The most commonly requested 
graphics (HOMO, LUMO, electron density, and electrostatic 
potential, local ionization potential and LUMO maps) may now be 
requested by the above names instead of as combinations of surfaces 
and properties.

Multi-Dimensional Energy Profiles. Multi-dimensional energy 
profiles may now be constructed with arbitrary limits on the number 
of steps in each dimension. Plots from two-dimensional profiles may 
be made.

Ramachandran Plot. A Ramachandran plot may be made for a 
protein structure retrieved from PDB.

Formula Editor. A dialog has been provided for construction of 
quantities (properties or combination of properties) of individual 
molecules or of molecules related by chemical reaction. These formulas 
can then be used in spreadsheet calculations or as queries for database 
searches (mining) and subsequent statistical analysis and plotting.
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QSAR Descriptors. Descriptors for QSAR type analyses have been 
collected in one place, and may now be conveniently  transferred 
for data analysis. A series of new descriptors based on the electron 
density surface and the electrostatic potential and local ionization 
potential maps have been added.

Thermodynamic Quantities. The zero-point energy, enthalpy, heat 
capacity, entropy and Gibbs energy (the last four as a function of 
temperature) are available. These require vibrational frequencies 
(the infrared spectrum) to have been calculated.

Computation

RI-CIS(D) Gradients. Gradients from RI-CIS(D) models are 
available allowing efficient calculation of the geometries of excited 
states.

Multi-Core Parallel. Vibrational frequency calculation has been 
parallelized for Hartree-Fock and density functional models, 
resulting in a speed improvement of approximately 1.8 for a two-
core machine and 3.2 for a four-core machine. RI-MP2 has been 
parallelized. The underlying Hartree-Fock part (which completely 
dominates the calculation for less than 500 basis functions) gives 
speed improvements of approximately 1.9 for a two-core machine 
and 3.5 for a four-core machine. Speed improvements for the MP2 
part are not as large. An important practical consequence is that the 
speed of T1 thermochemical calculations now improve significantly 
on multi-core machines.

PM6. The PM6 semi-empirical model has been implemented. This 
offers some improvement over PM3. PM6 becomes the second 
semi-empirical method available in Spartan that may be applied to 
transition metals.

T1 Extensions. The T1 thermochemical recipe has been extended to 
include molecules with silicon and phosphorus. Extension to boron 
is underway. A procedure for reliably estimating the best (lowest) T1 
energy for a flexible molecule has been specified and implemented 
inside the graphical user interface.
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IRC. The Intrinsic Reaction Coordinate (IRC) procedure in previous 
versions of Spartan has been improved.

Graphical Models

Orbital Energy Diagram. An orbital energy diagram (spanning up to 
20 occupied valence molecular orbitals and 2 unoccupied molecular 
orbitals) may now be displayed for the selected molecule. Clicking 
on a line (energy level) in this diagram generates on-the-fly and 
displays the orbital (assuming that the wavefunction  is available). 
Orbitals generated in this way are not kept when the molecule is 
closed.

Slicing Planes. Graphical surfaces may now be sliced allowing the 
inside or graphical surfaces (in particular, property maps) to be seen.

Areas of Banded Property Maps. This allows the area of a band on a 
property map to be determined. It is useful in quantifying the results 
of graphical models, for example, which face of a molecule is more 
likely to undergo electrophilic or nucleophilic attack. 

Spectroscopy

NMR. The NMR spectra dialog has been completely reorganized 
allowing (independent or simultaneous) display of six different 
spectra: 1H, 13C, DEPT, COSY, HMBC and HSQC. Empirically-
estimated H-H coupling constants may or may not be included in 1H, 
COSY, HMBC and HSQC plots and all plots may be averaged using 
Boltzmann weights (if available). Experimental 1H, and 13C and DEPT 
spectra (available from a public on-line database or accessed from 
a local file) may be displayed with or in place of calculated spectra.

A new scheme for correcting 13C chemical shifts has been 
implemented for spectra obtained from the EDF2/6-31G* model 
(only). The supplements the scheme provided in Spartan’08 (based 
on topology and applicable only to spectra obtained from the 
B3LYP/6-31G* model). The new scheme (based on topology and on 
bond orders to atoms connected to carbon) provides shifts with an 
(RMS) error of approximately 1.7 ppm (down from approximately 
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2.5 ppm for the previous correction scheme and approximately 6 
ppm for uncorrected shifts).

Infrared

Raman. Raman spectra may be calculated from Hartree-Fock and 
density functional models.  Calculated Raman spectra may be fit to 
experimental spectra the using an overall frequency scale parameter 
and a width parameter (analogous to what is done for infrared spectra).

Databases

Spartan Molecular Database (SMD). The full Spartan Molecular 
Database (provided with maintenance) continues to expand. 
Approximately 3,000 transition-metal inorganic and organometallic 
compounds have been added to SMD obtained from calculations 
using the B3LYP/6-31G* model (or the analogous B3LYP/
LACVP* model for second and third-row metals). This model has 
been shown to provide a good account of equilibrium geometries 
for organometallic compounds (based primarily on comparisons 
with X-ray crystal structures). Experimental thermochemical data 
for organometallic compounds are almost non-existent, and detailed 
assessment of the B3LYP for reaction energies is not possible. 
However, the B3LYP/6-31G* model appears to properly account 
for observed products in cases where multiple products are possible. 
All entries correspond to optimized geometries, and infrared spectra 
have been provided for most entries. (A sample of approximately 
6,000 molecules is provided with all copies of Spartan.)

Spartan Spectra and Properties Database (SSPD). A new database 
of IR and NMR spectra and of molecular and atomic properties, 
QSAR descriptors and thermodynamic quantities has been 
developed and is available as an option to Spartan’10. (A sample 
of approximately 6,000 molecules is provided with all copies of 
Spartan.) At first release, it contains ~70,000 molecules and is 
expected to double in size by the end of 2011. SSPD entries are 
based on equilibrium geometries from the EDF2/6-31G* density 
functional model using the best conformation obtained from the 
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T1 thermochemical recipe. In addition to spectra, properties, 
QSAR descriptors and thermodynamic quantities, SSPD entries 
include the T1 heat of formation, the vibrational modes (allowing 
animation of the motions associated with individual frequencies) 
and the wavefunction (allowing on-the-fly generation and display 
of graphical surfaces) including the molecular orbitals and property 
maps such as the electrostatic potential map.

Data Mining. Data mining allows access to all information relating 
to molecular structure, properties and spectra contained in SMD and 
SSPD (presently >600K entries in total). The primary objective is 
to allow relationships among different quantities or combinations of 
quantities to be examined across entire series of molecules. Information 
retrieved from mining may be presented in the form of histograms 
or XY plots and may be used as the basis for linear regression. 
Data mining opens up a wealth of information to exploration. 

Data mining is accomplished in a series of steps. First, a structural 
query is devised and all entries in SMD or SSPD containing this 
query are retrieved. For example, were the structural query the 
molecule phenol with an open valence at the para position, all para-
sustituted phenols available in SMD or SSPD would be retrieved. 
Next, one or more property queries are formulated. These might 
simply refer to individual quantities such as the dipole moment or 
the charge on a particular atom. More generally, they may reference 
a combination of properties, for example, the charge on one atom 
times the charge on another atom. By associating reaction arrows 
with a structural query, property queries can be extended to refer 
to one of the products of a chemical reaction (fully defined given 
the structural query and the reaction arrows) or to a property of 
the reaction itself, most conspicuously, the energy of the reaction. 
Finally, one or more properties queries and brought together with 
the retrieved data from SMD or SSPD. Results from mining SMD 
or SSPD may be displayed in terms of histograms or scatter plots. In 
addition, multiple regression analysis may be carried out to uncover 
relationships among properties. 
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Spartan Infrared Database (SIRD). The interface to the Spartan 
Infrared Database has been completely reworked. Matching to an 
unknown (experimental) spectrum may now be accomplished with 
or without functional group, formula and substructure filters.

Documentation

Tutorials, Topics and Problems. The full set of Spartan tutorials and 
a selection of discussion topics and problems may be opened inside 
of Spartan. Tutorials are indexed by chapter (in this manual).

Wikipedia Access. A Wikipedia page may be brought up from 
Spartan. Access is provided both from the Activities menu where 
the query is entered explicitly and from the Database Preview 
dialog where the query is the name of the molecule.

Changes from Spartan’10 and Spartan’08 include the following:

Attachment Points/Reaction Arrows. Specification of attachment 
points (used in database searches and reaction arrows (used both in 
database searches and transition-state guessing) have been separated 
from these functions.

Database Dialogs. A Spartan document (including a blank document 
in the case of a name search or spectra search) is required for entry 
into the databases. This is a consequence of being able to save search 
and data mining results.

T1 Database. The T1 database is no longer available. Rather, T1 
heats of formation are included with all entries in the SMD and 
SSPD databases for which the T1 data are available.

On-Line PDB Access.  PDB access has been moved from the Search 
menu to the File menu. 

Since the release of Spartan’08, Spartan users have diligently 
reported program bugs via support@wavefun.com. All reported 
bugs have been addressed. Wavefunction would like to thank our 
customers for their help in making Spartan a better program. User-
feedback is greatly appreciated!
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Chapter 1
Spartan’10

This chapter describes the architecture of Spartan’10, focusing on the 
connectivity of graphics, database and computational components. 
Available molecular mechanics and quantum chemical methods are 
enumerated, and their overall role suggested.

Spartan’10 (“Spartan”) is a cross-platform application. With very few 
exceptions, Spartan’s operations and features are identical between 
Windows, Mac and Linux versions. The following nomenclature 
will be used throughout this manual to indicate the few cases where 
features are not available: NAL; Not Available Linux, NAM; Not 
Available Macintosh and NAW; Not Available Windows.

Spartan comprises a series of independent modules tightly connected 
via a graphical user interface that is highly functional, yet simple 
and uncluttered. It has been designed not only to greatly reduce 
the drudgery and possibility for human error associated with the 
preparation of input, but also to guide the interpretation of output. 
The interface is perhaps best viewed as an interactive and intuitive 
window into a full range of modern computational techniques. 

Molecular 
Mechanics

Internal 
DatabasesCorrelated

Density
Functional

Properties

Hartree-
Fock

Spectra

Graphics

Semi-
Empirical Molecule/

Pharmacophore
Similarity

Web 
Databases

Graphical 
User 

Interface
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Included in the interface are builders for organic, inorganic and 
organometallic molecules, polypeptides and polynucleotides, as well 
as for creating substituted molecules, and a procedure for guessing 
transition states. Access to ChemDraw1 is provided without having to 
exit Spartan’s interface. The interface provides access by substructure 
to the Spartan Molecular Database (SMD)2, a collection of over 
150,000 calculated structures and associated properties of molecules, 
each obtained from as many as nine different theoretical models 
(Hartree-Fock models with 3-21G, 6-31G* and 6-311+G** basis sets, 
B3LYP and MP2 models with the 6-31G* and 6-311+G** basis sets, 
the EDF1 model with the 6-31G* basis set and the G3(MP2) model. 
New in Spartan’10 is a collection of approximately 3,000 transition-
metal inorganic and organometallic molecules obtained from the 
B3LYP/6-31G* model. The Spartan Reaction Database (SRD) has 
been significantly enhanced and now contains transition states for 
approximately 1,500 organic and organometallic reactions each 
obtained at one or more theoretical models. It may be accessed either 
by substructure searching (as SMD) or automatically, based on the 
structure of the reactant and a set of   “curly arrows” defining the reaction.

The Spartan Spectra and Properties Database (SSPD)2 appears for 
the first time with Spartan’10. It comprises IR and NMR spectra 
and diverse atomic and molecular properties together with QSAR 
and thermodynamic quantities descriptors for ~70,000 molecules. 
Database entries include the vibrational modes, allowing animation 
of atomic motions associated with lines in the IR spectrum, and the 
wavefunction, allowing on-the-fly generation and display of graphical 
models. Entries are based on equilibrium structures obtained from 
the EDF2/6-31G* density functional model and (where T1 has been 
defined) assuming the lowest-energy conformer assigned by the 
T1 thermochemical recipe. SSPD will be updated twice a year and 
the next release scheduled for June 2011 will contain upwards of 
~120,000 molecules.

The Spartan Infrared Database (SIRD) 2 comprises almost all the 
molecules with molecular weights < 400 amu as well as a selection of 
larger molecules in SSPD. It differs from SSPD in that it is searched 
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by matching to an unknown (experimental) infrared spectrum.

New to Spartan’10 is capability to “mine” SMD and SSPD, not 
only for information about individual molecules, but also about 
relationships among molecules in balanced chemical reactions. Basic 
statistical analysis and plotting capabilities have been provided, 
including a new capability for singular value decomposition (finding 
the most important of a starting set of variables).

Also provided is an interface to the Cambridge Structural Database 
(CSD), comprising (at the time of writing) more than 500,000 
experimental X-ray crystal structures3, and automatic retrieval from 
the PDB database4 comprising (at the time of writing) nearly 72,000 
protein and related crystal structures. Both CSD and PBD continue to 
increase in size. Finally, Spartan allows for import of a variety of data 
files, most important among them being PDB (protein structures) and 
SDF (structure drawings). Thus, it is not only possible to construct 
molecules from scratch, but also to access existing structures.

Spartan’s interface provides the gateway to a range of modern 
computational methods, including molecular mechanics models, 
semi-empirical and Hartree-Fock molecular orbital models, and a 
variety of correlated models including density functional and Møller-
Plesset models. None of these models is likely to be ideal for every 
application5. While the most sophisticated quantum chemical models 
may yield excellent results, they will likely be too time consuming for 
routine application, and it will usually be necessary to contend with 
lesser treatments. Spartan’s interface facilitates mixing and matching 
different molecular mechanics and quantum-chemical models. Results 
from one model may easily be passed on for further analysis with 
another (more rigorous) model.

The simplest computational methods in Spartan are molecular 
mechanics models using the SYBYL and MMFF force fields, with 
aqueous energy corrections available for the latter (MMFFaq). These 
are available to determine equilibrium geometries and conformations 
of molecules comprising upwards of several thousand atoms. These are 
the only computational techniques that are applicable to biopolymers. 
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In addition, databases of diverse conformers obtained from MMFF 
molecular mechanics and intended to be used for similarity analysis 
are available6.

Quantum chemical models are required to account for the geometries 
of transition states as well as for reaction and activation energies. 
The simplest of these, semi-empirical molecular orbital models, 
can be routinely applied to systems with 100-200 atoms. Supported 
in Spartan are the MNDO model (with extensions for second-row 
and heavier main-group elements), the AM1 model, the PM3 model 
(with parameters for transition metals) and the RM1 model (a 
reparameterization of AM1). The PM6 semi-empirical molecule has 
been made available with the introduction of Spartan’10. While semi-
empirical models have proven to be quite successful for determining 
equilibrium geometries including the geometries of transition-metal 
compounds, they have not proven to be reliable for the calculation 
of the reaction energies.

Hartree-Fock molecular orbital models are a mainstay of quantum 
chemical techniques, in particular, for equilibrium and transition-state 
structure determination, and for thermochemical comparisons. The 
models available in Spartan may be routinely applied to molecules 
with up to one hundred atoms. Hartree-Fock models are, however, not 
adequate for thermochemical comparisons where bonds are broken 
or formed, making them suspect for the calculation of activation 
energies. Also, Hartree-Fock models provide a poor account of the 
geometries of molecules incorporating transition metals. So-called 
correlated models are required. Several classes of correlated models 
are available in Spartan: density functional models, Møller-Plesset 
models, coupled cluster models and quadratic configuration interaction 
(QCI) models. Density functional models may be routinely applied to 
molecules of the same size as with Hartree-Fock models. On the other 
hand, the simplest Møller-Plesset model (MP2) is limited to molecules 
comprising thirty or fewer atoms. The recently introduced RI-MP2 
model is nearly an order of magnitude faster than MP2 for energy 
calculations and 2-3 times faster for equilibrium and transition-state 
geometry calculations, but provides nearly identical results.
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Higher order (MP3 and MP4) Møller-Plesset, coupled-cluster and QCI 
models are available for energy calculations only. They are limited in 
practice to molecules with less than 10-20 heavy (non-hydrogen) atoms.

Hartree-Fock and correlated models may be used with a variety 
of all-electron Gaussian basis sets. Hartree-Fock models are often  
quite successful with split-valence basis sets, while correlated 
models require polarization basis sets, and in some cases basis sets 
incorporating diffuse functions. Dual-basis set calculations, which 
approximate changes in energy and wavefunction resulting from 
extension from a small basis set to a large basis set, are also available. 
They can lead to an order of magnitude performance enhancement 
over calculations that directly use large basis sets. Pseudopotentials 
are provided for use with both Hartree-Fock and correlated models 
for calculations on molecules incorporating elements heavier than Kr 
(for which all-electron bases sets are not available).

A series of recipes (combinations of different methods) are available 
to estimate heats of formation. G2, G3 and G3 (MP2) recipes, while 
applicable only to very small systems, have been shown to yield heats 
of formation in excellent accord with experiment, and are benchmarks 
against which other calculations may be judged. The T1 recipe closely 
reproduces heats of formation from the G3 (MP2) recipe but requires 
2-3 orders of magnitude less computation time. T1 is used as a basis 
for choosing the lowest-energy conformer for almost all entries in the 
Spartan Spectra and Properties Database, and the T1 heat of formation 
is included as a property.

Spartan provides singles configuration interaction (CIS) techniques for 
energies, equilibrium and transition-state geometry and conformation 
calculations on molecules in electronically-excited states. In addition, 
energy calculations (only) on excited states with the CIS (D) and RI-
CIS(D) models as well as a range of density functional models may 
be performed.

Spartan provides access to several common spectral quantities, in 
particular infrared spectra (molecular mechanics, semi-empirical, 
Hartree-Fock, density functional and MP2 models), Raman spectra 
(Hartree-Fock and density functional models), NMR spectra (Hartree-
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Fock and density functional models) and UV/visible spectra (CIS, 
CIS(D) and density functional models). These are available both as 
numerical data (vibrational frequencies, chemical shifts, etc.) as well 
as spectral plots. Spectra may be directly input to Spartan and internet 
connections to public IR, NMR and UV/visible databases are available 
allowing direct comparison of calculated and experimental spectra. 
The infrared spectra fitting procedure first provided in Spartan’08 
has been significantly improved in Spartan’10 and a new interface 
has been implemented. This accesses the Spartan Infrared Database, 
a collection of 70,000 calculated infrared spectra at initial release.

The empirical scheme introduced in Spartan’08 to correct 13C 
chemical shifts obtained from the B3LYP/6-31G* model has been 
supplemented by a new scheme that applies to the EDF2/6-31G* 
density functional model. It reduces the rms error in 13C shifts to 1.2-
1.8 ppm, down from 2.0-2.6 ppm for the orginal correction scheme 
and from >6 ppm for uncorrected shifts. We believe that 13C NMR 
spectra obtained from the corrected EDF2/6-31G* model are now of 
sufficient quality to be useful in assigning experimentally determined 
NMR spectra. A collection of ~70,000 calculated proton and 13C NMR 
spectra is available in the initial release of the Spartan Spectra and 
Properties Database.

Spartan provides tools to quantify both the similarity of molecular 
structures and of chemical environments characteristic of these 
structures. Also available is the ability to identify molecules that fit 
into a specific chemical environment (a so-called pharmacophore). 
Finally, pharmacophores may be extracted from small molecules 
bound to proteins and nucleotides in the PDB.

Spartan provides a variety of graphical tools to assist in interpreting 
the results of calculations as well as similarity analyses. These 
include structure models, and also molecular orbitals, electron and 
spin densities, local ionization potentials and electrostatic potentials 
that can be displayed as surfaces, slices and property maps. New to 
Spartan’10 is an orbital energy diagram with subsequent clicking 
on an individual energy level in the diagram leading to display of 
the associated molecular orbital (assuming that a wavefunction is 
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1.  ChemDraw is not included with Spartan, but may be obtained from CambridgeSoft  
(www.cambridgesoft.com). NAL, NAM. While all versions of Spartan are able to read 
ChemDraw files, seamless access is presently available only in the Windows version.

2. Subsets of SMD, SIRD and SSPD are provided with Spartan. The full SMD database is 
provided under maintenance contract. The full SSPD and SIRD databases (SIRD uses the 
entries in SSPD) may be licensed separately from Wavefunction.

3. The Cambridge Structural Database is not included with Spartan, but is available by 
subscription from the Cambridge Crystallographic Data Centre (www.ccdc.cam.ac.uk).

4. PDB web reference: http://www.rcsb.org.
5. Full discussion and assessment of the specific molecular mechanics and quantum chemical 

models available in Spartan is provided in: W.J. Hehre, A Guide to Molecular Mechanics 
and Quantum Chemical Calculations, Wavefunction, Irvine, 2003. This is available as a 
PDF under the Help menu. See also: W.J. Hehre, L. Radom, P.v.R. Schleyer and J.A. Pople, 
Ab Initio Molecular Orbital Theory, Wiley, New York, 1986; Y. Shao, L.F. Molnar, Y. Jung, 
J. Kussmann, C. Ochsenfeld, S.T. Brown, A.T.B. Gilbert, L.V. Slipchenko, S.V. Levchenko, 
D.P. O’Neill, R.A. DiStasio Jr., R.C. Lochan, T. Wang, G.J.O. Beran, N.A. Besley, J.M. 
Herbert, C.Y. Lin, T. Van Voorhis, S.H. Chien, A. Sodt, R.P. Steele, V.A. Rassolov, P.E. 
Maslen, P.P. Korambath, R.D. Adamson, B. Austin, J. Baker, E.F.C. Byrd, H. Dachsel, R.J. 
Doerksen, A. Dreuw, B.D., Dunietz, A.D. Dutoi, T.R. Furlani, S.R. Gwaltney,  A. Heyden, 
S. Hirata, C-P. Hsu, G. Kedziora, R.Z. Khalliulin, P. Klunzinger, A.M. Lee, M.S. Lee, W.Z. 
Liang, I. Lotan, N. Nair, B. Peters, E.I. Proynov, P.A. Pieniazek, Y.M. Rhee, J. Ritchie, E. 
Rosta, C.D. Sherrill, A.C. Simmonett, J.E. Subotnik, H.L. Woodcock III, W. Zhang, A.T. Bell, 
A.K. Chakraborty, D.M. Chipman, F.J. Keil, A.Warshel, W.J. Hehre, H.F. Schaefer, J. Kong, 
A.I. Krylov, P.M.W. Gill and M. Head-Gordon, Phys. Chem. Chem. Phys., 8, 3172 (2006).

6. Databases comprising sets of diverse conformers pharmaceutical candidates as well as 
Maybridge and Life Chemicals collections may be licensed from Wavefunction.

available). Spartan provides the ability to distinguish accessible 
and inaccessible regions on a density surface and on property maps 
based on this surface. New to Spartan’10 is the ability to measure the 
area of a banded region on a property map and slice into a graphical 
surface or property map allowing the inside to be seen.

Graphical models may be manipulated in real time, and as many as 
desired can be displayed simultaneously. Animation files may be 
made, and can be used to depict conformational changes or chemical 
reactions.
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Section II
Getting Started

The chapters in this section provide a brief introduction to the 
graphical user interface for Spartan’10, and following this, a series of 
tutorials. The objective of the latter is to provide hands on experience, 
and in doing so, illustrate the way in which molecular mechanics, 
quantum chemical calculations and similarity analyses may be set up, 
performed and interpreted. This is the place to start for new users. 
Users of previous versions of Spartan are also advised to review this 
section as there are a variety of new capabilities.

No attempt has been made to illustrate the full range of Spartan’s 
capabilities. For this, the reader should consult Section III of this 
guide. Focus is on the use of Spartan to calculate equilibrium and 
transition-state geometries, to search conformation space, to align 
molecules and evaluate the similarities of molecules, to evaluate 
reaction thermochemistry and activation energetics and to obtain 
NMR, infrared and UV/visible spectra with emphasis on NMR. 
Likewise, no attempt has been made to assess the performance of the 
various molecular mechanics and quantum chemical models. 

Graphical models are illustrated in several of the tutorials that follow, 
and connections between specific models and chemical observables 
are pointed out, for example, between electrostatic potential maps 
and molecular polarity and between local ionization potential maps 
and electrophilic character. 

Discussion of both the behavior of different molecular mechanics 
and quantum chemical models and of graphical modeling techniques 
is provided in Topics available under the Activities menu. A more 
complete account is provided in A Guide to Molecular Mechanics and 
Quantum Chemical Calculations, included as a PDF under the Help 
menu and also available from Wavefunction as a hardbound volume.
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Operating Spartan (Chapter 2) outlines the basic workings of 
Spartan’s graphical user interface. It should be reviewed before 
starting the tutorials and referred to as needed. The tutorials that make 
up the bulk of this section are divided across nine chapters: Basic 
Operations, Organic Molecules, Groups of Organic Molecules,  
Spectra of Organic Molecules, Organic Reactions, Medicinal 
Chemistry, Polypeptides to Proteins, Inorganic/Organometallic 
Molecules and  “Dry Labs”: Using the Spartan Spectra and 
Properties Database. The initial three cover a number of important 
general features and should be completed first, and in order. The next 
five chapters cover more specialized topics and may be completed in 
any order. The final chapter  points to an entirely different mode of 
using Spartan by drawing on the large amount of information in the 
Spartan Spectra and Properties Database.

A few tutorials require precalculated results (in .spartan files) and/or 
experimental spectra (in .dx or .cml files). These have been provided 
and are specifically referenced for the individual tutorials.

Estimates for required computer time (in minutes, assuming a single 
processor on an Intel I7/920 processor) are indicated at the top of the 
first page of each tutorial. Users with dual and quad-core processors 
and who access Spartan’s parallel Hartree-Fock, density functional 
and RI-MP2 codes can expect significant reductions in these times.

5 mins

Where two times are provided, the second corresponds to the total 
time including the optional parts of the tutorial.
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Chapter 2
Operating Spartan

This chapter describes the general operating features of Spartan’10. 
It should be read prior to starting the tutorials.

Opening and Exiting Spartan

To open under Windows, click on the Start button, then click on All 
Programs, and finally click on Spartan’10 (or double click on the 
Spartan icon on your desktop). To open under Macintosh, double 
click on the Spartan’10 icon in the Applications Folder. To open 
under Linux, bring up a terminal and type spartan. To exit, select 
Exit from the File menu (Select Quit Spartan 10 from the Spartan 
10 menu on Mac), or click the Close button ( ) at the top right (top 
left for Mac) of the Spartan interface.

Menus

Program functions may be accessed using pull-down menus under 
the headings in the menu bar, for example, the Setup menu.

File  Allows you to create a new molecule or read in a molecule 
that you have previously saved, or a file created by another 
program (for example, an SD file created by ChemDraw) to 
print text and graphics, embed external files (for example, 
Word and Excel files) into Spartan documents, to access 
PDB files online and to make QuickTime movies.

Edit Allows you to transfer information to and from the clipboard, 
to undo the last operation, to find text strings and molecule 
fragments, to center molecules on screen, and to clear the 
active molecule by deleting it.
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Model Allows you to control the style of your model, to display 
hydrogen bonds and chemical function descriptors, and 
to couple or decouple molecules in a multi-molecule file. 
Allows you to display of a Ramachandran plot for a protein 
structure brought in from PDB.

Geometry Allows you to measure and constrain bond lengths, angles 
and dihedrals, define points and planes, setup frozen atoms, 
alter default settings for conformational degrees of freedom, 
select centers for similarity analysis and align molecules.

Build Allows you to build and edit molecules and to create lists 
of substituted molecules. Provides seamless access to 
ChemDraw™. (NAL, NAM)

Setup Allows you to specify the task to be performed and the 
theoretical model to be employed for this task, to specify 
graphical surfaces and property maps and to submit jobs 
for calculation.

Display Allows you to display text output, molecular and atomic 
properties, QSAR descriptors and thermodynamic quantities, 
orbital energy diagrams, surfaces and property maps and 
infrared, Raman, NMR and UV/visible spectra, as well as to 
access experimental IR, NMR and UV/visible spectra over 
the internet or from local files. Allows you to present data in 
a spreadsheet and make plots from and perform regression 
analysis on these data, to access the results of a similarity 
analysis and to compute reaction energies based either on 
user data or from entries in the Spartan Molecular Database 
(SMD) or Spartan Spectra and Properties Database (SSPD).

Search Allows you to specify queries for the Spartan Molecular 
Database (SMD), the Spartan Spectra and Properties 
Database (SSPD) and the Spartan Reaction Database 
(SRD). Allows you to search and mine SMD and SSPD 
for calculated structures, properties and spectra, and to 
search SRD for calculated transition-state structures. Allows 
you to search the Cambridge Structural Database (CSD) 
of experimental X-ray crystal structures, and to extract 
ligands from the Protein Data Bank (PDB). Allows you 
to match an unknown (experimental) infrared spectrum 
to calculated spectra in the Spartan Infrared Database 
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(SIRD). Allows you to guess a transition-state geometry 
based on a library of reactions and to identify tautomers.

Options Allows you to set display standards, specify databases, assign 
compute servers, monitor executing jobs and specify queues 
and customize icons and other aspects of the graphical user 
interface.

Activities Allows you to display tutorials and topics inside of Spartan 
and open up a Wikipedia search page.

Help Provides access to information on Spartan’s general 
operation, the Spartan’10 Tutorial and User’s Guide, A 
Guide to Molecular Mechanics and Quantum Chemical 
Calculations, and a number of computational FAQ’s.

A complete listing of menu functions is provided in Appendix C.

Keystroke Equivalents (NAM)

Keystroke equivalents for menus are designated by the underlined 
letter: File, Edit, Model, Geometry, Build, Setup, Display, 
Search, Options, Activities and Help. To access a menu, press the 
Alt key (Option key on Mac) and the appropriate letter key (case 
insensitive), for example, Alt S to access the Setup menu.

Each menu entry is designated by an underlined letter. To access the 
entry, press the appropriate letter key, for example, press the C key 
to access the Calculations dialog. 

Icons

Icons provide convenient access to selected functions under the 
File, Build, Geometry, Properties and Search menus, as well as 
other specialized functions. Icons may be selected or deselected for 
display from the Toolbars Preferences dialog (Preferences under 
the Options menu; Chapter 20).
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 New  Measure Distance  Define Plane
 Open  Measure Angle  Define CFD
 Close  Measure Dihedral  Align
 Save As  Freeze Center  Orbital Energies
 View  Set Torsions  Define Structure Query
 Add Fragment  Set Similarity Centers  Define Reaction  Query
 Delete  Constrain Distance  Open/Close Databases   

     Window
 Make Bond  Constrain Angle  Guess Transition State
 Break Bond  Constrain Dihedral  Extract Ligands
 Minimize  Define Point  Identify Tautomers

 Post to Spreadsheet  Guess Transition State
/  Lock/Unlock Constraints /  Move Up/Down Dialog
 Play  Pause /  Step

Tabs

Spartan’10 assigns a tab to each open document. These appear in 
a single row along the bottom of the screen in the order that the 
documents were created or read. Backward and forward step keys 
(  and ) at the far right provide access to tabs outside of those 
displayed. Documents are selected for display by clicking on its tab. 
To the left of each tab is a check box, which if checked indicates 
that the document will be displayed on screen even if it is not the 
selected document. The behavior of previous versions of Spartan (all 
tabs checked) can be preserved by selecting Pin New Documents 
from the Settings Preferences dialog (Options menu; Chapter 20). 
Alternatively, one or only a few tabs can be checked leading to less 
clutter on the screen.
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Mouse and Keyboard Operations

The following functions are associated with the two-button mouse.

 button
 keyboard left right

 – selection, X/Y rotate, atom/ X/Y translate
  fragment exchangea, 
  fragment insertiona

 Shift range selection, Z rotate scalingb

 Ctrl global X/Y rotatec global X/Y 
   translate
 Ctrl + Shift multiple selection, global Z rotatec scalingb

 Ctrl  fragment X/Y rotate fragment X/Y 
 (add fragment mode) chirality inverta,d translate
 Ctrl + Shift fragment Z rotate scalingb

 (add fragment mode) absolute configuration inverta,d

 Ctrl + Shiftd bond rotation bond stretching
 (Mac & Linux) 
 Alt (Windows), group selectione, bond rotationf bond stretching
 option (Mac)  

a) Requires double clicking.
b) Scaling is always applied to all open molecules and all fragments. The center mouse 

wheel will also scale molecules.
c) Global rotations can be either molecule or screen centered. This is controlled by Global 

Rotate in the Miscellaneous Preferences dialog (Preferences... under Options menu).
d) For Macintosh, command key replaces Ctrl key for chirality inversion.
e) In View mode only.
f) In Add Fragment mode with bond selected (red arrow visible).

Mouse/keyboard operations may be broadly separated into two 
categories: selection (picking) and manipulation (translation/rotation).

Selection. The left button is used for selection of objects on screen 
and/or of menu items. Left and right buttons together are used to 
define a selection box for copying to the clipboard, as well as for 
multiple model selection. Together with the Shift key, the left button 
allows for selection over a range. Together with the Ctrl (Control) 
key, the left button allows for multiple selection. Both range and 
multiple selection apply not only to text items in lists, but to atoms 
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and bonds in molecules as well. Together with the Alt key (option 
key for Mac), the left button allows for selection of an entire group 
(detached molecular fragment). In add fragment mode, double 
clicking the left button leads to atom or group exchange. Double 
clicking on an atom with the Ctrl key depressed leads to inversion in 
chirality of the atom and double clicking on an atom with both Ctrl 
and Shift keys depressed inverts the absolute configuration of the 
molecule. Once an initial fragment, group or ring has been drawn, 
double clicking on the background will insert it alongside (but not 
bonded to) whatever fragments currently exist on screen.

Manipulation. The left button is used for rotation and the right 
button is used for translation and scaling of objects on screen. With 
no keys depressed, the left mouse button gives rise to rotation about 
the X and Y (screen) axes, while the right mouse button gives rise 
to translation in the X and Y (screen) directions. Together with the 
Shift key, the left mouse button gives rise to rotation about the Z 
direction and the right mouse button gives rise to scaling. The center 
(scroll) wheel on the mouse may also be used for scaling.

The Ctrl key in conjunction with the left or right mouse buttons and 
(optionally) the Shift key, signifies a change in focus away from 
the default for the purpose of rotations and translations. Outside of 
add fragment mode, the default is focus on a single molecule (the 
selected molecule). Use of the Ctrl key changes focus to the entire 
set of molecules on screen, meaning that rotations and translations 
are carried out globally. In add fragment mode, the default is focus on 
the full set of fragments that make up the molecule being constructed, 
and rotations and translations refer to this set of fragments as a 
whole. Use of the Ctrl key changes focus to a single fragment (the 
selected fragment), and rotations and translations now refer only to 
this fragment.

In add fragment mode, use of the Alt key (option key for Mac, 
Ctrl and Shift keys for Linux) with the left mouse button allows for 
rotation about a selected bond and, with the right mouse button, for 
changing the length of the selected bond.

Additional keys control various Spartan functions.
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3 3 selects red-cyan stereo display. Pressing again 
returns to non-stereo display.

Page Up, Page Down Moves up (Page Up), down (Page Down), 
Home, End to the top (Home) and to the bottom (End) of the 

set of open molecules. Also, moves up and down 
pages in the Output dialog.

Insert In add fragment mode only, inserts a new fragment 
(option for Mac) on screen. This is accomplished by selecting the 

fragment from the model kit, holding down the 
Insert key and clicking on screen. Insertion may 
also be accomplished by double clicking on the 
background following selection of a fragment.

Delete Deletes a fragment, free valence, CFD, reaction 
arrow, the contents of a selection box, spectrum, 
curve, or plot. This is accomplished by holding down 
the Delete key and clicking on the fragment, etc.

Enter Required following text or data entry into
(return for Mac) spreadsheet or dialogs.

Selecting Molecules, etc.

Two or more molecules may be simultaneously displayed in 
Spartan’s window (see Tabs earlier in this chapter). However, only 
one molecule may be selected. The selected molecule has access to 
all capabilities (molecule building, job setup and submission and 
text and graphical display and manipulation), while non-selected 
molecules may only be displayed as static images. The exceptions 
involve scaling and the use of the Ctrl key.

Selection of a molecule occurs by clicking on its structure model 
or on any of its associated graphical surfaces. This will also result 
in deselection of any previously selected molecule. Molecular 
properties for the selected molecule are available in the Properties 
dialog (Display menu; Chapter 18). Atom, bond, substituent and 
surface display properties, pharmacophores and group descriptors, 
as well as information about geometrical constraints may be 
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accessed by subsequent clicking on an atom, bond, etc., associated 
with the selected molecule, that are then highlighted (colored 
gold). Clicking on the selected atom, bond etc. resets the display 
to molecular properties. Clicking on another molecule results in 
display of molecular properties for that molecule. Information about 
plots (including spectra) and changes to plot style and range are also 
available from the Plot Properties dialog.

Where the molecule belongs to a document with more than a single 
member, selection from among the different members in the document 
may be made using either the  and  buttons or the scroll bar at 
the bottom left of the screen. Alternatively, if the spreadsheet for the 
document is open on screen (Spreadsheet under the Display menu; 
Chapter 18), selection can be made by clicking on the molecule 
label at the left of the spreadsheet. Clicking on  at the bottom left 
of the screen animates the display of molecules in the document, 
that is, steps through them sequentially. This is useful for displaying 
a progression of graphical surfaces along a reaction coordinate. 
Clicking on  (that replaces ) stops the animation.

Two or more molecules from the same document may be displayed at 
once (although only one may be selected). Molecules are marked for 
display by checking the box immediately to the left of the molecule 
label in the spreadsheet.

Dialogs

Dialogs are either modal (as indicated by ... following their reference 
in a menu) or non-modal. Modal dialogs must be dismissed before 
program operation can continue, while non-modal dialogs may be 
kept open on screen. Only one modal dialog may be open on screen, 
while several different non-modal dialogs and/or several copies 
of the same non-modal dialog (each copy referring to a different 
molecule in a document or different documents) may be open on 
screen.
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Database Access

Spartan comes with sample copies of both the Spartan Molecular 
Database (SMD) and the Spartan Spectra and Properties Database 
(SSPD), each covering ~5,000 molecules. Full versions (~150,000 
molecules for SMD and ~70,000 molecules for SSPD) are available 
from Wavefunction. SMD accesses up to nine different quantum 
chemical models for each molecule, whereas SSPD is limited to a 
single model (the EDF2/6-31G* density functional model). SSPD 
is based on a more reliable model for selecting best conformer and 
includes infrared and NMR spectra as well as the wavefunction. 
Either (or both) SMD and SSPD may be searched by substructure 
(Open Databases under the Search menu; Chapter 19), but explicit 
molecular replacement requires that either SMD or SSPD be selected. 
This is done from a menu at the bottom of Spartan’s screen. Most 
of the tutorials that follow make use of SMD, and the menu should 
be set to SMD. The tutorials in Chapter 11 make use of SSPD and 
here the menu should be set to SSPD.

Stereo Displays
Spartan supports red-cyan stereo. Red/blue glasses must be worn. 
To enter stereo mode, press the 3 key. Press again to return to non-
stereo mode.

Changing Colors and Setting Preferences

Colors and Preferences... under the Options menu (Chapter 20) 
allows for changing default background and graphical object colors, 
and for setting (and resetting) program defaults, respectively. Further 
control of color is available in the various Style dialogs accessible 
from Properties under the Display menu; Chapter 18.

Monitoring and Terminating Jobs

Monitor under the Options menu (Chapter 20) allows for monitoring 
of executing jobs as well as for terminating jobs.
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Chapter 3
Basic Operations

This tutorial introduces a number of basic operations in Spartan 
required for molecule manipulation, property query and spectra and 
graphics display. It is a must for new Spartan users, and should at 
least be skimmed by experienced users to expose them to new features 
of Spartan’10. Specifically it shows how to: i) open molecules, ii) 
view different models and manipulate molecules on screen, iii) 
measure bond distances, angles and dihedral angles, iv) display 
energies, dipole moments, atomic charges and infrared, NMR and 
UV/visible spectra, and v) display graphical surfaces and property 
maps. Spreadsheet operations are not illustrated, no molecules are 
built and no quantum chemical calculations are performed.

1. Start Spartan. Click (left mouse button) on File from the menu 
bar that appears at the top of Spartan’s main window. Click on 
Open... from the File menu that appears. Alternatively, click on 
the  icon at the top of the screen. A file browser appears.

 Move to the tutorials directory*, click on basic operations and 
click on Open (or double click on basic operations). A single 
file containing ethane, acetic acid dimer, propene, ammonia, 
hydrogen peroxide, acetic acid, water, cyclohexanone, 
camphor, 3-aminobenzophenone, ethylene, benzene, aniline 
and cyclohexenone will be opened. A ball-and-spoke model 
for the first molecule (ethane) will be displayed, and its name 
appears at the bottom right of the screen. The appearance of the 
name means that ethane is in the Spartan Molecular Database.**

* For Windows, this directory is found in Program Files/Wavefunction/Spartan10 or 
Program Files(x86)/Wavefunction/Spartan10. It needs to be copied to another location 
available to the user prior to opening it in Spartan. For Linux, this is found in the directory 
where Spartan was installed. For Macintosh, this is located at the top level on the installation 
CDROM.

** Make certain that SMD and not SSPD is selected from the menu at the bottom of the 
screen.
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2. Practice rotating (move the mouse while holding down the left 
button) and translating (move the mouse while holding down 
the right button). Click on Model from the menu bar.

 

  
  Wire Ball-and-Wire Tube Ball-and-Spoke

 One after another, select Wire, Ball and Wire, Tube and finally 
Ball and Spoke from the Model menu. All four models for 
ethane show roughly the same information. The wire model 
looks the most like a conventional line formula. It uses color to 
distinguish different atoms, and one, two and three lines between 
atoms to indicate single, double and triple bonds, respectively.

 The ball-and-wire model is identical to the wire model, except 
that atom positions are represented by small spheres, making 
it easy to identify atom locations. The tube model is identical 
to the wire model, except that bonds are represented by solid 
cylinders. The tube model is better than the wire model in 
conveying three-dimensional shape. The ball-and-spoke model 
is a variation on the tube model; atom positions are represented 
by colored spheres, making it easy to see atom locations.

 Select Space Filling from the Model menu.
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 Space-Filling

 The space-filling model is different from the other models in 
that bonds are not shown. Rather, each atom is displayed as a 
colored sphere that represents its approximate size. Thus, the 
space-filling model for a molecule provides a measure of its 
size. While lines between atoms are not drawn, the existence 
(or absence) of bonds can be inferred from the extent to 
which spheres on neighboring atoms overlap. If two spheres 
substantially overlap, then the atoms are almost certainly 
bonded, and conversely, if two spheres barely overlap, then 
the atoms are not bonded. Intermediate overlaps suggest weak 
bonding, for example, hydrogen bonding.

3. Click once on the right arrow key  at the bottom left of the 
screen. This will move to the next molecule in the document, 
acetic acid dimer. Its name will appear at the bottom of the 
screen. If you make a mistake, use the backward  or forward 

 step keys to get to acetic acid dimer in the document. Switch 
to a space-filling model and look for overlap between the (OH) 
hydrogen on one acetic acid molecule and the (carbonyl) 
oxygen on the other. Return to a ball-and-spoke model and 
select Hydrogen Bonds from the Model menu.

 
 Ball-and-Spoke model for acetic acid dimer  

with hydrogen bonds displayed

 The two hydrogen bonds, that are responsible for holding the 
acetic acid molecules together, will be drawn.
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 Use the 3 key to toggle between stereo 3D and regular display. 
To view in 3D you will need to wear red/blue glasses.

4. Distances, angles, and dihedral angles can easily be measured 
with Spartan using Measure Distance, Measure Angle, and 
Measure Dihedral, respectively, from the Geometry menu.

 
a) Measure Distance: This measures the distance between 

two atoms. Click once on  to move to the next molecule, 
propene, and then select Measure Distance from the 
Geometry menu (or click on the  icon at the top of the 
screen). Click on a bond or on two atoms (the atoms do not 
need to be bonded). The distance (in Ångstroms) will be 
displayed at the bottom of the screen. Repeat the process for 
several atoms. When you are finished, select View from the 
Build menu (or click on the  icon at the top of the screen).

  
b) Measure Angle: This measures the angle around a central 

atom. Click once on  to move to the next molecule, 
ammonia, and then select Measure Angle from the 
Geometry menu (or click on the  icon at the top of the 
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screen). Click first on H, then on N, then on another H. 
Alternatively, click on two NH bonds. The HNH angle (in 
degrees) will be displayed at the bottom of the screen. Click 
on  when you are finished.

c) Measure Dihedral: This measures the angle formed by 
two intersecting planes, one containing the first three 
atoms selected and the other containing the last three atoms 
selected. Click once on  to move to the next molecule, 
hydrogen peroxide, then select Measure Dihedral from 
the Geometry menu (or click on the  icon at the top of 
the screen) and then click in turn on the four atoms (HOOH) 
that make up hydrogen peroxide. The HOOH dihedral 
angle will be displayed at the bottom of the screen. Click 
on  when you are finished.

5. Energies, dipole moments and atomic charges among other 
calculated properties, are available from Properties under the 
Display menu.

 

a) Energy: Click once on  to move to the next molecule,  acetic 
acid, and then select Properties from the Display menu. The 
Molecule Properties dialog appears. It is divided into three 
parts designated by tabs. Molecule provides the energy and 
other information relating to the isolated molecule, QSAR 
provides quantities that may be used as QSAR descriptors 
and Thermodynamics provides the enthalpy, heat capacity, 
Gibbs energy and zero-point energy.  Make certain that the 
Molecule tab is selected. 
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 This provides the energy for acetic acid in atomic units 
(Energy in au). Also provided is an estimate of the energy in 
water (Energy(aq) in au) and the difference between the two 
(Solvation E kJ/mol).

b) Dipole Moment: The magnitude of the dipole moment 
(Dipole Moment in debyes) is also provided in the Molecule 
Properties dialog. A large dipole moment indicates large 
separation of charge. You can attach the dipole moment 
vector,  where the + side refers to the positive end of the 
dipole, to the model on the screen, by checking the box to the 
left of  Display Dipole Vector near the bottom of the dialog.

The vector will not be displayed if the dipole moment is zero. 
The dipole moment will not be reported if the molecule is charged 
because in this case it depends on the location and orientation of 
the molecule in space. 

c) Atomic Charges: To display the charge on an atom, click on it 
with the Molecule Properties dialog on the screen. The Atom 
Properties dialog replaces the Molecule Properties dialog.
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 Three different atomic charges, Electrostatic, Mulliken 
and Natural, are given in units of electrons. A positive 
charge indicates a deficiency of electrons on an atom and 
a negative charge, an excess of electrons. Repeat for other 
atoms. Confirm that the positively-charged atom(s) lie at the 
positive end of the dipole moment vector. When you are 
finished, close the dialog by clicking on  at the top.

The three sets of atomic charges for acetic acid are different 
because the charge on an atom in a molecule cannot be uniquely 
defined, let alone measured. While the nuclear charge is equal to 
the atomic number, it is not possible to say how many electrons 
“belong” to a particular nucleus. The different calculated charges 
correspond to different ways of counting the number of electrons 
associated with an atom.

d) Infrared Spectra: Molecules vibrate (stretch, bend, twist) 
even if they are cooled to absolute zero. This is the basis 
of infrared spectroscopy, where absorption of energy occurs 
when the frequency of a particular molecular motion matches 
the frequency of the light. Infrared spectroscopy is important 
for identifying molecules as different functional groups 
vibrate at noticeably different and characteristic frequencies. 

 Click once on  to move to the next molecule in the 
document, water. To animate a vibration, select Spectra 
from the Display menu and click on the IR tab. This leads 
to the IR Spectra dialog.
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 This displays the three vibrational frequencies for the water 

molecule, corresponding to bending and symmetric and 
antisymmetric stretching motions. One after the other, click 
in the box to the left of each frequency and examine the 
motion. Turn off the animation by clicking in the box of the 
selected frequency when you are finished.

 Click once on  to move to cyclohexanone, the next 
molecule in the list. The Spectra dialog now lists its 45 
frequencies corresponding to the 45 vibrational motions of 
this molecule with 17 atoms. Examine each in turn (click 
on the entry in the dialog) until you locate the frequency 
corresponding to the CO (carbonyl) stretch. Next, click 
on Draw Calculated at the top of the dialog. The infrared 
spectrum of cyclohexanone appears.
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 You can move the spectrum around the screen by first clicking 
on it to select it (it will turn yellow) and then moving the 
mouse while holding down the right button. You can size it 
with the scroll wheel or by moving the mouse up and down 
while holding down both the Shift key and the right button.

 Identify the line in the spectrum associated with the C=O 
stretch (a small red circle moves from line to line as you step 
through the frequencies in the Spectra dialog). Note that this 
line is isolated and that it is very intense, making it easy to find.

 If your computer is connected to the internet, you can draw 
the experimental IR spectrum for cyclohexanone on top of the 
calculated spectrum. Select Web Site under Experimental 
Data From: at the bottom of the dialog. Make certain that 
Global Spectra is not checked before you click on Draw 
Experimental in the middle of the dialog. Click on Draw 
Experimental.

 

 If you are not online or have trouble downloading the experimental 
spectrum, select Local File under Experimental Data From: and 
find cyclohexanoneIR.dx in the tutorials directory. For Windows, 
this directory is found in Program Files/Wavefunction/Spartan10 
or Program Files(x86)/Wavefunction/Spartan10. It needs to be 
copied to another location available to the user prior to opening it 
in Spartan. For Linux, this is found in the directory where Spartan 
was installed. For Macintosh, this is located at the top level on the 
installation CDROM.  

 Note that the lines in the calculated spectrum are consistently 
of higher frequency. To scale the calculated spectrum, bringing 
it into closer agreement with the experimental spectrum,  
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click on it and move the slider bar to the right of Scale near  
the top of the dialog. Calculated and experimental spectra 
are automatically fit by selecting Experimental under 
Calculated Fit at the center of the IR Spectra dialog.

 
 You can remove the plot by clicking on both Delete 

Calculated and Delete Experimental in the Spectra dialog. 
(These buttons have replaced Draw Calculated and Draw 
Experimental, respectively.)

e) NMR Spectra: Along with mass spectrometry, NMR 
spectroscopy is the most powerful tool available with which 
to assign molecular structure. Many nuclei exhibit NMR 
spectra, but proton and 13C are by far the most important.

 Click once on  to move to the next molecule in the document, 
camphor. With the Spectra dialog on screen, click on the 
NMR tab to bring up the NMR Spectra dialog.

 



Chapter 3 39

 Make certain that Boltzmann Averaging is not checked and 
click on Draw Calculated under 13C Spectrum to show the 
calculated 13C spectrum.

 

 This comprises nine lines, in the range of 50 to 0 ppm 
(there is a tenth line corresponding to the carbonyl carbon 
at 218 ppm). Note that the scale used here is different than 
the default range (150 to 0 ppm). Scale adjustment will be 
discussed in a later tutorial. 

 If you are connected to the internet, select Web Site under 
Experimental Data From: at the bottom right of the dialog 
and make certain that Global Spectra is not checked before 
you click on Draw Experimental (under 13C Spectrum) to 
superimpose the experimental spectrum onto the calculated 
one. Click on Draw Experimental. 

 

 If you are not online or have trouble downloading the experimental 
spectrum, select Local File under Experimental Data From: and 
find camphorNMR.dx in the tutorials directory. 

 Remove the spectra by clicking on Delete Calculated 
and Delete Experimental in the NMR Spectra dialog. 
(These buttons have replaced Draw Calculated and Draw 
Experimental, respectively.) 
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 You can obtain numerical values for the individual chemical 
shifts by bringing up a properties dialog (Properties from 
the Display menu) and clicking on the atom of interest. Note 
that proton shifts in addition to 13C shifts are available. 

 Finally, draw both calculated and measured DEPT spectra. 
There is no experimental file, so before you click on Draw 
Experimental DEPT, select Local File under Experimental 
Data From: and find camphorDEPT.dx in the tutorials 
directory. Make certain that Global Spectra is not checked 
before you click on Draw Experimental.

 
 Note that both spectra now contain only seven lines. The lines 

corresponding to the three quaternary carbons (including the 
carbonyl carbon that is off scale) are missing. The three lines 
pointing down correspond to the methylene carbons while 
four lines pointing up correspond to the methyne carbon and 
the three methyl groups. 

f) UV/visible Spectra: Absorption of light in the visible or 
ultraviolet range of the electromagnetic spectrum leads to 
electronic excitation from the ground-state to excited-states 
and (in the case of absorption in the visible), is responsible 
for a molecule’s color. UV/visible spectroscopy not only 
offers a valuable fingerprint but is also an important screen to 
identify molecules that may be damaged by exposure to light.

 Click once on  to move to the next molecule,  
3-aminobenzophenone. Bring up the Spectra dialog and 
click on the UV/vis tab to give the UV/vis Spectra dialog.
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 Click on Draw Calculated to show the calculated spectrum.

 

 If you are on the internet, select Web Site under Experimental 
Data From: at the bottom of the dialog and click on Draw 
Experimental. Make certain that Global Spectra is not 
checked before you click on Draw Experimental. In either 
case, the experimental spectrum will be superimposed onto 
the calculated one.
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 If you are not online or have trouble downloading the experimental 
spectrum, select Local File under Experimental Data From: and 
find 3-aminobenzophenone.dx in the tutorials directory. 

 The two spectra are visually similar at least in a qualitative 
sense. Note, however, that any vibrational structure revealed 
in the experimental spectrum will not be mirrored in the 
calculated spectrum. Remove the spectra by clicking on 
Delete Calculated and Delete Experimental in the UV/
vis Spectra dialog. (These buttons have replaced Draw 
Calculated and Draw Experimental, respectively.) 

Even though the spectra look similar, they are sufficiently different 
that the theory would not likely be successful in accounting for the 
“color” of the molecule. Where it is likely to be more successful is 
in anticipating changes in color resulting from changes in structure.

6. Spartan permits display, manipulation and query of a number 
of important graphical quantities resulting from quantum 
chemical calculations. Most important are the electron density 
(that reveals how much space a molecule actually takes up), the 
bond density (that reveals chemical bonds), and key molecular 
orbitals (that provide insight into both bonding and chemical 
reactivity). In addition, the electrostatic potential map, an 
overlay of the electrostatic potential (the attraction or repulsion 
of a positive charge for a molecule) on the electron density, 
is valuable for describing overall molecular charge distribution 
as well as anticipating sites of electrophilic addition. Another 
indicator of electrophilic addition is provided by the local 
ionization potential map, an overlay of the energy of electron 
removal (ionization) on the electron density. Finally, an 
indicator of nucleophilic addition is provided by the |LUMO| 
map, an overlay of the absolute value of the lowest-unoccupied 
molecular orbital (the LUMO) on the electron density.

 Click once on  to move to the next molecule in the list, 
ethylene. Select Orbital Energies from the Display menu 
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(or click on icon). An orbital energy diagram for ethylene will 
appear at the left of the screen. This provides the energies of all 
six occupied valence molecular orbitals and two unoccupied 
molecular orbitals.

 

 Click on the energy level in the diagram labelled HOMO. In a 
second, the familiar π bond in ethylene will appear. Note that 
the graphic has “blue and red” regions. These correspond to 
positive and negative values of the orbital (the absolute sign 
is arbitrary). Examine the other occupied orbitals (by clicking 
on their respective energy levels in the diagram) as well as the 
lowest-unoccuped molecular orbital (the LUMO).

 Click once on  to move to the next molecule in the list, benzene. 
Select Surfaces from the Display menu. The Surfaces dialog 
appears.
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  Select Electrostatic Potential Map inside the Surfaces dialog 
(click inside the box to the left of the name). An electrostatic 
potential map for benzene will appear. Click on the map. The 
Style menu will appear at the bottom right of the screen. Select 
Transparent from this menu. This makes the map transparent 
and allows you to see the molecular skeleton underneath. Go 
back to a Solid display (Style menu) in order to clearly see 
color differences. The surface is colored red in the π system 
(by convention, indicating negative potential and the fact that 
this region is attracted to a positive charge), and blue in the 
σ system (by convention, indicating positive potential and the 
fact that this region is repelled by a positive charge). Bring up 
the Properties dialog (Display menu) and click on the surface. 
Remove the checkmark from the box to the left of Bands in the 
Surface Properties dialog to replace the series of color bands 
(discrete display) by a continuous display.*

* Discrete displays are the default in Spartan’10. You can change the default to continuous 
displays (the default in Spartan’08) from the Molecule Preferences dialog (Preferences 
under the Options menu; Chapter 20).
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 Click once on  to move to the next molecule in the list, aniline, 
and select Local Ionization Potential Map inside the Surfaces 
dialog. By convention, red regions on a local ionization potential 
map indicate areas from which electron removal (ionization) is 
relatively easy, meaning that they are subject to electrophilic 
attack. These are easily distinguished from regions where 
ionization is relatively difficult (by convention, colored blue). 
Note that the ortho and para ring carbons are more red than the 
meta carbons, consistent with the known directing ability of the 
amino substituent.

 Click once on  to move to the next molecule in the list, 
cyclohexenone, and select LUMO inside the Surfaces dialog. 
The resulting graphic portrays the lowest-energy empty 
molecular orbital (the LUMO) of cyclohexenone. This orbital 
is delocalized onto several atoms and it is difficult to tell 
where exactly a pair of electrons (a nucleophile) will attack the 
molecule.

 A clearer portrayal is provided by a LUMO map, that displays the 
(absolute) value of the LUMO on the electron density surface. By 
convention, the color blue is used to represent maximum value 
of the LUMO and the color red, minimum value. First, remove 
the LUMO from your structure (select LUMO in the Surfaces 
dialog) and then turn on the LUMO map (select |LUMO|Map 
in the dialog). Note that there are two blue regions, one directly 
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over the carbonyl carbon and the other over the β carbon. This 
is entirely consistent with known chemistry. Enones may either 
undergo carbonyl addition or conjugate (Michael) addition.

 

HO CH3

CH3

OO

CH3Li
carbonyl addition

(CH3)2CuLi
Michael addition

7. When you are finished, close the document by selecting Close 
from the File menu or alternatively by clicking on the  icon 
at the top of the screen.
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Chapter 4
Organic Molecules

This chapter shows how to: i) construct organic molecules from 
atomic fragments, functional groups and rings, ii) carry out 
molecular mechanics and quantum chemical calculations and iii) 
calculate and interpret graphical models. It also illustrates use of 
the Spartan Molecular Database* of calculated structures, energies 
and molecular properties as well as Spartan’s interface to the 
Cambridge Structural Database. Discussion of the calculation and 
display of infrared and NMR spectra is deferred until Chapter 6.

The simplest building blocks incorporated into Spartan’s organic 
model kit are atomic fragments. These constitute specification of 
atom type, for example, carbon, and local environment, for example, 
tetrahedral. However, much of organic chemistry is organized around 
functional groups, collections of atoms the structure and properties of 
which are roughly the same in every molecule. The organic model kit 
also incorporates a small library of functional groups that can easily 
be extended or modified. For example, the carboxylic acid group may 
be modified to build a carboxylate anion (by deleting a free valence 
from oxygen), or an ester (by adding tetrahedral carbon to the free 
valence at oxygen).

R
C

O
H

C

carboxylic acid
R

C
O–

O

carboxylate anion
R

C
O

CH3

O

ester

* Spartan’10 includes subsets of approximately 5,000 molecules from the Spartan Molecular 
Database (SMD) which comprises more than 150,000 molecules along with their structures, 
energies, spectra and properties calculated with up to 9 quantum chemical models, and 
from the Spartan Spectra and Properties Database (SSPD), which comprises more than 
70,000 molecules, includes the wavefunction allowing on-the-fly generation of graphical 
surfaces and property maps, and most of which provide both infrared and NMR spectra.
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Rings are also common components in organic molecules, and the 
organic model kit incorporates a library of commonly -encountered 
hydrocarbon rings that can easily be modified by atom replacement. 
For example, pyridine may be built starting from benzene by selecting 
aromatic nitrogen from the list of atomic fragments, and then double 
clicking on one of the carbons. This results in the substitution of 
aromatic nitrogen for aromatic carbon.

N

pyridinebenzene

select aromatic nitrogen
and double click on carbon

Functional groups may also be modified in this manner.

In addition to illustrating the construction of organic molecules, the 
tutorials in this chapter also illustrate the way in which molecular 
mechanics and quantum chemical calculations are set up and their 
results examined and interpreted. A variety of graphical models are 
introduced and illustrated. Finally, examples of the use of the Spartan 
Molecular Database of calculated molecular structures, energies and 
properties and of the Cambridge Structural Database of experimental 
X-ray crystal structures are provided. 
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Acrylonitrile

C C
H

H H

C
N

Acrylonitrile provides a good opportunity to illustrate the basics of 
molecule building in Spartan, as well as the steps involved in carrying 
out and analyzing a quantum chemical calculation.

1. Click with the left mouse button on File from the menu bar. Then 
click on New from the menu that appears (or click on the  icon 
at the top of the screen). The organic model kit appears.

 
 At the center of the kit is a library of atomic fragments. Click 

on trigonal planar sp2 hybridized carbon  from the fragment 
library. A model of the fragment appears at the top of the model 
kit. Bring the cursor anywhere on screen and click (left button). 
Rotate the carbon fragment (drag the mouse while holding down 
the left button) so that you can clearly see both the double free 
valence (=) and the two single free valences (–).

Spartan’s model kits connect atomic fragments (as well as groups, 
rings and ligands) through free valences. Any free valences that 

1 min
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remain upon exiting a model kit are automatically converted to 
hydrogen atoms; it is not necessary to explicitly add hydrogens to 
open valences.

2. sp2 carbon is still selected. Click on the double free valence. The 
two fragments are connected by a double bond, leaving you with 
ethylene. The name ethylene will appear at the bottom right of 
the screen. If you make a mistake and click instead on the single 
free valence, select Undo from the Edit menu. You can also start 
over by selecting Clear from the Edit menu.

Spartan’s organic model kit allow only the same type of free valences 
to be connected, for example, single to single, double to double, etc.

3. Click on Groups in the model kit, and select Cyano from the 
functional groups available from the menu.

 
 Click on any of the four single free valences on ethylene (they 

are equivalent). This bonds the cyano group to ethylene, leaving 
you with acrylonitrile.* Its name will now appear at the bottom 
right of the screen.

* You could also have built acrylonitrile without using the Groups menu. Starting from scratch 
(Clear from the Edit menu), first build ethylene as above, then select sp hybridized carbon 

 from the model kit and then click on one of the free valences on ethylene. Next, select 
sp hybridized nitrogen  from the model kit and click on the triple free valence on the sp 
carbon. Alternatively, you could have built the molecule entirely from groups. Starting from 
scratch, click on Groups, select Alkenyl from the menu and click anywhere on screen. Then 
select Cyano from the menu of functional groups and click on one of the free valences on 
ethylene. In general, molecules can be constructed in more than one way.
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4. Select Minimize from the Build menu (or click on the  icon 
at the top of the screen). The final molecular mechanics energy 
(36.2 kJ/mol) and symmetry point group (Cs) are provided at the 
bottom right of the screen.

5. Select View from the Build menu (or click on the  icon at 
the top of the screen). The model kit disappears, leaving only a 
ball-and-spoke model of acrylonitrile on screen.

 
 ball-and-spoke model

 This model can be rotated, translated and zoomed by using the 
mouse in conjunction with keyboard functions. To rotate the 
model, drag the mouse while holding down the left button; to 
rotate in the plane of the screen also hold down the Shift key. 
To translate the model, drag the mouse with the right button 
depressed. To zoom the model (translation perpendicular to the 
screen), use the center mouse wheel (scroll wheel) if available, 
or hold down the Shift key in addition to the right button while 
dragging the mouse up (zoom in) or down (zoom out). 

6. Select Calculations... from the Setup menu, and perform the 
following operations in the Calculations dialog which appears.
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a. Select Equilibrium Geometry from the top menu to the 
right of Calculate. This specifies optimization of equilibrium 
geometry. Ground and not First Excited should appear in 
the menu to the left of State.

b. Select Hartree-Fock and then 3-21G from the two bottom 
menus to the right of Calculate. This specifies a Hartree-
Fock calculation using the 3-21G split-valence basis set. 
Keep the default in Vacuum setting.

 When you finish, click on OK to remove the dialog.

7. Select Submit from the Setup menu.* A file browser appears.

 
 The name acrylonitrile will be presented to you in the box to 

the right of File name. Either use it or type in whatever name 
you like and then click on Save.** You will be notified that the 
calculation has been submitted.

 

* You could also have clicked on Submit inside the Calculations dialog.
** Proper names will automatically be provided for you to accept, modify or replace whenever 

the molecule exists in the Spartan Molecular Database or Spartan Spectra and Properties 
Database (whichever is selected) and where the document being submitted contains only 
one molecule. Otherwise the names “spartan1”, “spartan2” will be provided.
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 Click on OK to remove the message from the screen.

After a molecule has been submitted, and until the calculation has 
completed, you are not permitted to modify any dialogs or other 
information associated with it.

8. You will be notified when the calculation has completed.

 

 Click on OK to remove the message from the screen. Select 
Output from the Display menu. A window containing text output 
for the job appears.

 
 You can scan the output from the Hartree-Fock calculation by 

using the scroll bar at the right of the window or by clicking (left 
button) on or inside the output window and using the scroll wheel 
on your mouse. The information at the top of the dialog includes 
the task, basis set, number of electrons, charge and multiplicity, 
as well as further details of the calculation. Below this is the 
symmetry point group of the molecule that was maintained 
during the optimization.
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 Eventually, a series of lines appear, under the heading 
Optimization. These tell the history of the optimization process. 
Each line (or Step) provides results for a particular geometry. 
Ideally, the energy will monotonically approach a minimum 
value for an optimized geometry. If the geometry was not 
optimized satisfactorily an error message, such as: Optimization 
has exceeded N steps – Stop, will be displayed following the 
last optimization cycle. If this were the case, you would have 
been notified that the job had failed.

 Near the end of the output is the final energy* (-168.82040 
atomic units for acrylonitrile with the 3-21G basis set), and the 
computation time. Click on  at the top of the output dialog to 
close it.

 You may examine the total energy and dipole moment among 
other calculated properties without having to go through the 
output. Select Properties from the Display menu to bring up 
the Molecule Properties dialog (make certain that the Molecule 
tab and not the QSAR Thermodynamics tab is selected).

  
 To see the dipole moment vector (indicating the sign and 

direction of the dipole moment), check the box to the right of 
Display Dipole Vector. Wire, ball-and-wire or tube models are 
best for this display.

* See Calculations... (Setup menu; Chapter 17) for a discussion of how energy relates to 
heat of formation and strain energy.



Chapter 4 55

 
 Uncheck the box to remove the dipole moment vector.

 Click on an atom. The (Molecule Properties) dialog will be 
replaced by the Atom Properties dialog.

 
 Among other things, this provides three different sets of atomic 

charges: Electrostatic, Mulliken and Natural. To obtain the 
charge on another atom, simply click on it. Inspect all the atomic 
charges on acrylonitrile (by clicking on the appropriate atoms). 
When you are finished, click on  at the top of the Atom 
Properties dialog to close it.

9. Select Surfaces from either the Setup or Display menu. Click on 
Add (at the bottom of the Surfaces dialog that results) and select 
Electrostatic Potential Map from the menu.* This requests an 

*  Surfaces selected from this menu will be obtained at the resolution set in the last access to 
the Add Surfaces dialog. This is normally set to medium. Both lower and higher resolution 
images are available. The former provides rough images that require significantly less 
computer time to generate. The latter provides production quality images that require 
significantly more computer time and disk space. To specify resolution, click on More 
Surfaces instead of Add in the Surfaces dialog (or select More Surfaces... from the menu 
that follows from clicking on Add in the Surfaces dialog). This gives rise to the Add 
Surfaces dialog from which you can select the desired resolution from the Resolution 
menu. Computer time and storage can also be reduced by checking Fixed to the right of 
Isovalue in the Add Surface dialog. This results in constant isovalue surfaces that cannot 
be changed and cannot be used to generate “Slice” type displays.



56 Chapter 4

electrostatic potential map (an electron density surface onto 
which the value of the electrostatic potential will be mapped). 
Click on OK. A line Electrostatic Potential Map appears at 
the top of the dialog. If you make a mistake, click on this line 
(Electrostatic Potential Map) and then click on Delete at the 
bottom of the dialog.

10. The graphics calculation will run automatically (without needing 
to resubmit the job) following your request.* When it has 
completed (a few seconds), select Electrostatic Potential Map by 
clicking in the selection box in the Surfaces dialog. The surface 
itself corresponds to the electron density and provides a measure 
of the overall size and shape of acrylonitrile. The colors indicate 
values of the electrostatic potential on this surface; by convention, 
colors toward red correspond to negative potential (stabilizing 
interaction between the molecule and a positive charge), while 
colors toward blue correspond to positive potential. The nitrogen 
(the most electronegative atom) is red and the hydrogens (the most 
electropositive atoms) are blue.**

11. Select Close from the File menu (or click on ) to remove 
acrylonitrile from the screen.*** Also, close any dialogs that may 
be open.

*  If it does not, you need to select Auto-Gen Graphics in the Settings Preferences dialog 
(Preferences under the Options menu; Chapter 20). Note that automatic generation of 
graphics is supressed irrespective of the preferences setting when the request applies to a 
list with more than 10 molecules.

** The default display is a set of discrete color bands. You can alter the number of bands by 
bringing up (Molecule) Properties dialog (Properties from the Display menu), clicking on the 
map to bring up the Surface Properties dialog and altering the number to the right of Bands. 
You can change to a continuous display by removing the checkmark to the left of Bands.

***  While Spartan permits as many molecules as desired on screen at a given time, it will be 
less confusing for first-time users to keep only a single molecule open at a time.
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Cyclohexanone

O

Cyclohexanone provides the opportunity to illustrate additional 
building features as well as graphical models for investigation of the 
stereoselectivity of an important class of organic reactions.

1. Click on  to bring up the organic model kit. Click on Rings 
and select Cyclohexane from the menu of rings.

 
 Click anywhere on screen and cyclohexane will appear. Select 

sp2 carbon  from the model kit. Double click on any carbon 
(not free valence). The sp3 hybridized center will be replaced 
by an sp2 hybridized carbon.

Spartan’s organic model kit allows replacement of fragments, 
subject both to the usual valence rules and to the availability of 
free valences. For example, replacement of an sp3 carbon by an sp2 
carbon requires that at least two free valences be available. This is 
possible for cyclohexane (above), but would not have been allowed 
for the substituted ring carbon in methylcyclohexane.

•

•
Me

•

X

 Select sp2 oxygen  from the model kit. Click on the double 
free valence on the sp2 carbon. You have made cyclohexanone 
(its name will appear at the bottom right of the screen). Click 

1 min
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on  to produce a final structure with Cs symmetry, and then 
on  to remove the model kit.

2. Select Calculations... from the Setup menu. Specify Equilibrium 
Geometry from the top menu to the right of Calculate, and 
Hartree Fock, 3-21G and Vacuum from the three bottom menus 
to the right of Calculate. Click on OK. 

3. Cyclohexanone undergoes nucleophilic attack at the carbonyl 
carbon, and it is reasonable to expect that the molecule’s lowest-
unoccupied molecular orbital (the LUMO) will be localized 
here. To visualize the LUMO, enter the Surfaces dialog (Setup 
or Display menu). Click on Add and select LUMO from the 
menu. Also request an electron density surface onto which the 
(absolute) value of the LUMO has been mapped in color (a so-
called LUMO map). Click on Add and select |LUMO| Map 
from the menu. Submit the job (Submit from the Setup menu) 
with the name cyclohexanone (the selection that is offered).

Graphical displays may either be requested at the time of geometry 
calculation (as in the present example), or at anytime after (as in the 
previous example). In the latter case, it is not necessary to submit 
the job. Spartan keeps track of what has been done and will not 
perform unnecessary calculations.

4. After the calculations have completed, reenter the Surfaces 
dialog and click on LUMO. As expected, this is a π* orbital 
primarily localized on the carbonyl group.

5. Inside the Surfaces dialog, turn display of the LUMO off (click 
to deselect LUMO). Next, click on |LUMO| Map to display 
the electron density surface onto which the (absolute) value of 
the LUMO has been mapped. By convention, colors toward 
red indicate small (absolute) values of the LUMO (near zero), 
while colors toward blue indicate large (absolute) values of the 
LUMO. Note the blue spot directly over the carbonyl carbon. 
This corresponds to the maximum value of the LUMO and is 
where nucleophilic attack will occur.
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6. You will see that the blue spot over the axial face of the carbonyl 
carbon is bigger (and more blue) than that over the equatorial 
face. This indicates preferential attack by nucleophiles onto the 
axial face. Quantify the difference by measuring the (absolute) 
value of the LUMO on these two faces. Bring up the (Molecule) 
Properties dialog (Display menu) and click anywhere on the 
LUMO map. The Surface Properties dialog appears.

 

 Check the box next to Legend to display the property range 
on screen. (Remove the checkmark to remove the legend.) To 
translate the legend, click on the legend to select, then hold 
down the right mouse button and move the mouse. The legend is 
useful when making qualitative comparisons of property values. 
Turn the map such that you can clearly see the axial face of the 
carbonyl carbon, and click on the area of maximum blue. The 
(absolute) value of the LUMO at the surface point you have 
selected is provided in the dialog to the right of Val. Note the 
value, and then turn the map over such that you can now see the 
equatorial face of the carbonyl carbon, and click on the region 
of maximum blue on this face*. Do these values support your 
qualitative conclusions from viewing the image?

7. Turn off the LUMO map (click to deselect). Keep cyclohexanone 
on screen, it will be used in the next tutorial.

*  Click on the background to return to the Molecule Properties dialog.
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Camphor

O

CH3H3C

H3C

Camphor illustrates how one molecule may be used as the starting point 
for another. It also illustrates a search on the Cambridge Structural 
Database (CSD).* No calculations are involved in this example.

1. If you do not already have cyclohexanone on screen (see previous 
tutorial), select  Open... from the File menu (or click on ), 
select cyclohexanone in the dialog that results and click on Open 
(or double click on cyclohexanone). Select Save As... from the 
File menu (or click on the  icon at the top of the screen), supply 
the name camphor and click on Save.

2. Select Add Fragment from the Build menu (or click on the  
icon at the top of the screen) to bring up the organic model kit. 
Click on sp3 carbon  from the model kit and then click on the 
axial free valence two positions removed from the carbonyl 
carbon. You have made axial 3-methylcyclohexanone. The name 
3-methylcyclohexanone will appear at the bottom right of the 
screen.

3. Select Make Bond from the Build menu (or click on the  
icon at the top of the screen). Click on one of the free valences 
of the sp3 carbon which you have just added and then on the 
equatorial free valence on the opposite side of the six-membered 
ring (adjacent to the carbonyl group). A bond will be drawn. 
Click on  to produce a refined (intermediate) structure. It is 
2-norbornone, the name of which will appear at the bottom right 
of the screen. Finish making camphor by adding three methyl 

*  CSD will need to be licensed and installed in order to complete this tutorial. For information 
refer to the CCDC website (www.ccdc.cam.ac.uk). For installation instructions, see 
Appendix G. If you don’t have access to CSD, a trial license may be obtained from the 
Cambridge Crystallographic Data Centre (www.ccdc.cam.ac.uk). 

no calculations
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groups (click on  from the model kit and, one after the other, 
click on the three appropriate free valences; refer to image above 
for CH3 positions). Finally, click on  to give a minimized 
camphor geometry with C1 symmetry. Its name will appear at the 
bottom right of the screen. Click on  to remove the model kit.

4. Select Configure... from the Model menu to bring up the 
Configure dialog.

 
 Check R/S under Atom in the dialog that results, and click 

on OK. R/S labels now appear (only) on the two bridgehead 
carbons. Both should be R (or both S). You can change from 
one to the other by double clicking on any atom while holding 
down both the Ctrl and Shift keys. You can turn the labels off 
by selecting Labels from the Model menu.

5. Move the molecule to the far right of the screen. Then, select 
Open Databases from the Search menu (or click on the  icon 
at the top of the screen). Click on the CSD tab at the top of the 
Databases dialog that results. This brings up the CSD dialog.
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 Click on one of the free valences on the methyl group at the 

bridgehead carbon adjacent to the carbonyl group. The free 
valence is replaced by an orange cone. This restricts the search to 
molecules that derive from substitution of camphor at this carbon.

6. Click on the Search button at the bottom of the dialog. Hits will 
appear in the text box at the right of the CSD dialog.

 
7. Wait for the search to complete. Click on any line marked by a 

filled yellow circle.* Click on any one of these. Its name will be 
highlighted and a structure model will appear in the window at the 
top of the dialog. This model can be manipulated in the usual way.**

8. Close camphor and remove the CSD dialog (click on ).

*  Unfilled circles correspond to entries for which structural data are unavailable. The literature 
reference is available.

** One (or more) structures may be transfered to Spartan’s file system using the Retreive 
button. Full discussion is provided in Chapter 19.
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Ethinamate

O
O

NH2

Acrylonitrile, cyclohexanone and camphor are examples of molecules 
that adopt only a single conformation. Most molecules can adopt 
more than one conformation, due to rotation about single bonds 
or puckering of rings. The sedative ethinamate offers both rotation 
about the ring oxygen bond and the possibility for the carbamate 
functionality to occupy either the equatorial or axial position on 
the ring. This tutorial and the one immediately following, show 
how to find the lowest-energy conformer (the global minimum) of a 
conformationally-flexible molecule.

1. Bring up the organic model kit ( ). Click on Rings, select 
Cyclohexane from the menu and click anywhere on screen. 
Click on sp3 oxygen ( ) in the model kit and add to either 
an equatorial or axial free valence on cyclohexane. Click on 
Groups and select Amide from the menu. Make certain that free 
valence on the amide group to be used for bonding is associated 
with carbon and not with nitrogen. This is indicated by a • on 
the icon at the top of the model kit.

 
C N
O

•

 You can move the bonding position by repeatedly clicking on 
the icon. Click on the free valence on oxygen on the molecule 
on screen to make the carbamate functionality. Finally, select 
Alkynyl from the Groups menu and add to the same carbon on 
the cyclohexane ring as occupied by the carbamate group (using 
the remaining axial or equatorial free valence). Click on  and 
then on  to remove the model kit. 

2. Bring up the Calculations dialog (Setup menu). Select 
Equilibrium Conformer from the top menu to the right of 
Calculate and Molecular Mechanics and MMFF from the 

1 min
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two bottom menus. You have requested that Spartan examine 
all possible conformers*, but then select only the most stable 
conformer (according to the MMFF model). Click on Submit 
at the bottom of the dialog. Accept the name ethinamate that is 
provided.

3. When completed, the preferred conformer will replace the initial 
conformer (just like a calculated equilibrium geometry replaces a 
starting geometry). Which group, alkynyl or carbamate, occupies 
the equatorial position?

4. The name ethinamate appears at the bottom right of the screen. 
This indicates that the molecule exists in the Spartan Molecular 
Database (SMD) of structures and properties. Click on  
immediately to the left of the name. This brings up the Preview 
dialog**.

 
 Listed at the right are theoretical models for which ethanimate 

is available, while a ball-and-spoke model of the selected SMD 
entry is displayed at the left. Select 6-31G* and click on Replace. 
The entry in SMD will replace your model. Is the conformation 
of ethanimate in the database entries the same as you have found?

5. If you are on-line, you can learn more about ethinamate by 
clicking on the Wikipedia button in the Preview dialog.

6. Close ethinamate as well as any open dialogs.

* This system is small, and the possible conformers will be systematically examined. This 
is not practical for molecules with a large number of degrees of conformational freedom. 
Here, Spartan employs Monte-Carlo methods.

** Make certain that SMD and not SSPD is selected from the menu at the bottom of Spartan’s 
screen.
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3-Cyano-4-methylcyclohexenyl Radical

C N

CH3

This tutorial illustrates how different models may be combined to 
achieve a desired result with minimum computation cost. MMFF 
molecular mechanics will be employed to establish equilibrium 
conformation, the semi-empirical AM1 model to establish equilibrium 
geometry and the Hartree-Fock 3-21G model to provide a basis for 
graphical calculations.

1. Build 3-cyano-4-methylcyclohexene. Start with Cyclohexane 
from the Rings menu, click on , and then click on axial free 
valences on any two adjacent carbons. Add Cyano from the 
Groups menu to one of the equatorial free valences on a carbon 
adjacent to the double bond. Finally, add a methyl group ( ) to 
the appropriate ring position using either the equatorial or axial 
free valence.

2. Select Delete from the Build menu (or click on the  icon at 
the top of the screen), and click on the (axial) free valence on 
the carbon to which the cyano group is attached. Click on  to 
produce a refined geometry with C1 symmetry. Click on  to 
remove the model kit.

3. Select Calculations... (Setup menu). Specify Energy from the 
top menu to the right of Calculate, Hartree-Fock and 3-21G 
from the two bottom menus. Next, specify MMFF Conformer 
from the Start from menu and AM1 from the menu which then 
appears to the right. You have requested that a Hartree-Fock 
energy is to be obtained using an AM1 geometry, which in turn 
is to be based on the best conformation according to MMFF.

 This molecule has one unpaired electron. It is necessary to change 
Multiplicity from Singlet to Doublet. Click on OK.

4. Select Surfaces (Setup or Display menu). Click on Add and 
select Spin from the menu. Click on Add and select Spin 

1 min
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Density Map from the menu. You have requested two different 
representations of spin distribution. The first presents spin density 
as a surface of constant value, while the second uses color to map 
the value of the spin density onto an electron density surface. 
Finally, request the singly-occupied molecular orbital. Click on 
Add one more time and select aHOMO (the highest occupied 
molecular orbital of a spin) from the menu.

5. Submit the job. Name it 3-cyano-4-methylcyclohexenyl radical* 
When completed, examine the conformation. Is the methyl group 
equatorial or axial? Next, enter the Surfaces dialog. Select spin 
to display the spin density surface. Note that the spin density is 
delocalized over two of the ring carbons and onto the cyano group.

 
6. Again enter the Surfaces dialog. First, remove the spin density 

surface. Then, display the spin density map. Select Spin Density 
Map. Note that the areas of maximum spin (colored blue) exactly 
match those where the surface is large in the previous image.

 Select Properties (Display menu) and click anywhere on the 
spin density map. This brings up the Surface Properties dialog. 
Range provides the range of spin density values. Note, in 
particular, that negative values of the spin density are possible.

7. Enter the Surfaces dialog, turn the display of the spin density 
map off and then select aHOMO to turn the display of the a 
HOMO on. Note that the singly-occupied molecular orbital is 
nearly identical to the previously-displayed image of the spin.

* SMD contains very few radicals and/or charged species so a chemical name will only rarely 
be provided.
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8. Turn the display of the a HOMO off. Then, click on More 
Surfaces... at the bottom of the (Surfaces) dialog, and select 
Slice from the Surfaces menu and spin from the Properties 
menu. Click on OK. A new line Slice, spin appears in the window 
at the top of the dialog.* Select it.

9. A plane (a slice of spin density) surrounded by a frame appears 
in the middle of the model on screen. Click inside the frame 
to select. The frame will turn gold. Position the cursor outside 
the frame, then press both the Shift key and right button and 
move the mouse up and down (or use the scroll wheel). This 
will zoom the plane. You can also translate and rotate the plane 
independently of the molecule using the usual mouse operations. 
Alternatively, you can move the molecule and plane together by 
first clicking on the molecule (the frame will now turn white) 
and then using the mouse. For all operations, be certain to keep 
the cursor positioned outside of the frame. Size and orient the 
slice as you wish.**

 

10. Remove 3-cyano-4-methylcyclohexenyl radical and any 
remaining dialogs from the screen.

* No further calculations are involved as this is just another way of representing the spin density.
** You can change the display style from Contours to Solid or Transparent using the Style 

menu at the bottom right of the screen. This will appear only when the slice is selected.
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Androsterone
H3C

H

HH

H
HO

H3C

O

A B

C
D

The steroid androsterone illustrates the use of ChemDraw directly 
from Spartan. Also, the molecule provides a good opportunity 
to compare space-filling models and electron density surfaces as 
metrics of molecular size and shape. 

1. Click on  and then click on the 2D tab. Click on the New button 
to open ChemDraw.* Draw androsterone (pay close attention to 
stereochemistry) and close ChemDraw. You will now see the 
ChemDraw image of androsterone at the bottom of the 2D model 
kit and a 3D model at the top. Click in the workspace. The name 
androsterone will appear in the lower right hand corner. Click 
on ( ).

 

5 mins

* The 2D model kit in Spartan will automatically open ChemDraw if it is available on your 
machine (NAM, NAL). If you do not have access to ChemDraw, contact CambridgeSoft 
(www.cambridgesoft.com). While Spartan for Macintosh and Linux cannot automatically 
access ChemDraw, both programs can open 2D molecule files in .CDX or .SKC formats. 
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If you are not running Spartan for Windows, or if you do not have 
ChemDraw installed on your machine, follow the directions below to 
build androsterone.

Click on . Select Cyclohexane from the Rings menu, and click 
anywhere on screen to create the A ring. Cyclohexane is still selected. 
The icon at the top of the model kit should indicate eq (equatorial) 
rather than ax (axial); attachment needs to be made using an equatorial 
free valence. If not, click on the icon to switch to eq. Click on an 
equatorial free valence of the A ring to join it to the C ring. You have 
made bicyclohexane. Its name will appear at the bottom right of the 
screen.

Rotate around the bond connecting the A and C rings to position the 
axial free valences on the connecting carbons opposite (180°) to each 
other. (This bond should be encircled by a red marker. If it is not, click 
on the bond.) To do so, hold down both the Alt key and the left button 
and drag the mouse up and down. Equatorial free valences on the 
cyclohexane carbons adjacent to those that connect the two rings are 
now positioned to form the B ring (in a chair geometry).

Select sp3 carbon ( ) and click on the two opposing equatorial free 
valences on the rings you have just joined. The resulting structure 
should appear as follows.

CH3
CH3

H

H

Click on  and, one after another, click on the (equatorial) free 
valences that nearly overlap to create the B ring. Click on . Check 
to see that all rings are chairs and that the stereochemistry is as in the 
figure in the previous page. If not, you can start over (Clear from the 
Edit menu), or undo the last operation (Undo from the Edit menu).

Next, form the D ring starting from the carbon that will become a 
carbonyl group. Select Carbonyl from the Groups menu and click on 
the appropriate free valence on the C ring. Select sp3 carbon ( ) from 
the model kit and click first on the single free valence on the carbonyl 
carbon and then on a free valence of the sp3 carbon just added. Click on 

 and join the free valence from the second sp3 carbon added in the 
previous step and the appropriate equatorial free valence on the C ring. 



70 Chapter 4

Click on . You have made one of the forms of perhydrophenanthrene 
and its name will appear at the bottom right of the screen.

Add two methyl groups. Select sp3 carbon ( ) from the model kit. 
Click on the axial free valence at the appropriate juncture of the C and 
D rings, and then on the axial free valence at the proper juncture of the 
A and B rings. Add the hydroxy group. Select sp3 oxygen ( ) from 
the model kit, and click on the appropriate axial position on the A ring. 
Click on  and then on . The name adrosterone should appear at 
the bottom right of the screen.

2. Androsterone incorporates several chiral centers. To assign them 
as R or S, select Configure... (Model menu) and check R/S under 
Atom in the dialog that appears. Click on OK. R/S labels will 
appear next to each of the chiral centers. (To remove the labels, 
select Labels from the Model menu.)

3. Select Calculations... from the Setup menu and specify 
calculation of an energy using the Hartree-Fock 3-21G model. 
Select AM1 from the menu to the right of StartFrom. Click on 
Submit and accept the name androsterone.

4. When completed (several minutes), select Properties (Display 
menu). Write down the surface area of a space-filling (CPK) 
model given in the Molecule Properties dialog.

5. Select Surfaces (Setup or Display menu). Click on Add and 
select Density from the menu. Leave the dialog on screen.

6. When completed, click on Density in the Surfaces dialog. 
Click on the density surface to bring up the Surface Properties 
dialog. This provides both the surface area and the volume of the 
electron density surface. The second box to the right of IsoVal 
contains the percentage of the total number of electrons that are 
enclosed by the density surface. Adjust this value by typing over 
the existing value and pressing the Enter key (return on Mac) 
such that the surface area of the density surface is nearly the same 
as that for the CPK model. What is the percentage enclosure?

7. Remove androsterone and any dialogs from the screen.



Chapter 5 71

Chapter 5
Groups of Organic Molecules

This chapter introduces and illustrates a number of basic operations 
involved in processing groups of molecules, as well as the associated 
spreadsheet for organizing and fitting data and facilities for making 
plots.

Computational investigations, like experimental investigations, are 
rarely restricted to single molecules, but typically involve a series of 
related molecules. Here, it may be of interest to compare geometries, 
energies or other calculated properties, or to compare trends in 
calculated and measured properties. Spartan provides facilities for 
these purposes. In particular, it allows molecules to be grouped, either 
manually, or automatically as a result of a conformational search, 
from following a particular vibrational motion, or from a scan of one 
or more geometric variables. Once put into a group, molecules may 
be aligned based either on their structure or chemical functionality. 
Calculations may be performed either on individual molecules or, 
just as simply, on the complete group of molecules. The results of 
calculations on a group can be examined and analyzed individually 
or altogether to seek out trends.

Associated with a group (or an individual molecule) is a spreadsheet. 
This allows convenient access to virtually any calculated quantity that 
can be given a value. Additionally, data may be entered manually into 
the spreadsheet or transferred from another application such as Excel. 
Data in the spreadsheet may be manipulated, linear regression analyses 
performed and both 2D and 3D plots constructed. Alternatively, the 
data in a Spartan spreadsheet may be transferred to Excel for further 
analysis. The Excel worksheet can then be embedded in the Spartan 
document (see Embedded Data under the File menu; Chapter 
12).

The tutorials in this chapter introduce and illustrate a number of the 
basic group operations available in Spartan. These include building 
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a group from scratch and processing groups resulting from both 
a conformational search and from varying a torsion angle. Also 
provided is an example of fitting an experimental observable to one 
or more calculated properties by way of linear regression. The use of 
the Reactions dialog is illustrated both as it operates on molecules 
in a group and on molecules derived from substitution of grouped 
molecules.
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Dienophiles in Diels-Alder Cycloadditions

The most common Diels-Alder reactions involve electron-rich dienes 
and electron-deficient dienophiles.

X

Y

X = R, OR

Y = CN, CHO, CO2H
X

Y

+

The rate of these reactions generally increases with increasing 
π-donor ability of the diene substituent, and with increasing 
π−acceptor ability of the dienophile substituent. This can be 
rationalized by noting that donor groups raise the energy of the 
highest-occupied molecular orbital (the HOMO) on the diene, while 
acceptor groups lower the energy of the lowest-unoccupied molecular 
orbital (the LUMO) on the dienophile. Thus, the HOMO-LUMO gap 
is reduced, leading to enhanced stabilization.

HOMO

LUMO

Orbital 
Energy

diene dienophile

better acceptor groups

better donor groups

To test such an hypothesis, you will examine the extent to which 
experimental relative rates of Diels-Alder cycloadditions involving 
cyclopentadiene and a variety of cyanoethylenes correlate with 
dienophile LUMO energies.

1. Build acrylonitrile, H2C=C(H)CN, (to start, select New from 
the File menu or click on ), minimize ( ) and place it on the 
clipboard. Right click on the background and choose Copy from 
the resulting menu.

 

2 mins
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2. Select New Molecule (not New) from the File menu. This 
requests that a molecule that has yet to be built is to be appended 
onto the end of a group of molecules in which the currently 
selected molecule (acrylonitrile) is a member. The screen will be 
cleared. Click on Clipboard at the bottom of the model kit and 
click on screen. Acrylonitrile will appear. Click on Groups in the 
model kit, select Cyano and add to the appropriate free valence 
on acrylonitrile to make 1,1-dicyanoethylene. Click on .

3. Repeat this procedure (New Molecule, followed by Clipboard, 
followed by Groups, followed by ) four more times to 
build cis and trans-1,2-dicyanoethylene, tricyanoethylene and 
tetracyanoethylene. When you are all done (six molecules in 
total), click on  to remove the model kit.

4. The molecules have been grouped together, that is, put into a 
single document, allowing calculated properties to be accessed 
via a spreadsheet. Select Spreadsheet from the Display menu.

 

 To select an individual molecule in the group, click on its label 
(M0001, ...) in the left hand column, or use the  and  keys 
at the bottom left of the screen. Position the cursor in the header 
field above the left-hand column and left click, then right click 
and select Rename Selected Using SMD from the menu that 
results.
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 This results in replacement of the default labels by proper names 

from the Spartan Molecular Database.

 
5. Enter the Calculations dialog (Calculations under the Setup 

menu), select Energy using the Hartree-Fock 3-21G model, and 
AM1 from the Start from menu. A 3-21G energy calculation will 
be preceded by calculation of geometry using the AM1 model. 
Make certain that Global Calculations is checked to ensure that 
the calculations are to be applied to all the molecules.

6. Submit the job. Name it Diels-Alder dienophiles. After it 
completes, enter experimental relative rates into the spreadsheet.

 
Experimental relative rates for  

Diels-Alder cycloadditions of cyclopentadiene*

  log10   log10 
 dienophile (relative rate) dienophile (relative rate)
 acrylonitrile 0 1,1-dicyanoethylene 4.64
 trans-1,2-dicyanoethylene 1.89 tricyanoethylene 5.66
 cis-1,2-dicyanoethylene 1.94 tetracyanoethylene 7.61
 *  J. Sauer, H. Weist and A. Mielert, Chem. Ber., 97, 3183 (1964).
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 Double click inside the header cell for a blank column in the 
spreadsheet, type Log(rate)= and press the Enter key (return 
key on Mac). You need to press the Enter key (return key on 
Mac) following each entry or use the  key. Sort by relative 
rate. Click on the column header Log(rate), and then click on 
Sort at the bottom of the spreadsheet.

7. Click inside a header cell for a blank column and click on Add... 
at the bottom of the spreadsheet. Alternatively, right click inside 
the header cell for a blank column in the spreadsheet, and select 
Add... from the menu that results. Select E LUMO from the list 
in the dialog that results and eV from the Energy menu. Click 
on OK.

 
 Two data columns are added to the spreadsheet.

 
 The spreadsheet has now served its purpose by collecting both 

calculated (LUMO energy) and experimental (relative rate) data 
for all six dienophiles. You can, if you wish, now remove it from 
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the screen (click on  at the top).

8. Select Plots... from the Display menu. This leads to the Plots 
dialog.

 

 Make certain that the XY Plot tab at the top of the dialog is 
selected. Select Log(rate) from the list of items in the X Axis 
menu and E LUMO(eV) from the Y Axes list. Click on Create 
Plot to remove the dialog and show the plot.

 
 The default curve (a so-called cubic spline) smoothly connects 

the data points. To establish a correlation, use a simple linear 
least-squares fit. Select Properties from the Display menu and 
click anywhere on the curve that you have just drawn. The Curve 
Properties dialog appears.
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 Select Linear LSQ from the Fit menu. A new plot appears.

 

9. If the Database Preview dialog is not already on screen, click 
on  at the bottom of the screen to bring it up. Check the box to 
the left of B3LYP/6-31G* in the dialog and click on Replace All. 
The LUMO energies you have just calculated will be replaced 
by values from the Spartan Molecular Database, and the plot 
will be updated. Is the correlation between reaction rates and 
LUMO energies better or worse than that previously noted?

10. Remove all molecules and any remaining dialogs from the 
screen.
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Addition vs. Substitution

Alkenes normally undergo addition reactions whereas aromatic 
compounds normally undergo substitution reactions. For example, 
bromine reacts with cyclohexane to give trans-1,2-dibromocyclohexane 
(the addition product) not 1-bromocyclohexene, whereas it reacts with 
benzene to give bromobenzene (the substitution product) not trans-
5,6-dibromo-1,3-cyclohexadiene.

Br

Br Br
+ Br2 vs.

Br

Br Br
+ Br2 vs.

+  HBr

+  HBr

In this tutorial you will use results from the Spartan Molecular 
Database as accessed from Spartan’s reaction energy calculator in an 
effort to establish the change in preferred product. Specifically, heats 
of formation from the T1 thermochemical recipe will be employed. 
No calculations are involved.

1. One af ter  another,  bui ld  cyclohexene,  t rans -1 ,2-
dibromocyclohexane, 1-bromocyclohexene, benzene, trans-
5,6-dibromo-1,3-cyclohexadiene, bromobenzene, bromine (Br2) 
and hydrogen bromide (eight molecules in total). Put all in the 
same document. Use New from the File menu ( ) to enter the 
builder for the first molecule, and New Molecule (File menu) 
for each successive molecule.

2. Select Spreadsheet from the Display menu. Left click inside the 
header cell for the leftmost column, then right click and select 
Rename Selected Using SMD in the menu that appears. Click 
on OK in the dialog that results. The molecules can now be 
referenced using chemical names. Close the spreadsheet (click 
on  at the top).

3. Select Reactions from the Display menu.

no calculations
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 Choose SMD Database from the menu to the right of Use and  
T1 from the menu to the right of Theoretical Model at the 
bottom of the dialog.* Compute the energy for Br2 addition to 
cyclohexene: select cyclohexene and bromine as Reactants and 
trans-1,2-dibromocyclohexane (and <none>) as Products and 
click on the Compute Energies button at the bottom left of the 
dialog. Record the reaction energy. Repeat for the corresponding 
substitution energy (same reactants but the products are 
1-bromocyclohexene and hydrogen bromide) and for both 
addition and substitution reactions of benzene (reactants are 
benzene and bromine and products are trans-5,6-dibromomo-1-
3-cyclohexadiene and <none> for addition and bromobenzene 
and hydrogen bromide for substitution).

 Are all reactions thermodynamically favorable (exothermic)? 
Identify any reactions that are not and provide a rationale as to 
why they are not.  Why is there a change in preferred reaction 
in moving from the alkene to the arene?

4. Close the (unnamed) document and any open dialogs. 

* The T1 model was developed to closely reproduce heats of formation obtained from the 
G3(MP2) model, which in turn closely reproduces experimental heats. The T1 heat of 
formation is provided as a property for the molecule in SMD and SSPD.
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Allyl Vinyl Ether

O

Allyl vinyl ether undergoes Claisen rearrangement, the mechanism 
presumes a chair arrangement of the reactant. 

O O

O

‡

Is this the lowest-energy conformer (global minimum) or is additional 
energy required to properly orient the molecule for reaction? To find 
out, you need to locate all the conformers of allyl vinyl ether, identify 
the best chair structure and evaluate its energy relative to that of the 
actual global minimum. You will first carry out a conformational 
search using the MMFF molecular mechanics model, and then obtain 
relative conformer energies using single-point 6-31G* Hartree-Fock 
calculations based on 3-21G Hartree-Fock equilibrium geometries.

1. Bring up the organic model kit and build allyl vinyl ether from 
a sequence of sp2 and sp3 carbons and an sp3 oxygen. Click on 

 to produce a refined geometry. Click on .

2. Bring up the Calculations dialog and select Conformer 
Distribution from the top menu to the right of Calculate and 
Molecular Mechanics and MMFF from the two bottom menus. 
Click on OK.

3. Submit the job. Accept the name allyl vinyl ether. When 
completed, it will give rise to a series of low-energy conformers* 
placed in a new file allyl vinyl ether.Conf.M0001.** A prompt 
will ask you if you want to open this file. Click on OK.*** Select 
Spreadsheet from the Display menu. 

* By default, only conformers within 40 kJ/mol of the global minimum will be kept. This can 
be changed (see Conformational Search in Appendix D).

** M0001 is the default label of the molecule you built. You can change it by altering the Labels 
field in the Molecule Properties dialog (Properties under the Display menu; Chapter 18).

***  To avoid confusion, it is a good idea to close the original file allyl vinyl ether.

5 mins
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 Size the spreadsheet such that all rows (corresponding to different 
conformers) are visible at one time. Click on Add... at the bottom 
of the spreadsheet. Select E from the list at the top of the dialog 
which appears, kJ/mol from the Energy menu and click on OK. 
Energies for each of the different conformers will be added to 
the spreadsheet. Examine the lowest-energy conformer (the 
top entry). Is it in a chair conformation suitable for Claisen 
rearrangement? If not, identify the lowest-energy conformer that 
is suitable. You can keep two or more conformers on screen at 
the same time by checking the boxes immediately to the left of 
the molecule labels (the leftmost column) in the spreadsheet. To 
get a clearer idea of structural similarities and differences, align 
the conformers. Select Align from the Geometry menu (or click 
on the  icon at the top of the screen) and select Structure from 
the Align by menu at the bottom right of the screen. A message 
will appear at the bottom left of the screen.

 
 Click on oxygen and on the two carbons of the vinyl group 

bonded to oxygen to designate them as alignment centers. Each 
will be marked by a red circle. If you make a mistake, click on 
the circle and it will disappear. When you are done, click on the 
Align by button at the bottom right of the screen. Click on .

4. To obtain a better estimate of the energy required to twist allyl 
vinyl ether into a conformer suitable for Claisen rearrangement, 
perform 6-31G* energy calculations using 3-21G geometries. 
Make a copy of allyl vinyl ether.M0001 ( ), and name it allyl 
vinyl ether Hartree-Fock. Using the copy, delete all conformers 
except the global minimum and the lowest-energy conformer that 
is most closely poised for Claisen rearrangement. Select each 
conformer to be discarded, and then select Delete Molecule from 
the File menu. Alternatively, click on the cell in the spreadsheet 
containing the label for the molecule to be deleted, and then click 
on Delete at the bottom of the spreadsheet. When you are done, 
the spreadsheet should contain only two entries. 
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5. Enter the Calculations dialog, and specify calculation of an 
energy using the Hartree-Fock 6-31G* model. Also, specify 
3-21G from the Start from menu. Make certain that Global 
Calculations at the bottom of the dialog is checked to specify that 
the dialog settings apply to both conformers. Click on Submit.

6. When completed, examine the conformer energies. What is the 
energy needed to go from the global minimum to a conformer 
poised to undergo Claisen rearrangement?

7. Remove all molecules and any remaining dialogs from the 
screen.
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Internal Rotation in Dimethylperoxide

OO
CH3

CH3

Quantum chemical calculations, in particular, Hartree-Fock 
molecular orbital calculations, density functional calculations and 
MP2 calculations, may be called on to furnish data to parameterize 
empirical energy functions for use in molecular mechanics and/or 
molecular dynamics calculations. Most important are data relating to 
torsional motions, for it is here that experimental data are most scarce. 

Note that the function chosen to represent the energy of rotation 
about a single bond needs to reflect the inherent periodicity, that is, it 
must repeat itself in 360°. One suitable choice is a truncated Fourier 
series.

Etorsion (ω)  =  ktorsion1 (1 - cos(ω - ωeq))  + ktorsion2 (1 - cos2(ω - ωeq))
+  ktorsion3 (1 - cos3(ω - ωeq))

Here, ωe q is the ideal dihedral angle and ktorsion1, k torsion2 and ktorsion3 
are parameters. The first (one-fold) term accounts for the difference 
in energy between syn and anti conformers, the second (two-fold) 
term for the difference in energy between planar and perpendicular 
conformers, and the third (three-fold) term for the difference in energy 
between eclipsed and staggered conformers. 

In this tutorial, you will generate a potential energy function for rotation 
about the oxygen-oxygen bond in dimethylperoxide using 6-31G* 
Hartree-Fock calculations (and optionally from B3LYP/6-31G* 
density functional calculations) and then fit this potential to a truncated 
Fourier series.

1. Build dimethylperoxide. If the molecule is not already in an anti 
conformation, click on  and set the COOC dihedral angle to 
180 (180°) by typing 180 in the box at the lower right of the 
screen and pressing the Enter key (return key on Mac). Do not 
minimize.

15 mins/25 mins
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2. Select Constrain Dihedral from the Geometry menu (or click 
on the  icon at the top of the screen). Select the COOC torsion, 
and then click on  at the bottom right of the screen. The icon 
will change to  indicating that a dihedral constraint is to be 
applied. 

 Check the box to the left of Profile at the bottom right of the 
screen. This will result in two additional text boxes.

 
 Leave 180 (180°) in the original (leftmost) box alone, but change 

the contents of the box to the right of to to 0 (0°). You need to 
press the Enter (return) key after you type in the value. Steps 
should be 10. If it is not, type 10 and press the Enter (return) 
key. What you have specified is that the dihedral angle will be 
constrained first to 180°, then to 160°*, etc. and finally to 0°. 
Click on . 

4. Bring up the Calculations dialog and select Energy Profile 
from the top menu to the right of Calculate, and Hartree-Fock 
and 6-31G* from the two bottom menus. Click on Submit and 
accept the name dimethylperoxide.

5. When the calculations have completed, they will go into a file 
named dimethylperoxide.Prof.M0001. A prompt will ask you if 
you want to open this file. Click on OK. Align the conformers. 
Click on , select Structure from the Align by menu at the 
bottom right of the screen and, one after the other, click on both 
oxygens and on one of the carbons. Then click on the Align by 
button at the bottom right of the screen. Bring up the spreadsheet 
(Display menu), and enter both the energies relative to the 180° 
conformer, and the COOC dihedral angles. First click on the label 
(M0001) for the top entry in the spreadsheet (the 180° conformer), 
then click on the header cell for the leftmost blank column, and 
finally, click on Add... at the bottom of the spreadsheet. Select 
rel. E from the quantities in the dialog that results, kJ/mol from 

*  The difference between constraint values is given by: (final-initial)/(steps-1).
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the Energy menu and click on OK. To enter the dihedral angle 
constraints, click on , click on the constraint marker attached 
to dimethylperoxide and click on  at the bottom of the screen 
(to the right of the value of the dihedral angle). Click on .

6. Select Plots... (Display menu). Select Constraint(Con1) from 
the X Axis menu and rel. E(kJ/mol) from the Y Axes list. Click 
on Create Plot.

 
 A smooth curve (a so-called cubic spline) connects the data points. 

To fit the points to a Fourier series, bring up the Properties dialog 
(Display menu) and click anywhere on the curve. Select Fourier 
LSQ from the Fit menu and click on to remove the dialog. A 
new plot appears.
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 The actual fit expression appears at the bottom of the plot.

7 and 8 optional 

7. Use energies from B3LYP/6-31G* density functional 
calculations, together with the Hartree-Fock geometries  
to provide a better fitting function. First, make a copy  
of dimethylperoxide.Prof.M0001. Name it dimethylperoxide 
density functional. Next, enter the Calculations dialog and 
specify calculation of Energy using the B3LYP/6-31G* Density 
Functional model. Make certain that Global Calculations 
(at the bottom of the dialog) is checked to signify that energy 
calculations are to be performed on all conformers. Click on 
Submit.

8. Energy calculations for all ten confromers will require several 
minutes to complete. When they are done, draw a new energy 
plot and compare it to the energy plot produced earlier.

9. Remove all molecules and dialogs from the screen. 
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Hydration of Carbonyl Compounds

The hydration of carbonyl compounds has been extensively studied 
primarily because it serves as a model for a number of important 
reactions, nucleophilic addition to carbonyl compounds among them.

O
R

R‘ H2O
-H2O

R

R‘ OH

OH
Keq  =

[hydrate]
[H2O] [carbonyl]

=
[hydrate]

55.5 [carbonyl]

Experimental Keq for hydration of carbonyl compounds*

  log(keq/55.5)   log(keq/55.5) 
 PhCOCH3 -6.8 CF3COCH3 -0.2
 CH3COCH3 -4.6 PhCOCF3 0.1
 PhCHO -3.8 H2CO 1.6
 t-BuCHO -2.4 CF3CHO 2.7
 CH3CHO -1.7 CF3COCF3 4.3
 * J.P. Guthrie, Can. J. Chem., 53, 898 (1975); 56, 962 (1978).

In this tutorial, you will use Spartan’s linear regression analysis 
tool to correlate calculated properties of carbonyl compounds with 
measured equilibrium constants for their hydration.

1. Build all the compounds* listed above. Use Carbonyl (Groups 
menu) to start each to ensure consistent atom numbering. Put 
in one list; select New Molecule following construction of each 
molecule. That is, select New, build and minimize acetophenone, 
select, New Molecule, build and minimize acetone, select New 
Molecule, etc. Click on .

2. Enter the Calculations dialog and specify calculation of 
Equilibrium Geometry using the Hartree-Fock 3-21G model.**  

15 mins

*  Keep the phenyl ring and the carbonyl group coplanar for benzaldehyde, acetophenone and 
trifluoroacetophenone.

* * You can save computer time by specifying calculation of an Energy using the Hartree-
Fock 3-21G model, and then selecting AM1 from the Start from menu. This requests a 
semi-empirical AM1 geometry in place of the 3-21G geometry. As all of these molecules 
are in SMD, you can save even more time by bringing up the Preview dialog (click on  
at the bottom right of the screen), clicking on the yellow square to the left of 3-21G and 
then clicking on Replace All at the bottom of the dialog. (You need to be certain that SMD 
and not SSPD is selected in the menu at the bottom of Spartan’s screen.) In this case, skip 
the next step as all the results you require are already available.
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Make certain that Global Calculations is checked. Click on 
Submit. Name the job carbonyl compounds.

3. After the calculations complete, bring up the spreadsheet. Double 
click inside the header cell of an empty column, type Log(Keq) 
and press the Enter key (return key on Mac). Then enter the 
experimental equilibrium constants from the table on the previous 
page. You need to press the Enter (return) key following each 
data entry (or use the  key). Sort the list according to the value 
of Log(Keq). Click inside the header cell LogKeq and then 
click on Sort at the bottom of the spreadsheet. Also, replace the 
molecule identifiers in the spreadsheet (M0001, ...) by correct 
names (acetophenone, ... ). Position the cursor inside the header 
cell of the leftmost column of the spreadsheet, left click, then 
right click and choose Rename Selected Using SMD from the 
menu that appears.

4. Select Properties (Display menu) to bring up the Molecule 
Properties dialog. Click on  to the left of the following entries: 
E HOMO, E LUMO, Dipole Moment and Weight.

5. Click on the QSAR tab at the top of the Molecule Properties 
dialog.

 
 Click on  to the left of Volume under From CPK Model.

6. Click on the oxygen atom for whatever compound is displayed. 
Click on  to the left of Electrostatic (under Charges) in the Atom 
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Properties dialog (that has replaced the Molecule Properties 
dialog), to place oxygen charges into the spreadsheet.

7. Click on Add... at the bottom of the spreadsheet, and then click 
on the Linear Regression tab at the top of the dialog that results. 
This brings up the Add Linear Regression dialog.

 

 Select Log(Keq) from the Fit menu and Electrostatic (Ox)* from 
the Using list. Click on OK. Two new rows will be added at the 
bottom of the spreadsheet. With a Properties dialog on screen, 
click anywhere on the row in the spreadsheet labelled Fit1 (the 
first fit performed on this data set). The Regression Properties 
dialog appears.

 

*  Numbering depends on the order that atoms were introduced during building, but the reference 
is to the carbonyl oxygen.
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 This provides information about the fit of Log(Keq) to the charge 
on oxygen, in particular, the value of R2. This will tend to unity 
as the quality of the fit improves.

8. Inside the Regression Properties dialog, try fitting to different  
(single) properties in the Using list. (The entries toggle on and 
off with repeated clicking.) Maximize the value of R2. Next, try 
all combinations of two properties. The combination of E LUMO 
and Electrostatic (Ox) should give the highest value of R2. With 
this combination selected, bring up the Plots dialog (Display 
menu) and select Log(Keq) from the X Axis menu, and FitVals 
(Fit1) from the Y Axes list and click on Create Plot. Next, click 
on the curve (not on the axes) to bring up the Curve Properties 
dialog (which replaces the Regression Properties dialog). Select 
Linear LSQ (to replace Cubic Spline) from the Fit menu. The 
resulting plot should show a reasonable correlation.

9. Close carbonyl compounds and remove any remaining dialogs 
from the screen.
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Acidities of Carboxylic Acids

Acid strength is among the most important molecular properties. 
It is readily available from calculation, either in terms of absolute 
deprotonation energy,

AH A–  +  H+

or, more commonly, as the deprotonation energy relative to that of 
some standard acid (A°H).

AH  +  A°– A–  +  A°H

The value of the electrostatic potential in the vicinity of the acidic 
hydrogen in the neutral acid provides a possible additional measure 
of (relative) acid strength. Electrostatic potential maps are known to 
uncover gross trends in acidity, for example, the acidic hydrogen in 
a strong acid, such as nitric acid, is more positive than that in a weak 
acid, such as acetic acid, which in turn is more positive than that in 
a very weak acid, such as ethanol.

 ethanol acetic acid nitric acid

In this tutorial, you will explore the use of electrostatic potential 
maps to quantify changes in acid strength due to subtle variations in 
structure. You will use the Spartan Molecular Database of calculated 
structures, energies and properties to shorten the time required for an 
investigation.

1. One after the other, build trichloroacetic, dichloroacetic, 
chloroacetic, formic, benzoic, acetic and pivalic acids. Put all 
molecules into the same document (use New Molecule from the 
File menu following the first molecule). Click on  when you 
are done.

10 mins
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2. All of the molecules that you have built are available in the 
Spartan Molecular Database. Click on  to the left of the name 
of the presently selected molecule at the bottom of the screen. The 
Preview dialog will appear. (You need to be certain that SMD 
and not SSPD is selected in the menu at the bottom of Spartan’s 
screen.) This displays the structure of the selected molecule on 
the left and a list of theoretical models for which calculated 
results are available on the right. Check the yellow square to the 
left of 3-21G, click on Replace All at the bottom of the dialog 
and respond OK to the message that follows. Structures obtained 
from Hartree-Fock 3-21G calculations will replace those you 
have built. However, you need to calculate a wavefunction for 
each of the molecules in order to produce electrostatic potential 
maps.

3. Enter the Calculations dialog (Calculations from the Setup 
menu). Request a Hartree-Fock 3-21G Energy calculation, 
and make certain that Global Calculations is checked. Click 
on OK. Enter the Surfaces dialog (Surfaces from the Setup 
menu). Make certain that Global Surfaces at the bottom of the 
dialog is checked. Click on Add at the bottom of the dialog and 
select Electrostatic Potential Map from the menu. Leave the 
Surfaces dialog on screen. Submit the job (Submit from the 
Setup menu). Name it carboxylic acids. 

4. After the calculations have completed, bring up the spreadsheet 
(Spreadsheet from the Display menu). Expand it so that you 
can see all seven molecules, and that two data columns are 
available. Position the cursor in the leftmost header cell of the 
spreadsheet, right click and select Rename Selected Using SMD 
in the menu that appears. Double click inside the header cell of 
the next available data column, type pKa and press the Enter 
key (return key on Mac). Enter the experimental pKa’s (given 
on the next page) into the appropriate cells under this column. 
You need to press the Enter (return) key following each entry. 
Alternatively, use the  key to move to the next cell.
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 acid pKa acid pKa

 trichloroacetic (Cl3CCO2H) 0.7 benzoic (C6H5CO2H) 4.19
 dichloroacetic (Cl2CHCO2H) 1.48 acetic (CH3CO2H) 4.75
 chloroacetic (ClCH2CO2H) 2.85 pivalic ((CH3)3CCO2H) 5.03
 formic (HCO2H) 3.75  

 Experimental data from: E.P. Sargeant and B. Dempsey, Ionization Constants 
of Organic Acids in Aqueous Solution, IUPAC no. 23, Permagon Press, 1979.

5. Arrange the seven molecules on screen such that you can clearly 
see the acidic hydrogen on each. To display all molecules at once, 
check the box on the right hand side of the Label column (in the 
spreadsheet) for each entry. To manipulate them independently of 
one another, click to deselect Coupled from the Model menu.

6. Select Electrostatic Potential Map inside the Surfaces dialog to 
turn on the electrostatic potential map for each molecule. Bring 
up the Properties dialog (Properties from the Display menu). 
If the Surface Properties dialog is not already displayed, click 
on the electrostatic potential map to display it. Click on  to 
the right of Max inside the Surface Properties dialog. The 
maximum value of the electrostatic potential (corresponding to 
the acidic proton) will be pasted to the spreadsheet. Leave the 
dialog on screen.

7. Plot experimental pKa vs. maximum in the electrostatic potential. 
Bring up the Plots dialog (Plots from the Display menu), select 
pKa under the X Axis menu and Property Max (Surface) from 
the Y Axes list, and click on Create Plot. The data points are 
connected by a smooth curve (a so-called cubic spline). To get 
a least squares fit, click on the curve, and select Linear LSQ 
from the Fit menu in the Curve Properties dialog. Does there 
appear to be a correlation between pKa and the maximum value 
of the electrostatic potential?

8. Close carboxylic acids and any remaining dialogs from the 
screen. 
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Positional Selectivity of Substituted Naphthalenes

Thermochemical stabilities of positional isomers may depend on 
several factors, including a tendency to minimize unfavorable non-
bonded intramolecular interactions (sterics) and to minimize overall 
dipole moment (electrostatics). Naphthalene offers a good example 
with only two different positions.

X

X

1-substituted naphthalene 2-substituted naphthalene

In this tutorial you will use results from the Spartan Molecular Database 
as accessed from Spartan’s reaction energy calculator to assign in an 
effort to establish the change in preferred product. Specifically, heats 
of formation from the T1 thermochemical recipe* will be employed. 
Instead of building a series of substituted naphthalenes, you will 
use Spartan’s substituent model kit to construct a pair of molecules, 
one marked for substitution on the 1-position and the other on the 
2-position. No calculations are involved.

1. One after the other build methane, ammonia, water, hydrogen 
fluoride, hydrogen cyanide and formic acid. Put all in the same 
list (use New to enter the builder for the first molecule and 
New Molecule for each successive molecule). Bring up the 
spreadsheet (Spreadsheet under the Display menu), double 
click inside the leftmost cell for each molecule and replace the 
identifier (M0001, …) by proper functional group names (methyl, 
amino, hydroxy, fluoro, cyano and carboxylic acid). Put the 
contents on the clipboard. Right click inside the header cell for 
the leftmost column of the spreadsheet and select Copy for the 
menu that results. Close the document without saving.

no calculations

* The T1 model was developed to closely reproduce heats of formation obtained from the 
G3(MP2) model, which in turn closely reproduces experimental heats. The T1 heat of 
formation is provided as a property for the molecule in SMD and SSPD.
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2. Select New from the File menu (or click on ), click on Rings 
in the model kit, select Naphthalene from the menu and click 
on screen. Click on the Substituent tab at the top of the organic 
model kit to bring up the substituent model kit.

 
 Click on Cust. A near the middle of the model kit, then right click 

inside the box near the bottom and select Paste from the menu 
that results. Names of the six functional groups that you built in 
the previous step will appear in the box. As you click through 
the list, ball-and-wire models of their structures will appear in 
the small screen at the top of the model kit. Note that one of the 
hydrogens (white balls) for each is highlighted in gold. This 
hydrogen will be removed to make a free valence for attachment. 
The carboxylic acid group has two different hydrogens, one 
on carbon (leading to a carboxylic acid) and one on oxygen 
(leading to a formate). If the hydrogen on the carbon is not 
already highlighted, click on it and it will be highlighted. Click 
on the free valence on naphthalene that will lead to 1-substituted 
naphthalenes. The molecule on screen will now appear with a 
marker to indicate substitution at the 1-position.
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3. Select New Molecule (File menu). Bring up the organic model 
kit and again build naphthalene. Reenter the substituent model 
kit, make certain that Cust. A is selected (if not, click on it) 
and click on the free valence on naphthalene that will lead to 
2-substituted naphthalenes. Click on  to remove the model kit.

4. Bring up the spreadsheet (Spreadsheet from the Display menu). 
Double click inside the leftmost cell for the first molecule 
and change the default identifier (M0001) with 1-substituted 
naphthalenes. Double click inside the corresponding cell for the 
second molecule and replace the default name by 2-substituted 
naphthalenes.

5. Bring up the Reactions dialog (Reactions from the Display 
menu). Choose SMD Database from the menu to the right of Use 
and T1 from the menu to the right of Theoretical Model. Select 
1-substituted naphthalenes as Reactants and 2-substituted 
naphthalenes as Products, and click on Compute Energies at 
the bottom of the dialog. Reactions will be written (and reaction 
energies computed) for all six substituents.

6. Close the (unnamed) document and any open dialogs.
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Tautomers of Nucleotide Bases

Protons bound to heteroatoms in heterocyclic compounds are likely to be 
very mobile in solution and, where two or more heteroatoms are present 
in a structure, different isomers (tautomers) may be in equilibrium. As 
a case in point, consider the nucleotide base cytosine (where a methyl 
group has replaced the sugar-phosphate backbone at the 1-position).

N

N

O

CH3

N

NH

O

CH3

N

N

OH

CH3

NH2 NH NH

The existence of a low-energy tautomer could have far-reaching 
consequences, given that the valence structure of cytosine is key to 
hydrogen bonding in DNA. In this tutorial, you will examine the 
possible tautomers of 1-methylcytosine for evidence of low-energy 
structures.*

1. Build 1-methylcytosine. Start with Amide from the Groups 
menu. Select planar trigonal nitrogen for the external amino 
group. Minimize (click on ) and click on .

2. Note that the word Tautomer appears at the bottom right of 
the screen, indicating that tautomers exist. Select Identify 
Tautomers from the Search menu (or click on the  icon at the 
top of the screen). Step through the tautomers using the  and 

 keys that appear at the bottom right of the screen. To put the 
tautomers in a list, click on  at the bottom right of the screen 
and click on OK in the dialog that results.

3. Enter the Calculations dialog with the list of tautomers. (It is a 
good idea to close the molecule you built to get the tautomers.) 
Specify calculation of Equilibrium Geometry using the 3-21G 

5 mins/30 mins

* Note, however, that were the energy of an alternative tautomer only 10 kJ/mol higher than 
that for the normal structure, this would translate into a relative abundance of only about 
1% at room temperature. Thus, any alternative tautomers would need to be very close in 
energy to the lowest-energy tautomer to have noticeable effect.
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Hartree-Fock model. Submit the job with the name cytosine 
tautomers. 

4. After the calculations have completed, bring up the spreadsheet 
and click on the line corresponding to the structure for cytosine 
that you originally built. Click on Add at the bottom of the 
spreadsheet, select rel.E and Boltzmann Distribution from 
the available quantities and kJ/mol from the Energy menu and 
click on OK. Are either of the alternatives close in energy to the 
normal form of cytosine?

5 and 6 optional

To get a better estimate of relative tautomer energies, perform energy 
calculations using the T1 model.*

5. Make a copy of cytosine tautomers. Name it cytosine  tautomers 
T1. Enter the Calculations dialog (Setup menu) with this copy. 
Specify Energy from the top menu to the right of Calculate and 
Thermochemical Recipes and T1 from the two bottom menus. 
Submit the job.

6. When the calculations have completed (several minutes), 
bring up the spreadsheet and again examine relative tautomer 
energies and Boltzmann populations. Are either of the alternative 
structures competitive?

7. Remove all molecules and remaining dialogs from the screen.

* The T1 model was developed to closely reproduce heats of formation obtained from the 
G3(MP2) model, which in turn closely reproduces experimental heats. The T1 heat of 
formation is provided as a property for the molecule in SMD and SSPD.
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Chapter 6
Spectra of Organic Molecules

In addition to equilibrium geometries and conformations, reaction 
energies and conformational energy differences and diverse molecular 
properties, calculations are able to account for molecular spectra. 
These include, infrared and Raman spectra, NMR spectra and UV/
visible spectra. The first two arise from the transitions between ground 
and excited vibrational states, the third from transitions between 
nuclear spin states and the fourth from transitions between ground and 
excited electronic states. Most commonly, experimental spectra are 
used to provide clues to the structure of an unknown molecule, that 
is, features in the spectrum are taken as evidence for features in the 
molecular structure. On the other hand, a calculated spectrum starts 
with a known structure. A high degree of similarity with a measured 
spectrum may be taken as evidence that the molecule on which the 
calculation was made is the same as that for which a spectrum was 
measured. Lack of similarity suggests that the two molecules are not 
the same.

The first tutorial in this chapter deals with the infrared spectrum of 
methyl formate. It details the steps needed to calculate a spectrum 
and to relate the spectrum to the underlying molecular structure. The 
second tutorial illustrates the use of the Spartan Infrared Database to 
identify a molecule based on its infrared spectrum. The remaining  
tutorials in the chapter deal with NMR spectroscopy. The first details 
the steps involved in calculating a displaying  a proton spectrum and 
a 2D COSY spectrum for 2-norbornene. The second details the steps 
involved in calculating and interpreting both an 13C spectrum and a 
DEPT spectrum for a more complex organic molecule. The two final 
tutorials also focus on 13C NMR. The first of these compares NMR 
spectra for flexible and rigid molecules that are structurally similar, 
while the second examines the dependence of carbon chemical shifts 
on stereochemistry.
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All of the tutorials in this chapter make use of the EDF2/6-31G* 
density functional model. Structures and (infrared and NMR) spectra 
for all the molecules considered actually exist in the Spartan Spectra 
and Properties Database (SSPD). As the  calculations involved in 
the last three tutorials involve significant computer time, you might 
want to obtain some or all of the data from SSPD. On the other hand, 
running the calculations will give you a more accurate impression 
of the practical limits of the calculations. If you do decide to use 
SSPD, you need to change the selection at the bottom of Spartan’s 
interface from SMD to SSPD. 
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Infrared Spectrum of Methyl Formate

In the harmonic approximation, the frequency at which a diatomic 
molecule vibrates is proportional to the square root of the ratio of 
the force constant (the second derivative of the energy with respect 
to change in bond length) and the reduced mass (the product of the 
masses of the two atoms divided by their sum). This is in the infrared 
region of the electromagnetic spectrum. Frequency increases with 
increasing force constant or stiffness of the bond and decreases with 
increasing masses of the atoms involved in the bond.

frequency α force constant
mass

In order to generalize this expression to a polyatomic molecule, it is 
necessary to change into a coordinate system that leads to a diagonal 
matrix of second energy derivatives (so-called normal coordinates). 
The normal coordinates for a polyatomic molecule will typically 
involve the motions of several (and perhaps all) of the atoms.

The degree (or intensity) of absorption of infrared radiation by a 
diatomic molecule is proportional to the change in the dipole moment 
with change in bond length. Note that there is no change in the dipole 
moment of a homonuclear diatomic molecule with change in bond 
length, meaning that the intensity of absorption is zero. Molecules 
such as N2 and O2 are transparent in the infrared.

Were this not the case, the earth would be far hotter as radiation of the 
energy due to the sun would be trapped in the atmosphere (the greenhouse 
effect). The atmospheric concentration of carbon dioxide, the major 
atmospheric component that absorbs in the infrared, is < 400 ppm.

The intensity of each of the individual lines in an infrared spectrum 
of a polyatomic molecule follows from the change in dipole moment 
along the associated normal coordinate. Note that some of the 
normal coordinates in a polyatomic molecule may lead to no change 
in dipole moment, for example, the symmetric stretch in carbon 
dioxide where both CO bonds are simultaneously moved. 

10 mins
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This tutorial illustrates the steps required to calculate and display an 
infrared spectrum and to compare it with an experimental spectrum. 
You will see how the ease or difficulty of molecular motion and 
atomic masses affect frequency.

1. Build methyl formate and click on . Bring up the Calculations 
dialog (Setup menu), and request an equilibrium geometry using 
the EDF2/6-31G* density functional model. Check IR to the 
right of Compute and click on Submit. Accept the name.

2. After the calculation has completed (several minutes), select 
Spectra from the Display menu and click on the IR tab.

 
 Click on both Draw Calculated and Draw Experimental at the 

right of the IR Spectra dialog. If you are online, select Web 
Site under Experimental Data from at the bottom of the dialog 
before clicking on Draw Calculated. If not or if you are having 
trouble downloading the experimental spectrum, select Local 
File at the bottom right of the dialog. Navigate to the spectra of 
organic molecules subdirectory in the tutorials directory* and 

* For Windows, this directory is found in Program Files/Wavefunction/Spartan10 or 
Program Files(x86)/Wavefunction/Spartan10. It needs to be copied to another location 
available to the user prior to opening it in Spartan. For Linux, this is found in the directory 
where Spartan was installed. For Macintosh, this is located at the top level on the installation 
CDROM..
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click on methyl formate. You need to select All Files from the 
menu to the right of the file name in the Open directory. The 
calculated frequencies have been scaled to take account of a 
systematic error due primarily to the harmonic approximation. 
You can alter the default value (0.962) with the Scale slider 
bar. You can also alter the width of the lines in the calculated 
spectrum (which can be loosely associated with temperature) 
with the Temp slider bar. To get a best fit to the experimental 
spectrum (shown below), click on the Experimental button 
below the two slider bars. The scale factor has been reduced 
slightly (to 0.950) and the “temperature” has increased.  You 
can, if you wish, return to the default values by clicking on the 
Standard button.

 

3. Calculated frequencies scaled by the value on the slider bar are 
listed at the left of the dialog. Check the box to the left of the 
smallest frequency. Describe the motion. Repeat for the largest 
frequency. Which motion should be more difficult? Why? 
Finally, check the box corresponding to the most intense line, 
and describe the motion. Why is this line intense?

4. Make a copy of methyl formate ( ); name it methyl formate 
d3. Select Properties from the Display menu and click on one 
of the three hydrogen atoms on the methyl group to bring up 
the Atom Properties dialog. Change Mass Number from 1 to 
2 Deuterium. Repeat for the other two methyl group hydrogen 
atoms. Resubmit the calculation (it will require only a few 
seconds). Compare the frequencies of the undeuterated and 
deuterated forms of methyl formate, and identify which change 
the most and which change the least. Explain your results.

5. Close all molecules and dialogs that are open on screen.



106 Chapter 6

Searching Spartan’s Infrared Spectral Database

Pattern matching (“fingerprinting”) a measured infrared spectrum 
to experimental spectra contained in a library (database) has been 
common practice for many years. This has not previously been 
extended to comparisons of measured spectra to databases of 
calculated spectra. The likely reason is that the results of calculations 
(a set of vibrational frequencies and intensities to go along with 
these frequencies) do not look like experimental infrared spectra, at 
least, they do not look like spectra obtained at normal temperatures. 
However, a fit of the calculated data to a Lorentzian function 
in which peak width at half height is treated as a parameter (one 
value for all peaks) makes the two visually quite similar. One could 
argue that this parameter loosely corresponds to temperature, which 
is consistent with the fact that infrared spectra measured at low 
temperature comprise a series of sharp lines (rather than bands).

The frequency of an infrared absorption is proportional to (the 
square root of) the second derivative of the energy at a minimum in 
the potential surface for a particular vibrational coordinate, that is, 
the curvature of the surface. Practical frequency calculations replace 
the real potential at the energy minimum by a quadratic function. 
This leads to a surface that is too steep (and an energy second 
derivative that is too large), meaning that calculated frequencies will 
be larger than measured frequencies. For the most part, the error 
is systematic, with calculated frequencies being between 3% and 
15% larger than measured frequencies, depending on the theoretical 
model. Hartree-Fock models show an error near the top of the range, 
while density functional models show an error near the bottom of the 
range. Semi-empirical models do not show a consistent error pattern. 
Such a systematic error can be compensated for, at least in part, by 
incorporating a single linear scaling parameter into the fitting function.

In summary, Spartan fits calculated and measured infrared using a 
Lorentzian function that incorporates two parameters, a non-linear 
parameter accounting for peak width and a linear scaling parameter.

This tutorial illustrates the way in which searches of the Spartan 

2 mins
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Infrared Database (SIRD) are setup and performed and the results 
examined. You may choose from a small selection of measured 
infrared spectra (or supply your own spectra as a .dx file).

1. Click on  and then select Databases from the Search menu 
(or click on ). Click on the SIRD tab to bring up the Spartan 
Infrared Database dialog.

 

 Click on Select Spectrum at the bottom right of the dialog. 
Navigate to the spectra of organic molecules subdirectory under 
the tutorials directory.* You need to select All Files from the 
menu to the right of the file name inside the Open dialog.

 Select one of the following molecules and click on Open.

 
O

N

N

O

CN

CH3

NH2

chromone-3-carbonitrile dibenzopyrrole 8-amino-2-methylquinoline

 The experimental infrared spectrum of the selected molecule will 
appear in the window at the top right of the dialog with the name 

* For Windows, this directory is found in Program Files/Wavefunction/Spartan10 or 
Program Files(x86)/Wavefunction/Spartan10. It needs to be copied to another location 
available to the user prior to opening it in Spartan. For Linux, this is found in the directory 
where Spartan was installed. For Macintosh, this is located at the top level on the installation 
CDROM..
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underneath. Immediately to the left is a scroll box containing 
the most intense lines in the spectrum (obtained from a fit of the 
experimental spectrum to a Lorentzian function). 

 

2. Click on Filters at the bottom of the dialog to bring up the Search 
Filters dialog.

 
 This provides for substructure and formula filters (neither of 

which is used in this tutorial) as well as functional group filters. 
You can if you wish check an appropriate entry, for example, 
nitrile, if you have selected chromone-3-carbonitrile. Click on 
OK to exit the dialog.
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3. Click on Search at the bottom of the (Spartan Infrared 
Database) dialog. The search may require a minute or two. 
When it has completed, scan the list of hits at the lower right 
of the dialog for the name of your query. It will be at or near 
the top of the list.* Click on the name. The calculated infrared 
spectrum will be superimposed onto the experimental spectrum 
(in the window at the top right of the dialog).

4. Close all molecules and dialogs that are open on screen.

* This will not always be the case. The obvious exception occurs where the query is not in 
the database. Problems will also occur when the (query) infrared spectrum lacks sufficient 
structure to distinguish it from similar molecules.
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Proton NMR Spectrum of 2-Norbornene

Proton NMR spectroscopy was the first tool available to chemists that 
allowed definitive assignment of the molecular structures of complex 
organic molecules. By the 1970’s, it had largely replaced infrared 
spectroscopy and to a large extent chemical proofs of structure. 13C 
NMR is now more dominant, but proton NMR remains an essential 
tool in the chemist’s arsenal.

NMR is based on the fact that nuclei possess spins that can either 
align parallel or antiparallel to an applied magnetic field, giving rise 
to different nuclear spin states. The relative energy of these states 
(ΔE) depends on the nucleus and on the strength of the applied 
magnetic field, by way of a simple relationship.

∆E = γℏB0

γ is the gyromagnetic ratio (a constant for a given type of nucleus), 
ℏ is Planck’s constant divided by 2π and B0 is the strength of the 
magnetic field at the nucleus. While the two nuclear spin states are 
normally in equilibrium, this equilibrium can be upset by applying a 
second magnetic field. The absorption of energy as a function of field 
strength (a resonance) between the states can then be detected. 
The key to the utility of the magnetic resonance experiment is that 
the energy at which a nucleus resonates depends on its location in the 
molecule, and is different for each (chemically) distinct nucleus. The 
reason  is that the applied magnetic field is weakened by electrons 
around the nucleus. Nuclei that are well shielded by the electron 
cloud will feel a lesser magnetic field than those that are poorly 
shielded, and will show a smaller energy splitting. The difference, 
given relative to a standard, is termed a chemical shift. By convention, 
both proton and 13C chemical shifts (treated later in this chapter) 
are reported relative to tetramethylsilane (TMS) as a standard.

While each unique proton in a molecule gives rise to a single line 
(resonance) in the spectrum, the spins on nearby nuclei add and 
subtract to the external magnetic field. This leads to a splitting of 
lines, the splitting pattern depending on the number of neighboring 
protons and their geometry. Discounting splitting, the intensity of 

 10 mins
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the lines is approximately proportional to the number of equivalent 
protons that contribute. For example, the proton NMR spectrum of 
2-norbornene shows six lines, two with unit intensity corresponding 
to the two different protons on the methylene bridge (C7), and four 
with twice the intensity corresponding to protons  at C1 (C4), C2 (C3) 
and the two different (endo and exo) protons on C5 (C6).

7

3

216

5
4

In this tutorial, you will calculate the proton NMR spectrum of 
2-norbornene and compare it with that contained in the Spectral 
Database of Organic Compounds (SDBS), freely-accessible on the 
web from the National Institute of Advanced Industrial Science and 
Technology (AIST) in Japan.*

You will also make a COSY plot which identifies pairs of protons that 
are separated by three bonds. This requires HH coupling constants 
that are not calculated by Spartan but evaluated empirically based 
on the three-dimensional geometry of the molecule. 

1. Build 2-norbornene. Start from cyclohexane (Rings menu), add 
an sp3 carbon ( ) to an axial ring position and bond to ( ) to 
a free valence on the opposite side of the ring.  Make a double 
bond between the appropriate ring carbons ( ). Minimize ( ) 
and click on ( ). The name 2-norbornene will appear at the 
bottom right of the screen.

2. Enter the Calculations dialog (Calculations from the Setup 
menu), and specify an Equilibrium Geometry calculation using 
the EDF2 Density Functional model with the 6-31G* basis set. 
Check NMR to the right of Compute. Click on Submit. Accept 
the name 2-norbornene.

3. The calculation will require several minutes. When it has 
completed, proton shifts can be found in Atom Properties 

* Web address: http://riodb1.ibase.aist.go.jp/sbds.cgi-bin/cre_index.cgi. Unfortunately, 
electronic access to SDBS is prohibited by AIST.
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dialog. Select Properties from the Display menu and one after 
another click on the hydrogens. Propose assignments for the six 
resonances observed in the experimental spectrum: 5.99, 2.84, 
1.61, 1.31, 1.08 and 0.95 ppm.

4. Select Spectra from the Display menu and click on the NMR 
tab. The NMR Spectra dialog appears.

 

 Click on Draw Calculated and check the box to the left of Show 
HH Couplings (under 1H Spectrum) at the top left of the dialog. 
The following proton spectrum appears.

 
 Compare the calculated proton spectrum with that in SDBS (see 

below or examine it on-line).
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5. You may have a difficult time seeing that the lines are split (in both 

calculated and observed spectra). This is because the splittings are 
very small relative to differences in the magnitudes of the chemical 
shifts themselves.  Spartan provides a magnifier tool to assist. 
With the Properties dialog on screen, click on the horizontal axis 
of the spectra plot. Click on the Magnifier button at the bottom 
right of the Plot Properties dialog that results. Click on the 
border of the green magnifier box that results to select it. Move it 
(as you would any graphical object) to a position directly above 
the resonance around 6 ppm. The single line (due to protons on 
the double bond) will be split in two due to interaction (coupling) 
with the magnetic spins of the protons on the bridgehead carbons.

 
6. Draw the COSY spectrum for 2-norbornene (in addition to the 

proton spectrum). Click on Draw COSY under 2D H vs. H Spectra.
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 The circles indicate interactions between neighboring protons. 
Note that coupling constants are not obtained from quantum 
chemical calculations, but rather are based on geometrical 
relationship between protons in the calculated structure.

7. Close 2-norbornene and any remaining dialogs when you are 
finished.
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13C Spectrum of Caulophylline

There are several reasons why NMR spectroscopy, in particular, 13C 
NMR, is one of the most important routine analytical techniques 
available for characterizing organic molecules. The experiment, 
which is straightforward and can be carried out rapidly, requires 
relatively small samples and is non-destructive. The resulting (proton 
decoupled) spectrum is quite simple, comprising but a single line 
for each and every unique carbon. However, assigning 13C spectra 
is by no means trivial, even for molecules that might appear to be 
quite simple. The problem is that the positions of the lines in the 
spectrum (the chemical shifts) are very sensitive to the  environment 
in which the carbons find themselves. Where two or more carbons 
in  a molecule reside in what appears to be similar environments, it 
may be very difficult to distinguish them. 

This tutorial uses the alkaloid caulophylline (cytisine) to illustrate 
the use of calculated 13C spectra to assist in assigning the measured 
spectrum of the molecule.

N
O

NH

1. Build caulophylline and minimize ( ). Bring up the Calculations 
dialog (Setup menu) and specify calculation of equilibrium 
geometry with the EDF2/6-31G* density functional model. Check 
NMR to the right of Compute. Click on Submit and specify a 
name. The job will require upwards of one hour to complete*.

2. When the calculation is done (or after you have accessed 
information from SSPD), bring up the NMR Spectra dialog 
(Spectra under the Display menu) and click on the NMR tab. 
Click on Draw Calculated in the section designated 13C Spectra. 

* An optimized structure and NMR spectrum for caulophylline are available in the Spartan 
Spectra and Properties Database (SSPD). If you decide to use this instead of doing the 
calculations, select  SSPD from the menu at the bottom of Spartan’s main screen, and click 
on Replace inside the Preview dialog. 

 100 mins
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Next, check Local File in the section designated Experimental 
Data From, click on Draw Experimental (in the 13C Spectra 
section), move to the spectra of organic molecules subdirectory 
under the tutorials directory* and click on caulophylline carbon 
NMR. You need to select All Files from the menu to the right of 
the file name inside the Open dialog. The reason that two of the 
resonances are missing from both calculated and experimental 
spectra is because they are outside the default scale (0 to 150 
ppm). To change the scale, select Properties from the Display 
menu and click on the horizontal axis of the plot, to bring up 
the Plot Properties dialog. Click on the X-Axis tab at the top of 
the dialog. Change 150 at the left below Range to 175, increase 
the number of horizontal increments (Tics) from 6 to 8 (top 
right of dialog) and close the dialog. The plot now shows all ten 
resonances. 

3. Use the calculated spectrum to associate the individual lines 
in the experimental 13C spectrum with specific carbons in the 
structure of caulophylline.** Predict the DEPT spectrum, where 
CH groups point up, CH2 groups point down and quaternary 
carbons are missing. Leave the 13C plots on screen and click on 
DEPT Draw and on Draw Experimental DEPT (in the 13C 
section of the NMR Spectra dialog). The experimental spectrum 
is caulophylline DEPT NMR in the spectra of organic molecules 
subdirectory under the tutorials directory. Are your peak 
assignments consistent with the experimental DEPT spectrum?

4. Close all molecules and dialogs that are open on screen.

* For Windows, this directory is found in Program Files/Wavefunction/Spartan10 or 
Program Files(x86)/Wavefunction/Spartan10. It needs to be copied to another location 
available to the user prior to opening it in Spartan. For Linux, this is found in the directory 
where Spartan was installed. For Macintosh, this is located at the top level on the installation 
CDROM.

** 13C chemical shifts from EDF2/6-31G* calculations have been corrected to account for 
local environment.
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13C Spectrum of cis-1,2-Dimethylcyclohexane

At normal temperatures, the NMR spectrum of a conformationally-
flexible molecule represents a (Boltzmann-weighted) average of  
the NMR spectra of all accessible conformers. Only when the 
temperature is lowered will the spectrum reveal its components, and 
its complexity. A simple example is cis-1,2-dimethylcyclohexane, a 
molecule with two equivalent conformers.

Me

Me Me

Me
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1
23
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Me
Me

The room temperature 13C NMR spectrum contains only four lines at 
34.9, 31.9, 24.2 and 16.4 ppm relative to TMS, corresponding to an 
equal weighting of C1 and C2, C3 and C6, and C4 and C5 and the two 
methyl carbons, respectively. Only when the sample is cooled does 
the spectrum reveal eight distinct lines.

In this tutorial, you will calculate the 13C NMR spectrum of cis-1,2-
dimethylcyclohexane, and then average chemical shifts for equivalent 
carbons to yield a room temperature spectrum. You will then obtain 
a 13C spectrum for cis-decalin to see if it serves as a model for static 
cis-1,2-dimethylcyclohexane.

1. Build and minimize cis-1,2-dimethylcyclohexane. Inside the 
Calculations dialog, specify calculation of Equilibrium 
Geometry using the Density Functional EDF2 6-31G* model. 
Check NMR to the right of Compute, and submit the job. Accept 
the name cis-1,2-dimethylcyclohexane.

2. After the calculation has completed (several minutes), 
record the 13C chemical shifts* for all ring carbons in cis-1,2-
dimethylcyclohexane, either from the Atom Properties dialog 
(select Properties from the Display menu and click on a 

* 13C chemical shifts from EDF2/6-31G* calculations have been corrected to account for 
local environment.

15 mins
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carbon) or by labeling the model (select Configure... from the 
Model menu and check Chem Shift under Atom in the dialog 
that results). In the latter case, you may want to remove the 
hydrogens (click to deselect Hydrogens from the Model menu) 
to simplify the display. Finally, average the calculated chemical 
shifts in order to mimic what is seen at room temperature. Are 
the resulting 13C shifts consistant with what is actually observed? 
Elaborate.

3. cis-Decalin is a plausible model for static cis-1,2-
dimethylcyclohexane, in that it is unable to undergo (rapid) 
ring inversion.

 
 Build cis-decalin. Start with cyclohexane, add sp3 carbons at 

adjacent cis free valences and connect these carbons by two 
additional sp3 groups. Instead of calculating its equilibrium 
geometry and NMR spectrum, get them from the Spartan Spectra 
and Properties Database (SSPD). Click on  to the right of the 
name (cis-decalin) at the bottom of the screen to bring up the 
Preview dialog. Click on the Replace button at the bottom of the 
dialog. The entry in SSPD will replace the molecule you built.

4. Select Spectra from the Display menu and click on the 
NMR tab. Click on Draw Calculated under 13C Spectrum. 
Because of the (C2) symmetry of cis-decalin, your spectrum 
will contain only five lines, all of equal intensity. Relate these 
to the six lines corresponding to the ring carbons in static 
cis-1,2-dimethylcyclohexane. Pay particular attention to the 
differences in chemical shifts between carbons which average 
in the equilibrating molecule. Is cis-decalin a good model for 
cis-1,2-dimethylcyclohexane?

5. Close all molecules and any open dialogs.
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Stereochemical Assignments from 13C Spectra

NMR spectroscopy, in particular 13C spectroscopy, is without doubt 
the method of choice to establish the three-dimensional structure of 
organic molecules. Only X-ray diffraction provides more definitive 
results, although the requirement of a crystalline sample severely 
limits its application. It is now practical to routinely calculate the 
NMR spectra of organic molecules. In time, the availability of a 
virtual NMR spectrometer will offer organic chemists an entirely new 
paradigm for structure determination, that is direct comparison of a 
measured spectrum with calculated spectra for one or more chemically 
reasonable candidates.

Here, you will obtain 13C chemical shifts for endo and exo stereoisomers 
of 2-methylnorbornane, and compare these to experimental shifts. The 
EDF2/6-31G* density functional model will be employed. You will 
establish the extent to which the calculations are able to reproduce 
differences in chemical shifts as a function of stereochemistry.

1. Build norbornane. Start with Cyclohexane from the Rings menu. 
Add sp3 carbon  to one of the axial free valences (leaving you 
with axial-3-methylcyclohexane). Click on  and then click on 
one of the free valences of the methyl group and the equatorial 
free valence on cyclohexane that is directly across. Click on . 
The name norbornane should appear at the bottom right of the 
screen. Put norbornane onto the clipboard. Right click and select 
Copy from the menu that appears.

2. Select sp3 carbon  from the model kit and click on the exo 
free valence of the carbon in the 2-position. The name exo-2-
methylnorbornane should appear at the bottom right of the screen.

3. Select New Molecule from the File menu. Click on Clipboard 
at the bottom of the model kit and click on screen. Norbornane 
appears. Select sp3 carbon  and click on the endo free valence of 
the carbon in the 2-position. The name endo-2-methylnorbornane 
should appear at the bottom right of the screen. Click on .

30 mins



120 Chapter 6
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4. Name your molecules. Bring up the spreadsheet (Spreadsheet 
under the Display menu), right click on the header cell of the 
leftmost column and select Rename Selected Using SSPD from 
the menu that results.

5. Inside the Calculations dialog, specify calculation of Equilibrium 
Geometry using the EDF2 6-31G* Density Functional model. 
Check NMR (to the right of Compute). Submit the job with the 
name 2-methylnorbornane.

6. When completed (several minutes), compare the 13C chemical 
shifts with experimental values with particular attention to 
differences between endo and exo stereoisomers.*

   endo exo ∆
  C1 43.5 42.2 -1.3
  C2 36.8 34.6 -2.2
  C3 40.2 40.7 0.5
  C4 37.3 38.2 0.9
  C5 30.3 30.6 0.3
  C6 29.0 22.4 -6.6
  C7 35.0 38.9 3.9
  CH3 22.3 17.4 -4.9

 Can the calculations be used to distinguish between the two 
isomers?

8. Close 2-methylnorbornane.

* 13C chemical shifts from EDF2/6-31G* calculations have been corrected to account for 
local environment.
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13C Chemical Shifts Depend on Conformation

The time for nuclear spin relaxation is very long relative to time 
required for equilibration among conformers, at least at normal 
temperatures. This means that the each of the carbon chemical shifts 
in the NMR spectrum of a flexible molecule, 13C, will be a weighted  
average of the shifts NMR of the individual conformers,13Ci.

13C = Σi ωi
13Ci

The weight, ωi, is given by the Boltzmann equation, and depends on 
its energy, εi (relative to that of the lowest-energy conformer, ε0) and 
on temperature, T. Summation is over all conformers (including the 
lowest-energy conformer), gi is the number of times that conformer i 
appears in the overall distribution and k is the Boltzmann constant.

ωi = gi exp - [εi - ε0/kT]/Σj {exp - [εj - ε0/kT]}

In practice, conformers that are 10 kJ/mol or more above the lowest-
energy conformer make a negligible contribution to the total (at 
room temperature).

1. Open limonene from the spectra of organic molecules 
subdirectory under the tutorials directory.* This molecule with 
one freely-rotatable bond has three distinct conformers.

 

2. Select Spreadsheet under the Display menu. Click on Add... at 
the bottom of the spreadsheet, select both rel. E and  Boltzmann 
Distribution from the menu and click on OK. You will see that 

* For Windows, this directory is found in Program Files/Wavefunction/Spartan10 or 
Program Files(x86)/Wavefunction/Spartan10. It needs to be copied to another location 
available to the user prior to opening it in Spartan. For Linux, this is found in the directory 
where Spartan was installed. For Macintosh, this is located at the top level on the installation 
CDROM.

no calculations
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all three conformers are within 2 kJ/mol, meaning that all should 
contribute significantly to the NMR spectrum.

3. Select Spectra under the Display menu and click on the NMR tab. 
Click on both Draw Calculated and Draw Experimental under 
13C Spectra (the experimental spectrum has been attached to the 
.spartan file). Move among the three conformers and examine the 
changes to the calculated 13C spectrum and the quality of fit to 
the experimental spectrum.* Do any of the chemical shifts differ 
by more than a few ppm from one conformer to another?

4. Click on Boltzmann Averaging at the bottom of the NMR 
Spectra dialog. The calculated spectrum will now be based on 
the Boltzmann average (it will not change as you move from one 
conformer to another). Close limonene when you are done.

5. Repeat the above steps for 3,5-dimethyl-2-furyl methyl ketone 
(also available in the spectra of organic molecules subdirectory 
under the tutorials directory).

 

O
O

 The two conformers of this molecule are different in energy by 
17 kJ/mol and the minor conformer contributes very little to the 
overall average NMR spectrum. Does the large difference in 
(conformer) energy anticipate a large difference in 13C shifts (at 
least for those carbons that are directly involved in the change)?

6. Close 3,5-dimethyl-2-furyl methyl ketone and any open dialogs.

* 13C chemical shifts from EDF2/6-31G* calculations have been corrected to account for 
local environment.
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Chapter 7
Organic Reactions

This chapter outlines and illustrates strategies for locating and 
verifying transition states for organic reactions as well as exploring 
changes in product distributions as a function of substituents and 
reactant stereochemistry.

The treatment of chemical reactions adds an entirely new dimension to 
the application of quantum chemical models. Whereas unique valence 
structures may generally be written for most molecules and, based 
on these structures, reasonable guesses at bond lengths and angles 
may be made, it is often difficult to designate appropriate valence 
structures for transition states, let alone specify detailed geometries. 
While there is a complete absence of experimental data for the 
structures of transition states, calculated transition-state geometries 
are now commonplace. Spartan provides both an extensive library of 
calculated transition-state geometries and a facility for automatically 
matching an entry in this library with the reaction at hand.* This library 
is also available as the Spartan Reaction Database (SRD), and may 
be searched by substructure to yield all available transition states of 
reactions related to the one of interest. 

Spartan also provides a procedure for driving user-defined 
coordinates. Aside from conformational analysis (see discussion in 
previous chapter), the major application of this is to force reactions, 
thereby permitting identification of transition states.

The first four tutorials in this chapter illustrate Spartan’s automatic 
procedure for guessing transition-state geometries based on its library 
of organic reactions. The last two of these show how a transition state 
for one reaction may be used to provide a good guess at the transition 
state of a closely-related reaction. These tutorials also illustrate the 

* Where a reaction is unknown to Spartan’s library, a fallback technique which averages reactant 
and product geometries (similar to the so-called linear synchronous transit method) is invoked.
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use of vibrational analysis (infrared spectroscopy) to verify that a 
particular structure corresponds to a transition state and to show 
the motion connecting it to reactants and products. The fifth tutorial 
illustrates how a reaction may be driven through a transition state. 
This tutorial, along with the fourth tutorial, draw the connection 
between relative activation energies and kinetic product distributions. 
The last tutorial in this chapter illustrates how transition states may 
be extracted from the Spartan Reaction Database.

An example of a transition state calculation for an organometallic 
reaction is provided in Chapter 10.
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Ene Reaction of 1-Pentene
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The proposed mechanism of the ene reaction involves simultaneous 
transfer of a hydrogen atom and CC bond cleavage. In this tutorial, you 
will obtain the transition state for the ene reaction of 1-pentene from  
3-21G Hartree Fock calculations, and examine the reaction coordinate 
for evidence of concerted motion. Optionally, you will perform B3LYP/ 
6-31G* density functional energy calculations to estimate the 
activation energy for the reaction.

1. Bring up the organic model kit and build 1-pentene in a 
conformation in which one of the terminal hydrogens on the 
ethyl group is poised to transfer to the terminal methylene group. 
To rotate about a (single) bond, first click on it to select (it will 
be marked by a yellow cylinder), hold down the left button and 
Alt key (option key on Mac) and move the mouse up and down. 
Minimize and click on .

2. First, save 1-pentene as 1-pentene density functional for 
optional use later ( ). Also make a copy for immediate  
use; name it ene reaction 1-pentene. In both cases you will need 
to replace the suggested name (1-pentene).

3. Select Guess Transition State from the Search menu (or click 
on the  icon at the top of the screen). Click on bond a in the 
figure on the following page and then click on bond b. A curved 
arrow from double bond a to single bond b will be drawn.
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 Next, click on bond c and then on bond d. A second curved arrow 
from bonds c to d will be drawn. Finally, click on bond e and 
then, while holding down the Shift key, click on the (methyl) 
hydrogen to be transferred and on the terminal (methylene) 
carbon to receive this hydrogen. A third curved arrow from bond 
e to the center of a dotted line that has been drawn between the 
hydrogen and oxygen, will appear.

 If you make a mistake, you can remove an arrow by selecting 
Delete from the Build menu (click on ) and then clicking on 
the arrow. (You will need to select  to continue.) Alternatively, 
hold down the Delete key as you click on an arrow. With all three 
arrows in place, click on  at the bottom right of the screen. 
Your structure will be replaced by a guess at the ene transition 
state. If the resulting structure is unreasonable, then you have 
probably made an error in the placement of the arrows. In this 
case, select Undo from the Edit menu to return to the model 
with the arrows and modify accordingly.

4. Enter the Calculations dialog (Setup menu), and specify 
calculation of transition-state geometry using the 3-21G Hartree-
Fock model. Select Transition State Geometry from the top 
menu to the right of Calculate, and choose Hartree-Fock and  
3-21G from the two bottom menus. Finally, check IR to the 
right of Compute. This will allow you to confirm that you have 
found a transition state, and that it smoothly connects reactant 
and product. Click on Submit.

5. When the job completes, animate the motion of atoms along 
the reaction coordinate. Select Spectra from the Display menu 
and click on the IR tab. Click on the top entry in the list in the 
IR dialog that results. It corresponds to an imaginary frequency, 
and will be designated with an i in front of the number. 
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A vibrational frequency is proportional to the square root of the 
ratio of the force constant (reflecting the curvature of the potential 
surface along a particular coordinate) divided by a combination 
of the masses of atoms involved in motion along that coordinate. 
At a transition state (a maximum in the reaction coordinate), the 
curvature is negative. Since the mass term is positive, the quantity 
inside the square root is negative and the frequency is an imaginary 
number.

 Is the vibrational motion consistent with an ene reaction of 
interest and not with some other process? 

6. Controls at the bottom right of the IR dialog allow for changing 
both the amplitude of vibration (Amp) and the number of steps 
that make up the motion (Steps). The latter serves as a speed 
control. Change the amplitude to 0.3. Type 0.3 in the box to the 
right of Amp and press the Enter key (return key on Mac). Next, 
click on Make List at the bottom of the dialog. This will give 
rise to a group of structures that follow the reaction coordinate 
down from the transition state both toward reactant and product. 
Remove the original transition state from the screen. Click on 
ene reaction 1-pentene (the vibrating molecule) and close it, 
along with the IR dialog.

7. Enter the Calculations dialog and specify calculation of Energy 
using the 3-21G Hartree-Fock model (the same level of 
calculation used to obtain the transition state and calculate the 
frequencies). Make certain that Global Calculations is checked. 
Next, enter the Surfaces dialog and specify evaluation of two 
surfaces: a bond density surface and a bond density surface onto 
which the electrostatic potential has been mapped. Before you 
do so, make certain that Global Surfaces is checked. Click on 
More Surfaces...*, select density (bond) for Surface and none 
for Property and click on Apply. Select density (bond) for 
surface and potential for Property and click on OK.

* You need to use More Surfaces rather than Add as the electrostatic potential is mapped on 
the bond density surface.
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8. Submit for calculation. Name it ene reaction 1-pentene  
sequence. Once the job has completed, enter the Surfaces 
dialog and examine the surfaces that you have calculated. For 
each, step through the sequence of structures (  and ) keys at 
the bottom of the screen) or animate the reaction ( ). Note, in 
particular, the changes in bonding revealed by the bond density 
surface. Also pay attention to the value of the potential on the 
migrating atom. This reflects its charge. Is it best described as a 
proton (blue), hydrogen atom (green) or hydride anion (red)? 

9. Close ene reaction 1-pentene sequence as well as any remaining 
dialogs.

10 to 13 optional

Methods that account for electron correlation are generally needed 
to furnish accurate estimates of absolute activation energies. Perform 
B3LYP/6-31G* density functional energy calculations on both 
1-pentene and on the ene reaction transition state (using 3-21G 
geometries).

10. Open ene reaction 1-pentene ( ) and make a copy ( ). Name 
it ene reaction 1-pentene density functional.

11. Enter the Calculations dialog, and specify calculation of Energy 
using the B3LYP/6-31G* Density Functional model. Remove 
the checkmark from IR. Submit the job.

12. Open 1-pentene density functional ( ). Specify calculation of 
Energy using the B3LYP/6-31G* Density Functional model. 
Also select 3-21G from the Start from menu. This designates 
that a 3-21G equilibrium structure is to be used (that is, the same 
as employed for the transition state geometry). Submit the job.

13. Obtain the activation energy (difference in total energies between 
1-pentene and the ene reaction transition state).

14. Remove any molecules and dialogs from the screen.
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SN2 Reaction of Bromide and Methyl Chloride
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1. The SN2 reaction passes through a transition state in which 
carbon is in a trigonal bipyramid geometry and the entering and 
leaving groups are colinear. To build it, first construct methyl 
chloride. Then select bromine from the palette of icons in the 
model kit, click on the Insert button at the bottom right of the 
screen or hold down the Insert key (option key on Mac) and 
click anywhere on screen. Alternatively, double click in a blank 
area of the screen following selection of bromine. Two detached 
fragments, methyl chloride and hydrogen bromide, appear on 
screen. Click on  and then click on the free valence on bromine. 
Make sure to click on  when you are done. Alternatively, hold 
down the Delete key and click on the free valence on bromine. 
You are left with methyl chloride and bromine atom (bromide). 
Manipulate the two such that bromide is poised to attack methyl 
chloride from the backside (as in the transition state above). 
(Translations and rotations normally refer to both fragments, 
but can be made to refer to a single fragment by first clicking 
on the fragment and then holding down on the Ctrl key while 
carrying out the manipulations.) Do not minimize (If you do so 
by accident, select Undo from the Edit menu). Click on .

2. Select Guess Transition State from the Search menu or click 
on . Click on bromide and, while holding down the Shift key, 
click again on bromide and then on carbon. A dotted line will 
be drawn from bromine to carbon, together with an arrow from 
bromine to the center of this line. Next, click on the CCl bond 
and then click on the chlorine. A second arrow from the carbon-
chlorine bond to the chlorine will be drawn.

 
Br C Cl

2 mins/5mins
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 Click on  at the bottom right of the screen. Your structure will 
be replaced by a guess at the transition state.

3. Select Measure Distance from the Geometry menu (or click 
on ) and then click on the CBr bond. Replace the current CBr 
distance in the box at the bottom right of the screen by 3.8 (3.8Å) 
and press the Enter key (return key on Mac). You have made 
a complex representing the reactant.

4. Select Constrain Distance from the Geometry menu (or click 
on the  icon at the top of the screen). Click on the CBr bond, 
and then click on  at the bottom right of the screen. The icon 
will change to  indicating a constraint is to be applied to this 
distance. Check the box to the left of Profile at the bottom of right 
of the screen. This will result in two additional text boxes.

 
 Leave the value 3.8 (3.8Å) in the leftmost box alone, but change 

the number in the box to the right of to to 1.9 (1.9Å) and press 
the Enter (return) key. Change the number in the box to the 
right of Steps from 10 (the default) to 20. 20 Calculations with 
CBr bond lengths constrained from 3.8Å (the starting point) to 
1.9Å (the ending point) will be performed. The transition state 
should have a CBr distance in between these values. Click on .

5. Enter the Calculations dialog, and select Energy Profile, 
Semi-Empirical and AM1 from the appropriate menus to the 
right of Calculate. You need to change Total Charge to Anion.

6. Submit the job. Name it bromide+methyl chloride. When 
completed, it will give rise to a sequence of calculations placed 
in bromide+methyl chloride.Prof.M0001. You will be prompted 
as to whether you want to open this file. Click on OK. Align 
the molecules. Click on , select Structure from the Align by 
menu at the bottom right of the screen and, one after the other, 
click on the three hydrogens. Finally press the Align by button 
at the bottom right of the screen. Click on .

7. Bring up the Spreadsheet (Spreadsheet from the Display menu) 
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and click on Add.... Select E from among the quantities listed at 
the top of the dialog, kJ/mol from the Energy menu, and click 
on OK. Next, enter the (constrained) CBr distances and bromine 
charges in the spreadsheet. Click on , click on the constraint 
marker and click on  at the bottom right of the screen. Click on 

. Bring up the Properties dialog. Click on bromine and click 
on  to the left of Electrostatic under Charges in the Atom 
Properties dialog. Finally, bring up the Plots dialog, and select 
Constraint (Con1) (the distance at which the CBr bond has been 
constrained) from the X Axis menu, and both E (kJ/mol) and 
Electrostatic (Br1) from the Y Axes list. Click on Create Plot.

 One plot gives the energy as the reaction proceeds and the other 
gives charge on bromine. Are the two related? Explain.

 
 SN2 reactions involving charged species normally need to be 

carried out in highly-polar media, for example, water. Spartan 
provides two solvation models in which the solvent is represented 
by a reaction field (Appendix B). The SM5.4 model only alters 
the energy and not the charges. The more recent SM8 model 
does affect charges but is available only for Hartree-Fock and 
density functional models.

8. Add aqueous phase data (based on the SM5.4 model) to the 
spreadsheet. Click on an empty column header, click on Add..., 
select Eaq from the list of available quantities (kJ/mol from the 
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Energy menu), and click on OK. Bring up the Plots dialog and 
select Constraint (Con1) from the X Axis and Eaq(kJ/mol) 
from the Y Axes list. Click on Create Plot.

9 to 12 optional

9. With bromide+methyl chloride.Prof.M0001 selected, enter the 
Calculations dialog. Specify Energy (Semi-Empirical and 
AM1 should be selected) and click on OK. 

10. Enter the Surfaces dialog. Click on More Surfaces.... * Select density 
(bond) from the Surface menu and none from the Property menu 
and click on Apply. Select density (bond) from the Surface menu, 
but this time potential from the Property menu. Click on OK.

11. Submit the job. When completed, enter the Surfaces dialog and 
examine the bond density surface that you generated. Click on 

 at the bottom left of the screen to animate the display. Note, 
that bonds are smoothly broken and formed during the course 
of reaction. Click on  at the bottom of the screen when you 
are done.

12. Reenter the Surfaces dialog. Turn display of the bond density off, 
and then turn display of the electrostatic potential mapped onto 
the bond density on. Click on . Relate the migration of negative 
charge during reaction as indicated by colors in the electrostatic 
potential map to the plot you constructed earlier in step 7. Recall, 
that colors near red indicate maximum negative potential.

13. Remove all molecules and any remaining dialogs from the 
screen.

* You need to use More Surfaces rather than Add as the electrostatic potential is mapped on 
the bond density surface.
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Carbene Additions to Alkenes
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Singlet carbenes add to alkenes to yield cyclopropanes. Since a 
singlet carbene possesses both a high-energy occupied molecular 
orbital in the plane of the molecule, and a low-energy, out-of-plane 
unoccupied molecular orbital, this reaction presents an interesting 
dilemma. Clearly it would be more advantageous for the low-lying 
vacant orbital on the carbene, and not the high-lying filled orbital, to 
interact with the olefin π system during its approach.
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However, this leads to a product with an incorrect geometry. The 
carbene must twist by 90° during the course of reaction.
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In this tutorial, you will use the Hartree-Fock 3-21G model to find 
the transition state and to analyze the motion of the fragments.

1. Bring up the organic model kit and build ethylene.

2. Select  from the model kit. Click on the Insert button at the 
bottom right of the screen or hold down the Insert key (option  
key on Mac) and then click anywhere on screen. Alternatively, 
double click on a blank area of the screen following selection of sp3 

5 mins/15 mins
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carbon. Next, select  from the model kit and click on two of the 
free valences on the sp3 carbon. Next, click on  and, one after the 
other, click on the remaining two free valences on the sp3 carbon. 
Finally, click on . You are left with two fragments, ethylene 
and difluorocarbene. Orient the two as to be poised for reaction.*

 

C
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F
F

 Translations and rotations normally refer to the complete set of 
fragments, but if you click on a fragment  (not on a free valence) 
to select it, and then hold down  the Ctrl key they will refer to 
an individual fragment.

3. Select Guess Transition State from the Search menu or click 
on . Click on the carbon on the CF2 fragment and then, while 
holding down the Shift key, click on the CF2 carbon and on the 
closer of the carbons on the ethylene fragment. A dotted line is 
drawn between the two carbons that are to be bonded along with 
an arrow from the CF2 carbon to the center of this line.
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 Click on the CC double bond and then, while holding down the 
Shift key, click on the other ethylene carbon and on the CF2 
carbon. A second dotted line and arrow will be drawn.

 

C

C C

F
F

* Proper orientation of the two fragments is not crucial in this case, but is primarily to allow 
you to associate the arrows with the intended reaction. Proper orientation is, however, 
essential where different stereochemical outcomes are possible.
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 Click on  at the bottom right of the screen. Your structure will 
be replaced by a guess at the transition state.

4. Enter the Calculations dialog. Specify calculation of a Transition 
State Geometry using the 3-21G Hartree-Fock model. Check 
IR to the right of Compute, and click on Submit. Name the job 
difluorocarbene+ethylene.

5. When the job is complete, examine the geometry of the transition 
state. In light of the previous discussion, would you describe your 
structure as corresponding to an early or late transition state? 
Animate the vibration corresponding to the reaction coordinate. 
Bring up the IR dialog (Spectra under the Display menu and 
click on the IR tab). Click on the imaginary frequency at the 
top of the list of frequencies. Does the animation show that the 
carbene reorients as it approaches the double bond? Turn the 
animation off by again clicking on the imaginary frequency.

6. Select Properties (Display menu) and, in turn, click on each of 
the four hydrogens in the transition state. Change the value in the 
Mass Number menu in the Atom Properties dialog (Properties 
under the Display menu) from 1 to 2 Deuterium. Resubmit 
the job. (No additional quantum chemical calculations are 
involved, but the vibrational analysis needs to be repeated.) When 
complete, examine the new set of vibrational frequencies. Note 
that they are uniformly smaller than those for the undeuterated 
system, and that the largest changes are for vibrational motions 
where hydrogens are involved.

7 to 10 optional

7. Make a copy of difluorocarbene+ethylene ( ) name it difluoro- 
carbene+cyclohexene. The original file will be closed.

8. Bring up the organic model kit with the copy (click on ). Select 
Freeze Center from the Geometry menu (or click on the  icon 
at the top of the screen). One after the other, click on all atoms in 
the transition state except two of the hydrogens on one side (on 
different carbons) of the ethylene fragment. Each of the selected 
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atoms will be given a magenta colored marker, indicating that it 
is to be frozen (not moved during optimization). Build a chain 
of four sp3 carbons  off one of the free valences that you have 
not frozen. Select and click on the free valence on the terminal 
sp3 carbon and on the remaining free valence that you have not 
frozen to make a cyclohexene ring. Click on . Note that the 
only four methylene groups that you have just introduced move 
and not the underlying transition state. You have produced an 
excellent guess at the transition state for difluorocarbene addition 
to cyclohexene based on your previous transition state for the 
simpler process.*

9. Enter the Calculations dialog. It should already specify 
calculation of Transition State Geometry using the 3-21G 
Hartree-Fock  model. Remove the checkmark on IR (to the 
right of Compute). Do not check Frozen Atoms (to the right 
of Subject To). Click on Submit.

10. To compare the geometries of the two transition states, you need to 
put them into the same document. Select Append Molecule(s)... 
from the File menu, click on difluorocarbene+ethylene in the 
browser that results and click on Open. Select Spreadsheet from 
the Display menu and check each of the boxes to the right of their 
identifiers. This allows the two transition states to be displayed 
simultaneously on screen. Click on Add at the bottom of the 
spreadsheet and select Alignment Scores from the menu that 
results. Click on , select structure from the Align by menu at the 
bottom right of the screen, click on the three carbons that make up 
the cyclopropane ring and click on Align by at the bottom right of 
the screen. Click on . Are the two transition states very similar 
as expected (an alignment score of 1.0 is perfect alignment)?

11. Remove all molecules and dialogs from the screen.

* It is not necessary to replace the deuteriums by hydrogens. You will not request an IR 
spectrum and calculated geometry does not depend on atomic mass
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Stereospecific Diels-Alder Reactions
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Diels-Alder cycloaddition of 5-substituted cyclopentadienes with 
acrylonitrile can lead to four stereoproducts, in which the substituent, 
X, at the 5 position is syn or anti to the dienophile, and the nitrile is 
endo or exo. Anti products are preferred when X is alkyl (consistent 
with sterics), while syn products are favored when X is halogen or 
alkoxy.  In general, endo adducts are kinetically favored over exo 
adducts (see following tutorial). In this tutorial, you will use AM1 
calculations to obtain both syn and anti transition states for endo 
addition of both 5-methylcyclopentadiene and 5-fluorocyclopentadiene 
and acrylonitrile, and then use Hartree-Fock 3-21G calculations to 
estimate relative activation energies. All four transition states are likely 
to be very similar to the transition state for the parent cycloaddition 
(cyclopentadiene and acrylonitrile). You will take advantage of this, 
and obtain a transition state for the parent reaction, and then to use it as 
a starting point for locating transition states for the substituted systems.

1. Construct the following substituted norbornene (the product of 
endo addition of cyclopentadiene and acrylonitrile).

 
a

CN

b

cd
e

f

2. Select Guess Transition State from the Search menu or click 
on . Click on bond a (see figure above) and then on bond b. A 
curved arrow will be drawn from a to b. Next, click on bond c 
and then on bond d; a second curved arrow from c to d be drawn. 
Finally, click on bond e and then on bond f, leading to a third 
curved arrow. The model on screen should now appear as follows.

10 mins



138 Chapter 7

 CN

 Click on  at the bottom right to produce a guess at the transition 
state.

3. Inside the Calculations dialog, specify calculation of Transition 
State Geometry using the Semi-Empirical AM1 model. 
Check IR under Compute to specify calculation of vibrational 
frequencies. This will allow you to verify that you have indeed 
located a transition state that is consistent with a Diels-Alder 
reaction. 

4. Submit the job. Name it cyclopentadiene+acrylonitrile. When 
completed, examine the resulting structure and calculated 
frequencies. Verify that there is one and only one imaginary 
frequency. Animate the motion associated with the imaginary 
frequency (Spectra under the Display menu, click on the IR tab 
and check the box to the left of the imaginary frequency in the 
dialog that results) to verify that it corresponds to the expected 
motion along the reaction coordinate.

5. Place the transition-state structure onto the clipboard. Right click 
on the background and select Copy from the resulting menu. 
Close cyclopentadiene+ acrylonitrile ( ).

6. Bring up the organic model kit ( ). Click on Clipboard (at 
the bottom of the model kit) and then click anywhere on screen. 
The transition-state structure will appear. Add a fluorine to 
the methylene group on the cyclopentadiene fragment of the 
transition state either syn or anti. Do not minimize. Your starting 
structure should provide an excellent guess at the transition state 
for the substituted system. 

7. Select New Molecule (not New) from the File menu. The screen 
will clear. Click on Clipboard and then click anywhere on screen. 
Add fluorine to the other methylene group position. Repeat the 
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process two more times (starting with New Molecule), to add 
a methyl group (sp3 carbon) to both syn and anti on methylene. 
When you are done (four substituted transition states in total), 
click on .

 Bring up the spreadsheet and replace the molecule identifiers in 
the leftmost column (M0001, etc.) but more descriptive names 
(F syn, etc.). Click inside each cell and type.

8. Enter the Calculations dialog and specify calculation of 
Transition State Geometry using the Semi-Empirical AM1 
model. Check IR to the right of Compute. Make certain that 
Global Calculations is checked. Submit the job (name it Diels-
Alder stereochemistry. When it has completed, verify that all 
four structures correspond to transition states, that is, have one 
and only one imaginary frequency (Spectra from the Display 
menu). 

9. Make a copy of Diels-Alder stereochemistry ( ). Name it Diels-
Alder stereochemistry Hartree-Fock. Enter the Calculations 
dialog with this copy and specify a 3-21G Hartree-Fock Energy 
calculation. Make certain that you remove the checkmark on IR 
and that Global Calculations is checked before you exit the 
dialog.

10. Submit the job. When it completes, bring up the Reactions 
dialog (Reactions from the Display menu). Select syn and anti F 
compounds (and then syn and anti Me compounds) for Reactants 
and Products, respectively, select Current Document from 
the Use menu, kJ/mol from the Units menu and click on the 
Compute Energies button at the bottom of the dialog. Use the 
results to identify the more stable (thermodynamic) product in 
each case.

11. Remove all molecules and any remaining dialogs from the screen.
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Thermodynamic vs. Kinetic Control

Chemical reactions may yield different products depending on the 
conditions under which they are carried out. High temperatures and 
long reaction times favor the most stable (thermodynamic) products, 
whereas low temperatures and short reaction times favor the most 
easily formed (kinetic) products. For example, the kinetic product in 
Diels-Alder cycloaddition of cyclopentadiene and maleic anhydride 
is the endo adduct, whereas it seems likely that the less-crowded exo 
adduct is the thermodynamic product.
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Here you will first obtain pathways for reactions leading to both 
endo and exo adducts using the PM3 semi-empirical model and then 
follow these by 3-21G Hartree-Fock energy calculations to get a better 
estimate of the difference in activation energies.

1. Build the endo Diels-Alder adduct of cyclopentadiene and maleic 
anhydride and minimize ( ).

2. Select Constrain Distance from the Geometry menu (or click 
on ), and click on bond a in the figure above. Click on the 
icon  at the bottom right of the screen (it will then turn to 

). Check the box to the left of Profile at the bottom right of 
the screen. This will give rise to three additional check boxes. 
Change the value in the leftmost box from 1.54Å to 1.5Å by 
typing 1.5 inside the box and then pressing the Enter key (return 
key on Mac). Type 2.7 (2.7Å) into the box to the right of to and 
press the Enter (return) key. Type 13 into the box to the right 
of Steps and press the Enter (return) key. You have specified 
that bond a will be constrained first to 1.5Å, then to 1.6Å, then 
to 1.7Å, etc. and finally to 2.7Å. Click on .

5 mins/15 mins
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3. Repeat the process for bond b. When you are done, both bonds 
a and b will be constrained from 1.5Å to 2.7Å in 13 equal steps. 
Click on .

4. Bring up the Calculations dialog and select Energy Profile from 
the top menu to the right of Calculate, and Semi-Empirical and 
PM3 from the two bottom menus. Click on Submit at the bottom 
of the dialog. Name it cyclopentadiene+ maleic anhydride endo.

5. When completed the job will give rise to a new document 
cyclopentadiene+maleic anhydride endo.Prof.M0001. This 
contains 13 calculations corresponding to the 13 steps that make 
up the energy profile. You will be prompted as to whether you 
want to open this file. Click on OK.*

6. Bring up the Spreadsheet, and click on Add... at the bottom. 
Select E from among the entries, kJ/mol from the Energy menu, 
and click on OK. Next, click on  and click on one of the two 
CC bonds varied in the energy profile. Click on  at the bottom 
right of the screen. Click on . Finally, bring up the Plots dialog 
(Plots from the Display menu), and select Constraint (BondX)** 
from among the items in the X Axis menu and E (kJ/mol) from 
the Y Axes list. Click on Create Plot. 

 

* To avoid confusion, it is a good idea to close the original file cyclopentadiene+maleic 
anhydride endo.

** Bonds are numbered in the order they were formed upon initial construction of the molecule.
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 Identify both the reactant and transition state from the plot and 
estimate the activation energy for the cycloaddition reaction.

7. Repeat steps 1 to 6 for the exo adduct. Compare the activation 
energy for exo addition to that for endo addition (above). What 
is the kinetic product?

8 and 9 optional

8. Open cyclopentadiene+maleic anhydride endo.Prof.M0001 
( ) and make a copy ( ). Name it cyclopentadiene +maleic 
anhydride endo Hartree-Fock. Enter the Calculations dialog 
and specify a Hartree-Fock 3-21G Energy calculation. Submit. 
When completed, perform the same spreadsheet and plot 
operations you did for the PM3 calculations.

9. Repeat the above procedure for the exo adduct and compare the 
two activation energies. What is the kinetic product?

10. Remove all molecules and dialogs from the screen.
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Activation Energies of Diels Alder Reactions

In an earlier tutorial Dienophiles in Diels-Alder Reactions (Chapter 
5), you examined the extent to which LUMO energies for a series 
of related dienophiles correlated with relative rates of Diels-Alder 
cycloadditions involving cyclopentadiene. In this tutorial, you 
will compare calculated activation energies for this same set of 
reactions with the experimental rates. You will use the previous set 
of calculations on the dienophiles and obtain transition states from 
the Spartan Reaction Database (SRD). The only quantum chemical 
calculation that is required is for cyclopentadiene.

1. Build cyclopentadiene and minimize ( ). Before you proceed 
with the next step, copy cyclopentadiene onto the clipboard. 
Right click and select  Copy from the menu that appears.

2. Enter the Calculations dialog (Setup menu) and specify an 
Equilibrium Geometry calculation using the Hartree-Fock 
3-21G model. Submit the job with the name cyclopentadiene. 
Move it off to the side of the screen for use later on.

3. Enter the builder ( ). Click on Clipboard. The structure of 
cyclopentadiene will appear at the top of the model kit. Click 
anywhere on screen and cyclopentadiene will appear.

4. Select Alkenyl from the Groups menu, press the Insert button 
(at the bottom right of the model kit) or hold down the Insert key 
(option key on Mac) and click on screen, or double click in a blank 
area on screen. Both cyclopentadiene and ethylene will appear 
on screen, but they will not be connected. Select Cyano from the 
Groups menu and click on one of the free valences on ethylene. 
Both cyclopentadiene and acrylonitrile will appear on screen.

5. Orient the two molecules such that they are poised for a Diels-
Alder reaction leading to an endo product.

 

NC

a
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c
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1 min
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 Select Define Reaction Query from the Search menu (click on  
).* Click on the bond marked a in the above figure and, while 

holding down the Shift key, click on the two carbons that when 
connected will lead to the bond marked b. A dotted line will be 
drawn between these carbons and a curly arrow drawn from the 
center of bond a to the center of bond b. Next, click on bond c 
and then on bond d. A second arrow will be drawn. Finally, click 
on bond e and, while holding down the Shift key, click on the 
two carbons that when connected will lead to the bond marked 
f. A second dotted line and a third arrow will be drawn. 

6. Select Define Structure Query from the Search menu (click on 
). Click on all three free valences on the acrylonitrile fragment. 

They will be replaced by orange cones, meaning that anything 
(including hydrogen) may be attached to these positions. 

7. Select Open Databases from the Search menu (click on ) and 
click on the SRD tab at the top of the dialog that results. This 
leads to the Spartan Reaction Database (SRD) dialog.

 

 Before you begin the search, click on  to the right the Search 
button at the bottom of the dialog. This brings up the Search 
Options dialog.

* Define Search Query is equivalent to Guess Transition State for the purpose of defining 
curly arrows. It lacks the ability to automatically guess a transition state.
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 Check 3-21G under Method Filters and click on OK. Click 
on the Search button to search the Spartan Reaction Database 
for Diels-Alder transition states between cyclopentadiene and 
substituted acrylonitriles.

8. When the search completes, a listing of hits appears at the right 
of the dialog.

 

 This should contain four Diels-Alder transition states for endo 
additions of cyclopentadiene and trans-1,2-dicyanoethylene, cis-
1,2-dicyanoethylene, tricyanoethylene and tetracyanoethylene. 
All need to be retrieved into a single document. Click on  
to the right of the Retrieve button at the bottom of the dialog 
to bring up the Retrieve Options dialog. Make sure that New 
Document is selected in this dialog and click on OK. Hold down 
the Ctrl key, select (click on) all four Diels-Alder transition 
states and click on Retrieve at the bottom of the dialog. A new 
(unnamed) document will be created. Open a spreadsheet for 
this document.
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9. Open Diels-Alder dienophiles that you created in an earlier 
tutorial* and bring up a spreadsheet for this document. Select 
all entries in this document. Click inside the lefthand cell of the 
first entry, hold down the Shift key and click on the last entry. 
Right click and select Copy from the menu that results. Move 
the cursor over the leftmost cell of the first empty column of the 
new (unnamed) document, right click and select Paste from the 
menu that results. The contents of Diels-Alder dienophiles (the 
dienophiles and cyclopentadiene) will be copied into the new 
document. Close Diels-Alder dienophiles.

10. Bring up the Reactions dialog (Reactions from the Display 
menu). One after the other, calculate activation energies for the 
six Diels-Alder reactions. Use cyclopentadiene and one of the 
dienophile for Reactants and the appropriate transiton state 
and none for Products. Select Current Document under Use 
at the bottom of the dialog and click on Compute Energies. Is 
the ordering calculated activation energies consistent with the 
experimental relative rates (available in the tutorial Diels-Alder 
Dienophiles in Chapter 5)?

11. Close all molecules and any open dialogs.

* If you have not completed this tutorial, a copy of the document Diels-Alder dienophiles 
may be found in the organic reactions sub-directory (tutorials directory). For Windows, 
this directory is found in Program Files/Wavefunction/Spartan10 or Program Files(x86)/
Wavefunction/Spartan10. It needs to be copied to another location available to the user 
prior to opening it in Spartan. For Linux, this is found in the directory where Spartan was 
installed. For Macintosh, this is located at the top level on the installation CDROM.
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Chapter 8
Medicinal Chemistry

This chapter illustrates applications of Spartan to problems of 
relevance to medicinal chemists. The first involves an investigation 
of the relationship between polar surface area (defined both by atom 
counts and by electrostatic potential maps) and the rate of transport 
between blood and brain. The second uses a published pharmacophore 
to decide whether the antihistamine terfenadine should be considered 
a potential potassium channel blocker. The third seeks to find 
molecules with similar analgesic activity as morphine, based first 
on similar structure and then on similar chemical functionality. 

Many molecular properties may now be calculated using quantum 
chemical methods, some more accurately than they can be measured. 
Still, some quantities of key interest to medicinal chemists are not yet 
subject to calculation. A good example is the rate at which a molecule 
passes through a membrane. Here, overall molecular polarity plays 
an obvious role. Too polar and the lipid may not be able to drag 
the molecule from the (aqueous) solvent. Not sufficiently polar and 
the molecule will not want to leave the membrane to return to the 
aqueous environment. One descriptor commonly used to account 
for polarity is the so-called polar surface area, defined as the area of 
space-filling model due to nitrogen and oxygen together with any 
bonded hydrogens. The first tutorial in this chapter examines the 
correlation between polar surface area and blood-brain transport and 
then proposes an alternative based on electrostatic potential maps.

Many (if not most) drugs act by binding to a protein or nucleotide, 
either promoting a particular process (agonists) or inhibiting one 
(antagonists). New drugs can be found by identifying molecules that 
are structurally and/or functionally similar to compounds that are 
known or presumed to bind. The second tutorial examines whether 
the antihistamine terfenadine is likely to show serious side effects 
because of a binding affinity in potassium ion channels. Here, the 
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similarity analysis is not carried out between molecules but between 
a molecule and an environment. The third tutorial makes use of 
similarity analysis to suggest compounds that look like morphine 
and hence might exhibit similar analgesic action. 
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Anticipating Blood-Brain Transport

A drug must be able to be transported throughout the body. This 
includes intestinal absorption and passage across the blood/brain 
barrier. In this tutorial, you will first examine how well the polar 
surface area, the area of space-filling model due to nitrogen and 
oxygen atoms together with any attached hydrogens, correlates with 
log (Cbrain/Cblood)*.

1. Open blood brain transport from the medicinal chemistry sub-
directory (tutorials directory).** This comprises a list of drugs/
drug candidates for which experimental data relating to the ratio 
of concentrations in the brain and in the blood (Cbrain/Cblood) are 
available. These span a range of nearly 5 log units.

2. Bring up a spreadsheet (Spreadsheet under the Display 
menu) and size it to show all compounds, several extra rows 
and three columns, in addition to the column of experimental 
data log(brain/blood) that is already displayed. Bring up the 
Molecule Properties dialog and click on the QSAR tab. Click 
on the  to the left of PSA. Polar surface area values will fill 
one column in the spreadsheet.

3. Click on the Add button at the bottom of the spreadsheet and 
select (click on) the Linear Regression tab at the top of the 
dialog that appears (most likely the Add Columns dialog). This 
leads to the Add Linear Regression dialog. Select log(brain/
blood) from the Fit menu and click on PSA from the quantities 
in the box below Using. Click on OK. Bring up the Regression 
Properties dialog by first selecting Properties from the Display 
menu and then clicking on the cell labelled Fit1 under Label in 
the spreadsheet. RMSD and R2 values are reported. The smaller 
RMSD and the closer to unity R2, the better the fit. Leave the 

* J. Kelder et al, Pharmaceutical Res., 16, 1514 (1999). All 19 named compounds considered 
in this paper have been included.

** For Windows, this directory is found in Program Files/Wavefunction/Spartan10 or 
Program Files(x86)/Wavefunction/Spartan10. It needs to be copied to another location 
available to the user prior to opening it in Spartan. For Linux, this is found in the directory 
where Spartan was installed. For Macintosh, this is located at the top level on the installation 
CDROM.

no calculations
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Regression Properties dialog on screen.

4. Make a plot of log(brain/blood) vs. the regression fit. Select Plots 
from the Display menu to bring up the Plots dialog. Select log 
(brain/blood) from the X Axis menu, Fit Vals (Fit 1) from the 
Y Axis list and click on OK. Initial presentation uses a smooth 
curve (cubic spline) to connect the data points. Click on the curve 
(not on the axes) to bring up the Curve Properties dialog. Select 
Linear LSQ from the Fit menu to give a least squares line.

 
Next, you will consider an alternative definition of polar surface 
area, based on electrostatic potential maps.

5. Select Surfaces from the Display menu and select Electrostatic  
Potential Map  in the dialog that results. An electrostatic potential 
map for the selected drug appears (maps for the remaining drugs 
may be seen by stepping through the list). The overall size and 
shape is that of the electron density and corresponds roughly to a 
conventional space-filling model. The colors indicate the value 
of the electrostatic potential. Colors toward red designate areas 
of negative potential (where a positive charge is most likely to be 
attracted), while colors toward blue designate areas of positive 
potential (where a positive charge is least likely to be attracted). 
To see the molecular skeleton underneath the electrostatic 
potential map, change to a transparent or mesh display. Click 
on the map to select it and select Transparent or Mesh from 
the Style menu that appears at the bottom right of the screen.
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6. Select Properties from the Display menu. Click on the map. 
Click on the  button to the left of P-Area inside the Surfaces 
Properties dialog that results. Polar areas, defined as the area 
for which the absolute value of the electrostatic potential is > 
100 kJ/mol*, will be added to the spreadsheet.

7. Click on the Add button at the bottom of the spreadsheet and 
click on the Linear Regression tab at the top of the dialog that 
results. Select log(brain/blood) from the Fit menu and click on 
Polar Area from the quantities in the box below Using. Click 
on OK. Bring up the Regression Properties dialog by clicking 
on the cell labelled Fit2 under Label in the spreadsheet. Note 
that the R2 value is better (closer to unity) for this fit than for 
the previous fit (to PSA defined in the usual manner). Make a 
plot of log (brain/blood) vs. the new regression fit. Select Plots 
from the Display menu, choose log (brain/blood) from the 
X-Axis menu and FitVals (Fit 2) (instead of Fit Vals (Fit 1) 
from the Y Axis list and click on OK. Switch to a least square 
fit by clicking on the curve that results and selecting Linear 
LSQ from the Fit menu in the Curve Properties dialog. Which 
property provides better correlation with transport across the 
blood/brain barrier, PSA or polar area?

 
8. Close blood brain transport when you are finished.

* This value may be changed in the Settings Preferences dialog (Preferences under the 
Options menu; Chapter 20).
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Terfenadine. A Potassium Channel Blocker?

Cardiovascular toxicity due to blocking of potassium ion channels 
is commonly screened early in the drug development process. One 
way this is done is to compare drug candidates to a pharmacophore 
deduced from 3D QSAR studies. This tutorial uses a published 
pharmacophore* to see whether the antihistamine, terfenadine should 
be considered a potential channel blocker.

N
OH

OH

terfenadine

1. Open terfenadine conformer library from the medicinal 
chemistry sub-directory (tutorials directory).** This contains 
a selection of several hundred conformers of terfenadine (the 
number is reported in the Molecule Properties dialog) obtained 
from a conformer library calculation. It has been supplied in order 
to save computer time. Close terfenadine conformer library.

2. Open potassium channel blocker pharmacophore from the 
medicinal chemistry sub-directory (tutorials directory). This 
is a five-point pharmacophore comprising four hydrophobes 
(blue spheres) and one positive ionizable center (red sphere).

3. Select Set Similarity Centers from the Geometry menu (or 
click on the  icon at the top of the screen) and then select 
CFD from the menu at the bottom right of the screen. In turn, 
click on each of the (five) pharmacophore elements. In response, 

* S. Ekins et al,  J. Pharmacology and Experimental Therapeutics, 301, 427 (2002).
** For Windows, this directory is found in Program Files/Wavefunction/Spartan10 or 

Program Files(x86)/Wavefunction/Spartan10. It needs to be copied to another location 
available to the user prior to opening it in Spartan. For Linux, this is found in the directory 
where Spartan was installed. For Macintosh, this is located at the top level on the installation 
CDROM.

5 mins
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each will be surrounded by a violet circle indicating that it is to 
be used in the similarity analysis.

4. Select Calculations... from the Setup menu. Select Similarity 
Analysis from the top left menu to the right of Calculate 
inside the Calculations dialog. This leads to a new form of the 
Calculations dialog.

 

 Click on Add Library to bring up a file browser. Locate 
terfenadine conformer library in the medicinal chemistry sub-
directory (tutorials directory) and click on OK. This indicates 
that the library of terfenadine conformers will be searched for a 
match to the pharmacophore. Click on Submit.

5. When the analysis has completed, select Similarities... from 
the Display menu to bring up the Similarities dialog.

 

 One or more hits will appear in the box at the right of the dialog, 
together with a similarity score (limiting on 1.0 which means 
a perfect match). If there is more than one hit, click on that 
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with the largest score. A composite graphic of terfenadine and 
the pharmacophore will appear in a window at the left of the 
dialog. You can manipulate the two (as a single object) in the 
usual way (you need to position the cursor inside the window). 
Note that the positive ionizable center is positioned above the 
nitrogen, while the four hydrophobes are above the phenyl rings 
and the tert-butyl group.

The scoring algorithm not only accounts for position but also for 
direction of any nitrogen or oxygen centers that overlap with (non-
hydrophobe) pharmacophore elements.

6. You can, if you wish, retrieve your hit (without retrieving the 
pharmacophore), by clicking on the Retrieve button at the 
bottom left of the Similarities dialog. This can be used for 
further analysis.

9. Close all open documents on screen.
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Morphine. Structure vs. Pharmacophore
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Three elements of morphine appear to be required in order for the 
molecule to act as an analgesic. These are: i) the nitrogen center 
(assumed to be protonated in the protein-bound complex), ii) the 
aromatic ring and iii) the hydroxyl group attached to the aromatic 
ring. Loss of any of these results in significant loss of activity. This 
knowledge may either be used directly, to identify other likely 
analgesics based on structure, or indirectly, to construct a simple 
3-point pharmacophore that in turn may be employed to find 
compounds with potentially comparable analgesic activity.

This tutorial comprises three parts. In the first part, you will identify 
molecules in SMD that incorporate the three required elements. In 
practice, you will look for molecules that incorporate a nitrogen 
center substituted by a methyl group and two other (sp3) carbons and 
a substituted phenol. You will then select a single hit and generate 
a conformer library for similarity analysis. (In a comprehensive 
investigation, you would likely use several hits or all hits; the 
restriction here is simply in order to save computer time.)

1. Bring up the organic model kit ( ). Select Benzene from the 
Rings menu and click anywhere on screen. Select sp3 oxygen 
( ) and click on one of the free valences of benzene. You have 
made phenol. Select sp3 nitrogen ( ), click on the Insert button 
at the bottom of the screen or hold down the Insert key (option 
key on Mac) and click anywhere on screen. Alternatively, 
double click on a blank region on screen following selection 
of sp3 nitrogen. Two molecules (phenol and ammonia) appear 
on screen. Click on sp3 carbon ( ) and click on all three free 

5 mins
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valences on the nitrogen. Phenol and trimethylamine now 
appear on screen. Click on  remove the model kit.

2. Select Define Structure Query ( ) from the Search menu. 
Click on all five free valences on the carbons in the phenol 
fragment and on all three free valences on two of the three methyl 
groups and on one free valence for the remaining methyl group 
in the trimethylamine fragment. Orange cones will appear at all 
(twelve) selected positions.

 
 Anything can be grown from these positions (including 

hydrogen) but any hit must contain phenol and a nitrogen 
bonded to three sp3 carbon centers.

3. Select Open Databases from the Search menu ( ). Click on 
the SMD tab in the dialog that results. Click on  to the right 
of the Search button in the SMD dialog to bring up the Search 
Options dialog.

 

 Check 6-31G* under Method Filters and Structure under 
Search by in the Search Options dialog. Click on OK. Finally, 
click on the Search button at the bottom of the SMD dialog.
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4. The search will result in several hits. Find and click on cephaeline 
from among those hits listed inside in the scroll box at the right 
of the SMD dialog. 

 
 Its structure will be displayed in the window at the left of the 

dialog*. You can manipulate the model in the usual way by 
positioning the cursor inside this window. Click on  to the 
right of the Retrieve button at the bottom of the SMD dialog to 
bring up the Retrieve Options dialog. Check New Document 
under Retrieve Options and click on OK. Finally, click on the 
Retrieve button. Dismiss the SMD dialog by clicking on  at 
the top right-hand corner.

 Close the molecule used for the search (phenol and 
trimethylamine) without saving ( ). Save the molecule you 
retrieved under the name cephaeline ( ).

5. To shorten computer time, remove some of the degrees of 
conformational freedom from cephaeline. Select Set Torsions 
from the Geometry menu (or click on ). Your model will be 
augmented with yellow cylinders to designate flexible bonds. 
Remove the markers from the bonds connecting the three 
methoxy groups to the aromatic rings by double clicking on 
each in turn. These bonds will no longer be included in the 
conformational search. Your model should now appear as 
follows with only three single bonds selected.

* Right click on Name at the top of the list to sort in alphabetical order.
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 If more are selected, double click on the appropriate torsion 

markers to remove them.
6. Bring up the Calculations dialog (Calculations... from the 

Setup menu). Select Conformer Library from the top left 
menu to the right of Calculate. No further information is 
required. Click on Submit at the bottom of the dialog. Name it 
cephaeline library. You can continue with the tutorial while you 
are waiting for the job to complete. When cephaeline library 
completes, close this file ( ).

In the second part of the tutorial, you will identify the key structural 
components in morphine and perform a similarity analysis based on 
structure on the conformer library for cephaeline.

7. You can either build morphine or (to save time) open it: morphine 
from the medicinal chemistry sub-directory (tutorials directory).*

To build morphine, start with Benzene from the Rings menu. Add two 
(ortho) sp3 oxygens ( ) to make catechol and orient as below (free 
valences not drawn).

O

O
*

A

 

* For Windows, this directory is found in Program Files/Wavefunction/Spartan10 or 
Program Files(x86)/Wavefunction/Spartan10. It needs to be copied to another location 
available to the user prior to opening it in Spartan. For Linux, this is found in the directory 
where Spartan was installed. For Macintosh, this is located at the top level on the installation 
CDROM.



Chapter 8 159

Select Cyclohexane from the Rings menu and click on the free valence 
on the *’ed carbon in catechol. Orient as below, with the free valence on 
the cyclohexane carbon used to attach to benzene pointing straight up.

O

O

*

*
A

C

Select Make Bond from the Build menu (or click on ). Click on 
the *’ed free valences indicated in the structure above, one on oxygen 
and one on carbon pointing down (relative to the free valence on the 
carbon used to attach the two rings). A bond will be drawn to make 
the D ring.

O

O

*
*

A

C

D

Make Bond is still selected. Click on axial free valences on the *’ed 
carbons in the cycohexane ring to introduce a double bond. Also, add 
a hydroxyl group to this ring ( ) adjacent to the double bond. (Pay 
attention to stereochemistry.) Select Minimize from the Build menu 
(or click on ) to refine your structure.

O

O
*

*

O

A

C

D

Add sp3 carbons ( ) to free valences at the *’ed positions in the figure 
above (pay attention to stereochemistry on the cyclohexene ring). 
Click on  and then click on free valences on each of the two sp3 
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carbons that you have just added. You have made the B ring. Check 
that the stereochemisty is as it should be. 

O

*

O

*

O

A

C

D
B

Connect the two *’ed free valences in the figure above with a chain of 
two sp3 carbons ( ) and an sp3 nitrogen ( ). Add an sp3 carbon to 
the nitrogen. You have made morphine (its name should appear at the 
bottom of the screen). Click on  to produce a refined structure and 
on  to remove the model kit.  

8. Select Set Similarity Centers from the Geometry menu 
(or click on ) and select structure from the menu at the 
bottom right of the screen. Click on the eleven *’ed atoms in 
the figure below. A red circle will be drawn around each. If you 
make a mistake and select the wrong atom, click on the circle 
to deselect it.

 

HO

O

HO

N
H H

* *
*
**

*
*

*

*
*

*

9. Select Calculations... from the Setup menu. Select Similarity 
Analysis from the top left menu to the right of Calculate inside 
the Calculations dialog. Click on Add Library to bring up 
a file browser, locate and select cephaeline library, and click 
on OK. Make certain that Structure is selected from the Use 
menu at the lower right of the dialog. You have requested that 
the library of cephaline conformers be searched for a match 
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to the key structural elements of morphine. Click on Submit.* 

Supply the name morphine.

10. The similarity analysis will require a few seconds. When it 
completes, select Similarities... from the Display menu.

 

11. One or more hits appear in the box at the right of the dialog 
together with a score. Sort according to score (best on top) by 
clicking on Score at the top of the box. Select (click on) one of 
the best matches. A composite graphic consisting of morphine 
and the matching cephaeline conformer from the library will 
appear in a window at the left. You can manipulate the two 
structures (as a single object) in the usual way.

Repeat the similarity analysis using CFD’s rather than structure.

12. Select Set Similarity Centers from the Geometry menu ( ), 
but this time select CFD from the menu at the bottom right of 
the screen. CFD’s will augment the morphine structure.

 

* Make sure cephaeline library is closed before carrying out the similarity analysis.
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13. Designate three of the CFD’s as similarity centers. Select 
(click on) the CFD over the phenolic oxygen. A violet circle 
will surround this center indicating that it is to be used in the 
similarity analysis. (If you make a mistake and select the wrong 
CFD, click on the circle and it will disappear.) Select (click on) 
the CFD at nitrogen and the CFD at the middle of the phenol ring.

14. Enter the Calculations dialog. This should already designate 
Similarity Analysis and the appropriate library (cephaeline). 
Change the entry in the Use menu to CFD. Click on Submit.

15. When the analysis is complete, bring up the Similarities dialog 
(Similarities... under the Display menu). One or more hits 
should appear in the box at the right of the dialog. Select a hit to 
get a composite graphic (CFD and structure from the library). 
You can easily see the extent to which the two are matched.

16. Close any molecules and dialogs that are open on screen.
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Chapter 9
Polypeptides to Proteins

This chapter introduces the peptide model kit and shows how a 
structure from the Protein Data Bank (PDB) may be brought into 
Spartan for further analysis and a Ramachandran plot displayed.

At present, calculations on biopolymers (proteins and RNA/DNA 
strands) are limited to molecular mechanics models. However, 
quantum chemical calculations are now routinely applicable to 
molecules bound into biopolymers and to the investigation of the 
electronic and steric factors that are responsible.

This chapter comprises three tutorials. The first illustrates Spartan’s 
peptide model kit to construct triglycine and decaglycine in idealized 
helical arrangements. Comparisons are made between zwitterion and 
non-zwitterion forms in and out of water and electrostatic potential 
maps are employed to investigate charge separation.

The second tutorial illustrates Spartan’s on-line access to PDB. A 
small molecule is extracted from a protein structure and the question 
is posed as to the energy of its (bound) conformer compared to that 
of the free conformer.

The third tutorial also involves extraction from a PDB file, but this 
time the quantity of interest is not the molecule itself, but rather its 
environment. This is turned into a so-called pharmacophore (a simplified 
representation of the environment), and a search for other molecules 
that may also be consistent with this environment is carried out.





Polyglycine

Triglycine and decaglycine may be used to illustrate construction 
of simple amino acid sequences using Spartan’s peptide model kit, 
as well as to investigate the role of aqueous media in altering the 
equilibrium between neutral and zwitterionic forms of polypeptides 
and to show the utility of electrostatic potential maps in conveying 
information about overall charge distribution.

1. Bring up the peptide model kit by clicking on , and then 
clicking on the Peptide tab at the top of the organic model kit.

 

2. Click on  (glycine) from the amino acid codes to select and 
check the box to the left of Sequence. Then click two more times 
on . The sequence gly-gly-gly will appear in the box at the 
top of the model kit.

3. α Helix near the bottom of the model kit should be selected. If 
it is not, click on it. The backbone ψ and φ angles which define 
an α helix will appear at the right. Click anywhere on screen. 
Triglycine will appear, although it will not be properly terminated.

4. First consider the non-zwitterionic structure. Click on Terminate 
in the model kit. The Terminate dialog will appear allowing you 
to specify C and N terminating groups.

5 mins/10 mins
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 Choose CO2H for the C terminating group and NH2 for the N 
terminating group. Click on OK.

Amino acids replace atomic fragments, functional groups, rings 
and ligands as the basic building blocks in the peptide model 
kit, and these other building blocks are missing. Therefore, most 
modifications of peptides, aside from modifications in sequence 
of amino acids and in overall conformation, need to be carried out 
using either the organic or inorganic model kits.

5. Select Freeze Center from the Geometry menu (or click on 
). Click on Freeze Heavy at the bottom right of the screen. 

This indicates that all heavy (non-hydrogen) atoms are not to 
be moved during molecular mechanics minimization.* Click on 

 to produce a refined structure (subject to the restriction that 
heavy atoms are kept in place).

6. Select New Molecule from the File menu. The triglycine 
fragment is already specified. Click anywhere on screen. Click 
on Terminate inside the model kit and this time select CO2

– and 
NH3

+ for C and N terminating groups, respectively. Click on 
OK. Click on  and then click on Freeze Heavy at the bottom 
of the screen. Finally, click on .

7. Click on . Both forms of triglycine are now in the same 
document. Enter the Calculations dialog and specify an Energy 
calculation using the Hartree-Fock 3-21G model. Do not 
change Total Charge (from Neutral) for the zwitterionic form 
of triglycine. Even though its Lewis structure incorporates formal 
+ and - charges, the molecule is neutral. Also make certain that 
Global Calculations is checked. Click on Submit at the bottom 

* This is necessary to maintain the idealized helix structure.
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of the dialog. Name the job triglycine.

8. After the calculations complete, bring up the spreadsheet, click 
on the header cell of an empty column, and click on Add... at 
the bottom of the spreadsheet. Select both E and Eaq from the 
list of available properties at the top of the dialog which appears, 
and kJ/mol from the Energy menu, and then click on OK. 

 Which form of triglycine, zwitterion or non-zwitterion, is favored 
in the gas phase? Why? Does solvent better stabilize the neutral 
or zwitterionic form? Why?

9. Remove triglycine and remaining dialogs from the screen.

10 to 14 optional

An electrostatic potential map for the zwitterionic form of a larger 
polypeptide, decaglycine, clearly shows charge separation, and 
explains why such a structure is not favored in the gas phase.

10. Select New from the File menu ( ) and bring up the peptide 
model kit. Click seven times on  (glycine) from the selection 
of amino acid codes.* A sequence of ten glycines has now been 
requested. Make certain that α Helix is selected. Click anywhere 
on screen. Click on Terminate in the model kit and select CO2

– 
and NH3

+ for C and N terminating groups, respectively, and then 
click on OK. Click on  and then click on Freeze Heavy at the 
bottom of the screen. Click on , and then click on .

11. Enter the Calculations dialog and specify Energy using the  
AM1 Semi-Empirical model. Check Converge (near the bottom 
right of the dialog). Semi-empirical calculations on molecules 
of this complexity often have trouble converging and this option 
invokes a number of special convergence techniques. Click on OK.

12. Bring up the Surfaces dialog and request calculation of an 
electrostatic potential map. Click on Add and select Electrostatic 
Potential Map from the menu.

* This assumes that the box at the top of the peptide model kit already contains a sequence 
of three glycines. If you are starting from scratch, first make certain that  is selected 
and Sequence is checked, and then click nine times on .
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13. Submit the job. Name it decaglycine zwitterion. When 
completed, again enter the Surfaces dialog. Click on the line 
Electrostatic Potential Map. Examine the electrostatic potential 
map. Choose Properties from the Display menu and then click 
on the electrostatic potential map. Click on the selection box 
next to Legend to provide a graphical legend for the value of 
electrostatic potential. Recall that colors near red correspond 
to areas on the surface that are negatively charged (attracted 
to a point-positive charge), while colors toward blue designate 
regions that are positively charged. Intermediate colors (greens) 
represent neutral regions. What do you conclude about the 
environment in which decaglycine wishes to exist?

14. Remove decaglycine and any remaining dialogs from the screen.
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Gleevec. Protein Bound vs. Free Conformer

gleevec

H
N

O

N

N

N

N

N

H

Gleevec (Glivec, Imatinib) is a protein kinase inhibitor used in 
anticancer therapy. It specifically targets a protein kinase coded 
for in the rogue gene bcr-abl. Several crystal structures for gleevec 
docked in protein kinases have appeared in the literature and are 
available in the PDB. In this tutorial, you will examine one of them* 
to establish whether or not the conformation of gleevec in the protein 
is identical (or similar) to that of the free (gas-phase) molecule, and 
if not, what energy penalty is to be paid to adopt the protein-bound 
conformation. The next tutorial will return to this same structure and 
extract a pharmacophore (gleevec’s footprint).

1. Retreive a protein structure from the PDB. Select Access PDB 
Online... from the File menu. Type 1opj into the box to the 
right of PDB ID and click on Open.

If you are not online, you may skip this step as the structure is 
available as 1opj in the polypeptides to proteins sub-directory 
(tutorials directory).**

 The protein will be represented by a ribbon model. Red  sections 
correspond to parts of the chain that are α helices, while blue 

* B. Nager et al,  Cell, 112, 859 (2003): PDB identification 1opj.
** For Windows, this directory is found in Program Files/Wavefunction/Spartan10 or 

Program Files(x86)/Wavefunction/Spartan10. It needs to be copied to another location 
available to the user prior to opening it in Spartan. For Linux, this is found in the directory 
where Spartan was installed. For Macintosh, this is located at the top level on the installation 
CDROM

2 mins
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regions correspond to parts that are b sheets (the remaining 
regions are green). Note that these assignments are taken from 
the PDB file. A Ramachandran plot (the φ and ψ torsional 
angles connecting the individual amino acids) allows you to 
see the clustering of α helices and b sheets. To display, select 
Ramachandran Plot from the Model menu. The colors of the 
dots in the resulting plot map one-to-one with the colors of the 
ribbon model. When you are done, go back to the Model menu 
and deselect Ramachandran Plot to remove the plot.

The colors on the ribbon display may be modified, by selecting 
Configure... from the Model menu and clicking on the Ribbons 
tab. Coloring By Residue will give each amino acid its own unique 
color.

 The protein you have brought in from PDB incorporates two 
sets of bound molecules, depicted in the model as two sets of 
translucent spheres. Gleevec is the larger of the two incorporated 
molecules and is designated by its PDB HET code STI.

2. Select Extract Ligands from the Search menu (or click on the 
 icon at the top of the screen). Select (click on) one of the 

gleevec molecules inside the protein structure and click on the 
Extract Ligands button at the bottom right of the screen. This 
leads to the Extract Ligands dialog.

 

 Check Ligand Structures under Include and Grow Hydrogens 
under Extraction Filters inside the dialog and click on OK.
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3. A ball-and-spoke model for gleevec will appear on screen. 
(You no longer need the protein; select and close it.) Put a copy 
of gleevec on the clipboard. With the molecule selected, select 
Copy from the Edit menu.

4. Select New Molecule (not New) from the File menu. Select 
Clipboard from the organic model kit and click anywhere on 
screen. Click on . You now have two copies of gleevec in 
a single document. You can step between them using the step 
buttons at the bottom left of the screen.

5. Select the first copy and then select Calculations... from the 
Setup menu. Equilibrium Geometry from the top left menu to 
the right of Calculate and Molecular Mechanics and MMFF 
from the two bottom menus. The conformation will remain 
unchanged, but bond lengths and angles will be optimized. 

Structure optimization is necessary in order to establish the 
energy difference between protein-bound and free conformations 
of gleevec. The resolution of protein X-ray crystallography is not 
adequate to establish bond lengths and angles to chemical accuracy.

 Remove the checkmark from Global Calculations at the 
bottom of the dialog to signify that your choice (geometry 
optimization) only applies to this copy of gleevec. Click on OK 
(not on Submit).

6. You will use the second copy of gleevec as a starting point 
for a conformational search. First, remove some degrees of 
conformational freedom in order to shorten the computer time 
for the conformational search. Select the second copy and click 
on . Your model will be augmented with yellow cylinders 
and circles to designate flexible bonds and rings, respectively. 
Remove the marker from the bond connecting the phenyl ring 
to the carbonyl end of the amide group, by double clicking on it. 
Also, remove the (two) circles on the piperazine ring by double 
clicking on each in turn. The conformation of the piperazine 
ring will not change during the search. The model should now 
appear as below.
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7. Re-enter the Calculations dialog. Select Equilibrium 

Conformer from the top left menu to the right of Calculate 
and (as before) Molecular Mechanics and MMFF from the 
two bottom menus. Click on Submit, and provide the name 
gleevec protein bound vs. free conformer.

8. When the calculations have completed, bring up the spreadsheet 
(Spreadsheet under the Display menu), click inside leftmost the 
cell for the second molecule (the one on which a conformational 
search was performed) then click inside the header cell for a 
blank data column. Click on Add at the bottom of the dialog 
and select Rel. E from the scroll box in the dialog that appears 
and kJ/mol from the Energy menu. The relative energy of the 
protein bound conformer is provided in the spreadsheet. Is it 
close to zero meaning that the protein-bound conformer will be 
present in significant amount in a sample of free gleevec?

9. Close gleevec protein bound vs. free conformer and any dialogs 
remaining on screen.
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Gleevec. Making a Pharmacophore from PDB

gleevec
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In the previous tutorial, you extracted gleevec from a PDB structure 
of a protein kinase in order to see if the bound conformer was the 
same as the free conformer. Here, you will start from the same 
protein structure*, but instead of abstracting the molecular structure 
of gleevec, you will abstract its footprint, that is, the locations from 
which it interacts with its protein host in terms of hydrogen-bond or 
charge-charge interactions (non-steric contacts). This information, 
together with knowledge of either the steric requirements of the guest 
or the space occupied by the protein (excluded volumes), constitutes 
a structural pharmacophore, that is, a template for scrutiny of other 
possible guests. In this tutorial, you will use a subset of the non-steric 
contacts together with excluded volume elements to see to what extent 
this pharmacophore fits another protein kinase inhibitor, flavopiridol.

1. Either obtain the PDB file 1opj from the PDB database (see 
previous tutorial) or open 1opj from the polypeptides to proteins 
sub-directory (tutorials directory)**. Select Ligands from the 
Search menu (or click on ), click on the model for gleevec 
inside the protein structure (displayed as a set of transparent 

* B. Nager et. al., Cell, 112, 859 (2003): PDB identification 1opj.
** For Windows, this directory is found in Program Files/Wavefunction/Spartan10 or 

Program Files(x86)/Wavefunction/Spartan10. It needs to be copied to another location 
available to the user prior to opening it in Spartan. For Linux, this is found in the directory 
where Spartan was installed. For Macintosh, this is located at the top level on the installation 
CDROM.

5 mins
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spheres and look much like a space-filling model) to select 
it, and click on the Exact Ligands button. Inside the Extract 
Ligands dialog, check both HBA/HBD and +/- Centers and 
Excluded Volume Centers. If any other items are selected, 
make certain to deselect them before you click on OK.

2. You are finished with 1opj and may close it ( ). Also, simplify 
the display of the extracted information by removing the 
excluded volume elements from view. Select Configure... from 
the Model menu and click on the CFDs tab. Uncheck Excluded 
Volumes and click on OK.

3. The model that now appears comprises five blue spheres 
representing non-steric contacts between gleevec and its protein 
host. Turn on labels. Select Configure... from the Model menu, 
click on the Labels tab, check CFD Labels and click on OK.

 
 These have been assigned based on the observation that each is 

within a predefined distance of (one or more) complementary 
groups from amino acids in the protein host. Because hydrogen 
positions are not established (in the experimental X-ray 
structure) it may be impossible to say whether a particular site 
on the guest is acting as a (hydrogen-bond) donor or acceptor. In 
fact, it may not even be possible to say whether a particular site 
is protonated or deprotonated (although pH may dictate this). 
This being the case, all non-steric contacts have initially been 
given four CFD definitions: hydrogen-bond acceptor (HBA), 
hydrogen-bond donor (HBD), positive ionizable (+) and 
negative ionizable (–). Examination of the structure of gleevec 
suggests more focused assignments: 1 (HBA, +), 2 (HBA), 3 
(HBD), 4 (HBA) and 5 (HBA). (See above figure for numbering.)
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4. You will use only three elements of this pharmacophore (together 
with all the excluded volume elements) to assess whether or not 
flavopiridol is likely to fit into the same host environment as 
gleevec. Select Properties from the Display menu. Then select 
Set Similarity Centers from the Geometry menu (or click on 

). Make certain that CFD (not Structure) is selected in the 
lower right hand corner of Spartan’s interface. Click on the 
pharmacophore element designated as 1 (see figure on previous 
page). A violet circle will surround the element designating 
that it is to be used in the similarity analysis. If you make a 
mistake and select the wrong element, click on the circle and 
the designation will be removed. Inside the CFD Properties 
dialog, remove checkmarks from HBD and – Ionizable (you 
are left with HBA and + Ionizable). Repeat the process for the 
pharmacophore element 3, designating it as HBD only and 5, 
designating it as HBA only. When you are done, only three of the 
five pharmacophore elements should be marked. Click on .

5. Select Calculations... from the Setup menu and then Similarity 
Analysis from the top left menu to the right of Calculate. Click 
on Add Library... and then locate and select flavopiridol in the 
polypeptides to proteins sub-directory (tutorials directory) and 
click on OK. Make certain that CFD is selected next to Use: in the 
lower right of the Calculations dialog. Click on Submit. Name 
the document flavopiridol fit to gleevec pharmacophore.

6. When the similarity analysis has completed, bring up the 
Similarities dialog (Similarities... from the Display menu). 
Sort the hits according to similarity score (click on Score at the 
top of the dialog). One after the other, click on the top scoring 
entries in the box to the right of the dialog and examine the fits 
in the window at the left.

7. Close any open documents and dialogs on screen.
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Chapter 10
Inorganic and  

Organometallic Molecules
This chapter shows how to construct inorganic and organometallic 
molecules using Spartan’s inorganic model kit. It also identifies 
quantum chemical models that appear to be suitable for calculations 
on molecules incorporating transition metals.

Many molecules are made up of a relatively few elements and obey 
conventional valence rules. They may be easily built using the organic 
model kit. However, others cannot be assembled with this model kit 
either because they incorporate other elements, or do not conform to 
normal valence rules or they involve ligands. Important among these 
are inorganic and organometallic compounds involving transition 
metals. They may be constructed using the inorganic model kit.

Transition-metal inorganic and organometallic compounds may also 
require different quantum chemical methods from those that have 
proven to be satisfactory for organic molecules. In particular, Hartree-
Fock and MP2 models are known to produce poor results where 
transition metals are involved. The PM3 and PM6 semi-empirical 
models have been parameterized for most transition metals, and 
generally provide a good account of equilibrium geometries. Density 
functional models are also successful with regard to the calculation 
of geometries of molecules incorporating transition metals. Semi-
empirical models would not be expected to properly account for the 
energies of reactions involving transition metals as they generally 
perform poorly for reactions involving molecules without metals. By 
the same reasoning, it might be expected that density functional models 
would provide a solid account as they generally do well for reactions 
involving molecules without metals. Note, however, that  there are 
very few experimental thermochemical data with which to compare.
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Finally, note that there is almost no experience with molecules 
incorporating lanthanides and actinides, and few practical quantum 
chemical methods are available. 

The tutorials in this chapter illustrate construction of inorganic and 
organometallic molecules, as well as the selection of suitable quantum 
chemical models.
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*	 Not	all	methods	are	available	for	all	elements	listed.	Elements	for	which	a	specific	method	
(selected in the Calculations dialog) are available will be highlighted following selection of 
a theoretical model from the Model menu that appears in the center of the Periodic Table.

1 min

Sulfur Tetrafluoride

S
F

F

F

F

Sulfur	 tetrafluoride	cannot	be	constructed	using	Spartan’s organic 
model kit. This is because sulfur is not in its normal bent dicoordinate 
geometry, but rather in a trigonal bipyramid geometry with one of 
the equatorial positions vacant. However, the molecule can easily be 
made using the inorganic model kit.

1. Bring up the inorganic model kit by clicking on  and then 
clicking on the Inorganic tab at the top of the model kit.

 
 The inorganic model kit comprises an atom bar (clicking on 

which bring up the Periodic Table*) followed by a selection of 
atomic	hybrids,	 then	bond	 types,	and	finally	Rings, Groups, 
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*	 It	should	be	noted	that	were	an	incorrect	geometry	specified	at	the	outset,	optimization	would	
lead to the correct structure, as long as the starting geometry possessed no symmetry (C1 
point group). Thus, square planar SF4 in D4h symmetry would remain square planar, while an 
almost square planar structure (distorted only slightly from D4h symmetry to C1 symmetry) 
would collapse to the proper structure.

** The 3-21G basis set is extended by a set of d-type valence functions for sulfur (and other 
second-row elements).

Ligands, More and Clipboard menus (all except for Ligands 
are the same as found in the organic model kit).

2. Click on the atom bar to bring up the Periodic Table.

 

 Select (click on) S in the Periodic Table	and	the	five	coordinate	
trigonal bipyramid structure  from the list of atomic hybrids. 
Click on screen. A trigonal bipyramid sulfur will appear at the 
top of the model kit.

3. Again, click on the atom bar, select F in the Periodic Table and 
the one-coordinate entry  from the list of atomic hybrids. 
One after the other, click on both axial free valences of sulfur, 
and two of the three equatorial free valences.

4. It is necessary to delete the remaining free valence (on an 
equatorial position); otherwise it will become a hydrogen. Click 
on  and then click on the remaining equatorial free valence.

5. Click on . Click on  to remove the model kit.

6. Select Calculations... from the Setup menu. Specify calculation 
of Equilibrium Geometry* using the Hartree-Fock 3-21G 
model** and click on OK.

7. Select Surfaces from the Setup menu, click on Add and select 
HOMO from the menu that results. Leave the dialog on screen.
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8. Submit the job. Accept the name sulfur tetrafluoride.When 
completed, select Properties (Display menu) and click on an 
atom, for example, sulfur. Three different atomic charges will 
appear in the (Atom Properties) dialog (corresponding to 
different methods for establishing atomic charge). Of these, the 
procedure	based	on	fitting	the	electrostatic	potential	is	generally	
considered to be the best. Are the electrostatic charges consistent 
with covalent or ionic bonding?

9. Check the box to the left of HOMO inside the Surfaces dialog. 
Is	the	highest-occupied	molecular	orbital	in	sulfur	tetrafluoride	
consistent with the notion that sulfur is surrounded by six electron 
pairs? Elaborate.

10. Remove sulfur tetrafluoride and any remaining dialogs from 
the screen.
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Reactivity of Silicon-Carbon Double Bonds

C C

CH3

CH3H3C

H3C

Si C

CH3

CH3H3C

H3C

2,3-dimethyl-2-butene tetramethylsilaethylene

With the exception of so-called phosphorous ylides, compounds 
incorporating a double bond between carbon and a second-row 
element are quite rare. Most curious perhaps is the absence of stable 
compounds incorporating a carbon-silicon double bond. This can be 
rationalized by using local ionization potential and LUMO maps to 
compare	the	reactivities	of	olefins	and	silaolefins.

1. Build 2,3-dimethyl-2-butene with the organic model kit, 
minimize ( ) and copy onto the clipboard. (Right click on the 
molecule and select Copy from the resulting menu.) Select New 
Molecule (not New) from the File menu, click on Clipboard 
inside the organic model kit and click anywhere on screen. 
Click on the Inorganic tab (at the top of the organic model kit) 
to bring up the inorganic model kit. Click on the atom bar and 
select Si from the Periodic Table. Double click on one of the 
sp2 carbons to substitute a silicon atom for a carbon atom and to 
make tetramethylsilaethylene. Click on  and then on . You 
are left with 2,3-dimethyl-2-butene and tetramethylsilaethylene 
in the same document.

2. Use the structures in SMD to save computer time. Click on  
to the left of the molecule name (either 2,3-dimethyl-2-butene 
or tetramethylsilaethylene) at the bottom of the screen, select 
3-21G from the entries in the Preview dialog, click on Replace 
All and click on OK in the dialog that results.

3. Select Calculations from the Setup menu. Specify calculation 
of Energy using the Hartree-Fock 3-21G model. Click on OK.

4. Select Surfaces from the Setup menu. First request a local 
ionization potential map. Click on Add and select Local 
Ionization Potential Map from the menu. Then request a LUMO 

 5 mins
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map. Click on Add and select |LUMO|map from the menu.

5. Submit the job. Name it tetramethylsilaethylene. (Even though 
both molecules are in SMD, Spartan does not attempt to assign 
a name to a document that contains more than one molecule.) 
When completed, bring up the spreadsheet (Spreadsheet under 
the Display menu) and check the box at the far left for each 
entry in the spreadsheet. This allows simultaneous display of 
both molecules. Select Coupled (Model menu) to uncouple the 
motions of the molecules. Position the two molecules side by 
side on screen.

6. Inside the Surfaces dialog, select Local Ionization Potential 
Map.	Compare	 local	 ionization	potential	maps	 for	 the	 olefin	
and	 silaolefin,	 recognizing	 that	 the	more	 red	 the	 color,	 the	
lower the ionization potential and the more susceptible toward 
electrophilic attack. Which molecule do you conclude is likely to 
be more reactive toward an electrophile? Turn the local ionization 
potential maps off by again selecting it. Select |LUMO|map to 
turn the LUMO maps on. Here, the more blue the color, the 
greater the concentration of the LUMO and the more susceptible 
toward nucleophilic attack. Which molecule do you conclude is 
likely to be more reactive toward a nucleophile? Speculate why 
molecules which incorporate a silicon-carbon double bond are 
chemically problematic. Close tetramethylsilaethylene when 
you	are	finished.	

7 - 10 Requires Access to the Cambridge Structural Database

Identify molecules in the Cambridge Structural Database (CSD) that 
incorporate a carbon-silicon double bond.

7. Build silaethylene, H2Si=CH2, by starting from ethylene and 
(using the inorganic model kit) substituting a silicon for one of 
the carbons.

8. Select Define Structure Query from the Search menu ( ). 
Click on all four free valences in silaethylene. They will be 
marked by orange cones.
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9. Bring up the Cambridge Structural Database (CSD) dialog by 
first	selecting	Open Databases from the Search menu (or click 
on ( ) and then clicking on the CSD tab. Click on the Search 
button at the bottom of the dialog. In a few seconds, hits will 
begin to appear in the box at the right of the dialog. Examine 
each in turn (in the window at the left of the dialog) by clicking 
on its CSD reference code (REFCODE). Identify a structure 
that appears to be representative for closer scrutiny. Before you 
retrieve it, click on  to the right of the Retrieve button at the 
bottom	of	the	dialog.	Make	certain	that	all	five	boxes	under	Post 
Retrieval Filters in the Retrieve Options dialog are checked. 
Click on OK. Click on the selected REFCODE and then click 
on the Retrieve button. Dismiss the CSD dialog.

10. Click on . Except for hydrogens, all atoms in the structure you 
have	retrieved	will	be	fixed	and	energy	minimization	will	only	
change hydrogen positions. This is to compensate for the fact 
that hydrogens are generally not well located in X-ray crystal 
structure determinations.

	 Change	the	display	to	a	space-filling	model.	Pay	particular	attention	
to the incorporated silicon-carbon double bond. Is it accessible 
in all of the compounds or is it encumbered by the surrounding 
groups? What, if anything, do your observations suggest 
about why this particular compound can be (has been) made?

11. Close silaethylene and any open dialogs.
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10 mins

Benzene Chromium Tricarbonyl

Cr
OC CO

CO

benzene chromium tricarbonyl

Comparison of electrostatic potential maps for benzene chromium 
tricarbonyl and free benzene will allow you to classify Cr(CO)3 as 
an electron-donor or an electron-acceptor substituent.

1. Click on  and bring up the inorganic model kit. Click on 
the atom bar and select Cr from the Periodic Table. Select the 
four-coordinate tetrahedral structure  from the list of atomic 
hybrids. Click anywhere on screen.

2. Click on Ligands in the model kit, select Benzene from the 
menu of available ligands.

 
 Click on one of the free valences on the four-coordinate chromium 

center. 

3. Select Carbon Monoxide from the Ligands menu, and click 
on the remaining (three) free valences on chromium. Click on 
	to	produce	a	refined	structure.

4. Select New Molecule from the File menu. Click on Rings, select 
Benzene and click on the screen. Click on  and then on . 
The document now contains both benzene chromium tricarbonyl 
and benzene.

5. Select Calculations... (Setup menu). Specify calculation of 
Equilibrium Geometry with the Semi-Empirical PM3 model. 
Make certain that Global Calculations (at the bottom of the 
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dialog) is checked. Click on OK.

6. Select Surfaces (Setup or Display menu). Click on Add and 
choose Electrostatic Potential Map from the menu. Make 
certain that Global Surfaces is checked.

7. Submit the job. Name it benzene chromium tricarbonyl. When 
completed bring up the spreadsheet (Spreadsheet from the 
Display menu), and check the box to the right of the label for 
both entries. This allows the two molecules to be displayed 
simultaneously on screen. If Coupled (Model menu) is checked, 
remove the checkmark by selecting it. The two molecules may 
now be moved independently. Orient each molecule so that you 
can clearly see the benzene face (exposed face in the case of the 
organometallic).

8.  Check Electrostatic Potential Map in the Surfaces dialog. 
Compare electrostatic potential maps for both free and complexed 
benzene, with attention to the exposed benzene face.* Does the 
Cr(CO)3 group donate or withdraw electrons from the ring? Would 
you expect the aromatic ring in benzene chromium tricarbonyl 
to be more or less susceptible to electrophilic attack than free 
benzene? More or less susceptible to nucleophilic attack?

9. Both benzene and benzene chromium tricarbonyl are available 
from the Spartan Molecular Database. Make a copy of benzene 
chromium tricarbonyl (Save As from the File menu or click on 

); name it benzene chromium tricarbonyl density functional. 
With either molecule in the copy selected, check B3LYP/6-31G* 
from the list of available models in the Preview dialog and 
click on Replace All. Inside the Calculations dialog, specify 
an Energy calculation using the B3LYP/6-31G* Density 
Functional model. Submit. When completed, examine the 
electrostatic potential maps. Are they qualitatively similar to 
those from the PM3 calculations?

10. Remove all molecules and any remaining dialogs from the 
screen.

* Electrostatic potential maps (as well as other maps) for molecules in a group will be put onto 
the same (color) scale. This allows comparisons to be made among different members.
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5 mins/90 mins

Ziegler-Natta Polymerization of Ethylene

Ziegler-Natta	 polymerization	 involves	 a	metallocene.	This	 first	
complexes	an	olefin,	which	then	inserts	into	the	metal-alkyl	bond.

Cp2Zr+R Cp2Zr+R
H2C CH2 Cp2Zr+CH2CH2R

H2C CH2 H2C CH2

RCp2Zr+

In this tutorial, you will use PM3 calculations to obtain a transition state 
for insertion of ethylene into Cp2ZrCH3

+ and, (optionally), estimate 
the activation energy using density functional calculations.

1. Bring up the inorganic model kit. Click on the atom bar and select 
Zr from the Periodic Table. Select  from the list of hybrids 
and click on screen. Select Cyclopentadienyl from the Ligands 
menu and click on two of the free valences on zirconium. 

2. Move to the organic model kit. Select sp3 carbon  and click on 
the remaining free valence on zirconium. Select Alkenyl from 
the Groups menu, click on the Insert button at the bottom of the 
model kit or hold down the Insert key (option key on Mac) and 
click anywhere on screen or double click in a blank area on screen.

3. Orient the two fragments (Cp2ZrCH3 and ethylene) as shown 
below:

 
Zr CH3

Cp

Cp

H2C CH2

 (To move the two fragments independently, hold down the Ctrl 
key.)

4. Select Guess Transition State from the Search menu ( ). Click 
on the ZrC (methyl) bond, hold down the Shift key and, one after 
another, click on the methyl carbon and on one of the ethylene 
carbons. Next, click on the ethylene double bond, hold down 
the Shift key and, one after another, click on the other ethylene 
carbon and on zirconium. Click on  at the bottom right of the 
screen. In a few seconds, a guess at the transition state appears.
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5. Bring up the Calculations dialog. Specify a Transition State 
Geometry calculation using the PM3 Semi-Empirical model. 
Change Total Charge to Cation and check IR to the right of 
Compute. Click on Submit and name the job Cp2ZrMe cation 
+ ethylene.

6. When the job has completed, bring up the IR dialog (Spectra 
from the Properties menu and click on the IR tab) and click on 
the imaginary frequency at the top left of the dialog. Would you 
describe the process as concerted or occurring in discrete steps?

7 to 9 optional

7. Perform B3LYP/6-31G* density functional energy calculations 
using PM3 geometries to obtain a better estimate for 
the energy barrier for ethylene insertion. Spartan will 
automatically make use of a pseudopotential for Zr instead of 
the all-electron 6-31G* basis set. Make a copy of Cp2ZrMe 
cation+ethylene ( ); name it Cp2ZrMe cation+ethylene 
density functional. Enter the Calculations dialog with 
this copy, and specify calculation of Energy using the  
B3LYP/6-31G* Density Functional model. Remove the 
checkmark on IR (to the right of Compute). Total Charge 
should still be set to Cation. Click on Submit.

8. Build both ethylene and Cp2ZrCH3
+ (name them ethylene 

density functional and Cp2ZrMe cation, respectively). For 
Cp2ZrCH3

+, start with three-coordinate trigonal Zr, and then add 
two cyclopentadienyl ligands and a four-coordinate tetrahedral 
carbon. For each, enter the Calculations dialog, and specify 
calculation of Energy using the B3LYP/6-31G* Density 
Functional model. Select PM3 from the Start from menu to 
designate use of a PM3 geometry. For Cp2ZrMe cation density 
functional (only), set Total Charge to Cation.

9. Submit both jobs. When they have completed, calculate an 
activation energy for the insertion reaction.

10. Remove all molecules and any remaining dialogs from the 
screen.
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Chapter 11
“Dry Labs”:  

Using the Spartan Spectra 
and Properties Database

The tutorials in this chapter comprise examples where structures, 
energies, spectra and other properties can be extracted from the 
Spartan Spectra and Properties Database doing away with the 
need for actually having to carry out new quantum chemical 
calculations.

The Spartan Spectra and Properties Database (SSPD) is a collection 
of molecular structures, spectra and diverse properties obtained from 
a single theoretical model, specifically the EDF2/6-31G* density 
functional model. SSPD includes many of the molecules found in the 
Spartan Molecular Database (SMD) as well as numerous molecules 
not found in SMD, but differs from (and we believe, improves on) 
this previous collection in several important ways. First, for the 
vast majority of entries, the choice of conformer is based on the T1 
thermochemical recipe rather than on the MMFF molecular mechanics 
model. T1 is far more likely to correctly identify the lowest-energy 
conformer (or at least a conformer that is very close in energy to 
the lowest-energy conformer) than is MMFF. Second, SSPD entries 
provide a much wider variety of molecular properties than available 
in SMD, including a selection of QSAR descriptors. They also include 
both the infrared and NMR spectra (neither of which is available in 
SMD). Third, all SSPD entries include the wavefunction, allowing 
“on-the-fly” generation of molecular orbitals, electron densities and 
other graphical surfaces and the electrostatic potential and other 
property maps. In short, SSPD provides a rich source of diverse 
information for a wide selection of molecules.
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The limitation of SSPD to a single theoretical model is a deliberate 
attempt to focus attention away from the characteristics of a 
particular model (and the question “which model is best”) and onto 
the chemistry at hand. While the choice EDF2/6-31G* can be seen 
as a compromise between accuracy and practicality, in fact, EDF2/ 
6-31G* provides excellent results for a variety of properties that can 
be accurately measured, including molecular geometry and infrared 
and NMR spectra. Furthermore, the T1 heat of formation, a byproduct 
of using the T1 recipe to establish best conformer, is included in 
the SSPD entry. We believe that over the wide variety of molecules 
considered, T1 provides a reliable an indicator of internal energy as 
any (calculated or experimental) measure presently available.

Collections of calculated results such as the Spartan Spectra and 
Properties Database can serve different roles. At one end, information 
in a database may be used to supplement the calculation capabilities 
of Spartan and eliminate the need to perform calculations that have 
already been done. At the other end, is to use the database as the 
exclusive source of information, doing away altogether with the 
need for quantum chemical calculations. From the instructional 
perspective (teaching about molecular models and molecular 
modeling) this allows use of more complex examples than might 
otherwise be practical. The tutorials in this chapter fall into the latter 
category, and can be thought as the ultimate in “dry labs”.

To complete the tutorials in this chapter, SSPD needs to be installed 
on Spartan (the sample version included with the program will suffice 
or the full version can be used). In addition, database selection menu 
at the bottom of Spartan’s main screen needs to be set to SSPD. 
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Isomeric C5H8 Dienes

In addition to 2-methyl-1,3-butadiene, cis and trans-1,3-pentadiene 
(conjugated dienes) and 1,4-pentadiene (a non-conjugated diene), 
there are three other dienes with the same formula: 3-methyl-1,2-
butadiene (1,1-dimethylallene) 1,2-pentadiene (ethyl allene) and 
2,3-pentadiene (1,3-dimethylallene). 

1. Build all seven C5H8 dienes (place in a single document) and 
bring up the spreadsheet (Spreadsheet from the Display menu). 
With any of the dienes selected, click on the Replace All button 
in the Preview dialog at the bottom of the screen. This will 
substitute entries in SSPD for all seven C5H8 dienes. Molecule 
names are available but are not used unless requested explicitly. 
To use the names in SSPD, click on the top left header cell 
(Label) in the spreadsheet, hold down the right mouse button and 
select Rename Selected Using SSPD  from the menu. Bring up 
Molecule Properties dialog (Display menu) and click on the  
buttons to the left of both Expt. Heat and T1 Heat. This enters 
the experimental heat of formation (from the NIST database) as 
well as the value obtained from the T1 thermochemical recipe 
into the spreadsheet. The T1 heat of formation should provide a 
more accurate account of relative stability than available from 
the EDF2/6-31G* model itself.

The T1 model is presently defined only for uncharged, closed-shell 
molecules comprising H, C, N, O, F, Si, P, S, Cl and Br only. T1 
heats of formation are not available for the other molecules in SSPD 
(~2% of the total).

2. First verify that the T1 model correctly reproduces the ordering 
of experimental heats. Then use the T1 heats to answer the 
following questions:

 What is the difference in stability (heat) between the best of 
the three conjugated dienes and 1,4-pentadiene? What is the 
approximate energy gain due to conjugation? What is the 
difference in stabilities between the best of the substituted allenes 

no calculations
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and the best of the conjugated dienes?

3 Optional

3. There are several other C5H8 isomers in addition to the dienes 
discussed above, a number of which will be in SSPD (many more 
in the full version than in the sample). With any of the dienes 
selected, bring up the Databases window (Open Databases 
from the Search menu or click on  and click on the SSPD 
tab). Click on  to the right of the Search button in the SSPD 
dialog and select Isomer under Search By in the Search Options 
menu that results. Click on the Search button. Select several (or 
all) of the non-diene isomers, by clicking on them in the list at 
the right of the dialog while holding down the Ctrl key. Click 
on  to the right of the Retrieve button, then click on Current 
Document in the dialog that results.  Remove the Databases 
window by selecting Close Databases (that has replaced Open 
Databases) from the Search menu or clicking on . Bring up 
the spreadsheet. Add both experimental and T1 heats of formation 
to the spreadsheet. Note that not all the experimental heats of 
formation are available. In fact, experimental heats of formation 
exist for only around 2,000-3,000 molecules. According to the 
T1 model, are any of the non-diene isomers more stable than 
the best diene? 

4. Close any molecules and dialogs that are open on screen.
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Using Infrared Spectroscopy to Identify an Unknown Ethyl 
Benzoate Derivative

Unlike NMR spectra (at least carbon spectra) infrared (IR) spectra 
are rich in detail. Some chemists would view this as a curse, in that 
the complexity of an infrared spectrum masks its connection with the 
three-dimensional molecular structure. Others might see complexity 
as  a blessing, providing a detailed pattern or fingerprint with which 
to identify a molecule. In fact, this difference reflects the different 
ways that chemists actually use NMR and infrared spectroscopy. 
NMR is most commonly employed to assign structures of new 
molecules whereas IR is most commonly used to identify previously 
characterized (known) molecules. 

Extensive databases of experimental infrared spectra exist, and 
sophisticated programs have been developed to search these 
databases for matches to unknown spectra. It turns out that infrared 
spectra calculated from density functional models and adjusted to 
account for known systematic errors in frequencies and for finite 
temperature, generally closely match experimental spectra. This 
suggests that they might be used in lieu of experimental spectra to 
identify unknowns. This tutorial illustrates the point, attempting 
to identify which of a series of meta-substituted ethyl benzoates 
contained in the Spartan Infrared Database (SIRD) best matches the 
infrared spectrum of an unknown molecule.

SIRD uses the infrared spectra contained in the Spartan Spectra and 
Properties Database (SSPD). The fact that there are two different tabs 
simply reflects the different search paradigms (spectra matching for SIRD 
vs. substructure matching for SSPD).

1. Build ethyl benzoate. Then select Define Structure Query from 
the Search menu ( ) and click on one of the free valences on 
the phenyl ring that is meta to the ester group.

 

2 mins
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2. Select Open Databases from the Search menu ( ) and click 
on the SIRD tab at the top of the dialog that results. Size the 
dialog to occupy the greater part of the screen. Click on Select 
Spectrum, move to the using SSPD subdirectory under the 
tutorials directory* and click on  unknown ethyl benzoate. Make 
certain that All Files is selected in the menu to the right of the 
file name in the Open dialog. In a few seconds, the experimental 
infrared spectrum of the unknown will appear at the top right of 
the dialog. A list of the frequencies for all peaks may be found 
under Unknown: immediately to the left is the spectrum. This 
has been obtained by fitting the experimental spectrum to a 
Lorentzian function. You can obtain the frequency of a line in the 
spectrum using the yellow measurement bar. Position the cursor 
on top of the bar, hold the left button and move the mouse left 
of right until the bar is over the peak.  

3. You could carry out your search with nothing other than the 
unknown spectrum (see the optional part of this tutorial), or you 
could restrict it using structural or other information that you 
have. Let’s assume that we know that the unknown is a meta-
substituted ethyl benzoate. Click on the Filters button and then 
click on Copy Current Molecule at the top left of the Search 
Filters dialog that results. Click on OK to exit the dialog. What 
you have done is to restrict the search to meta-substituted ethyl 
benzoates, that is, examine only molecules that contain this 
particular substructure (ethyl benzoate substituted in the meta 
position). Click on the Search button and wait for the search to 
complete. Hits resulting from the search appear at the bottom 
right of the SIRD dialog, in numerical order starting from the 
best. As you click on each, the corresponding calculated infrared 
spectrum will be superimposed onto the experimental spectrum 
(of the unknown) at the top left of the display. Suggest a structure 
for the unknown.

* For Windows, this directory is found in Program Files/Wavefunction/Spartan10 or 
Program Files(x86)/Wavefunction/Spartan10. It needs to be copied to another location 
available to the user prior to opening it in Spartan. For Linux, this is found in the directory 
where Spartan was installed. For Macintosh, this is located at the top level on the installation 
CDROM.
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4 Optional

4.  Remove the substructure filter and repeat the search. Click on 
the Filters button, click on the Clear button at the top left of 
the Search Filters dialog and click on OK. Click on the Search 
button. Be patient; the search will require a minute or two. 
Unlike searches of experimental databases where spectra are 
directly compared, each of the calculated spectra in the database 
are adjusted for frequency scale and peak width (roughly 
associated with temperature) as it is compared to the unknown. 
Removing the substructure filter greatly increases the number 
of spectra that need to be examined. Does the meta substituted 
ethyl benzoate that came in at the top in the previous search, 
also come in at or very near the top in the full search?

A search of the full database will require more computer time than 
the search of the 5,000 molecule sample database supplied with 
Spartan, simply because it contains more molecules. However, the 
search is actually divided into preliminary and final parts, only the 
first of which depends on the overall size of the database.

5. Close any molecules and dialogs that are open on screen.
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Infrared Spectra of Short-Lived Molecules

While infrared spectroscopy is by no means as formidable a tool 
as NMR for elucidating the structures of molecules, it does offer 
significant advantages which can make it the method of choice in 
some instances. It is more sensitive, meaning that it can be used to 
detect transient species, for example, molecules trapped in an inert 
matrix at very low temperature. On the practical side, an infrared 
spectrometer is inherently simpler (more robust) and can be put into 
a much smaller package than an NMR spectrometer. This means 
that the spectrometer can be brought to the sample rather than the 
other way around. Imagine, putting an NMR spectrometer on the 
Mars rover! The problem is that IR spectroscopy unlike NMR 
typically does not provide an unambiguous structure. However, a 
close match to a calculated spectrum may offer convincing evidence 
for the veracity of a particular structure (or a mismatch convincing 
evidence that a structure is incorrect). 

The infrared spectrum of an unknown C4H4 isomer shows  
strong absorptions at 854, 1608, 2994 and 3080 cm-1. Possible 
structures include but-1-yne-3-ene, butatriene, singlet-1,3-butadiene, 
methylenecyclopropene and tetrahedrane.

HH

H

H

H

H

H

H

but-1-yne-3-ene butatriene cyclobutadiene

H H

HH

HH

H H
methylenecyclopropene

H

H

HH
tetrahedrane

1. Build any one of these molecules. Select Open Databases from 
the Search menu ( ) and click on the SSPD tab. Click on  to 
the left of the Search button, select Isomer under Search By: 
inside the Search Options dialog and click on OK. Click on 
the Search button. Structures for all C4H4 isomers will appear 
in a list at the right of the Databases dialog. Retrieve all of 
them to a new document. Click on  to the left of the Retrieve 
button, select New Document and click on OK. Click on each 
in turn while holding down the Ctrl key. Click on the Retrieve 

no calculations
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button. Remove the Databases dialog (select Close Databases 
from the Search menu or click on ).

2. Give proper names to the compounds. Open the spreadsheet 
(Spreadsheet under the Display menu), click on Label (the 
leftmost header cell), then right click and select Rename 
Selected Using SSPD from the menu that appears.

3. Select Spectra from the Display menu and click on the IR 
tab at the top of the resulting dialog. Numerical values of the 
frequencies and infrared intensities of the selected molecule in 
the document will appear at the left of the dialog. Note that 
the frequencies have been scaled to take account of systematic 
errors in the calculations (primarily due to the harmonic 
approximation). To see unscaled frequencies,  move the slider 
bar to the right of Scale: from 0.962 (the default) to 1.000. 
To return to scaled frequencies, click on the Standard button.  
Display the infrared spectrum of the selected isomer. Click on  
Display Calculated at the right of the dialog. Move through 
the list to bring up the spectra for the other isomers.

 The calculated infrared spectrum of which if any of the C4H4 
isomers best fits the unknown infrared spectrum?

4. Close any molecules and dialogs that are open on screen.
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Using 13C NMR to Distinguish Structural Isomers 

NMR spectroscopy, in particular 13C NMR spectroscopy, is arguably 
the single most important tool available to an organic chemist to 
establish molecular structure. Obtaining an NMR spectrum is 
straightforward and the spectrum itself is very simple, comprising 
but a single line for each unique carbon the molecule. Because a 
mass spectrum is normally also available, the molecular formula 
will be known, and assignment of the NMR reduces to deciding 
among possible isomers. Chemical evidence (how the molecule was 
made) can usually be counted on to eliminate some choices and to 
strengthen the case for others. Still, pinning an NMR spectrum to a 
particular molecule can be difficult and fraught with error.  

NMR assignment problems can be reduced but not alltogether 
eliminated by requiring that both proton and 13C NMR spectra are 
consistent with a particular structure. This is routine practice. Further 
help comes from taking a DEPT spectrum, allowing methylene 
carbons to be distinguished from methyne and methyl carbons and (in 
conjunction with the 13C spectrum) from quaternary carbons. This is 
less common but becoming more and more routine. In principal, all 
ambiguity can be eliminated by cross-correlating the results of the 
13C NMR with those of proton NMR using a variety of so-called 2D 
spectra, most important, the HMBC spectrum. However, 2D NMR 
experiments are not yet the norm, if for no other reason because they 
require significant instrument time on a spectrometer that may cost 
upward of $1,000,000. 

The fact that NMR spectra for reasonable size organic molecules 
may now be routinely calculated in a few minutes to a few hours on 
a personal computer costing $1000 or less raises the possibility for 
another tool to assist with spectral assignments. Whether this turns 
into reality ultimately depends on the ability of the calculations to 
obtain NMR spectra that are sufficiently accurate to distinguish 
among the different isomers. 

In this tutorial we first see which of three structural isomers 
with molecular formula C17H19NO3 (morphine, norcodeine and 
hydromorphone) best fits the NMR spectrum of an unknown isomer, 
or if clear assignment is not possible. Then, we draw comparisons 

no calculations
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between calculated and experimental DEPT spectra (the former 
just a different presentation of the 13C spectra) to see if this further 
clarifies the assignment.

1. Build morphine, norcodeine and hydromorphone and put in the 
same document.

 

O

HO

NMe
H

HO
morphine

O

MeO

NH
H

HO
norcodeine

O

HO

NMe
H

O
hydromorphone

 If the name for each fails to appear at the bottom of the screen 
(all three isomers are in SSPD), then you have made a mistake. 
When you are done, click on the Replace All button at the 
bottom of the Preview dialog. This will substitute structures 
from SSPD for what you have built. Give proper names to the 
three isomers. Bring up a spreadsheet (Spreadsheet under the 
Display menu), click on Label (the leftmost header cell), then 
right click and choose Rename Selected Using SSPD from the 
menu.

2. Bring up the NMR Spectra dialog (Spectra under the Display 
menu) and click on the NMR tab. First make certain that 
the box to the left of Boltzmann Averaging at the bottom 
of the dialog is not checked (if it is, click inside the box to 
remove the checkmark). Click on Draw Calculated in the 
section designated 13C Spectra. Next, check Local File in the 
section designated Experimental Data From, click on Draw 
Experimental (in the 13C Spectra section), move to the using 
SSPD subdirectory under the tutorials directory* and click on 
unknown C17H19NO2 carbon NMR. Make certain that All 

* For Windows, this directory is found in Program Files/Wavefunction/Spartan10 or 
Program Files(x86)/Wavefunction/Spartan10. It needs to be copied to another location 
available to the user prior to opening it in Spartan. For Linux, this is found in the directory 
where Spartan was installed. For Macintosh, this is located at the top level on the installation 
CDROM.
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Files is selected in the menu to the right of the file name in 
the Open dialog. You will need to repeat this two more times 
(providing the same experimental spectrum for each of the 
three candidates). Calculated and experimental 13C spectra now 
appear on the same plot. Step through the three isomers. Which, 
if any, of the calculated 13C spectra bests fits the experimental 
spectrum? To associate lines with specific carbons in each of 
the calculated spectra, bring up the Atom Properties dialog. 
Select Properties from the Display menu and click on an atom. 
Alternatively, you can attach chemical shifts as labels on your 
structures. Select Configure from the Model menu and click 
on Chem Shift under Atom in the dialog that results. Simplify 
your models by changing to a tube model (Tube under the 
Model menu) and by removing hydrogens from the model 
(Hydrogens under the Model menu). 

3. Click on both Delete Calculated and Delete Experimental 
buttons in the dialog (which have replaced the corresponding 
Draw buttons) to remove the 13C spectra. In their place, show 
the corresponding calculated and experimental DEPT spectra. 
Click on the Draw DEPT. Click on Draw Experimental, 
then move to the using SSPD subdirectory under the tutorials 
directory and click on unknown C17H19NO2 DEPT NMR. 
Again, you will need to do this three times. Recall that lines 
in a DEPT spectrum that point up correspond to carbons with 
either one or three attached hydrogens, lines that point down 
to carbons with two attached hydrogens and that missing lines 
correspond to quaternary carbons. How many methyne and 
methyl carbons are in the structure of the unknown? How many 
methylene carbons are there? How many quaternary carbons 
are there? Which if any of the three isomers examined provide 
the same count? What is the structure?

4. Close any molecules and dialogs that are open on screen.
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Using 13C NMR Spectra to Distinguish Stereoisomers

As commented in the previous tutorial, the combination of 1D and 
2D NMR spectra is almost always able to provide unambiguous 
assignment of molecular structure, including assignment of 
stereochemistry. However, as also noted, practical considerations 
(time on an expensive instrument) often make 2D experiments (in 
particular HMBC) the exception rather than the normal. Without the 
additional experiments, distinguishing stereoisomers based on their 
13C NMR spectra may be difficult experimentally, simply because 
the alternatives are likely to be structurally very similar. For the same 
reason, it is likely to be an ideal case for calculations as comparisons 
between molecules with similar structures should benefit from 
cancellation of errors. The bottom-line question is whether or not 
calculated 13C NMR spectra good enough to be able to clearly be 
able to distinguish between stereoisomers? This tutorial provides an 
illustration.

The hydroxyl CO bond in tibolone, shown below on the left, is 
gauche to the methyl group at C17 (the alkyne is anti), whereas it 
is anti (and the alkyne is gauche) in the stereoisomer shown on 
the right. The experimental 13C spectrum of a molecule that has 
been assigned as tribolone shows a line at 12.7 ppm attributed to 
the methyl group at C17 and lines at 88.9 and 74.8 ppm attributed 
to the internal and external alkyne carbons, respectively. The full 
13C spectrum may be found in the using SSPD subdirectory under 
the tutorials directory* as tibolone proposed carbon NMR. Make 
certain that All Files is selected in the menu to the right of the file 
name in the Open dialog.

* For Windows, this directory is found in Program Files/Wavefunction/Spartan10 or 
Program Files(x86)/Wavefunction/Spartan10. It needs to be copied to another location 
available to the user prior to opening it in Spartan. For Linux, this is found in the directory 
where Spartan was installed. For Macintosh, this is located at the top level on the installation 
CDROM.

no calculations
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1. Build both stereoisomers and replace your structures with 
those in SSPD. Select Properties from the Display menu and 
for each stereoisomer, record the calculated 13C shifts for the 
methyl group carbon and for the two alkyne carbons. Do the 
calculations support or refute the experimental assignment, or 
are they ambiguous?

2. Which stereoisomer is more stable according to the T1 heats 
of formation accessible from SSPD? Offer a reasonable 
explanation for the observed preference. 

3. Close any molecules and dialogs that are open on screen.
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Finding Stable Enols

The equilibrium between ketones and their corresponding alcohols 
(enols) almost always greatly favors the former, for example, 
between acetone and propen-2-ol favors acetone.

H3C CH3

H

CH3

O OH

H

acetone propen-2-ol

In this tutorial you will “mine” SSPD to see if you can find an enol 
that is actually more stable than its keto form. You will consider 
enols related to propen-2-ol by substitution at C1.  

1. Build propen-2-ol. Select Define Structure Query ( ) from 
the Search menu and click on both free valences at C1. Orange 
cones will appear designating these as growth points. 

 
2. Define the relationship between propen-2-ol and acetone using 

curly arrows.* Select Define Reaction Query from the Search 
menu ( ). Click on the OH bond, hold down the Shift key and 
one after another, click on the OH hydrogen and on C1. An arrow 
will be drawn from the OH bond to the space between the (OH) 
hydrogen and C1. Click on the (double) bond connecting C1 and 
C2 and then click on the (single) bond connecting C2 to oxygen. 
A second arrow will be drawn between these two bonds.

 

* Organic chemists interpret curly arrows in terms of the relationship between reactants and 
transition state but they also connect the reactants to the products. It is in this context that 
they are used here.

no calculations
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3. Select Formulas from the Display menu. Click on the T1 
Heat button under Energies and select P-R (reaction) from the 
Applied to: menu under Context (both near the bottom of the 
Formula Editor dialog). A formula for the query appears in 
the box at the center of the Formula Editor dialog, preceeded 
by the name of the query F0. Replace this name by enol to 
keto, click on the Enter button (to the right of the query name 
and formula). You have now defined the query as the difference 
between the T1 heats of formation of the keto and enol forms 
of (substituted) propen-2-ol.  Leave the Formula Editor dialog 
open.

4. Select Open Databases from the Search menu ( ) and click on 
the SSPD tab at the top of the dialog. Drag the query name enol 
to keto from the formula editor onto an empty column header 
at the top right of the SSPD dialog, and click on the Search 
button. In a few seconds, hits (molecules in SSPD formed from 
propen-2-ol by single or double substitution at C1) will begin 
to appear at the right of the dialog. Reaction energies for any 
entries where T1 data exists both for actual search query (the 
substitited enol) and for its associated keto form will appear in 
the column designated enol to keto. Pending signifies that an 
entry exists for the search query (the enol) but not for the keto 
form.

5.  After the search has completed, position the cursor over the 
enol to keto column, hold down the right mouse button and 
select Sort enol to keto from the menu that appears. Molecules 
where the equilibrium most favors the keto form now appear 
at the top. Scroll down the list to identify molecules where the 
enol form is preferred. 

6. Close any molecules and dialogs that are open on screen.
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Electrophilic Reactivity of Polycyclic Aromatics

Naphthalene, anthracene and phenanthrene undergo electrophilic 
substitution just as does benzene. Are they likely to be more or less 
reactive? Local ionization potential maps should be able to provide 
an answer. The lower the potential on the aromatic ring, the more 
likely it is to give up an electron, that is, the more susceptible it will 
be to electrophilic attack. 

naphthalene anthracene

phenanthrene

1. Build benzene, naphthalene, anthracene and phenanthrene and 
put into a single document. With any of the four molecules 
selected, click on Replace All from the Preview dialog. Give the 
molecules proper names. Bring up a spreadsheet (Spreadsheet 
under the Display menu), click on Label (leftmost header cell), 
then right click on an empty header cell and choose Rename 
Selected Using SSPD from the menu.

2. Bring up the Surfaces dialog from the Setup or Display menu 
and make certain that Global Surfaces is checked. Click on 
More Surfaces... at the bottom of the dialog to bring up the 
Add Surfaces dialog. (You need to use this route to specify 
fixed surfaces and save computer time.) Select density from 
the Surfaces menu and ionization from the Properties menu 
(medium from the Resolution menu), check Fixed to the right 
of IsoValue and click on OK. When the graphics calculations 
have completed, bring up the spreadsheet (Spreadsheet 
under the Display menu) and check the box to the left of 
each of the four entries. The four molecules will now be 
simultaneously displayed, but they will be coupled. To move 
them independently, select Coupled from the Geometry menu 
(this will remove the checkmark to the left). Position the four 
molecules on screen such that the π system is visible, and check 
Local Ionization Potential Map inside the Surfaces dialog. 
Which of the four molecules is indicated by its local ionization 

 2 mins
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potential map to be most susceptible to electrophilic attack? 
Which positions on naphthalene, anthracene and phenanthrene 
are most susceptible?

3. Compare local ionization potential maps for naphthalene, 
quinoline and isoquinoline. Focusing on the carbon ring, which 
of the three is likely to be most susceptible to electrophilic 
attack? Which is likely to be least susceptible?

 
N

N

quinoline isoquinoline

4. Compare the local ionization potential map for naphthalene with 
those of indole, benzofuran and benzothiophene. Focusing on 
the carbon ring, which of the four compounds is most susceptible 
to electrophilic attack? Which is the least susceptible?

 
N
H

O S

indole benzofuran benzothiophene

5. Close any molecules and dialogs that are open on screen.



Section III 207

Section III
Features and Functions

This section describes the functions available under the menus 
incorporated into Spartan’10, and is intended to serve as a general 
reference to the program. The coverage follows the order of the 
menus presented in Spartan’s user interface: File, Edit, Model, 
Geometry, Build, Setup, Display, Search, Options, Activities 
and Help. In turn, it describes the functions and usage of each of the 
menu entries. Entries under the File, Model, Geometry and Build 
menus deal primarily with the input of 2D structures and with the 
input and construction of 3D structures and with their display and 
query. Entries under the Setup menu specify molecular mechanics 
or quantum chemical models as well as similarity analysis tools, 
designate what properties and spectra are to be obtained, request 
one or more graphical models and submit jobs for calculation in 
the background. Entries under the Display menu access calculated 
quantities including calculated spectra, while those under the Search 
menu access databases of calculated information. Entries under the 
Options menu set program defaults, designate file paths and control 
job queues.

This chapter provides only limited commentary about the performance 
and requirements of different computational methods and the utility 
of the different graphical models. Additional information is provided 
under Topics accessed from the Activities menu and to A Guide 
to Molecular Mechanics and Quantum Chemical Calculations, 
available as a PDF under the Help menu.
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Chapter 12
The File Menu

Operations under the File menu access model kits to build, edit and 
substitute molecules and the file system to read and write both native 
and non-native files, print text and on-screen graphics, access the 
online PDB database of protein and nucleotide structures, embed 
text and other files into Spartan documents and create QuickTime 
movies.

New ( )

Brings up a model kit and clears the screen. Model kits are discussed 
in Chapter 16.

Open... ( )

Opens a file that contains all information associated with a 
particular molecule or pharmacophore (or list of molecules and/or 
pharmacophores). In addition to native (.spartan) files (documents), 
supported are files containing 2D drawings: CambridgeSoft 
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(ChemDraw) CDX (.cdx), and MDL SDF (.sdf)*, SKC (.skc), and 
TGF (.tgf), files containing 3D structures: MacroModel (.mac), 
SYBYL Mol (.mol), SYBYL Mol2 (.mol2), and PDB (.pdb), and 
files containing 1D “strings”: SMILES (.smi). Finally, infrared, NMR 
and UV/visible spectra may be input (discussion of file formats is 
provided in Appendix J).

We use the word “file” to refer to any information contained in the 
“file system” (the disk on your computer) and the word “document” 
to refer to files that are native to Spartan. Thus, an MDL SDF file may 
be read into Spartan and then written as a document. Documents may 
contain information on a single molecule or single pharmacophore or 
on a collection of molecules and/or pharmacophores. This collection is 
loosely referred to as a “list” or as a “spreadsheet” (in the context that it 
is presented in a spreadsheet).

Cartesian coordinates from any of these files (except spectra files 
which do not necessarily contain coordinates) may be replaced by 
coordinates generated based on atomic connectivity using Replace 
Coords. in the Molecule Utilities dialog (accessible from Properties 
under the Display menu; Chapter 18). Additionally, hydrogen atoms 
that are missing in the input structure may be provided using Grow 
Hydrogens in the Molecule Utilities dialog. Non-native files are 
normally hidden from view, but may be seen by selecting All Files 
from the Files of type menu at the bottom of the dialog.

Close ( )

Closes the document containing the selected molecule, as well as the 
spreadsheet, graphics, plots, spectra and document specific dialogs. 
If the document has not previously been saved, a name is requested. 

* SDF files may contain information in addition to geometry, for example, the name of the 
molecule or its CAS number. Each quantity appears in a line following <xyz> where xyz is 
a character string denoting the quantity, for example, CAS to denote the CAS number.

 <CAS>
 22090-26-2
 This information may be accessed in the spreadsheet by typing the character string into a 

header cell, for example, typing CAS will result in the CAS number.
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If a previously-saved document has been altered, verification that 
the changes are to be saved is requested.

Save
Save As... ( )

Saves the document containing the selected molecule exactly as it 
appears on screen. Opening the document will bring it on screen 
exactly as it was last saved. If the document has not previously been 
named, Save behaves as Save As.... Documents may be either be 
saved in native format or in one of the formats listed under Open. In 
addition, bitmap (.bmp), JPEG (.jpg) and PNG (.png) graphics file 
formats are supported as is the Spartan Database (.spentry) format 
for creating custom databases (see Appendix H). Support is also 
provided for writing QuickTime (movie) files (see discussion later 
in this chapter). Selection is made under the Save as type menu in 
the Save As dialog.

New Molecule

Brings up a model kit and clears the screen. This differs from New, 
in that the resulting molecule is appended to the end of the list 
associated with the molecule that is presently selected.*

* Examples are provided in the tutorials Dienophiles in Diels-Alder Cycloadditions and 
Hydration of Carbonyl Compounds in Chapter 5, Stereospecific Diels-Alder Reactions in 
Chapter 7, Polyglycine in Chapter 8 and Benzene Chromium Tricarbonyl in Chapter 10.
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Delete Molecule

Deletes the selected molecule(s) from a document. Deleting the last 
molecule leads to an empty document.

Append Molecule(s)...

Appends one or more documents onto the end of the document that 
contains the selected molecule.* Append Molecule(s)... leads to a file 
browser from which one or more documents need to be selected.**

Access PDB Online...

Provides access to the online Protein Data Bank (PDB)*** comprising 
nearly 72,000 protein and nucleotide structures. Selection results in 
a dialog. 

To access a PDB structure, enter the four character identification 
code in the box to the right of By PDB ID at the bottom of the dialog 
and click on the Search button. If the PDB entry contains more than 
one structure (typical with protein structures obtained from NMR 

* An example is provided in the tutorial Carbene Additions to Alkenes in Chapter 7.
** Alternatively, molecules may be appended onto an existing document either by copy/paste 

operations using the clipboard or by dragging from an external window. Both require that 
the spreadsheet associated with the destination document be open on screen.

 To copy a molecule open on screen onto the clipboard, first select (click on) it, and then 
select Copy from the Edit menu. Alternatively, click on its label in its spreadsheet (in the 
leftmost column), and then select Copy from the Edit menu. The latter permits several 
molecules to be selected (and copied) at once using the Shift and Ctrl keys in the usual 
manner. Once on the clipboard, the molecule or molecules may be moved to the destination 
list by clicking on an empty row header in the spreadsheet (for the destination document), 
and then selecting Paste from the Edit menu.

 To copy a document from an external window, drag it onto the open spreadsheet (associated 
with the destination document) inside of Spartan. Several documents can be dragged at 
once using the Shift and Ctrl keys in the usual manner.

*** The web address is http://www.rcsb.org.
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spectroscopy) and/or the PDB ID yields more than one entry, all 
structures will be returned in a list.

PDB access will typically require a few seconds. The PDB ID will 
appear at the right and a ribbon model of the protein or nucleotide 
will appear on screen. A Ramachandran plot associated with a 
protein structure may either be upon initial retrieval of the PDB file 
by checking the box to the left of Draw Ramachandran Plot or later 
from Ramachandran Plot under the Model menu (Chapter 14).

Print

Selection leads to a dialog in order to designate a printer, specify 
print layout and number of copies. It also allows printing to a file.

The contents of the spreadsheet (Spreadsheet under the Display 
menu; Chapter 18) may be printed using Print from the contextual 
menu. The results of a reaction energy calculation (Reactions... 
under the Display menu; Chapter 18), may be printed using Print 
from the contextual menu.
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Embedded Data

This allows non-native files, for example, Word, Excel or PowerPoint 
files, to be embedded in a Spartan document. These may be associated 
either with an individual molecule or with all the molecules (or 
both). Selection results in the Embedded Data dialog, the upper 
half of which relates to document level files and the lower half of 
which relates to molecule level files.

A file may be imported (at the document or molecule level) by clicking 
on the appropriate Import button. This leads to a file browser from 
which a file may be selected. Once embedded in a Spartan document, 
a non-native file may be exported by first selecting (clicking on) it 
and then clicking on Export Selected. It may be deleted by first 
selecting it and then clicking on Delete Selected.

Note that applications cannot be launched from the Embedded 
Data dialog. They need to be copied outside prior to launching.



Chapter 12 215

Start/Stop QuickTime Recording

This allows QuickTime movies to be created. To start making 
a movie, select Start QuickTime Recording. Any motions of 
all molecules in Spartan’s main screen will be captured. Dialogs 
(including the builders) will not be captured. Note the use of 
“tumbling” (see Settings Preferences under Preferences in the 
Options menu; Chapter 20) in making QuickTime movies. To stop 
making a movie, select Stop QuickTime Recording (which has 
replaced Start QuickTime Recording in the File menu) and supply 
the requested file name.

Note that the QuickTime entry in the File menu will only appear if 
QuickTime is actually installed on your machine.

Exit

Exits Spartan, that is, clears the screen and closes all open documents. 
A prompt for a name is provided for each document that has not 
previously been saved.
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Chapter 13
The Edit Menu

Operations under the Edit menu provide for undoing commands, 
copying items to and from the clipboard, finding text and graphics, 
centering molecules on screen and clearing the selected molecule.

Undo

Undoes the last operation from the Build and Edit menus and from 
the Molecule Utilities dialog. Undoes transition-state formation and 
retrieval from Spartan’s Databases.

Cut, Copy, Paste

Cut moves the selected item to the clipboard and removes it from 
the document. Copy copies the item to the clipboard. The item 
is unaffected. Paste transfers the contents of the clipboard to the 
selected location. The contents of the clipboard are unaffected. 
Among the important uses of the clipboard within Spartan are:

(i) Transferring on-screen graphics into other applications such 
as Microsoft Word® and PowerPoint®.

(ii) Temporary storage of a molecular structure for use in 
molecule building.

(iii) Transferring data between Spartan spreadsheets and 
between a Spartan spreadsheet and other applications such 
as Microsoft Excel®.
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(iv) Making multi-molecule documents and/or transferring 
molecules between documents.

Cut operations for (i) and (ii) require drawing a selection box. 
Position the cursor slightly above and slightly to the left of the item 
to be transferred, hold down both buttons and drag the mouse to 
a location slightly below and slightly to the right of the item to be 
transferred and release both buttons. Copy operations for (i) and 
(ii) also refer to the contents of a selection box if one has been 
drawn, but to the selected molecule if a box has not been drawn. 
Copy operations from a Spartan spreadsheet refer to all information 
associated with a molecule if selection is made on the header cell of 
the leftmost column, but only to the selected (text) information if 
selection is made on any other column. Further discussion relating 
to use of the clipboard in molecule building is provided in Chapter 
16 and for moving data in and out of the spreadsheet is provided in 
Chapter 18. 

Select All

Selects all atoms in the selected molecule.

Find..., Find Next

Find locates a text string defined in the Find dialog if an output 
window or a spreadsheet is selected, or a structure sequence defined 
on the clipboard if an on-screen model is selected. Find Next locates 
the next occurrence of a text string or a structure sequence.

Center

Centers on screen all molecules in the document for which the selected 
molecule is a member (only the selected molecule is displayed).

Clear

Clears (deletes) the structure and other information for the selected 
molecule, and brings up a model kit. No information is actually 
removed from the file system until the document is saved.
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Chapter 14
The Model Menu

Structure models available under the Model menu include wire, ball-
and-wire, tube, ball-and-spoke, space-filling (CPK) and line models, 
with or without hydrogens, with or without hydrogen bonds indicated, 
with or without chemical function descriptors (CFD’s) shown and with 
or without atom labels, as well as ribbon displays for polypeptides and 
polynucleotides, with or without labels and with or without hydrogen 
bonds indicated. It allows drawing a Ramachandran plot for a protein 
structure retrieved from the Protein Data Bank (PDB). The menu also 
provides for configuring atom labels to display element name, R/S 
chirality, mass number, charge or chemical shift, and for specifying 
color coding and display style for ribbon labels, as well as turning 
a variety of other labels on and off. Finally, it allows model style to 
be applied globally (to all molecules in a document) and models to 
be manipulated in concert.

Only one model style Wire, Ball and Wire, Tube, Ball and Spoke, 
Space Filling or Hide) may be selected. The selected model is 
designated by a check mark  in front of its entry in the menu. Global 
Model, Coupled, Hydrogens, Labels, Ribbons, Hydrogen Bonds 
and CFD’s operate as toggle switches. A  in front of the entry in the 
menu indicates that it is turned on.
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All structure models, and graphics may be displayed either in orthogonal 
or perspective projections. The latter may be valuable in helping to 
visualize large molecules. Selection is done in the Settings Preferences 
dialog (Preferences... under the Options menu; Chapter 20). Both 
structure models and graphics may be presented in 3D stereo. This is also 
controlled from the Settings Preferences dialog as well as from the 3 
key. Stereographic displays require perspective projections. 

Wire

This represents the molecule as a wire model where the vertices 
represent the atoms.

The bonds are drawn in two colors, one for each of the atoms making 
up the bond. Default atom colors are given in Table 14-1. 

Atom colors apply globally (to all atoms of given type), and may be 
changed using the Set Colors dialog (Colors under the Options menu; 
Chapter 20). Colors of individually selected atoms may be set using 
the Atom Style dialog (Properties under the Display menu; Chapter 
18). All models use the same color scheme for atoms, and provide for 
the same mechanism of changing colors globally or individually.

Ball and Wire 

This represents atoms by small balls and bonds by wires.

Wire Model

Ball-and-Wire Model
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 main group   main group (con’t)

 Hydrogen white Indium orange
 Lithium orange Tin gray
 Beryllium green Antimony orange
 Boron orange Tellurium orange
 Carbon gray Iodine violet
 Nitrogen blue-gray 
 Oxygen red 
 Fluorine pale yellow 
 Sodium yellow   
 Magnesium purple 
 Aluminum magenta 
 Silicon gray 
 Phosphorus orange 
 Sulfur yellow 
 Chlorine  green 
 Potassium red 
 Calcium red 
 Gallium orange 
 Germanium gray 
 Arsenic dark orange 
 Selenium red orange
 Bromine dark red
 Rubidium red
 Strontium red

Table 14-1: Default Atom Colors

transition metals
Scandium-Zinc green
Yttrium-Cadnium green
Lanthanum-Mercury green

lanthanides
Cerium-Lutetium violet

actinides
Thorium-Lawrencium dark blue

noble gases
Helium dark orange
Neon dark orange
Argon dark orange
Krypton dark orange
Xenon orange
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Ball-and-Spoke Model

The balls are color coded according to atom type, and the wires 
representing bonds are drawn in two colors (as in wire models).

Tube

This is similar to the wire model, except that tubes instead of wires 
are used to represent bonds.

Tubes may either be solid cylinders or be split to represent multiple 
bonds depending on whether Split Tubes in the Settings Preferences 
dialog (Preferences... under the Options menu; Chapter 20) is turned 
off or on. As with wire models, bonds are drawn in two colors.

Ball and Spoke

This represents atoms by balls (the size and color of which depend 
on atom type), and bonds by spokes.

Spokes may either be cylinders or be split to represent multiple bonds 
depending on whether Split Tubes in the Settings Preferences dialog 
(Preferences... under the Options menu; Chapter 20) is turned off or 
on. Bond (spoke) color is gray by default but it may be changed using 
the Set Colors dialog (Colors under the Options menu; Chapter 
20). Colors of individually selected bonds may be set using the Bond 
Style dialog (accessible from Properties under the Display menu; 
Chapter 18). 

Tube Model
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Space Filling

This represents the molecule as a composite of spheres, the radii 
of which have been chosen to approximate van der Waals contact 
distances.* Also known as CPK models, space-filling models are 
intended to portray overall molecular size and shape.

Volume, surface area and polar surface area (PSA)** displayed under 
the QSAR tab in the Molecule Properties dialog (accessible from 
Properties under the Display menu; Chapter 18) correspond to a 
space-filling model.

Line

A line model is a 2D representation (similar to that provided from 
drawing programs such as ChemDraw and IsisDraw). It designates 
carbons as the termini or the intersection of lines and non-carbons 
by their elemental symbols without any use of color.

O

H
H

HH

H

H H

H

Line models include stereochemical cues (  and ) if these 
have been provided in the 2D drawing or if they are specified from 

* Default values for van der Waals radii may be changed from the VDW Radii dialog accessible 
from Preferences under the Options menu (Chapter 20). Settings apply to all atoms of 
given atomic number.

** By default, polar surface area is defined as the area due to nitrogen and oxygen and any 
hydrogens attached to nitrogen and oxygen. Other combinations of atoms may be employed 
to define a polar surface area. See Formulas under the Display menu (Chapter 18).

Space-Filling Model
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the Bond Properties dialog (accessible from Properties under the 
Display menu; Chapter 18).

Hide

This removes the structure model from the screen. This may be 
desirable where its display may lead to unnecessary crowding, for 
example, in proteins where ribbon displays are more appropriate. A 
structure model may be restored by selecting it from the Model menu.

Different parts of a molecule may be rendered in terms of different model 
styles and colors. This allows focus on specific interesting regions of a 
molecule. Regions may be individual atoms and/or bonds or any collection 
of atoms and/or bonds contiguous or not. They are selected either by 
clicking on an individual atom or bond or, with the aid of the Ctrl (select 
multiple) or command key (Macintosh), Shift (select over a range), and 
Alt (select all bonded) or option key (Macintosh), by clicking on a set 
of atoms and/or bonds, or by defining a selection box. Discussion has 
already been provided in Chapter 2. Style and color of selected model 
components is by way of the “Selected” Style dialog accessible from 
Properties under the Display menu (Chapter 18).

Global Model

If checked (turned on), this signifies that all molecules in a document 
will share attributes. These include presentation of hydrogens, atom 
and other labels, hydrogen bonds, CFD’s and ribbon displays. Global 
model style is controlled from the Molecule Preferences dialog 
(Preferences... under the Options menu; Chapter 20). Global Model 
acts in a toggle manner, switching between global and local display. 
Global Model is normally on.

Coupled

If checked (turned on), this signifies that all molecules in a document 
selected for simultaneous display will be moved together. Coupled 
is turned on following molecule alignment (see Align under the 
Geometry menu; Chapter 15). Coupled acts in a toggle manner, 
that is, repeated selection couples and decouples the molecules.
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Hydrogens

If checked, this signifies that hydrogens are to be included in the 
model. Note that 2D SD files as well as structures retreived from the 
Cambridge Structural Database or the Protein Data Bank may lack 
hydrogens. These need to be added to the model before they can be 
displayed, before CFD’s (Chemical Function Descriptors) can be 
assigned (see discussion later in this chapter) and before calculations 
may be performed. This may be done either upon retrieval (see Open/
Close Databases and Extract Ligands under the Search menu; 
Chapter 19) or using Grow Hydrogens in the Molecule Utilities 
dialog (accessible from Properties under the Display menu; Chapter 
18). Hydrogens acts in a toggle manner, that is, repeated selection 
turns the display of hydrogens on and off.

Labels

If checked, this signifies that labels associated with atoms, ribbons 
and bonds as well as with other attributes specified in Configure... 
(see discussion later in this chapter) are to be displayed in the model. 
Labels acts in a toggle manner, that is, repeated selection turns display 
of labels on and off. Labels is automatically turned on following 
selection of Apply or OK in the Configure dialog.

Ribbons

If checked, this signifies that ribbons are to be displayed along with the 
selected model. (If only ribbons are desired, for example, in proteins, 
select Hide for the model.) Ribbons acts in a toggle manner, that is, 
repeated selection turns display of ribbons on and off.

Ramachandran Plot

If checked, this draws a Ramachandran plot for a protein input from 
the Protein Data Bank (see Access PDB Online under the File menu; 
Chapter 12). Ramachandran Plot acts in a toggle manner, that 
is, repeated selection turns the plot on and off. Note that coloring 
of the points on the plot (red for a-helices, blue for b-sheets, green 
otherwise) is not based on the actual 3D geometry but rather on 
assignments in the PDB file.



226 Chapter 14

Hydrogen Bonds

If checked, this signifies that hydrogen bonds are to be drawn as part 
of the model. Hydrogen bonds are defined as non-bonded contacts 
between a  nitrogen or oxygen and a hydrogen attached to nitrogen or 
oxygen separated by a distance ranging from 1.6 to 2.1Å and making 
an X–H--Y (X,Y = N, O) angle of >120°. Note that hydrogen bonds 
are not used in either molecular mechanics or quantum chemical 
calculations. Hydrogen Bonds  acts in a toggle manner, that is, 
repeated selection turns display of hydrogen bonds on and off.

CFD’s

If checked, this signifies that Chemical Function Descriptors (CFD’s) 
are to be displayed along with the structure model. CFD’s are 
descriptors given to a molecule in order to characterize or anticipate 
its chemical behavior or to identify commonality among molecules 
with different structures. They parallel terms in a chemist’s vocabulary 
such as lone pair (to suggest the role of a hydrogen-bond acceptor) and 
sterically crowded (to suggest that getting close may be difficult). 

Spartan uses seven different kinds of CFD, the first six of which may 
be thought of as attributes of a molecule.

 CFD chemical language

1. hydrophobe sterically-crowded region
2. aromatic aromatic π system
3. hydrogen-bond donor acidic hydrogen
4. hydrogen-bond acceptor lone pair
5. positive ionizable site basic site
6. negative ionizable site acidic site

Default CFD assignments follow from atomic connectivity and 
rules covering common organic functional groups. They may be 
modified on a case-by-case basis using the CFD Properties dialog 
(accessible from Properties under the Display menu; Chapter 18). 
CFD’s (represented by *’s in the figures below) may either be atom 
centered, or they may be centered in between atoms. For example, 
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a hydrogen-bond acceptor CFD is placed on an ether oxygen, while 
an aromatic CFD is placed at the center of a benzene ring.

aromatichydrogen-bond acceptor

*R R'
*

CFD’s may also be associated with a number of common functional 
groups. For example, a single CFD is provided for the carboxylic acid 
group, sited in-plane and equidistant from the carbon and two oxygens.
The CFD’s for this and other functional groups may depend on pH. 
At neutral (or basic) pH this CFD should be designated both as a 
hydrogen-bond donor and a hydrogen-bond acceptor, whereas at 
acidic pH it should be designated as a negative ionizable site.

neutral pH:

*

hydrogen-bond donor
hydrogen-bond acceptor

acidic pH: negative ionizable site

C
O

O
*C
O

OH

Finally, note that default assignments for hydrogen-bond donors and 
acceptors depend not only on atomic type (N, O, . . . ) and (in the case 
of hydrogen-bond donors) on the availability of hydrogens, but also 
on known (or presumed) chemical behavior. For example, because an 
amide nitrogen would generally not be considered to be a hydrogen-
bond acceptor, no (hydrogen-bond acceptor) CFD is provided. It is 
assigned to be a hydrogen-bond donor (if hydrogens are available) 
and the amide oxygen is assigned as a hydrogen-bond acceptor.

Note that, hydrogen-bond acceptor and donor CFD’s may be related to the 
electrostatic potential obtained from quantum chemical calculations. For 
example, a negative potential associated with an oxygen center suggests 
that it might serve as a hydrogen-bond acceptor, while a positive potential 
associated with a hydrogen attached to such a center suggests its role as 
a hydrogen-bond donor. These are, of course, the same conclusions that 
a chemist would draw simply by looking at the molecule. However, the 
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calculations may be able to say which acceptor or donor sites are likely 
to be strong and which are likely to be weak.

Calculated electrostatic potentials may offer significant advantage over 
CFD’s and other qualitative descriptions when there are no heteroatoms 
and hydrogen bonding is not possible. The π systems of benzene and other 
aromatics provide the most common examples. The same conditions that 
make the ring susceptible to electrophilic aromatic substitution mean that 
it repels other electron-rich regions (and attracts electron-poor regions).

A seventh CFD type, excluded volume, derives from knowledge 
of a molecule incorporated into a host. Excluded volumes may be 
obtained for ligands extracted from PDB files using the Ligands 
dialog (Extract Ligands under the Search menu; Chapter 19).

Configure...

This selects the types of labels attached to atoms, ribbons and CFD’s.

	 Configure	Labels

Atom labels may be selected from among the following: Labels, 
a unique element/number combination that may be changed from 
the Atom Properties dialog (accessible from Properties under 
the Display menu; Chapter 18), Element, Mass Number, R/S 
(chirality), Mulliken Charge, Electrostatic Charge, Natural 
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Charge, Strand: Res\Label (polypeptides and polynucleotides), 
Exposed Area (of an atom in a space-filling model), Chem Shift. 
Selection of Custom leads to a text box into which a formula 
defining an atomic label may be entered. Details are provided in 
Formulas under the Display menu (Chapter 18). In addition, 
Bond Labels, Point Labels, Plane Labels, Constraint Labels, 
Residue Labels, Reaction Labels and/or CFD Labels may be 
provided. Default settings (for a new molecule) are made in the 
Molecule Preferences dialog (Preferences under the Options 
menu; Chapter 20).

	 Configure	Objects

Clicking on the Objects	tab leads to the Configure	Objects	dialog.

If checked, Constraint and Frozen markers, Points and Planes, 
infrared and Raman Peaks, Reaction arrows and CFD’s attach to 
the model. If not checked, these are shown only in the respective 
modes, for example, Frozen markers are shown only if Freeze 
Center is selected.
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	 Configure	Ribbons

Clicking on the Ribbons tab leads to the Configure	Ribbons	dialog.

Ribbon coloring may be selected from among the following: 
Monochrome, By Secondary Structure, By Strand or By 
Residue. Ribbon style may be selected from among the following: 
Ribbons, Beads or Lines.

	 Configure	CFD’s

Clicking on the CFD’s tab leads to the Configure	CFDs dialog.

This allows for turning CFD descriptors on (identifying the 
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type of CFD) identifiers and CFD’s corresponding to excluded 
volumes.

The Configure dialog is removed from the screen with all 
selections maintained by clicking on OK. Clicking on Cancel 
or on  removes the dialog but selections are lost. Clicking on 
Apply maintains the selections but leaves the Configure	dialog on 
screen. Note, that Labels (from the Model menu) will be turned 
on following either clicking on OK or on Apply. 
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Chapter 15
The Geometry Menu

Functions available under the Geometry menu allow querying and 
changing bond lengths, angles and dihedral angles, defining points 
and ligand points, planes and chemical function descriptor (CFD) 
locations, setting geometrical constraints or ranges of constraints, 
freezing atomic centers, altering default bond and ring conformer 
assignments, introducing NOE’s (maximum intramolecular distances) 
in conformational searching, selecting atoms or CFD’s for similarity 
analysis and aligning molecules in a list.

Measure Distance ( )
Measure Angle ( )  
Measure Dihedral ( )

Measure Distance displays the distance (in Ångstroms) between two 
atoms, whether or not they are bonded. Selection results in a message 
at the bottom left of the screen.

Clicking on two atoms displays the distance at the bottom right of 
the screen.
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Alternatively, clicking on a bond displays its length.

Measure Distance may also be used to alter the distance between 
atoms (as long as both are not incorporated into the same ring), by 
altering the contents of the box to the right of Distance (A,B) = or 
Length (A)=, and then pressing the Enter key (return key on Mac). 
The distance (length) may be entered into the spreadsheet by clicking 
on  to the right of its display (see Spreadsheet under the Display 
menu; Chapter 18). Alternatively, the label “Distance (A,B)=” or 
“Length (A)=” may be dragged into the spreadsheet, the formula 
editor (see Formulas under the Display menu; Chapter 18) or into 
any of the dialogs associated with the Spartan Molecular Database 
or Spartan Spectra and Properties Database (see Open Databases 
under the Search menu; Chapter 19).

Angle and dihedral angle queries are handled in a similar manner. 
Angles require that three atoms or two bonds be identified in the 
proper order while dihedral angles require that four atoms or three 
bonds be identified in the proper order.

Freeze Center ( )

This allows one or more atoms to be held in place during minimization 
(in build mode) or (optionally) during equilibrium or transition-state 
geometry optimization, conformational searching, or energy profile 
generation. Outside of build mode, use of frozen atoms needs to be 
explicitly indicated in the Calculations dialog (Chapter 17).

Atom freezing may be useful in a number of situations, among them 
guessing a transition-state geometry for a reaction that is closely 
related to one for which a transition state is available. For example, a 
good guess at the transition state for pyrolysis of cyclohexyl formate 
will be obtained by modifying the transition state for pyrolysis of 
ethyl formate, freezing all but the modified sections (designated in 
bold in the figure below) and then minimizing.*

* An example of this is presented in the tutorial Carbene Additions to Alkenes in Chapter 7.
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Selection of Freeze Center leads to a message at the bottom left of 
the screen.

Clicking on an atom or free valence*, freezes it; clicking again thaws 
it. Buttons at the bottom right of the screen allow for freezing all 
atoms (Freeze All), freezing all heavy (non-hydrogen) atoms (Freeze 
Heavy) and for thawing all atoms (Thaw All).

Another important use of frozen atoms is to adjust XH bond lengths in 
structures resulting from a search of the Cambridge Structural Database 
(see Open/Close Databases under the Search menu; Chapter 19). 
Hydrogen positions are more often than not poorly located in small 
molecule X-ray structures, and XH bond lengths are commonly as much 
as 0.1 to 0.2Å shorter than they should be. Structures incorporating such 
bond lengths are clearly inappropriate for energy and property calculations 
and may also be problematic as starting geometries in quantum chemical 
calculations. Protein crystal structures always lack hydrogens, and 
hydrogen positions of bound ligands extracted from PDB files may 
be poorly defined. A reasonable solution to both problems is to freeze 
all heavy (non-hydrogen) atoms (Freeze Heavy) and then to carry out 
molecular mechanics minimization using either Minimize from the Build 
menu (see discussion in Chapter 16) or from the Calculations dialog 
under the Setup menu (see discussion in Chapter 17).

Frozen atoms are indicated by magenta colored markers ( ). Whether 
or not these are included with the model (outside of freeze center 
mode) is controlled from the Molecule Preferences dialog under 
Preferences... in the Options menu (Chapter 20). 

* The bond distance in this case is that appropriate for hydrogen being added to the free valence.
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Set Torsions ( )

Spartan automatically identifies bonds and rings for conformational 
searching and specifies default step sizes. 

Two different rule sets have been provided. Normal is intended for 
use in determining the lowest-energy conformation or in establishing a 
distribution of low-energy conformers, whereas Trimmed is intended 
for use in building conformer libraries for use in similarity analyses. 
(Different modes of conformational analysis are discussed in Chapter 
17.) Selection of rule set is made in the Settings Preferences dialog 
(Preferences... under the Options menu; Chapter 20).

Set Torsions allows these defaults to be altered. Selection results in 
rotatable bonds each being marked by a gold cylinder, and flexible 
rings each being marked by a gold circle around one or more atoms, 
and a message at the bottom left of the screen.

Clicking on a bond or an atom contained in a ring selects it for 
rotation.  In the case of a ring, rotation means that the atom is to 
be puckered up and down (restricted rotation). The default rotation 
is provided in a box to the right of Fold at the bottom right of the 
screen. This is typically 2 or 3 for a single bond (step size of 180° 
and 120°, respectively) and 3 for a flexible ring. A value of either 
0 or 1 indicates that the bond (ring) is not to be rotated (rotation by 
360°). Other integer values may be entered into the box, followed by 
pressing the Enter key (return key on Mac). The original settings 
may be retrieved by clicking on Defaults at the bottom right of the 
screen. Double clicking on a marked bond or ring atom removes the 
marker and eliminates the conformational degree of freedom.

Saturated six-membered rings, for example, cyclohexane, are treated as 
special cases with only chair conformers examined. This is indicated by 
two circles on opposite atoms. Other conformers, for example, twist-boat 
conformers, can be generated by selecting additional ring atoms.

 and  buttons at the bottom right of the screen are available to step 
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through the possible single-bond conformers* (ring conformers are not 
provided). Geometries have not been optimized and some conformers 
may be severely crowded. Any conformer can be selected in lieu of 
the initial structure. The full set of single-bond conformers may be 
placed in an unnamed document by clicking on  (to the right of the 
step buttons), and then clicking OK in the dialog that results. Note, 
that duplicate conformers have not been removed.

The total number of conformers (excluding ring conformers) that will 
be examined in a systematic search (see discussion in Chapter 17) 
is indicated at the bottom right of the screen Conformers = xx. This 
is an upper bound to the number of conformers that will actually be 
kept as duplicates and high-energy conformers are eliminated. This 
can be dragged into the spreadsheet (see discussion in Chapter 18), 
into the Formulas dialog (see discussion in Chapter 19), or into any 
of the dialogs associated with the Spartan Molecular Database or 
Spartan Spectra and Properties Database (see discussion in Chapter 
19). The number of conformers is also available under the Molecule 
tab in the Molecule Properties dialog (Properties under the Display 
menu; Chapter 18). This can also be dragged into the same dialog 
as well as posted to the spreadsheet.

Set Torsions is also used to specify non-bonded distances that need 
to be kept below a threshold value. These follow from NOE (Nuclear 
Overhauser Effect) measurements and may be referred to as NOE 
conditions or simply NOEs. NOEs are specified by clicking on two 
(non-bonded) atoms while holding down the Shift key. In response, 
a message appears at the bottom of the screen.

Clicking on  changes it to  and enters the default value for the NOE 
threshold into the box. This value can be changed. A line is drawn 
between atoms that are to be kept within the threshold value.

* A limit of 1000 conformers is enforced.
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Once set, NOEs are used in conformational searching (conformer 
distribution only; see discussion under Calculations in Chapter 17) 
without further user intervention. They act as a post-processor filter 
to eliminate conformers that do not satisfy the constraints and do not 
affect the speed of the search.

Set Similarity Centers ( )

This specifies the set of atomic centers, or Chemical Function 
Descriptors (CFD’s) or pharmacophore elements that are to be used in 
similarity analysis. Choice of whether the similarity analysis is to be 
based on structure or CFD’s (pharmacophore elements) is made from a 
menu that appears at the bottom right of the screen following selection 
of Set Similarity Centers. This menu is also accessible from the 
Similarity Analysis task in the Calculations dialog (Calculations... 
under the Setup menu; Chapter 17).

Similarity Based on Structure

Selection of structure from the Similarity by menu at the bottom 
right of the screen results in a message at the bottom left of the screen.

Clicking on an atom designates it as an alignment center and it 
marks it with a violet circle. Clicking on the circle removes the 
designation (and the circle). Hydrogens are not used in similarity 
analysis and may not be selected.

The computer time required for similarity analysis based on structure 
depends on the number of molecules in the query, the number of molecules 
in the library to which comparisons are being made and the choice of 
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similarity centers. Single atoms should never be selected as similarity 
centers unless they are unique. Rather, contiguous groups of atoms that 
are likely to be unique should be chosen. For example, analysis carried 
out on morphine based on selection of its phenol and trialkylamine 
components (left) will be much faster and much more informative than 
that based on selection of the phenol oxygen, two carbons on benzene 
and the nitrogen (right).
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This is because there will be many few occurences of phenol and 
trialkylamine substructures in the library entries than there will be 
aromatic carbons and nitrogen atoms and fewer permutations that need 
to be examined and fewer false positive results. 

Similarity Based on CFD’s

Similarity analysis may also be based on CFD’s. These indicate 
whether a particular center is likely to act as a hydrogen-bond 
donor or hydrogen-bond acceptor, is likely to take on positive 
or negative charge or is a hydrophobe. This is accomplished by 
selecting CFD from the Similarity by menu at the bottom right of 
the screen. In response, the selected molecule is augmented with 
CFD’s, and a message appears at the bottom left of the screen.

Clicking on a CFD designates it as a similarity center and marks it 
with a violet circle. Clicking on the circle removes the designation 
(and the circle).

The computer time required for similarity analysis based on CFD’s 
depends on the number of molecules and/or pharmacophores in the query, 
the number of molecules and/or pharmacophores in the library and the 
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nature of the selected CFD’s in the query. For each query/library pair, 
where the query is represented by i CFD’s of type A, j CFD’s of type B, 
k CFD’s of type C, etc., the number of different alignment combinations 
that need to be considered is given by:

i!j!k! . . .

(! is the factorial symbol.) This rapidly becomes unmanageable. For 
example, if there are 6 CFD’s of type A, 3 of type B and 2 of type C, the 
number of combinations is 6!3!2! or 8640. Considerable savings can be 
achieved by limiting the number of CFD’s of a given type in the overall 
representation.

Similarity Based on a Pharmacophore

Finally, it is possible to base similarity on a pharmacophore. This 
is set up in exactly the same way as similarity based on CFD’s 
insofar as the elements of a pharmacophore are CFD’s (see 
previous section).

Selection of similarity centers either needs to be repeated for the 
remaining molecules in the list or the selections may be designated 
as global, that is, applying to all molecules in the list. The latter 
is applicable where the molecules in the list are conformers or 
are closely related at least insofar as the alignment centers are 
concerned. Global designation is accomplished by checking the 
Global Similarity Settings at the bottom of the screen.

Constrain Distance ( )
Constrain Angle ( )
Constrain Dihedral ( )

These introduce one or more geometrical constraints during structure 
minimization (in build mode), and (if requested) during equilibrium 
or transition-state geometry optimization or conformational searching 
using methods under the Calculations dialog (Chapter 17). They 
also allow for setting a range of constraints needed for generation of 
energy profiles. Constraints may be useful in a number of situations, 
among them:



Chapter 15 241

(i) constructing conformational energy profiles where one or 
more dihedral angles need to be fixed while other geometrical 
variables are optimized,

(ii) optimizing molecular structures where the values of certain key 
parameters are known, for example, optimizing the geometry of 
a molecule with an intramolecular hydrogen bond or a disulfide 
linkage, and 

(iii) building molecules with unusual geometries, for example, 
molecules with very long bonds, as might be required in the 
construction of transition states and intermolecular complexes.

Selecting Constrain Distance results in a message at the bottom left 
of the screen.

Clicking on two atoms, or a bond results in a message at the bottom 
right of the screen.

Clicking on  changes it to  and shows the current distance.

This (constraint) distance can now be changed by altering the contents 
of the box and then pressing the Enter key (return key on Mac). 
Alternatively, the existing distance may be used as the constraint 
distance. If the selected distance had previously been constrained, 
the icon  would have been initially displayed. In this case, clicking 
on  turns the constraint off and returns the icon to . Finally, the 
value of the constraint (that may be different from the value of the 
current distance*) may be entered into the spreadsheet by clicking 
on  to its right. Alternatively, the label Constraint (A,B)= may 
be dragged into the spreadsheet, the formula editor (see Formulas 
under the Display menu; Chapter 18) or into any of the dialogs 
associated with the Spartan Molecular Database or Spartan Spectra 

* Note, however, that it may be problematic to carry out a constrained geometry optimization 
starting from a structure that is very different from that satisfying one or more constraints.
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and Properties Database (see Open Databases under the Search 
menu; Chapter 19).

This sequence of operations (bond identification followed by turning 
the constraint on and off) may be repeated as many times as necessary. 
Any bonds or non-bonded distances on which constraints are to be 
imposed are indicated by magenta colored markers. Any constraints 
introduced are automatically enforced only upon energy minimization 
in add fragment mode ( ), but need to be requested  for methods 
under the Calculations dialog (Chapter 17). 

Angle and dihedral angle constraints are handled in a similar manner. 
Note that points and planes may not be used to define constraints.

Locking in a constraint leads to two additional text boxes at the 
bottom right of the screen. This allows a sequence of constraints to be 
defined (from some initial value to some final value in a given number 
of steps) for the purpose of constructing an energy profile along a 
predefined set of coordinates* (see discussion under Calculations 
from the Setup menu; Chapter 17).

The leftmost box sets the initial value of the constraint, the middle box 
to the right of to sets the final value, and the rightmost box to the right 
of Steps: sets the number of steps. For example, were the initial value 
set to 0°, the final value to 180° and the number of steps to 10, then a 
series of ten constraints (0°, 20°, 40°, ... 180°) would be specified. This 
can also be accomplished using the Constraint Properties dialog, 
and the value of the constraint posted to the spreadsheet.

Whether or not constraint markers are included as part of the 
model (outside of constrain distance, constrain angle or constrain 
dihedral mode) is controlled from the Molecule Preferences dialog 
(Preferences... under the Options menu; Chapter 20).

* Examples of this are provided in the tutorial Internal Rotation in Dimethylperoxide in 
Chapter 6, and the tutorial Thermodynamic vs. Kinetic Control in Chapter 7.
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Define Point ( )

This defines a point as the geometric (unweighted) center of selected 
atoms (or points) previously defined. Selection results in display of 
a message at the bottom left of the screen.

Clicking on atoms (or points) in any order, and clicking a second 
time on any one of the atoms (or points) defines a point (depicted as 
a small sphere). As many points as desired can be defined and these 
are treated in the same way as an atom in defining distances, angles, 
etc. Points move with the molecule as its geometry is altered.

Selecting Define Point (or clicking on ) while holding down on 
the Shift key, followed by clicking on the appropriate atoms, leads to 
a ligand point. This is a point of attachment directed perpendicular 
to the geometric center of the plane defined by three atoms (or best 
plane in the case of four or more atoms). A ligand point shares all 
the characteristics of a normal point, but may also be used to bond 
to atomic fragments, functional groups, etc. See Make Bond under 
the Build menu (Chapter 16) for a discussion. Ligand points move 
with the molecule as geometry is altered.

Delete from the Build menu ( ) or the Delete key may be used to 
remove a point or ligand point.

Whether or not points and ligand points are shown as part of the model 
is controlled from the Molecule Preferences dialog (Preferences... 
under the Options menu; Chapter 20).

Define Plane ( )

This defines and displays a reference plane. Selection results in 
display of a message at the bottom left of the screen.

Clicking on three atoms or points defines a plane. As many planes 
as desired may be defined, and these may be used in defining 
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distances, angles, etc. Planes move with the molecule as its geometry 
changes.

Delete from the Build menu ( ) or the Delete key may be used to 
remove a plane.

Whether or not planes are included as part of the model for an is 
controlled from the Molecule Preferences dialog (Preferences... 
under the Options menu; Chapter 20).

Define CFD ( )

This defines the position of a new CFD. The CFD Properties dialog 
(accessible from Properties under the Display menu; Chapter 18) 
allows CFD size and type to be selected. Selection results in display 
of a message at the bottom left of the screen.

Clicking on atoms (or points) in any order, and clicking a second 
time on any one of the atoms (or points) defines the position of a 
CFD (depicted as a transparent sphere labelled Null). Clicking twice 
on only one atom locates the CFD on the atom. As many CFD’s as 
desired can be defined. These move with the molecule as its geometry 
is altered.

Whether or not CFD’s are included as part of the model is controlled 
from the Molecule Preferences dialog (Preferences under the 
Options menu; Chapter 20).

Align ( )

This aligns the selected molecule to all other molecules in the 
same document based either on structure or on CFD’s. If the 
selected molecule is a pharmacophore, aligns the pharmacophore 
to all molecules in the same document (based on CFD’s). Choice 
of whether alignment is based on structure or CFD’s is made from 
the Align by menu that appears at the bottom right of the screen.
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The terms “alignment” and “similarity analysis” have subtly different 
meanings inside of Spartan. Alignment refers to the operation in which 
the molecules and/or pharmacophores in a document are reoriented to best 
coincide with the selected molecule (pharmacophore). Where a molecule 
is selected, alignment may either be based on a set of atoms or on a set 
of CFD’s. Where a pharmacophore is selected, alignment is based on a 
set of CFD’s. A single reorientation is provided for each molecule in the 
document that can be aligned to the selected molecule (pharmacophore).

Similarity analysis refers to the operation in which all molecules in a 
user-specifed library comprising one or more documents are compared 
one-on-one to all molecules and/or pharmacophores in the selected 
document (in the graphical user interface). As with alignment, either 
structural elements or CFD’s may be employed. The result is a similarity 
score from 0 to 1 (1 is perfect) and a manipulatable model of the two 
molecules (or molecule and pharmacophore). It is likely that most  
comparisons will not be successful, and also that some comparisons may 
lead to more than one score (corresponding to different orientations of 
the two components). Similarity analysis both by structure and CFD as 
well as to a pharmacophore is discussed in detail in Chapter 17.

In short, the role of alignment is to orient molecules and/or pharmacophores 
in order to highlight their common features, while the role of similarity 
analysis is to rank pairs of molecules or molecule/pharmacophore pairs 
according to the extent of their common features.

Align Based on Structure

Selection of Structure from the Align by menu results in a 
message at the bottom left of the screen.

Clicking on an atom designates it as an alignment center, and marks 
it with a red circle. Clicking on the circle removes the designation 
(and the circle). Following selection of alignment centers, clicking 
on the Align by button at the bottom right of the screen aligns the 
molecules. If no atoms are selected prior to clicking on Align by, 
then alignment is based on all (non-hydrogen) atoms.

Following alignment, two or more molecules may be displayed 
at once using spreadsheet functions (see Spreadsheet under the 
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Display menu; Chapter 18). Their motions (coordinates) will be 
coupled following alignment, but may be uncoupled allowing the 
aligned molecules to move independently (see Coupled under the 
Model menu; Chapter 14). Note that alignment center selections 
are kept and molecules can be realigned by again selecting Align 
from the Geometry menu (or clicking on ) followed by clicking 
on the Align by button.

Align Based on CFD’s

It is also possible to base molecule alignment on CFD’s. These 
indicate whether a particular center is likely to act as a hydrogen-
bond donor or acceptor, is likely to take on positive or negative 
charge or is a hydrophobe. This is accomplished by choosing CFD 
from the Align by menu at the bottom right of the screen followed 
by clicking on the Align by button. In response, the selected 
molecule is augmented with CFD’s, and a message appears at the 
bottom left of the screen.

Clicking on a CFD designates it as an alignment center and marks 
it with a red circle. Clicking on the circle removes the designation 
(and the circle).

The CFD Properties dialog (accessible from Properties under the 
Display menu; Chapter 18) allows definitions of the individual 
CFD’s to be altered.

Following selection of CFD’s, clicking on the Align by button at 
the bottom right of the screen aligns the molecules. If no CFD’s 
are selected prior to clicking on Align by, then alignment is based 
on all CFD’s.

Following alignment, one or more molecules may be displayed 
at once using spreadsheet functions (see Spreadsheet under the 
Display menu; Chapter 18). Their motions (coordinates) will be 
coupled following alignment, but may be uncoupled allowing the 
aligned molecules to move independently (see Coupled under the 
Model menu; Chapter 14). Note that alignment center selections 
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are kept and molecules can be realigned by again selecting Align 
from the Geometry menu (or clicking on ) followed by clicking 
on the Align by button.

Align to a Pharmacophore

Finally, it is possible to align molecules to a pharmacophore 
contained in the same list. This is set up in exactly the same way 
as alignment based on CFD’s insofar as a pharmacophore element 
is a CFD (see previous section).

For both structure and CFD alignment (and for alignment to 
a pharmacophore), an alignment score from 0 to 1 (perfect 
alignment), is available in the spreadsheet. This is accessed by 
clicking on the Add button at the bottom of the spreadsheet, and 
selecting Alignment Score from the list of available properties 
(see Spreadsheet under the Display menu; Chapter 18). A score 
of 0 is assigned to molecules that cannot be aligned to the selected 
molecule.
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Chapter 16
The Build Menu

The Build menu provides model kits and tools for building and 
editing organic, inorganic and organometallic molecules, as well as 
polypeptides and polynucleotides, for generating lists of substituted 
molecules, and a molecular mechanics procedure for structure 
refinement. This menu also provides seamless access to ChemDraw.

Model Kits

Spartan provides five different model kits for assembling a variety of 
molecular systems: an organic model kit for most organic molecules, 
an inorganic model kit for organic molecules not well represented in 
terms of an uncharged (non-zwitterionic) valence structure, as well as 
inorganic and organometallic molecules, model kits for polypeptides 
and polynucleotides and a model kit for attaching substituents (lists 
of chemical groups) to previously-built molecules. The organic and 
inorganic model kits utilize atomic fragments, functional groups 
and rings (and ligands in the inorganic model kit), while the peptide 
model kit uses the set of natural amino acids as building blocks, and 
the nucleotide model kit the set of nucleotide bases.

Two-dimensional molecular structures (drawings) produced using 
ChemDraw* can also be brought into Spartan and converted to three- 
dimensional structures. 

Molecule construction in Spartan proceeds much in the same manner 
as a chemist would assemble a structure from a model kit, that is, 
pieces are taken from the kit one at a time and added sequentially to 
the molecule under construction.

* Seamless access to ChemDraw is available for the Windows version only. All versions are 
able to read ChemDraw files. ChemDraw is not included with Spartan and must be obtained 
from CambridgeSoft at http://www.cambridgesoft.com.
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Organic Model Kit

The organic model kit contains a suite of molecule building/editing 
tools specifically designed to construct organic molecules.

In the center of the model kit are a selection of atomic fragments, 
which from left to right and then top to bottom, correspond to:

 C(sp3) N(sp3) P(sp3) H
 C(sp2) N(sp2) O(sp3) F
 C(sp) N(sp) O(sp2) Cl
 C(aromatic) N(aromatic) S(sp3) Br
 Si(sp3) N(planar) S(sp2) I

A fragment is chosen by clicking on its icon, which is then displayed 
at the top of the model kit. Once selected, the fragment may be used to 
initiate building, to add alongside of an existing structure or appended 
onto an existing structure. To initiate building, click anywhere on 
screen. To add alongside of an existing structure, first click on the 
Insert button at the bottom right of the screen or hold down the Insert 
key (option key on Mac), and then click anywhere on screen or double 
click in a blank area on screen. To bond to an existing structure, click 
on a free valence (not an atom). (Free valences are colored yellow 
on the selected molecule.) Bond type in the case of atomic fragments 
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with multiple bond types, for example, sp2 carbon, depends on the 
nature of the free valence selected.

While only H, C, N, O, F, Si, P, S, Cl, Br and I are available from 
the organic model kit, other elements may be substituted using atom 
replacement feature available in the inorganic model kit (see General 
Molecule Building Functionality later in this chapter). Similarly, 
bond types may be altered in the inorganic model kit. The latter may 
be necessary in order to alter bonding in structures retrieved from the 
Cambridge Structural Database or ligands obtained from PDB files. Atom 
and bond types may also be altered using the Atom and Bond Properties 
dialogs, respectively (accessible from Properties under the Display 
menu; Chapter 18). Note that bond type (or the fact that bonds may be 
present) is not utilized in quantum chemical calculations, and only atom 
identities and coordinates are required. They are, however, utilized in 
molecular mechanics calculations.

Menus inside the model kit provide access to a number of pre-built 
fragments corresponding to functional groups (Groups) and rings 
(Rings), and to additional libraries of rings (as well as any user-
defined structures) stored in Spartan’s file system (More). The model 
kit also accesses the clipboard (Clipboard).

 Groups 

 Clicking on Groups brings up a menu of groups, and displays an 
icon of one group at the top of the model kit.

 

 Once selected from the menu, a group may be used to initiate 
building, to add alongside of an existing structure on screen, or 
to add to an existing structure. 
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 The amide and carboxylic acid/ester groups have more than one 
different free valence. The free valence that is to be used is marked 
with a gold • (in the icon at the top of the model kit). The marked 
position circulates among the possible positions with repeated 
clicking on the icon.

 Rings

 Clicking on Rings brings up a menu of hydrocarbon rings, and 
displays an icon of one ring at the top of the model kit.

 
 Once selected from the menu, a ring may be used to initiate 

building, to add alongside of an existing structure on screen, or 
to add to an existing structure. 

 Cyclohexane, cycloheptane, napthalene, anthracene, phenanthrene, 
indene and fluorene have more than one different free valence. 
The one that is to be used is marked with a gold • (in the icon). 
The marked position circulates among the available positions with 
repeated clicking on the icon. Selection of an axial or equatorial 
free valence in cyclohexane and cycloheptane is indicated by the 
label ax or eq appearing alongside the icon. All rings in this menu 
are hydrocarbons, but heteroatoms may be substituted (see General 
Molecule Building Functionality later in this chapter).

 More

 This provides access to a broader selection of rings as well as to 
access user-defined entities (rings, groups, ligands, etc.). Upon 
initial entry, the menu to the right of More will be empty. It can be 
populated, by clicking on  to the far right. This brings up a file 
browser that has been set to point toward a directory containing 
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several Spartan files of common rings.

  nitrogen heterocycles saturated nitrogen rings
  oxygen heterocycles saturated oxygen rings
  sulfur heterocycles saturated sulfur rings
  mixed heterocycles saturated mixed rings

  Clicking on a file followed by clicking on Open or double clicking 
on a file fills the menu to the right of More. Menu entries are 
selected in the usual way. In response, a ball-and-wire model of the 
selected ring will appear at the top of the model kit. This may be 
manipulated (rotated, translated, zoomed) using the usual mouse/
keyboard commands (you need to position the cursor inside the 
box). The ring may be used to initiate building, to add alongside 
of an existing structure, or to add to an existing structure. In the 
latter case, the attachment point (on the ring in the window) needs 
to be identified by clicking on the appropriate free valence. 

 Three other collections (ligands, chelates and high-coordination 
fragments) appear in the selected directory. They are intended for 
use with the inorganic model kit as discussed in the next section. 
User-defined libraries may also be accessed (they are normal 
Spartan documents).

 Clipboard

 Clicking on Clipboard accesses the clipboard. A ball-and-wire 
model of whatever is on the clipboard is displayed at the top of 
the model kit. This may be manipulated using the usual mouse/
keyboard commands (you need to position the cursor inside the 
box). Once selected, the contents of the clipboard may be used to 
initiate building, to add alongside of an existing structure, or to 
add to an existing structure. In the latter case, the attachment point 
needs to be identified by clicking on the appropriate free valence.

 An empty clipboard will be signaled by:
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Inorganic Model Kit

Spartan’s inorganic model kit allows construction of a much wider 
class of molecules (including inorganic and organometallic species) 
than possible with the organic model kit. Structures that violate 
conventional bonding rules may be constructed, as this model kit 
purposefully provides no checking. The inorganic model kit is 
reached by clicking on the Inorganic tab, located at the top of the 
organic (peptide, nucleotide or substituent) model kit. (Return to the 
organic, peptide, nucleotide or substituent model kit or to ChemDraw 
is accomplished by clicking on the Organic, Peptide, Nucleotide, 
Substituent or 2D tab, respectively,  in the inorganic model kit).

 
Atoms may be selected by clicking on the center atom button, which 
brings up a full Periodic Table. Main-group elements are colored red, 
transition metals are colored green and lanthanides and actinides are 
colored blue. The Model menu inside the Periodic Table contains a 
selection of theoretical models (basis sets except for semi-empirical 
models). 
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Selecting an entry from this menu leads to recoloring of the Periodic 
Table. A light green color is used to indicate elements for which the 
selected model may be used.* Immediately below is a selection of 
atomic hybrids.

Selection of atom type is effected by clicking on the appropriate 
element in the Periodic Table. The entry will be highlighted. Selection 
of an atomic hybrid follows by clicking on the appropriate icon which 
will then be highlighted.** This combination (atom type + atomic 
hybrid) may be used to initiate building, to add alongside of an existing 
structure or to append onto an existing molecular fragment. To initiate 
building, click anywhere on screen. To add alongside of an existing 
structure, first click on Insert at the bottom right of the screen or 
press the Insert key (option key on Mac), and then click anywhere 
on screen, or double click in a blank area on screen. To bond to an 
existing fragment, click on the appropriate free valence.

Two of the hybrids (trigonal bipyramidal and square-based pyramidal) 
may bond either axially or equatorially. Selection of the appropriate 
bonding point, marked by a •, is effected by repeatedly clicking on 
the icon; the bonding point alternates between the two sites.

Atoms are connected with whatever bond type (partial single, single, 
aromatic, double, triple or quadruple) is selected from a menu below 
atom types in the model kit. A bond type may be changed by first 
selecting a type and then double clicking on the bond. Bond types have 
no impact on quantum chemical calculations, but do affect molecular 

* The existence of either an all-electron basis set or a pseudopotential is sufficient to classify 
a model as available for a particular element. Note that while molecular mechanics models 
are available for all elements, they have been carefully parameterized for only a relatively 
few of these. Use caution in interpreting molecular mechanics geometries for molecules 
incorporating heavy main-group elements, transition metals, lanthanides and actinides.

** Hybrids for a number of high-coordination centers are available as a library reachable from 
More (see discussion under Organic Model Kit).
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mechanics calculations which reference a Lewis structure (including 
minimization in the builder; see discussion later in this chapter).

No valence checking is performed in the inorganic model kit, and the 
user is free to construct any arrangement of atoms.

Menus under Groups, Rings and More are the same as those 
described for the organic model kit as is Clipboard. One additional 
fragment collection is provided:

 Ligands
 This provides access to a number of pre-built ligands, useful in 

the construction of inorganic and organometallic molecules. Its 
operation is analogous to that for the Groups and Rings menus. 
Clicking on Ligands brings up a menu of available ligands, and 
results in an icon of one ligand from this menu being displayed 
at the top of the model kit.

 

A ligand may be used to initiate building or to add alongside or to an 
existing structure. Additional ligands are accessible from More (see 
previous discussion). Ligands may also be built with the aid of ligand 
points (Define Point in the Geometry menu; Chapter 15).
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Peptide Model Kit

A model kit for construction of polypeptides is reached by clicking on 
the Peptide tab located at the top of the organic, inorganic, nucleotide 
and substituent model kits. (Return to the organic, inorganic, nucleotide 
or substituent model kit or to ChemDraw is accomplished by clicking 
on the Organic, Inorganic, Nucleotide, Substituent or 2D tab, 
respectively,  in the peptide model kit.) This builder is not intended to 
be used for constructing proteins (although this is actually possible). 
Rather, it is primarily intended to build idealized helix and sheet 
structures. Protein structures are best entered from the Protein Data 
Bank (see Access PDB Online... under the File menu; Chapter 12).

At the middle of the peptide model kit are icons designating the 
amino acids (specified by their usual three-letter codes). An amino 
acid is selected by clicking on its three-letter code, following which 
either an icon of the amino acid is displayed in the box at the top of 
the model kit, or the three-letter code for the amino acid is appended 
to the sequence of codes in the box. Amino acids replace atoms, 
functional groups, rings and ligands as the building blocks in the 
peptide model kit. Because these other building blocks are missing, 
modifications of  peptides, aside from modifications in sequence and 
in overall conformation, need to be carried out using the organic or 
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inorganic model kits.

There are two different modes of operation: single amino acid mode 
and polypeptide mode. The former is used to initiate building with a 
single amino acid, to add a single amino acid alongside of an existing 
structure or to add a single amino acid to an existing structure, while 
the latter is used to construct amino acid sequences (polypeptides).  
Sequence off (unchecked) corresponds to single amino acid mode, 
and on (checked) corresponds to polypeptide mode.

Peptide construction (Sequence on) is accomplished in three steps:

 Specification of Amino Acid Sequence

 This is accomplished by clicking in the desired order on the 
amino acid codes. Building occurs from the N end  to the C 
end of the peptide. In response to each selection, the three-
letter code is appended to the sequence of codes in the box 
at the top of the model kit. The stereochemical configuration 
of the amino acid is by default the l configuration; this may 
be changed to the d configuration prior to selection of the 
amino acid, by checking d to the right of stereoisomer in 
the model kit. (It may be changed back to l by checking l). d 
amino acids are indicated by .d following the code in the box.

 The sequence may be altered by changing the text in the box. 
Existing amino acid codes may be deleted or changed or new codes 
can be added. The entire sequence may be specified in this way 
if desired. Specification of a non-existent code will result in an 
error message. The sequence can be cleared by clicking on Clear.

 Specification of Macroscopic Structure

 Once sequencing is complete, macroscopic structure (ψ and φ 
angles), is  specified by clicking  on one of α Helix, β Sheet or 
Other. In the case of the first two, preset angle values are displayed 
on the right. In the case of specification of Other, boxes appear, 
into which the desired dihedral angles need to be entered.
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 Termination

 The peptide is not yet terminated, and the two ends are still set up 
for addition of further amino acids.

 

O
C

*
C end

N
H

*
N end

 where the * indicates a free valence. Clicking on Terminate at 
the bottom of the model kit leads to the Terminate dialog.

 
 C and N terminating groups may be selected by repeated clicking 

on the C and N icons, respectively. Selection will rotate among 
the available terminating groups. Clicking on OK removes the 
dialog and terminates the polypeptide. Clicking on Cancel or  
removes the dialog but does not terminate the polypeptide.

The peptide (or single amino acid) may now be used either to initiate 
building, by clicking anywhere on screen or added alongside of an 
existing structure, by first clicking on Insert at the bottom right of 
the screen or pressing the Insert key (option key on Mac), followed 
by clicking anywhere on screen, or double clicking in a blank area 
on screen. If unterminated, it may also be joined onto an existing 
structure by clicking on a free valence. In the latter case, attachment 
is made from the N end, unless the free valence corresponds to an 
unterminated peptide fragment, in which case the appropriate end 
required to make an amide bond is used.
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Nucleotide Model Kit

Finally, Spartan provides a model kit for construction of 
polynucleotides. It is reached by clicking on the Nucleotide tab which 
is located at the top of the organic, inorganic, peptide and substituent 
model kits. (Return to the organic, inorganic, peptide or substituent 
model kit or to ChemDraw is accomplished by clicking on the 
Organic, Inorganic, Peptide, Substituent or 2D tab, respectively, 
in the nucleotide model kit.)

At the middle of the model kit is a menu designating the type of 
polynucleotide.

     DNA
     DNA (single strand)
     DNA-RNA
     RNA
     RNA (double strand)
     RNA-DNA

Immediately below this menu are icons, designating the nucleotide 
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bases. Selection of DNA, DNA (single strand) or DNA-RNA from 
the menu leads to one set of icons.

Selection of RNA, RNA (double strand) or RNA-DNA leads to a 
second set, the only difference is that uracil (U) has been substituted 
for thymine (T).

A nucleotide base is selected by clicking on its letter, following 
which either an icon of the base is displayed in the box at the top of 
the model kit, or the letter for the base is appended to the sequence 
of letters in the box. Nucleotide bases replace atomic fragments, 
functional groups, rings and ligands as the building blocks in the 
nucleotide model kit. Because these other building blocks are missing, 
modifications of nucleotides, aside from modifications in sequence 
and helical structure, need to be carried out using either the organic 
or inorganic model kits.

There are two different modes of operation: single base mode and 
polynucleotide mode. The former is used to place a single base or base 
pair on screen, to add a single base or base pair alongside of an existing 
structure, or to add a single base or base pair to an existing structure, 
while the latter is used to construct strands of DNA or RNA (or mixed 
strands). Sequence off (unchecked) corresponds to single base (base 
pair) mode and on (checked) corresponds to polynucleotide mode.

Polynucleotide construction (Sequence on) is accomplished in two 
steps:

 Specification of Base Sequence 

 This is accomplished by clicking in order on the base codes. In 
response to each selection, the letter code is appended to the 
sequence of codes in the box at the top of the model kit. The 
sequence may be altered by editing the contents of the box. 
Existing base codes may be deleted or changed or new codes 
added. The entire sequence can be specified in this way if desired. 
The sequence may be cleared by clicking on Clear.
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 Specification of Helical Structure 

 Once sequencing is complete, a helical structure may be specified 
by clicking on A or B. These correspond to A and B helices, 
respectively. Selecting Other allows user modification of  the 
rise (in Å) per base (Rise/Base) and twist (in degrees) per base 
(Twist/Base).

Note that the polynucleotide is not yet terminated, and the two ends 
are still set up for addition of further bases or base pairs.

O

O

CH2OPO2

*

Base *

* indicates a free valence. Hydrogens occupy all free valences (except 
the *’ed positions at the two ends of the chain). 

The polynucleotide (or single base pair) may now be used to either 
initiate building, by clicking anywhere on screen, added alongside of 
an existing structure, by first clicking on Insert at the bottom right of 
the screen or pressing the Insert key (option key on Mac) followed 
by clicking on screen, or double clicking on a blank area on screen, 
or joined onto an existing structure by clicking on a free valence. In 
the latter case, attachment is made from the phosphate end.

Substituent Model Kit

The substituent model kit designates one or more locations for libraries 
of substituents to be added to a molecule. Additionally, it designates 
one or more carbon hybrids for replacement by their heteroatom 
equivalents, for example, sp3 carbon by sp3 nitrogen. There are two 
uses for the Substituent model kit. The first is to facilitate assembling 
lists of molecules that differ only in substitution and/or heteroatom. 
The second application is to use molecules incorporating one or more 
substituent libraries as queries in searches of the Spartan Molecular 
Database and Spartan Spectra and Properties Database (see Open 
Databases under the Search menu; Chapter 19) or as elements of 
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reaction energy calculations (see Reactions under the Display menu; 
Chapter 18). Here, the search or reaction energy calculation is not 
confined to a single molecule but rather is open to a set of molecules 
that are related by substitution. Further discussion is provided in the 
appropriate sections of Chapters 18 and 19.

The substituent model kit is accessed by clicking on the Substituent 
tab located at the top of the organic, inorganic, peptide and nucleotide 
model kits. (Return to the organic, inorganic, peptide or nucleotide 
model kit or to ChemDraw is accomplished by clicking on the 
Organic, Inorganic, Peptide, Nucleotide or 2D tab, respectively, 
in the substituent model kit.)

At the center of the model kit are four rows of buttons. Buttons in 
the first two rows provide access to predefined substituent libraries: 
R (alkyl groups), Ar (aromatic groups), OR (alkoxy groups), EDG 
(electron donor groups), EWG (electron withdrawing groups) and 
LG (leaving groups). Buttons in the third row allow access to user-
defined substituent libraries (Cust. A, Cust. B, Cust. C), while those 
in the last row permit substitution of heteroatom hybrids for sp3, sp2 



264 Chapter 16

and aromatic carbons incorporated in a molecule. Immediately below 
the buttons, a dialog lists the entries in the individual libraries (the 
three custom libraries should be blank upon initial entry). As entries 
are selected, they will appear in the window at the top of the dialog. 
Predefined libraries may not be altered and individual entries may not 
be renamed, but existing library entries in custom libraries may be 
renamed or deleted and new entries added. Modifications to existing 
substituent libraries need to be performed following attachment using 
the Substituent Properties dialog (accessible from Properties under 
the Display menu; Chapter 18).

Creating lists of substituted molecules starting from an unsubstituted 
molecule occurs in three stages: library preparation, attachment and 
(optionally) list generation. 

 Library Preparation

 Six substituent libraries have been provided.

 R (alkyl group): methyl, ethyl, n-propyl, isopropyl, n-butyl, sec-butyl, 
isobutyl, t-butyl, t-amyl

 Ar (aromatic ring): phenyl, p-tolyl, p-nitrophenyl, 1-naphthyl, 2-naphthyl, 
2-pyridyl, 3-pyridyl, 4-pyridyl

 OR (alkoxy group): methoxy, ethoxy, n-propoxy, isopropoxy, t-butoxy

 EDG (electron donor group): hydroxy, methoxy, ethoxy, phenoxy, amino, 
dimethylamino, mercapto, methylthio, phenylthio

 EWG (electron withdrawing group): cyano, nitro, trifluoromethyl, carboxy, 
formyl, methoxycarbonyl, ethoxycarbonyl, methyl sulfonyl, methyl 
sulfoxyl

 LG (leaving group): bromo, iodo, tosylate, triflate, mesylate

 The contents of an existing library may be displayed in the scroll 
box at the bottom of the model kit by clicking the appropriate 
button. A ball-and-wire model of a substituent may be seen at the 
top of the model kit by clicking on its name in the scroll box. The 
model may be manipulated in the usual way. The attachment point 
is indicated by a gold ball surrounding a free valence.
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 To create a custom substituent library, first click on the Cust. A, 
Cust. B or Cust. C buttons inside the model kit. The scroll box 
is empty. If a substituent (set of substituents) has previously been 
copied to the clipboard, it may be pasted into the library by right 
clicking inside the scroll box and selecting Paste from the menu 
that appears. Alternatively, a substituent (set of substituents) may 
be appended to the document (including an empty document) by 
right clicking inside the scroll box, selecting Append from the 
menu that results and selecting a Spartan document comprising 
one or more molecules from the browser. Finally, any Spartan 
document may be dragged onto the scroll box from the file 
system. As many substituents (sets of substituents) as desired may 
be pasted, appended and/or dragged into a library. To remove a 
substituent from the library, right click on its name in the scroll 
box and select Delete from the menu that appears. Ctrl (command 
for Mac) and Shift keys may be used in the usual way.

 Substituents need to be specified in terms of both their structure 
and their connection point. One way to do this is to specify the 
latter is to replace all free valences except the one that will serve 
as the connection point by hydrogens. For example, to designate a 
2-pyridyl substituent, add hydrogens (  from the organic model kit) to 
four of the five free valences in pyridine, leaving only one free valence in 
the 2-position available. Alternatively, a connection point can be specified 
by clicking on the appropriate position as the substituent displayed at the 
top of the model kit. 

 The three buttons in the last row designate heteroatom equivalents 
of carbon-based hybrids.

 sp2: carbon ( ), nitrogen ( )
 sp3: carbon ( ), nitrogen ( ), oxygen ( )
 Arom: carbon ( ), nitrogen ( )



266 Chapter 16

 Attachment

 Following selection, a substituent library may be used to initiate 
building, to add alongside of an existing structure or to attach to an 
existing structure. The model is augmented by an icon containing 
the library name from the button, for example EWG, followed by 
a number. As many substituent libraries as desired may be attached 
to a molecule. Each library is given a unique label, that can be 
changed prior to list generation using the Substituent Properties 
dialog. A substituent library may be removed from the molecule 
by selecting Delete from the Build menu and then clicking on the 
library icon.

 A document containing one or more molecules with attached substituent 
libraries may be saved prior to list generation just as any other Spartan 
document. Any queries (bond distances, angles, etc.) and calculations refer 
to the unsubstituted molecule, that is, hydrogens replacing substituent 
markers. Database searches on the Spartan Molecular Database (SMD) 
or Spartan Spectra and Properties Database (SSPD) and reaction energy 
calculations based on entries in SMD or SSPD pertain to all possible 
substituted molecules.

 List Generation

 Generation of a list of substituted molecules follows specification 
and (optionally) editing of one or more substituent libraries and 
attachment of each of these libraries at one or more positions in a 
molecule. Duplicates are eliminated. Clicking on Generate List 
at the bottom of the model kit, leads to the Generate List dialog.

 
 A box at the top of the dialog allows the user to specify (or modify) 
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a Name Template, from which the names of substituted molecules 
will be derived. Upon entry, this takes the form.

 Ax-By-Cz-molecule name

 A, B, C are the names of the substituent libraries (R, EWG, etc.), x, 
y, z are integers and molecule name is the name of the unsubstituted 
molecule if and as it appears in the Spartan Molecular Database 
(SMD) or in the Spartan Spectra and Properties Database (SSPD). 
If the unsubstituted molecule is not in the database, then the box 
below Name-Template will be blank. If the substituted molecule 
is in SMD or SSPD, its name in the database may be used (instead 
of the name generated from the template) by checking the box to 
the left of Use names from SMD or SSPD where possible.

 Nulls are molecules with less than the full complement of 
substituents, for example, monosubstituted molecules in the case 
where two different positions have be substituted. These will not 
be included in the list of substituted molecules unless Generate 
Nulls is checked.

 Note, that the conformations of the substituted molecules are 
arbitrary and they have not been subjected to energy minimization 
to relieve unfavorable crowding interactions. Therefore, the list 
entries should be examined, conformations adjusted as appropriate 
and minimized with molecular mechanics prior to using them for 
quantum chemical calculations.

 The list may either be written to a New Document or appended 
to the end of the Current Document.

Accessing ChemDraw (NAL, NAM)

The ChemDraw program may be seamlessly accessed inside of 
Spartan** allowing chemical drawings to be produced in a familiar 
environment and then brought over as 3D structures***. The conversion 

* ChemDraw files (.cdx) may be read with all versions of Spartan.
** ChemDraw is not provided with Spartan but must be obtained from CambridgeSoft at  

http://www.cambridgesoft.com.
*** Transfer is one directional only. 3D structures that have been altered may not be transferred 

back to ChemDraw.
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is unambiguous as long as all stereochemical cues are in place in the 
2D drawing. Note that the conformation implied by the 2D drawing 
may be ambiguous and need to be altered. 

To access ChemDraw, enter the builder, click on the 2D tab and click 
on Edit at the bottom of the panel that results. ChemDraw will appear. 
To return to Spartan, close ChemDraw. The 2D drawing will appear 
at the center of the panel and manipulatable 3D structure will appear 
at the top of the panel. Clicking on screen will move the 3D structure 
into Spartan’s main window.

General Molecule Building Functionality

Additional capabilities are available with Add Fragment selected:

Multiple Fragments

Multiple fragments may result either from bond breakage (see 
Break Bond later in this chapter) or from use of the Insert 
button or Insert  key (option key on Mac), or double clicking 
in a blank area on screen. A fragment is selected by clicking 
on it, following which the associated free valences are colored 
gold (free valences for any non-selected fragments are colored 
white). All builder functions apply to the selected fragment only. 
Rotation and translation also apply to the selected fragment, 
but may be made to apply to the entire set of fragments by 
holding down the Ctrl key while carrying out these operations.

Fragments may be attached using Make Bond (see discussion 
later in this chapter).

Bond Rotation/Bond Stretching

In addition to molecule rotation, translation and scaling, the mouse 
is used to rotate about and stretch bonds not incorporated into rings. 
This is accomplished via the following sequence of operations:

(i) Clicking on the bond, which is then marked by a red 
cylindrical arrow. (The bond connecting the last atom, group, 
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ring or substituent  added to the molecule is automatically 
selected.)

(ii) Simultaneously holding down the Alt key (option key on 
Mac) and the left mouse button while dragging the mouse 
up and down, for bond rotation, or the Alt (option) key and 
the right mouse button for bond stretching.

Atom/Fragment Replacement

Another function of the mouse is atom replacement. This 
behaves differently in the organic and inorganic model kits. 
Double clicking on an atom (not a free valence) while an atomic 
fragment in the organic model is highlighted, replaces the atom by 
selected fragment. Free valences are adjusted to accommodate the 
replacement, for example, replacement of sp3 carbon by sp3 oxygen 
results in two free valences being removed. Atom replacements 
that violate valence rules or that would disrupt substituents are 
not permitted. Double clicking on an atom (not a free valence) 
while an element in the Periodic Table from the inorganic model 
kit is selected, replaces the atom by the selected element, that 
is, changes the atomic number. No changes in the number or 
arrangement of free valences is made, and no checking is done. 
Atom replacement is not available in the peptide, nucleotide and 
substituent model kits.

Chirality Inversion

In the Add Fragment mode, double clicking on a  chiral atom 
with the Ctrl key (command key on Mac) depressed inverts the 
chirality of the atom (R→S or S→R). This is not available in 
fused ring systems. Double clicking on any atom with both Ctrl 
(command key on Mac) and Shift keys depressed inverts the 
absolute configuration of the molecule.
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Building/Editing Menu Functions

Molecule building/editing functions are found under the Build 
menu.

View ( )

This exits build mode, and removes the model kit from the screen.

Initial entry into build mode is by way of New or New Molecule under 
the File menu (Chapter 12). Add Fragment, Delete, Make Bond, 
Break Bond and Minimize are for modifying existing structures.

Add Fragment ( )

In addition to the capabilities discussed under General Molecule 
Building Functionality, this allows access to the libraries of 
atomic fragments, groups, rings, ligands and substituents, as well 
as the file system and the clipboard. Clicking on any buttons or 
menus in the organic, inorganic, peptide, nucleotide or substituent 
model kits, leads to Add Fragment. (If a model kit is not already 
on screen, selection brings up the last-accessed model kit.) A 
fragment may be used to initiate building by clicking anywhere on 
screen, to add alongside an existing structure on screen by clicking 
on the Insert button at the bottom right of the screen or pressing 
the Insert key (option key on Mac) followed by clicking anywhere 
on screen, or by double clicking in a blank area on screen, or be 
added to an existing structure by clicking on the appropriate free 
valence. Fragment addition can be terminated by selection of any 
other function.
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* Free valences can be protected without altering the molecule by adding hydrogens to them 
(  from the organic model kit). One use of this is in conjunction with custom substituent 
libraries (see discussion under Substituent Model Kit earlier in this chapter).

Delete ( )
This allows atom, free valence and substituent library removal from a 
structure. Selection leads to a message at the bottom left of the screen.

Subsequent clicking on an atom, free valence or substituent library 
results in its deletion. Deletion of an atom results in deletion of 
all of its associated free valences. Free valences for any atoms to 
which the deleted atom was previously connected are restored. 
Note that atom deletion may result in one or more detached 
fragments. Clicking inside a selection box results in deletion of 
everything inside the box. Selection of Delete does not bring up a 
model kit nor does it remove a model kit that is present on screen. 
Delete may be terminated by selection of any other function.

Delete is also used to delete points and planes, CFD’s and 
pharmacophore elements as well as spectra and plots (or individual 
curves that make up plots). Be careful!

Deletion may also be accomplished by holding down on the Delete 
key while clicking on the item to be deleted.

Make Bond ( )
This allows bonds to be drawn between free valences and/or atoms. 
Selection leads to a message at the bottom left of the screen.

Clicking on two free valences (on different atoms) will cause 
these atoms to be linked by a single bond. Alternatively, double 
clicking on each of two atoms will bond them, and clicking on a 
free valence on one atom and double clicking on a different atom 
will bond the two atoms. Note that available free valences are 
consumed as a result of bond formation, irrespective of whether 
free valences or atoms are selected.* If the selected atoms are 
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already bonded, this will result in the bond order being increased 
by one, that is, single → double, double → triple. Selection of 
Make Bond does not bring up a model kit nor does it remove a 
model kit that is already present on screen. Make Bond may be 
terminated by selection of any other function.

Break Bond ( )
This allows breaking an existing bond resulting in free valences. 
Selection leads to a message at the bottom left of the screen.

Clicking on a bond breaks it and restores free valences. Note that 
bond breaking may result in detached fragments. Selection of 
Break Bond does not bring up a model kit nor does it remove a 
model kit that is present on screen. Break Bond may be terminated 
by selection of any other function. 

Minimize ( )

This uses MMFF molecular mechanics to refine the geometry. 
Selection leads to a message at the bottom left of the screen.

The molecular mechanics energy* in kJ/mol, displayed at the 
bottom right of the screen, is continually updated during the 
minimization process. Minimization may be stopped at any time 
by clicking on the  icon at the bottom right of the screen. Any 
geometrical constraints imposed on the structure (see Constrain 
Distance, Constrain Angle, Constrain Dihedral in Chapter 
15) are enforced during minimization. NOE’s are not taken into 
account. Also, any frozen atoms in the structure (see Freeze 
Center under the Geometry menu; Chapter 15) remain frozen. 
Following completion, Minimize reverts back to Add Fragment 
only if a model kit is on screen.

* The mechanics energy is a combination of the strain energy which is necessarily positive and 
the non-bonded or intramolecular interaction energy which can be either positive or negative. 
It will most commonly be a positive quantity, although it can be slightly negative.
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Chapter 17
The Setup Menu

This chapter describes functions available under the Setup menu. 
Calculations is used to specify molecular mechanics calculations, 
semi-empirical calculations, Hartree-Fock molecular orbital 
calculations and correlated calculations, including density 
functional calculations, Møller-Plesset calculations, coupled cluster 
calculations and quadratic configuration interaction calculations 
for ground-state species, and configuration interaction calculations 
and (time dependent) density functional calculations for excited-state 
species. Tasks include calculation of energy, equilibrium structure 
and conformation, transition-state structure and constructing energy 
profiles, although not all tasks are available for some methods. In 
addition, Hartree-Fock and density functional calculations may be 
extended to include an empirical solvation term, allowing equilibrium 
and transition-state structures, infrared spectra and molecular 
properties to be obtained in the presence of a solvent. (Solvated NMR, 
Raman and UV/visible spectra are not available.) A wide variety of 
all-electron Gaussian basis sets are supported for Hartree-Fock and 
correlated calculations as are pseudopotentials for calculations on 
molecules incorporating elements for which all-electron basis sets are 
not available. Also provided are a number of thermochemical recipes, 
including G3 and G3(MP2), as well as the T1 recipe that has been 
parameterized to closely reproduce G3(MP2) heats of formation with 
2-3 orders of magnitude less computation time. Calculations also 
requests IR, Raman, NMR and UV/visible spectra, and calculation and 
printing of a variety of molecular properties, QSAR descriptors and 
thermodynamic quantities. Finally, Calculations specifies conditions 
for identifying similar molecules, based either on molecular structure 
or chemical functionality, as well as for identifying molecules 
that are compatible with a particular molecular environment (a 
pharmacophore).
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Surfaces is used to designate graphical surfaces, including electron 
and spin densities, electrostatic potentials, local ionization potentials 
and molecular orbitals, for later display as surfaces, property maps 
and contour plots. Accessible regions on electron density surfaces 
and property maps based on these surfaces may be demarked.

Submit is used to direct jobs for calculation, either locally or on a 
remote Linux server. Multi-core processors may either be used to 
simultaneously process different jobs or (for most tasks involving 
Hartree-Fock, density functional and RI-MP2 models) may be 
directed at a single job.

The Setup menu provides access to dialogs for specifying molecular 
mechanics and quantum chemical calculations, for specifying 
conditions for similarity analysis as well as specifying surfaces and 
property maps and for submitting jobs for calculation.

Calculations...

Calculations modules perform: molecular mechanics calculations 
using the SYBYL and MMFF force fields; MNDO (MNDO/d for 
second-row elements), AM1, RM1, PM3 and PM6 semi-empirical 
calculations, including PM3 and PM6 calculations on transition-
metal inorganic and organometallic systems; Hartree-Fock molecular 
orbital calculations; BP, BLYP, EDF1, EDF2 and B3LYP among other 
density functional calculations, including calculations based on a user-
specified mix of existing exchange and correlation functionals; MP2 
and RI-MP2 Møller-Plesset calculations; configuration interaction 
calculations (for excited-state species). All are applicable to energy 
calculation, equilibrium and transition-state geometry determination, 
conformational searching and energy profile construction, although 
some methods may not be practical for some tasks. Available for 
energy calculations only, are a series of high-order correlated models, 
including MP3 and MP4 Møller-Plesset models, coupled cluster 
models and quadratic configuration interaction models. 
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A wide selection of basis sets is available, ranging from the STO-3G 
minimal basis set (recommended for Hartree-Fock models only), to 
the 3-21G split-valence basis set (recommended for Hartree-Fock 
models only), to 6-31G*, 6-311G*, and cc-pVDZ, cc-pVTZ, cc-pVQZ 
and cc-pV5Z polarization basis sets. In addition, pseudopotentials for 
elements which all-electron basis sets do not exist are available. Note, 
however, that first derivatives of pseudopotentials in the case where 
the valence incorporates f-type and higher order functions are not 
presently available. All basis sets, except STO-3G and 3-21G, may 
be supplemented with polarization functions on hydrogen, additional 
and/or higher-order polarization functions on heavy atoms and/or 
diffuse functions on hydrogens and/or heavy atoms.

Finally, a series of recipes for estimating heats of formation are 
available. These include the G3 and G3 (MP2) recipes as well as the 
T1 recipe that is based on G3(MP2) and provides nearly identical 
heats of formation, but is two to three orders of magnitude less costly 
in terms of computation.

Quantum chemical calculations also result in a variety of atomic 
and molecular properties, QSAR descriptors and thermodynamic 
quantities as well as IR, Raman, NMR and UV/visible spectra. 
IR spectra are available for molecular mechanics, semi-empirical, 
Hartree-Fock, density functional and MP2 and RI-MP2 models. Other 
spectra are available only for Hartree-Fock and density functional 
models. Note, however, that NMR spectra are not presently available 
with pseudopotentials.

Solvent may be introduced in one of two ways, both of which involve 
empirical formulations. The simpler and less costly in terms of 
computation is to add the aqueous solvation energy obtained using the 
semi-empirical SM5.4 model to the energy of any molecular mechanics 
or quantum chemical calculation. Equilibrium and transition-state 
geometries as well as spectra and any properties derived from the 
wavefunction are unaffected. A second and computationally more 
costly method is based on the more recent SM8 model. Here, the 
correction affects the wavefunction in addition to the energy. This 
means that it can be used to obtain equilibrium and transition-state 
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geometries as well as infrared spectra and most properties that depend 
on the wavefunction. The SM8 solvation correction is limited to 
Hartree-Fock and density functional models, and applies to water in 
addition to a variety of organic solvents. A listing of available solvents 
is provided in the Properties FAQ section accessed from the Help 
menu. Solvent-corrected Raman, NMR and UV/visible spectra are 
not available.

Discussion of molecular mechanics and quantum chemical methods 
in general, focusing on the specific methods available in Spartan, is 
provided both in Topics under the Activities menu and in A Guide to 
Molecular Mechanics and Quantum Chemical Calculations which 
is provided as a PDF under the Help menu. The guide also discusses 
how different methods may be combined, as well as illustrates 
graphical modeling techniques. 

Finally, the Calculations dialog accesses a procedure to quantify the 
extent to which two molecules or a molecule and a pharmacophore 
are similar. This does not involve either molecular mechanics or 
quantum chemical calculations but depends only on geometry of the 
molecule (pharmacophore).

Selection of Calculations... results in the Calculations dialog*.

This contains a number of pull-down menus, buttons, check boxes 
and a space to enter additional information (keywords):

* The dialogs associated with similarity analysis and with conformer library generation are 
different from that associated with the other entries under the Calculate menu, and will be 
presented later in this chapter.
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Calculate

This section contains a series of menus and check boxes that 
specify the task to be accomplished, the electronic state (ground or 
first excited), the type of calculation, method, basis set and solvent 
to be employed, as well as details specific to each calculation type.
Task
Specification of Task is by way of a pull-down menu:

Energy specifies calculation of energy (and in the case of quantum 
chemical methods, a wavefunction) at a single geometry. 

Spartan reports energies from molecular mechanics calculations in 
kJ/mol, from semi-empirical calculations and from T1, G3(MP2) and 
other thermochemical recipes as heats of formation in kJ/mol, and from 
Hartree-Fock and correlated calculations as total energies in atomic units 
(hartrees).

The molecular mechanics energy comprises two parts: the strain energy 
and the non-bonded energy. The strain energy is the difference in energy 
between a molecule and its strain free analog. It is nearly always positive 
and less than a few hundred kJ/mols in magnitude. The non-bonded energy 
accounts for attraction or repulsion between atomic centers that are not 
connected due to van der Waals and Coulombic interactions. Because the 
strain energy of every molecule relates to a different standard, molecular 
mechanics energies cannot be used to obtain reaction energies (unless 
there are no changes in bonding between reactants and products).

The heat of formation is to the enthalpy at 298K of a balanced chemical 
reaction in which a molecule is converted to a set of standard products. 
For example, the heat of formation of ethylene is given by reaction,

C2H4 → 2C (graphite) + 2H2 (gas)

where graphite and hydrogen molecule are the carbon and hydrogen 
standards, respectively. In practice, the actual measurement is typically 
carried out for a combustion reaction, for example, for ethylene:
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C2H4 + 3O2 → 2CO2 + 2H2O

Heats of formation may either be positive or negative quantities and 
generally span a range of only a few thousand kJ/mol.

Heats of formation are not suitable for presenting energy data from most 
quantum chemical calculations (except thermochemical recipes), simply 
because the standards for several important elements (most notably, 
carbon) are not well-defined isolated species. In its place is the energy 
of a reaction that splits a molecule into isolated nuclei and electrons, for 
example, for ethylene:

C2H4 → 2C+6 + 4H+ + 16e–

Total energies, as the energies of such reactions are termed, are always 
negative and may be very large (tens of thousands of kJ/mol). They are 
most commonly given in atomic units (hartrees).

1 atomic unit = 2625 kJ/mol

Aside from a difference in units (see Appendix E), it makes no 
difference whatsoever which standard is employed to investigate 
thermochemistry.

To summarize, the heat of formation differs from the total energy both with 
regard to the standard reaction and with regard to units. Either provides 
a suitable basis for thermochemical calculations.

Equilibrium Geometry specifies that the nearest energy minimum 
will be located, and Transition State Geometry that the nearest 
first-order saddle point (energy maximum in one dimension and 
energy minima in all other dimensions or commonly known as 
a transition state) will be located. Equilibrium Conformer, 
Conformer Distribution and Conformer Library attempt to 
characterize the conformers available to a molecule based on 
different criteria (see discussion following). Energy Profile steps 
along a user-defined coordinate or set of coordinates. Similarity 
Analysis quantifies the likeness among molecules based either 
on structure or chemical functionality or between molecules and 
a template (a pharmacophore).
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Three different conformational analysis procedures are available in 
Spartan. The first two (Equilibrium Conformer and Conformer 
Distribution) may be employed with a variety of molecular mechanics 
and quantum chemical models (although practical concerns may limit 
application to molecular mechanics), while the third (Conformer 
Library) is restricted to the MMFF molecular mechanics model.

Equilibrium Conformer replaces the initial conformer of a molecule 
by the lowest-energy conformer. This procedure is typically used to get 
a good guess at the best (lowest-energy) conformer for calculation of 
properties using quantum chemical methods.

Conformer Distribution provides a selection of low-energy conformers. 
This procedure is commonly used to identify a set of energetically 
accessible conformers and construct a Boltzmann distribution for 
calculation of average molecular properties.

Except for molecules with very few degrees of conformational freedom 
full systematic searches (looking everywhere) are not likely to be 
practical. A Monte-Carlo search follows a path that biases in favor of 
low-energy conformers (but that does not completely exclude high-energy 
conformers). While there is no guarantee that the lowest-energy conformer 
(the global minimum) will actually be located, it can be shown that the set 
of conformers examined (and kept) approach a Boltzmann distribution. 
(This is strictly true only for a large number of search steps, but is closely 
approximated for searches with reasonable numbers of steps.)

Conformer Library replaces the initial conformer of a molecule by 
the lowest-energy conformer and attaches the coordinates of a set of 
conformers spanning all shapes accessible to the molecule without regard 
to energy. Used to build libraries for similarity analysis.

The following recipe is used to generate a conformer library:

 1. Step through all possible conformers in a systematic manner and 
calculate equilibrium structures and energies for each using the MMFF 
force field. Eliminate duplicates and very high-energy conformers.

 2. Place spheres on each nitrogen, and oxygen atom and at the center 
of each hydrophobic region for each conformer.

 3. Find the smallest set of conformers for which spheres do not overlap, 
that is, eliminate any conformer for which all of its spheres overlap 
with the corresponding spheres on another conformer.
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Because this procedure involves a systematic search of all possible 
conformers, it is desirable to use a set of conformer assignment rules 
that eliminate degrees of freedom, but are unlikely to produce significant 
shape changes. See Set Torsions under the Geometry menu (Chapter 15) 
and Settings Preferences under the Options menu (Chapter 20). A limit 
may be placed on the total number of conformers actually considered. 
This is known as a restricted systematic search, a procedure that walks 
through all possible conformers but randomly discards some without 
further minimization in order to enforce a fixed number of conformers. 
Conformers Examined sets this number and Conformers Kept (≤ to 
Conformers Examined) sets the number that are actually kept. This is 
different from the Monte-Carlo method, in that it strives to span all possible 
shapes open to a flexible molecule without consideration of energy.

Selection of Conformer Library results in a different dialog.

Conformers Examined, sets the maximum number of conformers.

Energy applies to all methods. Equilibrium Geometry, 
Equilibrium Conformer, Conformer Distribution and Energy 
Profile does not apply to advanced correlated methods and 
thermochemical recipes. Transition State Geometry does not 
apply to molecular mechanics methods, advanced correlated 
methods and thermochemical recipes. Conformer Library applies 
only to MMFF molecular mechanics. Similarity Analysis does not 
involve any molecular mechanics or quantum chemical methods.
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State

Specification of State (electronic state) is by way of a pull-down 
menu. The default setting Ground (state) may be changed to 
First Excited (state) by clicking on  to the right of the box 
and back again to Ground (state) by clicking on . Different 
methods are available to handle ground and excited-state species.* 
Hartree-Fock, Møller-Plesset as well as a variety of advanced 
correlated methods are available only for ground-state species, 
while configuration interaction methods are available only for 
excited-state species. Density functional methods are available 
for both ground and excited-state species. State is ignored for 
molecular mechanics calculations, and semi-empirical calculations 
are limited to the ground state.

Type of Calculation

Specification of Type of Calculation is by way of a menu, the 
selections in which depend on electronic state. For ground states:

For excited states:

Some calculation types require additional information:

Molecular Mechanics  Møller-Plesset 

Semi-Empirical  Advanced 

* Note that gradients for density functional methods for excited states need to be calculated 
numerically. This means that determining an equilibrium geometry for an excited state of a 
molecule is significantly slower than determining an equilibrium geometry for the ground 
state. Analytical gradients for CIS and CIS(D) methods for excited states are available. 

** A number of other advanced correlated methods are available, but need to be entered directly 
into the Options box: CCSD(2), OD, OD(T), QCCD, QCCD(2), QCISD and QCISD (T).

Correlated**
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Density Functional*  Thermochemical 
 

Configuration 
Interaction  

The most important application of molecular mechanics models is 
conformational searching, in particular, for molecules with several 
degrees of conformational freedom. In these cases, even the simplest 
quantum chemical models may not be practical. The MMFF force field 
is known to properly assign equilibrium conformation in a variety of 
simple molecules for which experimental data are available. It also has 
been shown to generally (but not always) provide a reasonable account 
of conformational energy differences in larger organic molecules as 
obtained from high-level quantum chemical calculations. Aside from 
conformational energy differences, molecular mechanics models are not 
suitable for thermochemical calculations.

Semi-empirical models are simplest methods based on quantum 
mechanics. They are applicable to molecules containing 100 - 200 atoms, 
but not to molecules containing thousands of atoms, for example, proteins. 
The MNDO, AM1, RM1, PM3 and PM6 models generally provide 
geometries in good accord with experimental structures. This makes 
them suitable for evaluation of such properties as polar surface area that 
depend solely on geometry. However, none of the present-generation 
semi-empirical models is suitable for the calculation of relative energies 
as might be required to conclude, whether a chemical reaction is weakly or 
strongly exothermic, thermoneutral or weakly or strongly endothermic, or 
whether one isomeric product of a reaction is likely to be more or less stable 
than another, or to identify the lowest-energy tautomer. Also, none of the 
methods reliably accounts for conformational energy differences, as would 
be required to establish whether a particular conformer has a good chance 
at actually being present or to calculate the average value of a property 
based on the relative (Boltzmann) populations of different conformers.

Hartree-Fock models follow from the Schrödinger equation by 
requiring that the electrons be independent particles. This is known as 

* A variety of other functionals are available and may be entered directly into the Options 
box. A full listing is provided in Appendix B. Additionally, any combination of supported 
exchange and correlation functionals may be specified.

** G2 and G3 recipes are also available but need to be entered into the Options box.

Recipes**
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the Hartree-Fock approximation. Here, the motions of electrons in 
molecules (molecular orbitals) are approximated by a sum of the motions 
of electrons in atoms (atomic orbitals). A second approximation, termed 
the LCAO or Linear Combinations of Atomic Orbital approximation, 
distinguishes different Hartree-Fock models. Different models use 
different basis sets, that is, different numbers and kinds of atomic orbitals. 
For example, the model with the 3-21G split-valence basis set uses one 
atomic orbital to describe each non-valence electron and two atomic 
orbitals to describe each valence (core) electron, that is, it comprises one 
1s atomic orbital and two sets of 2s and 2p atomic orbitals. 

1s
2s, 2px, 2py, 2pz

2s´, 2px´, 2py´, 2pz´

The model with the 6-31G* polarization basis set increases the flexibility 
by including d type atomic orbitals that, while not occupied in the atom, 
are used in molecules.

1s
2s, 2px, 2py, 2pz

2s´, 2px´, 2py´, 2pz´
dxx, dxy, dxz, dyy, dyz, dzz

Larger basis sets involving even higher splitting of valence shells, 
including higher-order (f and g type) functions as well as diffuse functions 
can be and have been defined and are available in Spartan. Description 
of their makeup is provided in Topics available under the Activities 
menu and in  A Guide to Molecular Mechanics and Quantum Chemical 
Calculations which is provided as a PDF under the Help menu.

3-21G and 6-31G* and larger basis set Hartree-Fock models generally 
provide good accounts of the geometries of organic molecules. This 
extends to unusual or unstable systems for which experimental data may 
be limited (and hence may be poorly represented in parameterization of 
the semi-empirical models). The 6-31G* model (and to a lesser extent, the  
3-21G model) also properly accounts for thermochemistry, at least 
insofar as being able to say whether a particular reaction is weakly or 
strongly exothermic or weakly or strongly endothermic. It is also able to 
properly order the stabilities of isomeric products and to reliably identify 
the lowest-energy tautomer. Finally, Hartree-Fock 6-31G* calculations 
provide a qualitatively correct account of the relative stabilities of different 
conformational arrangements. Hartree-Fock models with larger basis sets 
show similar behavior but 3-21G calculations do not provide reliable results.
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Hartree-Fock models are generally able to properly describe the energies 
of isodesmic reactions, that is, reactions where formal bond count is 
maintained. The most conspicuous and most important flaw of Hartree-
Fock models is their inability to properly account for the energetics of 
bond dissociation. This includes activation energies, that is, the difference 
in energy between reactants and transition state. This is the case even with 
very large basis sets, and can be traced to the Hartree-Fock approximation 
which in effect replaces interactions between electrons by interactions 
between one electron and the average field created by all other electrons. 
As a consequence, electrons get in each other’s way to a greater extent 
than they should. This leads to overestimation of the electron-electron 
repulsion energy, most significantly for electrons that are paired. Because 
bond dissociation reduces the number of electron-pairs (by one), the 
overestimation will be greater for reactants than for products and the 
calculated dissociation energy will be too small.*

Models that do away with the Hartree-Fock approximation, or at least 
lessen its effect, are termed correlated models. These divide into two 
broad categories, density functional models and wavefunction-based 
models. Density functional models explicitely introduce an approximate 
correlation term (a functional). They are not much more costly in terms of 
computation time than Hartree-Fock models, although it is not apparent 
how to improve on a particular choice of functional. Wavefunction-based 
models, typified by Møller-Plesset models and configuration interaction 
models extend the flexibility of Hartree-Fock models by mixing ground-
state and excited-state wavefunctions. They are significantly more costly 
than both Hartree-Fock and density functional models, but offer the 
advantage over the latter of a clear path to improvement. In the limit 
of complete mixing, so-called full configuration interaction and infinite 
order Møller-Plesset models, wavefunction-based models lead to the 
exact result, although in practice this limit cannot be reached.

Density functional and wavefunction-based correlated models make 
use of the same basis sets as Hartree-Fock models, except that 
minimal and split-valence basis sets do not yield satisfactory results. 
Among the simplest and most popular models are the B3LYP/6-31G* 
density functional model and the MP2/6-31G* (second-order) Møller-
Plesset model. The primary use of these models (and other correlated 

* Consider the bond dissociation energy of H2. The (limiting)Hartree-Fock energy of 
the products (hydrogen atoms each with only one electron) is exact, while the energy 
of the reactant (H2 with two electrons) is too large. Therefore, the bond dissociation 
energy will be too small.
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models) is to obtain thermochemistry, including for reactions in which 
bonds are made or broken and including activation energies.

A number of thermochemical recipes or combinations of different quantum 
chemical methods have been formulated to reproduce experimental heats 
of formation to within 4-8 kJ/mol. (Except for very simple molecules, 
experimental heats are seldom more accurate than this.) G3(MP2) is the 
simplest of the recipes that have been formulated. It reproduces experimental 
heats of formation for a wide variety of small molecules to within  
6 kJ/mol (mean absolute error), with only a small number of systems 
showing errors twice this amount. The problem with G3(MP2) is its large 
computational cost, which limits the size of systems that can be dealt 
with. G3(MP2) may easily be applied to molecules comprising up to ten 
heavy (non-hydrogen) atoms, but applications to molecules comprising 
fifteen or more heavy atoms will generally not be practical.

Three different energies are required in the G3(MP2) recipe:

EA MP2/6-31G* using the MP2/6-31G* equilibrium geometry
EB MP2/6-311++G(2df, 2p) using the MP2/6-31G* equilibrium  
 geometry
EC QCISD(T)/6-31G* using the MP2/6-31G* equilibrium geometry

These are combined in order to take into account both the effects of 
increased basis set size and of electron correlation beyond the MP2 level. 
Note, that the two effects are treated independently in order to avoid 
having to perform a QCISD(T) calculation using a large basis set.

E = EA + (EB - EA) + (EC - EA)
Two corrections are needed to bring the calculated energy in line with 
what is actually measured experimentally: a correction for zero-point 
energy; Ezero-point, and a correction to the enthalpy (energy) to account for 
finite temperature (298K), H(T).

Ezero-point  =
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h is Planck’s constant, k is the Boltzmann constant, R is the gas constant 
and N is Avogadro’s number. Both zero-point and temperature corrections 
require vibrational frequencies.* These are obtained from Hartree-Fock/ 
6-31G* calculations and require the corresponding equilibrium geometry.

To summarize, the G3(MP2) recipe requires two equilibrium geometry 
calculations (at HF/6-31G* and MP2/6-31G*), a HF/6-31G* frequency 
calculation, a MP2/6-311++G (2df, 2p) energy calculation and a 
QCISD(T)/6-31G* energy calculation. The QCISD(T) calculation 
dominates with increasing molecular size. Next most costly is the MP2/ 
6-31G* geometry optimization, although both the large basis set MP2 
energy and the HF/6-31G* frequency may be significant.

T1 is a simplified recipe based on G3(MP2) and intended to closely 
reproduce G3(MP2) heats of formation. It eliminates the QCISD(T)/ 
6-31G* energy calculation (EC), the zero-point energy calculation (Ezero-

point) and the temperature correction to the enthalpy (∆H(T)), and replaces 
the large basis set MP2 energy calculation (EB) with a dual-basis-set RI-
MP2 calculation, where G3MP2large is the large basis set (the same basis 
set that is used in the G3(MP2) recipe) and 6-311G* is the small basis set. 
To compensate, an empirical correction based on the Hartree-Fock and 
RI-MP2 energies and Mulliken bond orders is introduced. This follows 
from a linear regression analysis involving G3(MP2) heats of formation 
for ≈1,050 molecules. T1 uses HF/6-31G* equilibrium geometries, instead 
of MP2/6-31G* geometries.

An automated procedure has been developed to locate the best (lowest 
heat of formation) conformer, or at least a conformer that is very close 
to the best. This involves four steps: (i) examine up to 1,000 conformers 
using a restricted systematic search procedure and the MMFF molecular 
mechanics model; (ii) obtain equilibrium geometries for (up to) the 
six best conformers, making certain to exclude duplicate conformers 
and conformers that are nearly the same using the HF/6-31G* model; 
(iii) perform (up to) two T1 calculations on the two best HF/6-31G* 
structures; (iv) select the lower energy T1 conformer. The default 
numbers of structures examined in the second and third steps (six and 
two, respectively) may be altered by keywords typed into the Options 
box (Appendix D).

* Note, that the expression for ∆Hvib(T) goes to RT instead of 1/2 RT as νi goes to 
zero. This requires that contributions that would exceed 1/2 RT be set to 1/2 RT.
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Except for semi-empirical methods and for thermochemical 
recipes, either restricted or unrestricted scf methods may be 
used. The former restricts paired electrons to the same orbital, 
whereas the latter allows the electrons to occupy different orbitals. 
The default (singlets with restricted methods and non-singlets with 
unrestricted methods) may be overridden using the Scf keyword 
from the Options box (Appendix D). Semi-empirical methods 
and thermochemical recipes are limited to the default settings.

Basis Sets

Except for molecular mechanics and semi-empirical methods and 
for thermochemical recipes, a basis set needs to be specified. Menus 
provide a number of choices.* For Hartree-Fock methods:

            
For all other methods:

The 3-21G basis set for second-row and heavier main-group elements 
incorporates a set of d-type functions. While these are not occupied 
in the atomic ground state, they have been found necessary for proper 
description of bonding in molecules. 6-311++G (2df,2p) uses the 
6-311++G (3d2f,2p) basis set for second-row elements.

The combination of a method, for example, B3LYP, and a basis set, for 
example, 6-31G*, constitutes a theoretical model or more simply a 
model. The nomenclature is to separate method and basis set by a “/”, for 

* A number of other basis sets are available, and may be entered directly into the Options box: 
These include the Pople 6-31G or 6-311G basis sets followed by: (idjf) or (idjf, kpld) where i is 
the number of sets of d functions on non-hydrogen atoms, j is the number of sets of f functions 
on non-hydrogen atoms, k is the number of s functions on hydrogen atoms and l is the number 
of sets of p functions on hydrogen atoms. If 0 eliminate p, d, f; if 1 eliminate the number; 
6-31G or 6-311G with “+” or “++” inserted before G; cc-pVDZ, cc-pVQZ and cc-PV5Z.
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example, B3LYP/6-31G*. By convention, specification of Hartree-Fock 
(HF) as a method is optional. That is, specification of basis set alone refers 
to Hartree-Fock models, for example, both HF/6-31G* and 6-31G* refer 
to combination of the Hartree-Fock method and the 6-31G* basis set. 
Methods without basis sets, for example, MMFF (molecular mechanics) 
and PM3 (semi-empirical) are themselves models. 

Pseudopotentials

Pseudopotentials are employed only where all-electron basis 
sets are unavailable, and are used in conjunction with all-
electron basis sets for elements where they are available. This is 
primarily for elements heavier than Kr, most importantly fourth-
row main-group elements and second and third-row transition 
metals. For example, a B3LYP/6-31G* calculation on rutherium 
ethylene tetracarbonyl would employ a pseudopotential only for 
rutherium and the all-electron 6-31G* basis set for hydrogen, 
carbon and oxygen. The overall method is referred to as B3LYP/ 
6-31G*. Pseudopotentials pertain to Hartree-Fock, density 
functional, MP2 and advanced correlated calculations only, but 
not to RI-MP2 calculations or calculations using the STO-3G and 
3-21G basis sets.

Solvent

A solvent is specified for Hartree-Fock and density functional 
calculations by replacing vacuum in the menu to the right of in 
by water or one of a selection of common organic solvents.*

The effect of the solvent on the energy and wavefunction (and hence on 
any properties derived from the wavefunction) is approximated by way of 

* Other solvents are available and can be entered via the Solvent keyword in the Options box.
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the SM8 model. This has been parameterized to reproduce experimental 
energies of solvation and related quantities. It has not been parameterized 
to reproduce equilibrium geometries and properties other than the energy, 
and there is no solid calibration of its success or failure for anything other 
than energy. It should be used with caution.

The cost of SM8 in terms of computation time is roughly equal to that 
of an energy calculation. Therefore, solvated Hartree-Fock and density 
functional energy calculations are twice as costly as the corresponding 
calculation in vacuum while geometry calculations are roughly 30% 
more costly.

If checked, Dual Basis signifies that a Hartree-Fock, density 
functional, MP2 or RI-MP2 energy equilibrium and transition-
state geometry calculations with the 6-311+G**, 6-311++G**, 
6-311++G (2df, 2p), or cc-pVTZ basis set will be approximated 
by a calculation in which scf convergence is first achieved using 
the smaller 6-311G* basis set and then corrected pertubatively for 
the effects of basis set extension. Other combinations of small and 
large basis sets may be specified under Options (see discussion 
following). Use of dual basis has only a small effect on calculated 
relative energies, but can reduce the cost of large-basis-set energy 
calculations by two to ten times (depending on the choice of 
the small and large basis sets). A dual basis set is employed for 
calculations with the T1 thermochemical recipe.

Start from (Energy, Equilibrium Geometry)

Energy and equilibrium geometry calculations (only) from one 
model may be preceded by equilibrium geometry calculations at 
another (simpler) model. Choices depend on the model:

 Molecular Mechanics not applicable

 Semi-Empirical 

 Hartree-Fock 
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 Density Functional, Møller-Plesset,
 Advanced Correlated, Thermochemical
 Recipes

Selection of MMFF conformer or MMFFaq conformer signifies 
that geometry optimization will follow a search for the lowest-
energy conformer. These lead to an additional menu specifying 
the level of geometry optimization.

 Molecular Mechanics, Semi-Empirical not applicable

 Hartree-Fock 

 Density Functional, Møller-Plesset, Advanced
 Correlated, Thermochemical Recipes

Maximum (Equilibrium Conformer, Conformer Distribution)

Maximum Conformers Examined sets a maximum for the 
number of possible conformers that will be considered both 
for Equilibrium Conformer and Conformer Distribution 
tasks. Note, that if a systematic search has been requested 
(SearchMethod keyword; Appendix D) this invokes an algorithm 
whereby systematic conformers are randomly eliminated in order 
to enforce the conformer limit.

Maximum Conformers Kept sets a maximum for the number of 
conformers returned at the end of a Conformer Distribution task. 
It must be smaller or equal to the number of conformers examined. 

Subject to

Spartan allows calculations to be carried out in the presence of 
geometrical constraints or with atoms which have been frozen in 
place. In addition, Spartan attempts to make use of symmetry.

If checked, Constraints signifies use of any previously 
defined constraints on distances, angles and dihedral angles 
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into equilibrium and transition-state geometry optimization, 
conformation searching and generation of energy profiles. Does 
not apply to energy calculation, conformer library generation or 
similarity analysis. See Constrain Distance, Constrain Angle 
and Constrain Dihedral under the Geometry menu (Chapter 
15) for information about constraining geometrical parameters.

NOE data are not treated as constraints, but rather as post-calculation 
filters in establishing conformer distributions. 

If checked, Frozen Atoms signifies that the coordinates of 
any atoms that have previously been frozen will not be moved 
during equilibrium and transition-state geometry optimization, 
conformation searching and generation of energy profiles. Does not 
apply to energy calculation, conformer library generation or similarity 
analysis. See Freeze Center under the Geometry menu (Chapter 
15) for information about freezing atoms. See also discussion in 
Chapter 19 regarding the freezing of heavy atoms in structures 
resulting from a search of the Cambridge Structural Database.

If checked, Symmetry signifies that molecular symmetry is to 
be employed wherever possible to simplify the calculation. By 
default Symmetry is checked.

Compute

Entries under this section request calculation of infrared, Raman, 
NMR and UV/visible spectra as well as a variety of descriptors 
used in QSAR analyses.

IR

If checked, calculates vibrational frequencies and infrared 
intensities together with the corresponding vibrational modes. 
These are available in the output (Output under the Display 
menu; Chapter 18). Thermodynamic properties (enthalpy, 
entropy, heat capacity and Gibbs energy) are available from 
the Thermodynamics tab of the Molecule Properties dialog 
accessible from Properties under the Display menu (Chapter 
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18)*. Vibrational modes may be animated and an IR spectrum 
displayed from the IR dialog accessible from Spectra under the 
Display menu (Chapter 18). Second derivatives required for 
frequency calculation are evaluated analytically for molecular 
mechanics, semi-empirical, Hartree-Fock and density 
functional models, but involves numerical differentiation of 
analytical gradients for RI-MP2 and MP2 models. This is much 
more costly in terms of computation. Frequency calculations 
for higher-order correlated models are not available.

Raman

If checked, calculates Raman intensities (IR must also be 
checked in order for vibrational frequencies to be available.) 
The Raman spectrum may be displayed from the Raman dialog 
accessible from Spectra under the Display menu (Chapter 18).

NMR

If checked, calculates NMR chemical shifts. These are then 
available in the output (Output under the Display menu; 
Chapter 18) as well as from the Atom Properties dialog 
(accessible from Properties under the Display menu; Chapter 
18) and as atom labels (Configure... under the Model menu; 
Chapter 14). 13C (proton decoupled) and 1H (shifts only) 
spectra from Hartree-Fock or density functional calculations 
may be displayed from the NMR Spectra dialog accessible 
from Spectra under the Display menu (Chapter 18)**. DEPT 
spectra may also be displayed (13C spectra in which carbons 
with one or three attached protons point up, carbons with two 
attached protons point down and quaternary carbons are absent). 
Finally, 2D COSY (proton vs. proton) and HSQC and HMBC 

* Note that the linear harmonic oscillator approximation incorrectly leads to a vibrational 
contribution to the entropy that goes to ∞ as frequency goes to 0. Vibrational entropy 
contributions from frequencies below 300 cm-1 should be treated with caution.

** Chemical shifts for other nuclei are available in the Output dialog (Output under the 
Display menu) and may also be attached as labels (Configure... under the Model menu). 
All chemical shifts are given relative to standard compounds, for example, TMS in the case 
of both proton and carbon. Standards are listed in Appendix L.
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(proton vs 13C) spectra may be displayed from the dialog.
13C chemical shifts calculated from the B3LYP/6-31G* have been 
empirically corrected for local topology (numbers and kinds of 
directly-bonded atoms), and 13C shifts calculated from the EDF2/ 
6-31G* model have been corrected using a more elaborate 
scheme involving both topology and bond orders to neighboring 
atoms. Corrections for other quantum chemical models and for 
proton chemical shifts are not available. Experience suggests 
that uncorrected 13C shifts are not sufficiently accurate to be 
useful for NMR spectra prediction, but that corrected shifts 
are generally successful in this regard. Uncorrected shifts are 
available in the printed output. Line intensities are assumed 
to be proportional to the number of equivalent carbons or 
hydrogens. HH and CH coupling constants are not calculated, 
but are estimated empirically from the molecular geometry.

UV/vis

If checked, specifies that a series of excited-state energy 
calculations will be performed (following a ground-state 
calculation), state-to-state energy differences will be reported 
in, and if desired a UV/visible spectrum will be displayed from 
the UV/vis Spectra dialog accessible from Spectra under the 
Display menu (Chapter 18). The default number of excited 
states is 6, but may be changed using the UV States keyword 
from the Options box (Appendix D). UV/visible spectra 
calculations are available for Hartree-Fock models (CIS for the 
excited state) and density functional models (time-dependent 
density functional theory for the excited state).

QSAR

If checked, specifies calculation of a number of QSAR 
descriptors that would not otherwise be available. These 
include descriptors based on the electron density surface, the 
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electrostatic potential map and the local ionization potential 
map, as well as polarizability and logP.*

Total Charge

Total charge. The default setting, Neutral, may be changed either 
by clicking on  to the right of the box, and selecting Cation, 
Anion, etc. from the menu which appears, or by replacing any 
menu entry by a numerical value. Total Charge is ignored for 
molecular mechanics calculations.

Multiplicity

Spin multiplicity (number of unpaired electrons). The default 
setting, Singlet, may be changed either by clicking on  to the 
right of the box, and selecting instead Doublet or Triplet from 
the menu which appears, or by replacing any menu entry by 
a numerical value. Multiplicity is 1 for singlets (no unpaired 
electrons), 2 for doublets (one unpaired electron), 3 for triplets (two 
unpaired electrons), 4 for quartets (three unpaired electrons), etc. 
Multiplicity is ignored for molecular mechanics calculations.

Print

If checked, writes the quantity to the output window. Text 
output may be seen by selecting Output from the Display menu 
(Chapter 18) and printed by first selecting the output dialog and 
then selecting Print Output from the File menu (Chapter 12). 
Additional printing may be requested from the Options box (see 
discussion following).

Orbitals & Energies

If checked, writes the orbitals and energies to the output. Orbital 
energies are also available in the spreadsheet (Chapter 18). 
An orbital energy diagram is available from Orbital Energies 
under the Display menu (Chapter 18).

* LogP is estimated according to the method of Ghose, Pritchett and Crippen (J. Computational 
Chem., 9, 80 (1988)). An alternative procedure due to Villar (J. Computational Chem., 6, 
681 (1991); Int. J. Quantum Chem., 44, 203 (1992)) is available. See Table 18-3.
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Thermodynamics

If checked, writes thermodynamic quantities to the output. 
Requires that vibrational frequencies (IR under Compute) 
have been calculated. Selected thermodynamic quantities 
are also available in the spreadsheet (Spreadsheet under the 
Display menu; Chapter 18).

Vibrational Modes

If checked, writes vibrational frequencies and modes to the 
output. Requires that IR under Compute have been calculated.

Charges & Bond Orders

If checked, writes Mulliken, natural and electrostatic-fit 
charges and Millikan and Löwdin bond orders to the output. 
Note that Mulliken and natural charges from semi-empirical 
models are identical. Atomic charges are also available from 
the Atom Properties dialog (accessible from Properties 
under the Display menu; Chapter 18), in the spreadsheet 
(Spreadsheet under the Display menu; Chapter 18) and as 
atom labels (Configure... under the Model menu; Chapter 
14). Mulliken and Löwdin bond orders are available from the 
Bond Properties dialog (accessible from Properties under the 
Display menu; Chapter 18). Atomic charges and bond orders 
are not available for calculations using advanced correlated 
models or for thermochemical recipes.

Options

Program options may be specified using keywords entered 
into the Options box. Keywords may be either single words or 
expressions. Keyword=N indicates an integer argument, and 
keyword=F indicates a real argument. Appendix D contains a 
listing of commonly-used keywords.

Converge

If checked, invokes procedures to assist in convergence of quantum 
chemical calculations. May lead to an increase in computation time.
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Similarity
Spartan provides a procedure to assess and quantify the similarity of 
one or more molecules in a document to one or more molecules in 
one or more different documents. Similarity may either be based on 
molecular structure (geometry) or on chemical function descriptors 
(CFD’s). Spartan also assesses the similarity of one or more 
pharmacophores in a document to one or more molecules in one or 
more different documents.

Three different similarity analysis modes are available, depending on 
the template (the selected document in the graphical user interface) 
and the library (one or more different documents specified in the 
Calculations dialog).

 template library

 pharmacophores molecular structures for which CFD’s 
are assigned on-the-fly

 molecular structures molecular structures

 CFD’s from molecular molecular structures for which CFD’s 
 structures are assigned on-the-fly

Two types of libraries are supported for molecular structures (and 
CFD’s generated on-the-fly from molecular structures). In the first, 
each entry represents a single molecule. In the second, each entry 
represents a selection of different conformers of a single molecule 
and spanning all possible shapes that the molecule may take on. The 
latter are generated using Conformer Library under the Calculate 
menu (see discussion earlier in this chapter), and may only be used 
as library entries in similarity analysis and not as templates.

Of the three similarity analysis modes, only the second makes direct 
use of molecular structures (selected atomic centers for the molecules 
in the template) as a similarity measure. The other two make use 
of CFD’s generated (and optionally edited) for the template, and 
generated on-the-fly in the library. Selection of structure or CFD as the 
basis of similarity measure must be explicitely stated (see discussion 
following).
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Seven different chemical function descriptors (CFD’s) are recognized 
by the similarity analysis procedure, the first six of which are attributes 
of a molecule while the seventh derives from knowledge of a molecule 
bound to a protein or nucleic acid.

hydrophobe (sterically crowded region)
aromatic hydrophobe (aromatic ring)

hydrogen-bond donor
hydrogen-bond acceptor

positive ionizable site
negative ionizable site

excluded volume

Discussion of CFD types has already been provided (see CFD’s under 
the Model menu; Chapter 14).

The individual CFD’s for molecules in the template (only) may either 
be used or ignored in the similarity procedure. This is specified from 
Set Similarity Centers under the Geometry menu (Chapter 15). 
The CFD Properties dialog (accessible from Properties under the 
Display menu; Chapter 18) allows for changing or extending the 
definition of a CFD For example, the nitrogen in a dimethylamino 
group might initially be assigned as a hydrogen bond acceptor CFD, 
but could be changed to a positive ionizable site (as such a center could 
become positively-charged at biological pH) or could be extended to 
cover both possibilities.

Spartan assumes that any chiral molecules in a library are unresolved 
(they comprise an equal mixture of enantiomers). By default, similarity 
comparisons are carried out on both the library molecules as they are 
stored and (if the molecules are chiral) on their mirror images. The default 
procedure may be overridden (providing comparisons only to the stored 
molecules) by way of the SingleEnantiomer keyword entered in the 
Options box. See discussion later in this chapter and also Appendix D.

Note that only a single enantiomer of a chiral template molecule is 
considered. If comparisons involving both enantiomers are desired, the 
second enantiomer must be added to the query.
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Selection of Similarity from the Calculate menu with either a 
molecule or pharmacophore (list of molecules/pharmacophores) leads 
to a dialog for setting up a similarity analysis.

One or more libraries need to be identified. This is accomplished 
by clicking on the Add Library... button, and gives rise to a file 
browser. Once selected, clicking on Open adds the library to the list 
of templates. A library may be deleted from the list by clicking on 
its name in the list and clicking on the Remove Selected button at 
the bottom of the dialog. Shift and Ctrl keys function in the usual 
manner in both library addition and removal.

Prior to starting a similarity analysis, it is necessary to select either 
structure or CFD from the Use menu near the bottom of the 
Calculations dialog.

Similarity analysis is most valuable where the template molecule is 
conformationally flexible, and it is not apparent which (if any) of the 
different shapes it adopts might match a particular target in a library. 
It becomes indispensable where the target is also flexible and its 
conformation is not established. Here, the process must be repeated for 
every template conformer-target conformer pair, that is, thousands or 
tens of thousands of times.

This process can be shortened if the purpose is simply to identify which 
target molecules a particular template molecule might match, irrespective 
of conformer. In this case, the first good match concludes the analysis, 
and the user is left with the knowledge that template and target can be 
made to match (together with an example of a match).
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The similarity algorithm incorporated in Spartan attempts to examine 
template-target pairs that are most likely to lead to matches before examining 
pairs that are less likely. It also allows early termination upon finding a single 
good match, or a user-specified number of good matches*. Taken together, 
these can lead to one or two orders of magnitude speedup in the analysis.

Global Calculations

If checked, signifies that settings in the Calculations dialog are to be 
applied to all molecules in the document.

The Calculations dialog may be exited by clicking on Submit, 
Cancel or OK at the bottom right of the dialog, or on  at the top. 
(Submit and OK are not available if the job is already executing.) 
Clicking on OK or on Submit overwrites any previous information. 
Additionally, Submit enters the job in the execution queue (see 
discussion later this chapter). Clicking on Cancel or on  exits the 
Calculations dialog without saving any changes.

Surfaces and Property Maps

Spartan allows graphical display of the HOMO and LUMO among 
other molecular orbitals, the electron density, the spin density for 
molecules with unpaired electrons, the electrostatic potential, and 
the local ionization potential.

The electron density is the number of electrons found at a point in space. 
It is the quantity measured in an X-ray diffraction experiment that is 
then used to locate atomic positions, that is, most electrons are closely 
associated with atoms. While the electron density is non-zero everywhere, 
it is possible to define surfaces of constant density. The most important of 
these contains most of a molecule’s electrons and that roughly corresponds 
to a space-filling model, that is, a van der Waals surface. We will refer 
to this as the electron density. It is interesting because it reveals overall 
molecular size and shape and demarks the steric barrier seen by encroaching 
molecules. Another important surface, that we will refer to as the bond 
density, contains fewer electrons in total and demarks atomic connectivity.

* Criteria for early termination are specified using program options. See Similarity 
Analysis Options in Appendix D.
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The spin density is the difference in the number of electrons of α and β 
spin at a point in space. It indicates the location of the unpaired electron in 
a radical or unpaired electrons in a triplet or higher multiplicity state. 

The electrostatic potential is the energy of interaction of a positive 
charge with a molecule. This assumes a fixed electron distribution for the 
molecule. It represents a balance between repulsive interactions involving 
the positively-charged nuclei and attractive interactions involving the 
negatively-charged electrons. Regions where the balance tips toward 
attraction are said to be electron rich (basic) and subject to attack by 
electrophiles, while regions where the balance tips toward repulsion are 
said to be electron poor (acidic) and subject to attack by nucleophiles. 
Electron-rich regions such as lone pairs are typically located outside 
the van der Waals surface. As such, they may be easily identified by 
constructing a surface of negative (attractive) electrostatic potential. 
While interesting electron-poor areas such as acidic hydrogens also 
lie outside the van der Waals surface, the electrostatic potential is also 
positive (repulsive) throughout the region inside this surface.

The local ionization potential indicates the ease or difficulty of electron 
removal (ionization). Like the negative regions of the electrostatic 
potential, regions of low local ionization potential are likely to be subject 
to attack by electrophiles.

Note that neither of the last two quantities are experimental observables, 
although all relate to quantities that can be given clear chemical 
interpretation.

Additionally, any one of the quantities listed above (except the electron 
density) may be mapped onto any surface (except a molecular orbital 
surface). In practice, the only maps to have received widespread 
attention are those based on the electron density surface (depicting 
overall molecular size and shape). Most common are the electrostatic 
potential map, the local ionization potential map and the LUMO map.

The electrostatic potential map paints the value of the electrostatic 
potential onto an electron density surface. By convention, colors 
toward red depict negative potential, while colors toward blue depict 
positive potential, and colors in between (orange, yellow, green) depict 
intermediate values of the potential. Thus, an electrostatic potential map for  
p-tert-butylphenol will show oxygen to be red, its attached (acidic) 
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hydrogen to be blue, the π faces of benzene to be orange or yellow and 
the tert-butyl group to be green. 

The main advantages of this presentation relative to separate electron 
density and electrostatic potential surfaces are its clarity and its 
compactness. The main disadvantage is that it provides information only 
about the contact surface and does not reveal how far electron-rich and 
electron-poor areas extend beyond the surface.

An alternative to an electrostatic potential map, referred to as an exposed 
electrostatic potential surface, is a composite of three different surfaces: 
an electron density surface depicting overall molecular size and shape, a 
negative electrostatic potential surface identifying electron-rich regions 
and a positive electrostatic potential surface identifying electron-
poor regions. These surfaces need to be generated and then displayed 
simultaneously. The electron density may either be displayed as an opaque 
solid or as a transparent solid (in order that the molecular skeleton may be 
seen inside). The two potential surfaces are best represented as transparent 
solids, the negative surface colored red and the positive surface colored 
blue. The exposed electrostatic potential surface for p-tert-butyl phenol 
is shown on the next page.

Note that the exposed electrostatic potential surface provides the same 
information as the electrostatic potential map. Red areas in the map 
correspond to regions when the negative electrostatic potential surface is 
likely to protrude from the electron density while blue areas correspond 
to regions where the positive electrostatic potential surface is likely to 
stick out. There is broad similarity of this graphic to CFD representations 
discussed previously (see CFD’s under the Model menu in Chapter 14). 
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Hydrogen-bond acceptors and/or positive ionizable sites are associated 
with protruding negative potential surfaces, whereas hydrogen-bond 
donors and/or negative ionizable sites are associated with protruding 
positive potential surfaces.

The local ionization potential map paints the value of the local ionization 
potential onto an electron density surface. By convention, colors toward 
red indicate low ionization potential, while colors toward blue indicate 
high ionization potential. Thus, the local ionization potential map for 
aniline shows that the ortho and para ring positions have a lower ionization 
potential than the meta positions, consistent with the known directing 
ability of an amino group in electrophilic aromatic substitution.

The LUMO map paints the absolute value of the lowest-unoccupied 
molecular orbital (the LUMO) onto an electron density surface. By 
convention, colors near blue indicate high concentration of the LUMO, 
while colors near red indicate low concentration. Given that the LUMO 
designates space available for a pair of electrons, a LUMO map indicates 
where nucleophilic attack would likely occur. For example, a LUMO 
map for cyclohexenone shows concentration in two regions, one over 
the carbonyl carbon and the other over the β carbon, consistent with both 
carbonyl addition and Michael (conjugate) addition.
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The spin density map paints the value of the spin density onto an electron 
density surface. By convention, colors near blue indicate high concentration 
of spin density, while colors near red indicate low concentration. For 
example, a spin density map for the radical resulting from loss of 
hydrogen from 3,5-di-tert-butylhydroxytoluene (BHT) shows that the 
spin has delocalized from oxygen onto the ortho and para ring positions.

This radical would be expected to be particularly stable, which explains why 
BHT acts as an antioxidant (scavenging less favorable localized radicals).

All of these maps use an electron density surface and to delineate 
overall molecular size and shape. Not all regions on this surface 
are accessible and therefore available for interaction with their 
environment (or with an incoming reagent). Spartan allows these 
regions to be identified.*

Surfaces (including those underlying maps) connect points of equal 
value (they are isosurfaces), and may be displayed as an arrangement 
of dots, a mesh, or an opaque or translucent solid. Examples of 
graphical output in orthogonal projection are provided in Figure 
17-1. Surfaces (and maps) may also be rendered in perspective (see 
Chapter 14) and in stereo (see Chapter 2).

Calculated quantities may also be displayed as two dimensional 
contour plots (slices). Unlike surfaces and maps, these can be 
translated, rotated and zoomed independently of the molecular 
skeleton. An example of a slice display is provided in Figure 17-1.

* A region on a density surface is designated as inaccessible if a sphere of radius 1.0 Å 
centered on a line normal to the surface and touching a point in the middle of the region, 
impinges on any other regions of the density surface. The sphere radius may be changed in 
the Settings Preferences dialog (Preferences under the Options menu; Chapter 20).



304 Chapter 17

showing bonding in the transition state.

showing hydrogen bonding.

showing interaction of the HOMO of 
1,3-butadiene and the LUMO of ethylene. 

showing overall molecular size and shape.

Frontier orbitals for a symmetry-allowed 
Diels-Alder reaction,

Space-filling model and electron density 
surface of cyclohexanone,

Electron density surface (0.08 electrons/
au3) of transition structure for pyrolysis 
of ethyl formate,

Electrostatic potential surfaces (-40 kJ/mol) 
of trimethyl am ine (left) and dimethyl ether 
(right),

Electron density slice for acetic acid 
dimer,

Figure 17-1: Examples of Graphical Displays Available in Spartan

showing ac ces sibility for nucleophilic 
attack.

Simultaneous display of the LUMO 
and the elec  tron density surfaces of 
cyclohexanone,

showing the lone pairs on nitrogen 
and oxygen, respectively.
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Several different surfaces, maps and slices may be simultaneously 
displayed. In addition, any of the usual structure models may be 
displayed along with the graphic. The total display can become very 
complex, and selective use of meshes and/or translucent solids (as 
opposed to opaque solids) may facilitate visualization.

Discussion of the utility of graphical models for describing molecular 
structure and chemical reactivity is provided in Topics available 
under the Activities menu and in A Guide to Molecular Mechanics 
and Quantum Chemical Calculations, provided as a PDF under the 
Help menu.

Selection of Surfaces from the Setup menu results in display of the 
Surfaces dialog.

This contains a box at the top for listing requested surfaces and 
property maps. 

Common Surfaces and Property Maps

Add at the bottom of the dialog is used to specify a number of 
commonly-used graphical surfaces and property maps*. Clicking 
on it leads to a menu.

 

* The number of selections will increase if the molecule has unpaired electrons.
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 Selection of all but the last entry in the menu leads to a request for 
the analogous surface or map. This will be calculated at medium 
resolution unless a different resolution has been selected (see 
below). Additional surfaces and maps or the same surfaces or 
maps at different resolution may be requested by selecting More 
Surfaces... from the menu (or by clicking on More Surfaces... at 
the bottom of the Surfaces dialog). This leads to the Add Surfaces 
dialog that contains three menus and a check box:

 
Surface

Available surface types appear under the Surface menu.

 Density portrays overall molecular size*, density (bond) locates 
bonds, HOMO{-}, HOMO, LUMO, LUMO{+}, SOMO** are 
molecular orbitals, potential is the electrostatic potential, 
ionization is the local ionization potential and spin** is the spin 
density.

Unlike the molecular orbitals, the electron density and the electrostatic 
potential, the local ionization potential does not go to zero with increasing 
distance. This makes its use as a surface problematic.

* In the case of molecular mechanics, the density will be based on van der Waals radii.
** These menu entries appear only for molecules with unpaired electrons.
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 Selection of HOMO{-} and LUMO{+} results in display of a box 
to decrement the HOMO and increment the LUMO. This allows 
any molecular orbital to be specified.

 

 Slice designates that a plane will cut through the graphic defined 
by Property (see discussion following).

 Property  

 Properties for maps appear in the Property menu.

 
 Available properties are the molecular orbitals (HOMO{-}, 

HOMO, LUMO, LUMO{+}, SOMO*), the electrostatic potential 
(potential)**, the local ionization potential (ionization) and the 
spin density (spin)*. none indicates that no property is to be 
mapped onto the surface). As with Surface above, selection of 
HOMO{-} and LUMO{+} leads to a decrement (increment) box.

 A Spin button will be displayed if Multiplicity (in the Calculations 
dialog) is set to a value other than Singlet, or if Scf=unrestricted 
has been specified in the Options box (Calculations dialog; 
see also Appendix D) and if HOMO{-}, HOMO, LUMO or 
LUMO{+} has been selected for Surface or for Property. Clicking 
on Spin toggles it between Alpha and Beta. Alpha designates 
that the molecular orbital either to be displayed as a surface or 
mapped as a property corresponds to α spin; Beta designates that 
the molecular orbital corresponds to β spin.

 

* These menu entries appear only for molecules with unpaired electrons.
** In the case of molecular mechanics, the electrostatic potential will be based on charges.
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Resolution 

 Selection of surface resolution is from the Resolution menu.

  
Medium resolution generally is intended for routine work, 
low resolution is used to get rough images very quickly, while 
intermediate and high resolution may be employed to obtain 
publication quality graphics. Both calculation time and disk 
storage increase significantly with increasing resolution.

 IsoValue

 This allows a fixed isosurface to be generated in place of a three-
dimensional grid of points (from which different isosurfaces, and/
or slices can be constructed). Fixed isosurfaces are particularly 
attractive for property maps (that are generally based on a density 
surface representing molecular size and shape) as they require less 
computer time and disk storage. Note that a fixed density surface 
needs to be based on a specific isovalue (see below) and not on 
percentage enclosure of the total number of electrons.

 Checking the box to the left of Fixed leads to display of the 
isovalue (0.002 electrons/au3 in the case of density). This value 
may be changed prior to surface generation by editing the text box 
that appears to the right. Fixed may not be specified in conjunction 
with Slice as a Surface.

 Following Surface, Property, Resolution and (optionally) spin 
selection, clicking on OK adds the requested graphic to the list 
and removes the (Add Surfaces) dialog. Clicking on Apply adds 
the requested graphic to the list but leaves the dialog on screen. 
Clicking on Cancel does not add a graphic to the list but removes 
the (Add Surfaces) dialog.

 The process (clicking on Add..., surface and property selection, 
clicking on OK or Apply) may be repeated as required.

 An existing graphic or a request for a graphic may be deleted from 
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the list by first highlighting (clicking on) it and then clicking on 
Delete.

 Global Surfaces

 If checked, Global Surfaces signifies that the requested surfaces 
will be calculated for all members of the list.

Only one copy of the Surfaces dialog may appear on screen, and any 
actions relate to the currently selected molecule. The dialog may be 
removed by clicking on .

Submit

Following setup of a molecular mechanics or quantum chemical 
calculation, or a similarity analysis, as well as any requests for 
properties, spectra and/or graphical displays, the required calculations 
will begin when Submit is selected. If the job has not previously 
been named, selection of Submit triggers a request for a name. If 
the document being submitted comprises a single molecule and the 
molecule exists in the Spartan Molecular Database or the Spartan 
Spectra and Properties Database, the name in the database will be 
presented as a default name. Otherwise, the default name presented 
will be spartan for the first job and spartanX (X an integer starting 
with 1 for all successive jobs). After a name has been provided (or 
if a name already exists or if the default name is accepted) a dialog 
appears indicating that the job has actually been submitted.*

Click on OK to remove it. After a job has started, and until it has 
completed, all associated files will be designated read only.

* The job is submitted to a job queue and will be submitted for execution only when released 
from this queue. See Monitor under the Options menu (Chapter 20) for discussion.
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In addition to the local (Windows, Macintosh or Linux) machine, 
Spartan’s computational codes may run on a remote (licensed) Linux 
server. The only exception is the similarity analysis code which must be 
run on the local machine. If remote submission has been set up (see Hosts 
from the Preferences dialog under the Options menu; Chapter 20), 
selection of Submit will also request a name for the destination machine.

Another dialog appears following completion of a calculation.

Click on OK to remove it.

Some types of jobs, including requests for a conformer distribution 
and an energy profile, lead to an additional document being created 
for each molecule in the original document. These new documents 
are named document.task.identifier where document is the name 
given to the original document, for example, Conf for a conformer 
distribution and Prof for energy profile, and identifier identifies the 
molecule inside the original document.

In the case where there is only one molecule in the original document, 
a query dialog is provided asking whether the resulting Spartan 
document is to be opened.
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Chapter 18
The Display Menu

Functions available under the Display menu provide for text, dialog, 
spreadsheet and graphical displays following structure/property 
calculation, conformational analysis or similarity analysis. Functions 
are also available to query a variety of on-screen objects, display 
and compare IR, Raman, NMR and UV/visible spectra, animate 
vibrational motions, construct relationships among calculated 
properties or for a property between reactants and products of a 
chemical reaction, perform linear regression and prepare plots 
from spreadsheet data, display similarities between molecular 
structures and between molecular structures and pharmacophores 
and calculate reaction energies.

Output

Selection of Output opens a window.
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A menu at the top left of the window selects the type of output.

Output provides normal output. Verbose Output contains more 
detailed output, but is eliminated upon normal completion unless Keep 
Verbose is checked in the Setting Preferences dialog (Preferences 
under the Options menu; Chapter 20). CSD Reference provides the 
literature reference for data retrieved from CSD. Job Log and List 
Output contain diagnostic information. The contents of the output 
window may be printed by right clicking inside it and selecting Print 
from the menu, or copied to the clipboard by right clicking inside it 
and selecting Copy from the menu. Find... and Find Next functions 
are also available from the contextual menu. An output window is 
associated with each document and pertains to the selected molecule. 
Several output windows may be open and may be closed by clicking 
on  at the top right.

Output is not accessible for jobs that are executing or are in the execution 
queue. Output for jobs that execute locally may be viewed using the 
Monitor under the Options menu (Chapter 20), and the current structure 
(in a geometry or transition-state optimization) can be examined.

Properties

Spartan provides specialized dialogs for reporting (and in some cases 
changing) the properties of molecules, atoms, bonds, surfaces and 
constraints, and for changing default plot styles, limits and fitting 
functions, and for editing CFD’s and substituent libraries. Only one 
Properties dialog may be open, and this refers either to the selected 
molecule (Molecule Properties), or to the selected component (atom, 
bond, etc.) or attribute (spectra, graphical surface, substituent, etc.) of 
the selected molecule (Atom Properties, Bond Properties, Surface 
Properties, etc.), or to a plot (Plot Properties, Curve Properties, 
etc.), or fitting function (Regression Properties). Selection of a 
different molecule leads to the Molecule Properties dialog for that 
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molecule. Dialogs that refer to components/attributes of the (newly 
selected) molecule follow by clicking on the component/attribute.

Dialog selection operates in toggle mode, with the Molecule 
Properties dialog being in the neutral position. With the Molecule 
Properties dialog on screen, clicking on a component/attribute brings 
up the appropriate Properties dialog. For example, clicking on an 
atom brings up the Atom Properties dialog. Clicking on a different 
component/attribute brings up the appropriate Properties dialog. 
Clicking a second time on the same component reverts back to the 
Molecule Properties dialog.*

Most Properties dialogs have an associated Utilities or Style dialog. 
For example, associated with the Molecule Properties dialog is a 
Molecule Utilities dialog. These access additional information about 
the molecule and its components/attributes, or provide style and color 
controls. This is useful for highlighting (or dehighlighting) a particular 
molecule, component or attribute. Utilities/Style dialogs are reached 
by clicking on  at the bottom right of the appropriate Properties 
dialog. Return to the Properties dialog follows from clicking on  
at the bottom right of the associated Utilities/Style dialog. 

The Properties (or Utilities/Style) dialog may be removed from the 
screen by clicking on .

 Molecule Properties, QSAR Descriptors and Thermodynamics

 The Molecular Properties dialog is divided into three displays 
Molecule, QSAR and Thermodynamics, controlled by tabs at 
the top left. Entries under the Molecule tab relate to common 
molecular properties that (if applicable to the selected level of 
calculation) are automatically calculated. 

 

* The exception to this involves clicking on a graphical surface or property map, for example, 
clicking on a property map to obtain the value of the property at a particular surface location. 
Clicking a second time on the surface or map will report a new value of the property. Clicking 
on the background leads to the Molecule Properties dialog.
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Molecule

 
 These include the energy (in au), the heat of formation (in kJ/

mol), or the sum of the strain energy and the intramolecular 
interaction energy (in kJ/mol) depending on the theoretical 
model, the energy (heat of formation, strain energy) corrected for 
an aqueous environment according to the SM5.4 model (in the 
same units as the non-corrected quantity), the HOMO and LUMO 
energies (in eV), the dipole moment (in debyes), the formula, the 
molecular weight (in amu), the point group, the predicted number 
of tautomers and the predicted number of conformers, and (if 
available) the experimental heat of formation (in kJ/mol), the heat 
of formation from the T1 thermochemical recipe (in kJ/mol) and 
the CAS number. These may be posted to the spreadsheet using 
the  buttons, or dragged into the spreadsheet, into the formula 
editor (see Formulas in this chapter), or onto any of the dialogs 
associated with the Spartan Molecular Database or Spartan Spectra 
and Properties Database (see Open Database under the Search 
menu; Chapter 19).  Label identifies the molecule in a document 
and appears in the first column of the spreadsheet (see Spreadsheet 
in this chapter).  Conformer Library Entries is the number of 
entries in a conformer library (see discussion under Calculations 
from the Setup menu; Chapter 17). Finally, the dialog permits 
display of the dipole moment vector by checking the box to the 
right of Display Dipole Vector.
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 QSAR

 Entries under the QSAR tab provide additional properties, some 
of which may be particularly valuable in QSAR type analyses.

 
 These include: the area, volume, polar surface area (PSA)* and 

ovality obtained from a space-filling model, and other structure-
dependent indicators: LogP, polarizability and the number of 
hydrogen-bond donor (HBD) and acceptor sites (HBA).** All of 
these are provided automatically. Additional quantities based on the 
electron density surfaces as well as on electrostatic potential maps 
are also available: the accessible area, the polar area and accessible 
polar area corresponding to absolute values of the electrostatic 
potential greater than 75, 100 and 125 kJ/mol (selection is made 
by repeated clicking on ), the minimum and maximum values 
of the electrostatic potential (as mapped onto an electron density 
surface) and the minimum value of the local ionization potential 
(as mapped onto an electron density surface). These quantities 
need to be requested by checking QSAR inside the Calculations 
dialog (Calculations under the Setup menu; Chapter 17).

* Polar surface area is defined as the area due to nitrogen and oxygen and any attached 
hydrogens. Polar surface areas corresponding to arbitrary alternative definitions are available 
for posting into the spreadsheet using the PAREA function. See Table 18-3.

** Counts of hydrogen-bond donors and acceptors and positive and negative ionizable sites 
derive from CFD assignments. These in turn follow from atomic connectivity together with 
special case designations for common organic functional groups. CFD’s assignments may 
be modified on a case-by-case basis using the CFD Properties dialog (Properties under 
the Display menu; this chapter).
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 Thermodynamics
 Entries under the Thermodynamics tab provide the zero-point 

energy, the enthalpy, the constant volume heat capacity, the entropy 
and the Gibbs energy. Except for the zero-point energy, all depend 
on temperature. All require vibrational frequencies.

 

 Molecule Utilities

 Clicking on  at the bottom right of the Molecule Properties 
dialog brings up the Molecule Utilities dialog (clicking on  
returns to the Molecule Properties dialog).

 
 Notes is reproduced in the output. Controls reset model color 

and style, add missing hydrogens and bonds, provide information 
about amino acids in polypeptides and about CFD’s, replace 
coordinates by standards based only on  atomic connectivities, 
change enantiomers and reset default conformer selections.
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 Atom Properties

 Selection of an atom with a Properties dialog on screen, or 
selection of Properties following selection of an atom, leads to 
the Atom Properties dialog.

 
 This displays the element name and symbol, mass number 

(isotope), R/S chirality, Mulliken, electrostatic-fit and natural 
charges (in electrons), NMR chemical shifts (in ppm relative to 
an appropriate standard; see Appendix L). Charges and chemical 
shifts may be posted into the spreadsheet. The dialog also allows 
changing the element and/or the isotope and the default label.

For B3LYP/6-31G* and EDF2/6-31G* only, 13C chemical shifts 
have been empirically corrected (see Appendix A). Corrections for 
the B3LYP/6-31G* model use only topological data and show an 
RMS error of 2.6 ppm. Corrections for the EDF2/6-31G* model use 
both topology and bond orders to neighboring atoms, and show an 
RMS error of 1.8 ppm. Uncorrected shifts from B3LYP/6-31G* and 
EDF2/6-31G* calculations show RMS errors of 5-6 ppm.

 Check boxes allow freezing the atom (see Freeze Center in Chapter 
15), and turning off (unchecked) its line in the NMR spectrum.

 Clicking on  at the bottom right of the Atom Properties dialog 
brings up the Atom Style dialog (not shown). This contains controls 
for selecting atom color and changing model style. Clicking on  at 
the bottom right of this dialog returns to the Atom Properties dialog.
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 Bond Properties

 Selection of a bond with a Properties dialog on screen, or selection 
of Properties following selection of a bond leads to the Bond 
Properties dialog.

 
 This displays the bond length, bond type (and allows changing 

the bond type) and Mulliken and Löwdin bond orders (the latter 
are used in NMR shift corrections).

 Clicking on  at the bottom right of the Bond Properties dialog 
brings up the Bond Style dialog (not shown). This contains 
controls for changing bond color. Clicking on  at the bottom 
right of this dialog returns to the Bond Properties dialog.

 Constraint Properties

 Selection of a constraint marker with a Properties dialog on 
screen, or selection of Properties following selection of a 
constraint marker, leads to the Constraint Properties dialog (not 
shown). This allows setting the value of a constraint, posting it to 
the spreadsheet and changing the default constraint label. Checking 
Profile leads to an expanded dialog.
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 This allows specifying a sequence of constraints for an energy 

profile (see Calculations... under the Setup menu; Chapter 15). 
The value of the starting constraint is given in the lefthand box to 
the right of Value, and the value of the ending constraint is given 
in the righthand box to the right of Value. The number of steps 
in the profile is given in the box to the right of Steps. Initially, 
the numbers in both boxes to the right of Value will be the same, 
and Steps will be set to 1. These may be altered by typing the 
desired numbers into the appropriate boxes and then pressing the 
Enter key (return key on Mac). This functionality may also be 
accessed from Constrain Distance (Angle, Dihedral) under the 
Geometry menu (Chapter 15). An energy profile may involve 
constraints on more than one geometrical variable (changed in 
lock-step with one another). In this case, the constraint ranges 
for the individual variables need to be selected. If Global Steps 
is checked, the independent variables are moved in concert, 
meaning that the number of steps must and will be the same for 
each variable. If unchecked, the variables are moved independently 
and the number of steps may differ from one to another. In this 
case, the total number of steps in the profile is the product of the 
number of steps for each variable. 

 Clicking on  at the bottom right of the Constraint Properties 
dialog brings up the Constraint Style dialog (not shown). This 
contains controls for selecting the color of the constraint marker. 
Clicking on  returns to the Constraint Properties dialog.
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 Point and Plane Properties

 Selection of a user-defined point or plane with a Properties dialog 
on screen, or selection of Properties from the Display menu 
following selection of a point or plane, leads to the Point Properties 
or Plane Properties dialog (not shown). These allow changing 
point or plane labels. Clicking on  at the bottom right of the 
Point (Plane) Properties dialog leads to the Point (Plane) Style 
dialog (not shown), with controls for adjusting point (plane) colors. 
Clicking on  returns to the Point (Plane) Properties dialog.

 Surface Properties

 Selection of a graphical display with a Properties dialog on screen, 
or selection of Properties following selection of a graphical 
display, leads to the Surface Properties dialog.

 
 This allows changing display style (Style), selecting between 

continuous and banded displays and, in the case of the latter, 
setting the number of bands, specifying isovalue (and for electron 
density surfaces), percentage of the electrons contained inside the 
surface, turning on mapped properties, setting the property range of 
maps, and changing default surface labels. The dialog reports (and 
optionally posts) the area (Area), volume (Vol) and accessible area 
(Acc. Area)* of the surface, the polar area (P-Area) and accessible 

* A region on a density surface is designated as inaccessible if a sphere of radius 1.0 Å centered 
on a line normal to the surface and touching a point in the middle of the region, impinges on 
any other regions of the surface. The default radius (Accessible Area Radius) may be changed 
in the Settings Preferences dialog (Preferences under the Options menu; Chapter 20).
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polar area (Acc. P-Area) of an electrostatic potential map*, the 
value of the mapped property at the cursor position (Val)** and the 
area enclosed in a selected band (Selected Area). The dialog also 
allows posting of the minimum and maximum value of the mapped 
property. If checked, Legend displays a color scale. If checked, 
Selected Area outlines the band containing the cursor. If checked, 
Display Accessible Markers reveals regions that are inaccessible. 
If checked, Global Surfaces designates that the settings apply to 
all molecules in the document.

 The dialog also provides for up to three independent clipping 
planes which operate in toggle mode. Following selection, a 
plane may be rotated, translated or zoomed with the usual mouse 
operations.

 Where the graphic is a slice, the Slice Properties dialog appears.

 
 This contains controls to set the range of the property and to change 

the number of contours displayed and to the type of slice (plane, 
cylinder or sphere). The value of the property at the cursor position 
is displayed and, together with the minimum and maximum values 
of the property, may be posted to the spreadsheet. Check boxes 
allow for a legend, a frame around the slice and for a grid.

 Clicking on  at the bottom right of the Surface Properties dialog 
brings up the Surface Style dialog (not shown). This contains 

* This is defined as that part of the surface area for which the absolute value of the electrostatic 
potential is > 100 kJ/mol. The cutoff (Polar Area Range) may be changed in the Settings 
Preferences dialog (Preferences under the Options menu; Chapter 20).

** To determine property value at another position click on it. To bring up the Molecule 
Properties dialog, click on the background.



322 Chapter 18

controls for selecting surface color. Clicking on  at the bottom 
right of this dialog returns to the Surface Properties dialog.

 Curve and Plot Properties

 Plots created either using data from the spreadsheet or from spectra 
may be edited using a set of closely-related dialogs. These refer 
to curves (a relationship between variables), and plots (a set of 
relationships that share variables).

 Selection of a plot frame with a Properties dialog on screen, or 
selection of Properties following selection of a plot frame, leads 
to the Plot Properties dialog (XY plot case shown).

 

 The X Axis menu and the Y Axes list duplicate functionality 
under the Plots dialog (see Plots... later in this chapter) and allow 
specification of a molecular property to serve as the X axis of the 
plot and one or more properties to serve as the Y axes. The contents 
of the Y-Axes list depends on selection from the Type menu: 
By Molecule and Free Form reference explicit entries in the 
spreadsheet (see discussion later in this chapter) while By Atom 
references Spartan’s file of atom-based properties (the Property 
Archive). Initial selections may be altered as desired. In addition, 
the aspect ratio of the plot may be changed, the numerical scale of 
the X (horizontal) axis turned on or off, a grid added to the plot, 
and the default label changed. Magnifier brings up a frame with 
which to magnify selected areas of a plot. The magnifier may be 
positioned by clicking on the frame and then moving the mouse 
with the right button depressed. Magnifier selection results in 
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the Plot Magnifier Properties dialog (not shown) with a single 
control to alter the width. The magnifier may be removed from 
the plot using Delete (Build menu) or the Delete key.

 The range along the X (horizontal) axis may be altered from default 
settings by clicking on the X-Axis. tab at the left of the dialog. 
This brings up the Plot X-Axis Properties dialog (clicking on the 
Plot tab returns to the Plot Properties dialog).

 

 To alter the range, edit the values inside the Range boxes, and press 
the Enter key (return key on Mac). Controls are also available 
to alter the number of tic marks on the X axis, the label size and 
precision and change the scale from linear to logarithmic.

 Clicking on  at the bottom right of either the Plot Properties 
or Plot X-Axis Properties dialog brings up the Plot Style dialog 
(not shown). This contains controls for selecting the color of the 
plot frame, as well as the label associated with the X axis. Clicking 
on  at the bottom right of this dialog returns to either the Plot 
Properties or Plot X-Axis Properties dialog.

 The Style menu in the Plot Properties dialog allows shifting 
between 2D (XY) and 3D (XYZ) plots. Selection of XYZ Plot 
leads to an extended XYZ Plot Properties dialog.
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 This is identical to the XY Plot Properties dialog, except that it 
includes an additional menu (Y Axis) from which one property 
needs to be selected. In addition, the Y Axes list in the XY Plot 
Properties dialog has been renamed to Z Axes.

 Ranges along X and Y axes may be adjusted by clicking on 
X-Axis and Y-Axis tabs to the left of the dialog. This leads to 
the Plot X-Axis (Plot Y-Axis) Properties dialog (clicking on the 
Plot tab at the left of this dialog returns to the Plot Properties 
dialog). These are analogous to the (Plot X-Axis Properties) 
dialog discussed for XY plots.

 Selection of an individual curve in a plot with a Properties dialog 
on screen, or selection of Properties from the Display menu 
following selection of an individual curve, leads to the Curve 
Properties dialog.

 
 This allows changing the quantity that is plotted (Axis), providing 

a scale and error bars (obtained from the column in the spreadsheet 
designated in the Error menu) and turning clipping on. Controls 
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are available to designate the kind of markers for the data points, 
request marker labels, and designate the kind of fit to the data 
points and the line width of the fitting curve*. If checked, Focus 
marks the selected molecule on the curve.

 The scale along the Y axis of an XY plot or Z axis of an XYZ plot 
may be altered from the default (minimum to maximum value of 
the Y or Z) by clicking on the Axis tab. This brings up the Curve 
Axis Properties dialog.

 

 To alter the scale, type in new values inside the boxes underneath 
Range. You need to press the Enter key (return key on 
Mac) following each entry. Controls are also available to alter 
characteristics of the Y (XY plot) or Z axis (XYZ plot) labels.

 Clicking on  at the bottom right of either the Curve Properties 
or Curve Axis Properties dialog brings up the Curve Style 
dialog (not shown). This contains controls for selecting the color 
of the curve (and the label associated with the Y (or Z) axis). 
Clicking on  at the bottom right returns to the original dialog.

 Substituent Properties

 Selection of a substituent icon with a Properties dialog on screen, 
or selection of Properties following selection of a substituent 
icon, leads to the Substituent Properties dialog.

* Fitting functions include linear, quadratic and cubic least square, a Fourier series, a Lorentzian 
or a Gaussian. The data points may also be connected by straight lines (point-to-point) or 
by a smooth curve (cubic spline) or be presented as a skyline. Finally, the fitting curve can 
be removed.
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 This allows substituent libraries already attached to a molecule to 
be edited, and the label on the substituent icon to be changed. It 
does not allow for attachment points to be reassigned. The dialog 
comprises a scroll box (listing the substituent names), a viewing 
window (showing a model of the substituent) and a label field.

 To delete a substituent from the library, click on its name in the 
scroll box, then right click and select Delete from the menu that 
appears. To add a new substituent that has previously been copied 
to the clipboard, right click inside the scroll box and select Paste 
from the menu that appears. Note, that if the clipboard contains 
several molecules, all will be added to the substituent library. To 
add a substituent (or list of substituents) in a Spartan document to 
the library, right click inside the scroll box, select Append from 
the menu that appears and choose a document from the browser. 
Alternatively, drag the document that contains the substituent(s) 
from a window into the scroll box.

 Clicking on  at the bottom right of the Substituent Properties 
dialog brings up the Substituent Style dialog (not shown). This 
contains controls for selecting substituent (icon) color. Clicking 
on  returns to the Subtituent Properties dialog.

 CFD Properties

 Selection of a chemical function descriptor (CFD) or of an element 
of a pharmacophore with a Properties dialog on screen, or selection 
of Properties (Display menu) following selection of a CFD or 
pharmacophore element, leads to the CFD Properties  dialog.
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 This allows changing the definition of the CFD, its label and 
the precision of the fit (the bigger the radius of the CFD, the 
less precise the fit). If checked, Global CFD specifies that CFD 
definitions will apply to all molecules in the document.*

 Clicking on  in the dialog brings up the CFD Style dialog (not 
shown). This contains controls for selecting CFD color. Clicking 
on  in this dialog returns to the CFD Properties dialog.

 Regression Properties

 Following a linear regression analysis, a new row, labeled 
Fit1**, appears near the bottom of the spreadsheet. This contains 
information about the fit. Clicking on this line with a Properties 
dialog on screen, or selecting Properties (Display menu) after 
clicking on the line, leads to the Regression Properties dialog.

 

* This is generally applicable only where the molecules are conformers, or the CFD labels 
have been adjusted to associate positions on different molecules. Label reassignment is 
accomplished using the Atom Properties dialog (see discussion earlier in this chapter).

** More precisely, a row will be written for each fit, and labelled Fit1, Fit2, . . ..
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 This reports RMSD and R2, as well as allows for changing what is 
to be fit (Fit) and what it is to be fit to (Using). The error statistics 
will immediately update.

 “Selected” Style

 The “Selected” Style dialog is accessed either by defining a 
selection box (see Mouse and Keyboard Operations in Chapter 
2) with a Properties dialog on screen, or by selecting Properties 
from the Display menu after defining a selection box. This contains 
controls for changing the color and model type of whatever is 
included in the selection box.

 Orbital Energies

 Selection of Orbital Energies leads to the display of an orbital 
energy diagram (this assumes that a wavefunction is available). 
This comprises up to twelve occupied molecular orbitals and two 
unoccupied molecular orbitals, the highest-occupied (HOMO) and 
lowest-unoccupied (LUMO) being explicitely designated. 

 Clicking on an energy level in the diagram leads to display of 
the corresponding molecular orbital. This may be manipulated 
in the usual way and the display style altered (from the menu at 
the bottom right of the screen). Only one orbital at a time may be 
displayed.
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Surfaces

This accesses the same dialog already described in Chapter 17.

Spectra

Spartan displays calculated IR, Raman, NMR and UV/visible 
spectra. (Spectra need to have been previously requested from the 
Calculations dialog under the Setup menu; Chapter 17.) In addition, 
it allows on-line access and display of experimental IR, NMR and 
UV/visible spectra from publicly available collections, facilitating 
comparison with calculated spectra. Calculated IR and Raman spectra 
may be fit to measured spectra, using a linear scaling parameter and 
a peak width parameter.*

Access to spectra  display is via a series of tabbed dialogs (IR, Raman, 
NMR and UV/vis).

IR, Raman (these two dialogs are nearly identical and will be 
discussed together)

Clicking on the IR (Raman) tab leads to the IR Spectra (Raman 
Spectra) dialog. This displays the calculated and (if available) 
experimental infrared (Raman) spectra, and allows for animated 
display of the vibrational modes as well as for generation of a 
sequence of structures along a vibrational coordinate.

* While IR and Raman frequencies are the same and only the intensities are different, both the 
scaling and line-width parameters may differ in order to provide best fits to the respective 
experimental spectra. 
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At the left-hand side of the dialog is an ascending list of frequencies 
(in cm-1)* together with (infrared) intensities and symmetry labels. 
A frequency is selected for display (animation) by clicking on it. 
Clicking again deselects it (stops the animation).

The amplitude of vibrational motion (the maximum displacement 
away from equilibrium of any pair of atoms) may be changed 
from the default amplitude (0.5Å which is much larger than 
appropriate for vibrational motion at room temperature) by 
altering the contents of the box to the right of Amp at the lower 
right of the dialog. The default number of steps that make up the 
display (11) may be changed by altering the contents of the box 
to the right of Steps** at the lower right of the dialog.

Clicking on Make List creates an unnamed Spartan document 
containing a sequence of structures corresponding to motion 
along the selected vibrational mode. The original document is 
not closed and additional sequences (corresponding to different 
vibrations) can be created.

* Imaginary frequencies, for example, corresponding to the reaction coordinate for a transition state, 
will appear first in the list, and will be designated by the letter i in front of the frequency value.

** It is recommended that the number of steps be odd ensuring that the center point corresponds 
to the actual equilibrium or transition-state structure.

* 
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Note that the information required to produce vibrational motions 
(animations) and to construct lists of structures along different 
vibrational coordinates is not available as part of an entry in the 
Spartan Molecular Database. However, it is available as part of 
the entry in the Spartan Spectra and Properties Database (see 
discussion in Chapter 19).

The calculated spectrum may be drawn by clicking on Draw 
Calculated at the top right of the dialog (IR spectrum shown).

The experimental spectrum (if available) may be drawn on top 
of the calculated spectrum (or by itself) by clicking on Draw 
Experimental at the center right of the dialog (IR spectrum 
shown).

Finally, a reference spectrum (a spectrum shared by all molecules 
in the document; see discussion of the Spartan Infrared Database 
in Chapter 19) if available, may be displayed along with the 
calculated and/or experimental spectra by clicking on Draw 
Reference.

Draw operations for both calculated and experimental IR and 
Raman spectra, apply to all molecules in the document (not 
just the selected molecule). Note, however, that the reference 
spectrum is common to all molecules in the document.

* 
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Experimental IR spectra are accessed from the NIST (National Institute 
of Standards and Technology) website (http://webbook.nist.gov/
chemistry). This comprises approximately 7,000 IR spectra, primarily 
for organic molecules. Spartan keeps an index to facilitate retrieval but 
the actual data are on the website. Alternatively, the user may supply 
a spectra file (see Appendix J). Selection (website vs. file) is made at 
the bottom right of the dialog. Global Spectra controls whether spectra 
access pertains to all molecules in the document (checked) or just the 
selected molecule (unchecked). Note that experimental spectra, once 
retrieved either on-line or from a file, are kept in the document (and 
need not be retrieved again if they are deleted). They can be removed 
from the document by clicking on the Reset button.

The default range for calculated, experimental and (for infrared 
only) reference IR and Raman spectra is from 4000 cm-1 to 500 
cm-1. This corresponds to the range commonly measured and 
reported. This range may be changed by selecting Properties 
from the Display menu, clicking on the horizontal axis to bring 
up the Plot Properties dialog, clicking on the X Axis. tab at 
the left of the dialog and editing the values under Range. The 
spectrum is treated like any other graphical object, and may be 
translated and scaled using the appropriate mouse operations. It 
may not be rotated. 

The calculated spectrum may be removed by clicking on Delete 
Calculated (that has replaced Draw Calculated) in the dialog. 
Similarly, the experimental spectrum (infrared only) may be 
removed by clicking on Delete Experimental (that has replaced 
Draw Experimental) and the reference spectrum may be 
removed by clicking on Delete Reference (that has replaced 
Draw Reference). The last spectrum (calculated, experimental 
or reference) removed will also cause removal of the plot axes. 
These operations apply to all molecules in the document (not just 
the selected molecule). An individual (calculated or experimental) 
spectrum or entire plot may also be removed by selecting Delete 
from the Build menu and then clicking on a spectrum or on 
the plot axes, respectively. Holding down the Delete key while 
clicking on the spectrum or plot axes has the same effect.
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Calculated IR (Raman) frequencies exhibit systematic errors. 
Frequencies obtained from (limiting) Hartree-Fock models 
are typically 10-12% larger than measured frequencies, while 
frequencies obtained from density functional and MP2 models 
are typically 3-4% larger than measured frequencies. Systematic 
errors may be revealed (and quantified) by first simultaneously 
displaying calculated and experimental spectra and then 
scaling one of the spectra to provide a best visual fit. To scale 
the calculated spectrum, use the slider bar to the right of Scale 
near the top right of the dialog. This is limited in range (from 
0.8 to 1.0). If it is necessary to scale outside this range, click 
on the spectra (not on an axis) to select and move the mouse 
up and down while simultaneously depressing the Shift and Alt 
keys (option on Mac) keys in addition to the right button. The 
scale factor (multiplying the frequency) will be displayed on the 
vertical axis. Scaling applies uniformly to all molecules in the 
list (not just the selected molecule).

A scaling factor may be applied to frequencies, and to all properties that 
make use of frequencies, prior to reporting using the FreqScale keyword 
typed into the Options box in the Calculations dialog (Calculations... 
under the Setup menu, Chapter 17).

A second slider bar marked Temp controls peak width. This is 
loosely connected with the temperature at which the experimental 
measurement is carried out. Low “temperature” (slider to the 
left) will produce sharp spikes, whereas high “temperatures” 
(slider to the right) will produce broad bands. The default setting 
is intended to give calculated spectra that broadly resemble 
experimental infrared spectra. Both Scale and Temp slider bars 
actually control the fit of the calculated frequencies and intensities 
to a Lorentzian function. The default settings can be restored by 
clicking on the Standard button. A best fit to an experimental 
spectrum superimposed onto the calculated spectrum can be 
obtained by clicking on the Experimental button. A best fit to an 
unknown reference spectrum (associated with all the molecules 
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in the document rather than a single molecule) can be obtained 
by clicking on the Reference button.

NMR

Spectra are divided into four categories*: 1H spectra, 13C and 
DEPT spectra, COSY spectra and HSQC and HMBC spectra. 
Access to experimental 1D spectra is provided either on-line or 
from a local file. Clicking on the NMR tab leads to the NMR 
Spectra dialog.

Calculated proton, 13C and DEPT spectra may be drawn by 
clicking on their respective Draw Calculated buttons. Carbon 
shifts (only) for both 13C and DEPT spectra from the B3LYP/ 
6-31G* model are corrected based on topology and from the EDF2/ 
6-31G* model are corrected based on topology and bond orders. 
Carbon shifts from other models and proton shifts are not corrected.

* Chemical shifts for other nuclei may be displayed as labels (see Configure... under the 
Model menu; Chapter 14).
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Experimental 13C and DEPT spectra (if available) may be drawn 
together with or independently of the calculated spectra by 
clicking on Draw Experimental. Draw operations apply to all 
molecules in the list.

Experimental proton and 13C spectra are accessed from 
http://nmrshiftdb.ice.mpg.de. This comprises approximately 15,000 
experimental spectra, all for organic molecules. Alternatively, the user 
may supply a spectra file (Appendix J). Selection (website vs. file) is 
made at the bottom right of the dialog. Global Spectra controls whether 
spectra access pertains to all molecules in the document (checked) or just 
to the selected molecule (unchecked). Note that experimental spectra, 
once retrieved either on-line or from a file, are kept in the document (and 
need not be retrieved again if they are deleted). They can be removed 
from the document by clicking on the Reset button.

Proton spectra may be drawn to reflect spin-spin coupling due 
to neighboring nuclei. Coupling constants are not calculated, but 
are estimated empirically based on three-dimensional geometry. 
A magnifier is available under the Plot Properties dialog (see 
discussion earlier in this chapter).
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Default ranges for proton spectra (0 to 10 ppm) and 13C spectra 
(0 to 150 ppm) may be changed by selecting Properties from 
the Display menu, clicking on the horizontal axis to bring up 
the Plot Properties dialog, clicking on the X Axis tab at the left 
of the dialog and editing the values under Range. Spectral plots 
may be translated and scaled.

A calculated spectrum may be removed by clicking on 
Delete Calculated (that has replaced Draw Calculated) and 
an experimental spectrum removed by clicking on Delete 
Experimental. The last spectrum removed will also cause 
removal of the plot axes. These operations apply to all molecules 
in the document. An individual (calculated or experimental) 
spectrum or entire plot may also be removed by selecting Delete 
from the Build menu (or holding down the Delete key) and then 
clicking on the spectrum or on the plot axes, respectively.

2D spectra are available from Draw Calculated buttons. COSY 
spectra identify protons three bonds removed, HSQC spectra 
identify protons directly attached to carbons and HMBC spectra 
identify protons that are two or three bonds removed. Note that 
proton spectra “broadened” because of the inclusion of spin-
spin coupling are not used in construction of 2D spectra. The 
corresponding proton and carbon spectra axes may be displayed 
along with 2D spectra by selecting them in addition to the 2D 
spectra. 2D spectra (and the 1D axes spectra) may be removed 
using the Delete Calculated buttons (that have replaced the 
Draw Calculated buttons). Experimental 2D spectra displays 
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are not yet available. An HMBC spectrum is shown below.

Uncorrected spectra (all proton spectra and 13C and DEPT spectra 
from models other than B3LYP/6-31G* and EDF2/6-31G*) are 
likely to show significant systematic errors in chemical shifts.  
To scale either the calculated or experimental spectra in order to 
provide a best visual fit, click on the spectra (not on an axis) to 
select and move the mouse up and down while simultaneously 
depressing the Shift and Alt (option on Mac) keys in addition to 
the right button. The scale factor (multiplying the chemical shifts) 
will be displayed on the vertical axis. Scaling applies uniformly 
to all molecules in the document.
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UV/vis

Clicking on the UV/vis tab leads to the UV/vis Spectra dialog 
that provides for display of UV/visible spectra.

This lists wavelengths and intensities. Click on Draw Calculated 
to draw the calculated spectrum.

Click on Draw Experimental to draw the corresponding  
experimental spectrum. Draw operations for both calculated and 
experimental UV/visible spectra and apply to all molecules in 
the list.



Chapter 18 339

Experimental UV/visible spectra are accessed from the NIST (National 
Institute of Standards and Technology) website (http://webbook.nist.
gov/chemistry). This comprises approximately 1,500 UV/visible spectra, 
primarily for organic molecules. Spartan keeps an index to facilitate 
retrieval but the actual data are on the website. Alternatively, the user 
may supply a spectra file (see Appendix J). Selection (website vs. file) is 
made at the bottom right of the dialog. Global Spectra controls whether 
spectra access pertains to all molecules in the document (checked) or just 
to the selected molecule (unchecked). Note that experimental spectra, 
once retrieved either on-line or from a file, are kept in the document (and 
need not be retrieved again if they are deleted). They can be removed 
from the document by clicking on the Reset button.

The default range for both calculated and experimental UV/visible 
spectra is from 200 nm to 700 nm. This corresponds to the range 
commonly measured and reported. This range may be changed 
by selecting Properties from the Display menu, clicking on the 
horizontal axis to bring up the Plot Properties dialog, clicking 
on the X Axis tab at the left of the dialog and editing the values 
under Range. The spectrum is treated like any other graphical 
object, and may be translated and scaled using the appropriate 
mouse operations.

The calculated spectrum may be removed by clicking on Delete 
Calculated (that has replaced Draw Calculated) in the dialog. 
Similarly, the experimental spectrum may be removed by clicking 
on Delete Experimental (that has replaced Draw Experimental). 
The last spectrum removed will also cause removal of the plot axes. 
These operations apply to all molecules in the document (not just 
the selected molecule). An individual (calculated or experimental) 
spectrum or entire plot may also be removed by selecting Delete 
from the Build menu (or holding down the Delete key) and 
then clicking on the spectrum or on the plot axes, respectively.

To help reveal similarities and differences between calculated 
and experimental UV/visible spectra, one or the other may be 
scaled. To scale, click on the spectra (not on an axis) to select and 
move the mouse up and down while simultaneously depressing 
the Shift and Alt (option on Mac) keys in addition to the right 
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button. The scale factor will be displayed on the vertical axis. 
Scaling applies to all molecules in the document.

Only a single copy of one of the dialogs under Spectra may 
appear on screen; scaling will relate to the currently selected 
molecule. The dialog may be removed by clicking on .

Formulas

The molecular mechanics and quantum chemical methods available 
in Spartan are able to provide a wide variety of molecular and atomic 
properties and QSAR descriptors. Quantities related to structure are 
available through functions under the Geometry menu (Chapter 15), 
while most other properties may be accessed from Properties dialogs 
or from the spreadsheet. In some cases, however, it is not the properties 
or descriptors themselves that are of interest, but rather relationships 
among them. For example, while the energies of the HOMO and 
LUMO of a molecule may not be of interest, the difference in their 
energies (the HOMO-LUMO gap) may be. Another important kind of 
relationship is that involving a change in property between reactants 
and products of a chemical reaction, in particular, the change in energy.

Spartan provides a tool to help define relationships among properties 
of a single molecule or of a single property between molecules that 
formally correspond to the reactants and products of a chemical 
reaction. The former will be discussed here and the latter will be 
discussed in the next chapter in the context of data mining. The 
Formula Editor dialog is accessed by selecting Formulas from the 
Display menu.
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The bottom half of the dialog contains controls to build formulas, 
while the top half is a box to store finished formulas. As the most 
important property is arguably the energy, it is provided its own 
control (button). So too is the heat of formation obtained from the 
T1 model.* Both are found under Energies at the lower left of the 
Formula Editor dialog along with a menu to specify units. Other 
properties need to be accessed by dragging the property from its on-
screen display (for example, a bond distance from its display at the 
bottom of the screen following selection of Measure Distance from 
the Geometry menu) or from one of the Properties dialogs (for 
example, the dipole moment in the Molecule Properties dialog) 
onto one of the three buttons under Properties at the lower right 
of the Formula Editor dialog. Following this, the button takes the 
name of the property. The property obtained from Spartan is now 
available for use in a formula.

The only other setting required is the Theoretical Model (under 
Context in the lower center of the Formula Editor dialog). The 
choices reflect the theory levels stored in databases available to Spartan 
(see discussion in Chapter 19). Ambient refers to the theoretical 
model actually used for the calculation of the selected molecule, and 
should not be selected if a calculation has not actually been run. The 
Applied to menu under Context will be grayed out if the molecule 
that Spartan is pointing to does not contain reaction information. 
Use of the formula editor to relate information for the reactants 
and products of chemical reactions is discussed in Chapter 19.

Pressing either the E or H(T1) buttons or a Property button onto 
which a property has been dragged, builds a formula and places it 
inside the second box at the center of the dialog. The default name 
(Fx, x=0, 1, 2...) appears in the first box. Either the formula or its 
name may be edited. Pressing Enter (return on Mac) stores the 
formula with the default or edited name. Pressing Clear removes the 
formula. Double clicking on a formula in storage brings it back to the 
boxes at the center of the formula editor (but does not remove it from 

* Heats of formation from the T1 recipe where available are included with SMD and SSPD 
entries.
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storage). The formula can then be edited and returned to storage (by 
clicking on Enter). If the name of the formula has not been changed, 
it will replace the original in storage. If it has been changed, it will be 
treated as a new formula. Once in storage, a formula can be dragged 
to wherever it is needed, in particular, into the spreadsheet, the Plots 
dialog or any of the dialogs associated with the Spartan Molecular 
Database or Spartan Spectra and Properties Database. To remove a 
stored formula, right click on it and select Delete from the menu.

Formulas use the usual set of arithmetic operations and parentheses 
to connect different properties. In addition, Boolean operators and 
standard mathematical functions designated in Table 18-1 may be 
used. These need to be typed into the box at the center of the dialog. 
For example, to construct a formula for the HOMO-LUMO gap, 
first drag the LUMO energy from the Molecule Properties dialog 
onto one of the properties buttons in the Formula Editor dialog. 
Pressing the button leads to the text string @LUMO*@hart2eV at 
the center of the dialog. Insert (type) “-” at the end of the string. 
Next, drag the HOMO energy from the Molecule Properties dialog 
onto a properties buton in the editor and press the button. The text 
string is now @LUMO*@hart2eV-@LUMO*@hart2eV. Note that 
while orbital energies are evaluated in atomic units (hartrees), the 
formula includes a conversion factor @hart2eV to bring them into 
electron volts (eV). You can change units by manually editing the 
text string using the expressions provided in Table 18-2 (preceeded 
by @). Change the title to the left of the string from Fx to HOMO/
LUMO gap, and press the Enter (return) key to the right of the 
string. The full formula is moved to the storage area at the top of the 
dialog. Note that the formula will be evaluated and numerical results 
presented if the appropriate data for the selected molecule with the 
selected theoretical model are available in the database (in this case, 
HOMO and LUMO energies).

A number of the quantities that are calculated by Spartan are not 
available from the graphical interface, but must be extracted from 
the archive of properties maintained by Spartan. Examples include 
orbital energies other than those corresponding to the HOMO and 
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Table 18-1: Arithmetic and Boolean Operations and Mathematical 
Functions

arithemetic operations boolean operations
+ addition > greater than
_ subtraction >= greater than or equal to
* multiplication < less than
/ division <= less than or equal to
^ raise to a power == equal to
   != not equal to
   | or
   & and

mathematical functions
ABS(x) absolute value LN(x)  natural logarithm
ACOS(x) inverse cosine LOG(x)  log (base 10)
ASIN(x) inverse sine SIN(x)  sine
ATAN(x) inverse tangent SQRT(x) square root
COS(x) cosine TAN(x)  tangent
EXP(x) exponential

Table 18-2: Conversion Factors and Constants

ANGS2AU Ångstroms to atomic units
AU2ANGS atomic units to Ångstroms
EV2HART eV to atomic units (hartrees)
EV2KCAL eV to kcal/mol
EV2KJ eV to kJ/mol
HART2KCAL atomic units (hartrees) to kcal/mol
HART2EV atomic units (hartrees) to eV
HART2KJ atomic units (hartrees) to kJ/mol
KCAL2EV kcal/mol to eV
KCAL2HART kcal/mol to atomic units (hartrees)
KCAL2KJ kcal/mol to kJ/mol
KJ2EV kJ/mol to eV
KJ2HART kJ/mol to atomic units (hartrees)
KJ2KCAL kJ/mol to kcal/mol
PI π
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LUMO, and the polar surface area defined to include sulfur and any 
attached atoms in addition to nitrogen, oxygen and any attached 
hydrogens (the default). However, these and other quantities may be 
used in formulas by manually editing the text string. The expressions 
provided in Table 18-3 need to be preceeded by a @. For example, @
HOMO(-1) accesses the energy of the molecular orbital immediately 
below the HOMO, while @PAREA(7,8,16,7:,8:,16:) accesses the 
polar area extended to sulfur and any attached hydrogens.

Formulas are used in conjunction with spreadsheet manipulations 
and plotting (both discussed later in this chapter) and with data 
mining (discussed in Chapter 19).

Spreadsheet

Associated with each Spartan document (including documents 
comprising a single molecule) is a spreadsheet. This may be displayed 
by selecting Spreadsheet.

The spreadsheet comprises a series of rows (corresponding to 
different molecules in the document) and columns (corresponding to 
different molecular properties). This gives rise to cells, the number 
of which is the product of the number of rows (molecules) and the 
number of columns (molecular properties). The spreadsheet may 
be expanded or contracted by positioning the cursor at one of the 
corners, pressing the left mouse button and dragging the mouse.
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Table 18-3: Calculated Quantities

AREA	 area	of	a	user-defined	plane	(Å2)
ELECTRONEGATIVITYEV	 QSAR	descriptor	-(HOMO+LUMO)/2	(eV)
HARDNESSEV	 QSAR	descriptor	-(HOMO-LUMO)/2	(eV)	
HOMO(-n)EV	 energy	of	nth	orbital	below	the	HOMO	(eV)
HOMOBETA(-n)EV	 energy	of	the	nth	orbital	below	the	β HOMO	(eV)
HYPERPOLARIZABILITY	 beta	hyperpolarizability	parameter	
INERTIA(i)	 principle	movements	of	 inertia	 from	 largest	

(i=1)	to	smallest	(i=3)	
ISOTOPE(i)	 mass	number	of	atom	i
LENGTH	(i)	 length	of	bond	i	(Å)
LOGPC	 LogP	from	Crippen	model
LOGPV	 LogP	from	Villar	model
LUMO(+n)EV	 energy	of	nth	orbital	above	the	LUMO	(eV)
LUMOBETA(+n)EV	 energy	of	nth	orbital	above	the	β LUMO	(eV)
PAREA	(i,	j,	.	.	.)	 surface	area	of	space-filling	model	due	to	atoms	

of	type	i,	j,	...,	(atomic	numbers	or	elemental	
symbols).	 i:,	 j:,	 ...	 signifies	 that	 attached	
hydrogens	are	also	included.	The	surface	area	
of	nitrogen,	oxygen	and	bonded	hydrogens	is	
the	polar	surface	area.	(Å2)

POLARIZABILITY	 alpha	polarizability	parameter	

Table 18-4: Specialty Functions

AVG	(column	name)	 average	of	values	in	column
FITVAL	(fit	name)	 column	of	fit	values	from	regression	analysis
MIN	(column	name)	 minimum	of	values	in	column
MAX	(column	name)	 maximum	of	values	in	column
NUM	(column	name)	 number	of	defined	entries	in	column
ROW	 the	number	of	the	row	in	the	spreadsheet
ROW(molecule	name)	 the	number	of	the	row	of	molecule
REF(i,	x)	 the	value	of	the	x	referenced	to	row	i
STDEV	(column	name)	 standard	deviation	of	values	in	column
SUM	(column	name)	 sum	of	values	in	column
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Only one molecule from one document may be selected (although 
several molecules may be simultaneously displayed). Molecule 
selection follows either by clicking on the spreadsheet cell containing 
the molecule label or identifier (leftmost column), or by using the 

 and  buttons or the scroll bar at the bottom left of the screen. 
Molecules may be animated (stepped through in succession) using 
the  button at the bottom left of the screen. Animation speed may 
be adjusted from the Settings Preferences dialog (Preferences under 
the Options menu; Chapter 20). Selection of a new molecule in the 
document results in deselection of the previously selected molecule. 
A molecule may be designated for permanent display by checking 
the box to the left of its identifier in the spreadsheet. The molecules 
in a document may either be translated and rotated in concert or 
manipulated independently. This is controlled by Coupled (which 
operates in toggle mode) under the Model menu (Chapter 14). By 
default (Coupled checked) molecules move in concert. Uncheck 
Coupled to move them independently.

Upon initial entry, all columns of the spreadsheet except the leftmost 
column, are blank. The leftmost column contains a label that may be 
changed either by directly typing a new label into the spreadsheet or 
into the Label box in the Molecule Properties dialog (see discussion 
earlier in this chapter). Additionally, default identifiers (M0001, 
...) may be replaced by chemical names if the molecule exists in 
the Spartan Molecular Database (SMD) by clicking on Label (the 
leftmost header cell), then right clicking and selecting Rename 
Selected using SMD from the menu that results. To replace all 
identifiers, right click inside the header cell of the leftmost column and 
again select Rename Selected using SMD. Renaming also applies 
to molecules in the Spartan Spectra and Properties Database (SSPD) 
in which case the menu entry is Rename Selected Using SSPD.

Information may be added to the spreadsheet in several different 
ways:

From the Add Dialog

A selection of molecular properties may be entered into the 
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spreadsheet by first clicking on the header cell of an empty column, 
and then clicking on Add... at the bottom of the spreadsheet. 
Alternatively, right click inside the header cell and then to select 
Add... from the menu that results.

This leads to the Add Columns dialog.

Name molecule name as it appears in SMD or SSPD
Formula molecular formula
E energy (heat of formation, strain energy)
Eaq aqueous energy (heat of formation, strain energy) 

based on the SM5.4 model
rel. E energy (heat of formation, strain energy) relative to 

selected molecule
rel. Eaq aqueous energy (heat of formation, strain energy) 

relative to selected molecule based on the SM5.4 
model

E HOMO energy of highest-occupied molecular orbital
E LUMO energy of lowest-occupied molecular orbital
Dipole dipole moment (in debyes)
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Molecular Weight molecular weight (in amu)
Boltzmann Boltzmann distribution based on energy
Distribution 
Boltzmann Boltzmann distribution based on aqueous energy
Distribution (aq) as estimated from SM5.4 model 
Alignment Scores 1-R2/N, where R2 is the root mean square distance 

and N is the number of alignment centers. 1 is a 
perfect score

One or more properties may be added to the spreadsheet by 
clicking on their entries, then specifying appropriate units from 
the Energy and Length menus, varying temperature from the 
Temp menu (as applied to the Boltzmann distributions), and 
finally clicking on OK or on Apply. In the former case, the 
dialog is dismissed and in the latter it is left on screen. Clicking 
on Cancel or  removes the dialog without further affecting 
the contents of the spreadsheet. (Any previous additions to the 
spreadsheet as a result of clicking on Apply are maintained.)

Column totals, averages and Boltzmann-weighted averages may 
be accessed by clicking on the Summaries tab. This leads to the 
Add Summaries dialog.

Totals sum of column values
Averages average of column values
Boltzmann Averages Boltzmann weighted average of column 

values
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Boltzmann Averages (aq) Boltzmann weighted average of column 
values using energies corrected for aqueous 
environment based on the SM5.4 model

Clicking on one or more of these followed by clicking on OK or 
Apply, leads to the requested summaries as rows at the bottom of 
the spreadsheet, identified as Totals, Averages, etc. (one row for 
each summary). Note, that this dialog can be brought up directly 
by clicking on an empty row header (instead of an empty column 
header) inside the spreadsheet prior to clicking on Add....

Finally, a linear regression analysis may be performed on the 
data in the spreadsheet. First click on the Linear Regression tab 
to bring up the Add Linear Regression dialog.

Select one entry from the Fit menu and one or more entries from 
the list under Using. Clicking on OK or Apply performs the linear 
regression analysis and places the results in a row at the bottom 
of the spreadsheet identified by Fit. As many regression analyses 
as desired may be performed on the data in the spreadsheet. 
The individual results will be entered as separate rows in the 
spreadsheet, with names Fit1, Fit2, etc. Additional information 
about the regression analyses is available from the Regression 
Properties dialog (see discussion earlier in this chapter).
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From Post ( ) Buttons

Post buttons ( ) found in a number of properties dialogs provide 
an alternative method to the Add dialog for entering calculated 
properties into the spreadsheet. Note that some properties 
may require user specification. These include individual bond 
distances, angles and dihedral angles (available from Measure 
Distance, Measure Angle and Measure Dihedral under the 
Geometry menu; Chapter 15), bond distance, angle and dihedral 
angle constraints (available from Constrain Distance, Constrain 
Angle and Constrain Dihedral under the Geometry menu; 
see discussion in Chapter 15), atomic charges, chemical shifts 
(available from the Atom Properties dialog; this chapter), the 
accessible area of an electron density surface, the polar area and 
accessible polar area of an electrostatic potential map, the area 
of a selected region (band) of a banded property map, minimum 
and maximum property values on a map and the value of the 
property at a specific location on a property map (available from 
the Surfaces Properties dialog; this chapter). With the exception 
of the property value on a map and the area of a selected band, 
post generates an entire column. Where atom labels are involved, 
for example, in defining a specific distance, post can be expected 
to yield consistent results for all molecules in a document only 
where the molecules are closely related, for example, molecules 
resulting from a conformational search, or where labels have been 
explicitly reassigned*. The property value and the area of a selected 
band on a map is posted only for the selected molecule. Post 
buttons are also available for CAS numbers and experimental heats 
of formation contained in Spartan’s internal database, and for T1 
heats of formation contained in both SMD and SSPD databases.

From the Clipboard

Properties of one or more molecules in a document may be copied 
into the clipboard and then pasted into individual spreadsheet 

* Label reassignment is accomplished using the Atom Properties dialog (see discussion 
earlier in this chapter).
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cells. These include (but are not restricted to) bond distances, 
angles and dihedral angles (Measure Distance, Measure 
Angle and Measure Dihedral under the Geometry menu), 
bond distance, angle and dihedral angle constraints (Constrain 
Distance, Constrain Angle and Constrain Dihedral under the 
Geometry menu), atomic charges and chemical shifts  (Atom 
Properties dialog), and the value of a property on a property 
map and the area of a selected band (Surface Properties dialog). 
To copy the spreadsheet, first highlight the numerical value of 
the property in the appropriate screen location (distances, etc.) or 
dialog (charges, etc.), then select Copy from the Edit menu, then 
click on the appropriate (destination) cell in the spreadsheet, and 
finally select Paste from the Edit menu.

User-Defined Expressions

An expression may be entered either into a header cell (in which 
case it refers to all molecules) or into an individual cell (in which 
case it refers only to a single molecule). Expressions in the column 
header take the form name=formula, where formula is made 
up of arithmetic operations (Table 18-1), specialty functions 
(Table 18-4), calculated quantities (Table 18-3), conversion 
factors and constants (Table 18-2) in addition to numerical 
values. References to specialty functions, calculated quantities 
and conversion factors and constants must be preceded by @. 
For example, mu=@DIPOLE typed into a header cell gives the 
dipole moment. Some functions have arguments, for example, 
c1 and c2 in the expression c12= @DISTANCE (c1,c2) refer to 
atoms c1 and c2, while 3 in the expression orbitalE=@HOMO 
(-3) designates the energy of the molecular orbital three orbitals 
below the HOMO. It is necessary to press the Enter key (return 
key on Mac) following entry of the expression into a cell. The 
leading name= is optional for individual entries. 

Formula construction inside the spreadsheet uses the same rules 
and references the same set of functions described in Formulas 
earlier in this chapter (in addition to the specialty functions in 
Table 18-4). It may be more convenient to construct expressions 
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in the formula editor and drag them into the spreadsheet than 
to construct them in the spreadsheet. Note that spreadsheet 
expressions refer to the molecules in the spreadsheet and not to 
their reaction products.

Numerical Data

Numerical data may be entered by typing directly into the 
spreadsheet. A column header first needs to be specified. Double 
click on an empty column header cell, type in a name and press 
the Enter key (return key on Mac). Then, type the data into 
individual cells of the new column (press the Enter (return) key 
following each data entry). Alternatively, use the ↓ key.

Each row in a spreadsheet corresponds to a molecule in a document, 
and new rows are automatically added in response to adding new 
molecules to the document. New molecules may be added by 
building (New Molecule under the File menu; Chapter 12), by 
appending one or more existing documents each containing one or 
more molecules using either Append Molecule(s)... under the File 
menu (Chapter 12), or by right clicking inside the header cell of 
the first available row and selecting Append from the menu that 
appears, by pasting from the clipboard, or by dragging  from the file 
system. To copy a molecule into the clipboard, first select (click on) 
it, and then select Copy from the Edit menu, or click on its identifier 
(left most column) in its spreadsheet, and then select Copy from 
the Edit menu. Alternatively right click either on the molecule or 
on its identifier in the spreadsheet and select Copy from the menu 
that appears. Use of the clipboard permits several molecules to be 
selected (and copied) at once using the Shift and Ctrl keys in the 
usual manner. To copy the contents of the clipboard to its destination, 
click on an empty row header in the spreadsheet (for the destination 
document), and then select Paste from the Edit menu. An alternative 
to the two-step Copy-Paste procedure is to drag the molecule or set 
of molecules from one spreadsheet to another.
A row (molecule) may be deleted from a spreadsheet, either by first 
selecting the molecule and then selecting Delete Molecule from the 
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File menu (Chapter 12), or by first clicking on its identifier in the 
spreadsheet (leftmost column) and then either clicking on the Delete 
button at the bottom of the spreadsheet, or by right clicking on its 
identifier in the spreadsheet and then selecting Delete Selected from 
the menu that appears. In all cases, a warning is provided prior to 
deletion. An entire column in the spreadsheet may be deleted by first 
clicking inside its header cell and then clicking on the Delete button 
(or Delete Selected from the menu).
Rows in the spreadsheet may be sorted according to the numerical 
values in any column either by first clicking inside the header cell 
and then clicking on the Sort button at the bottom of the spreadsheet 
or by right clicking inside the header cell and selecting Sort from 
the menu that appears. The rows are placed in ascending order, the 
smallest (least positive) value of the selected property at the top, 
largest (most positive) value at the bottom. To sort in descending 
order, hold down the Shift key before clicking on the Sort button or 
selecting Sort from the menu.
Information in one or more columns of the spreadsheet may be 
formated by right clicking inside the header cell(s) and selecting 
Format Selected from the menu that appears.

Format as desired and click on OK to remove the dialog. The full 
contents of the spreadsheet may be formated by right clicking inside 
the header cell for the left most column and then selecting Format 
Selected from the menu.

A button at the bottom right of the spreadsheet toggles between 
numerical representation of data, f(x), and formula presentation, =?.

The spreadsheet may be printed by right clicking inside the 
spreadsheet and selecting Print from the menu that results.



354 Chapter 18

As many spreadsheets as desired (corresponding to the same or 
to different documents) may be open on screen. A spreadsheet is 
removed when the associated document is closed and may also be 
removed by clicking on .

The contents of the spreadsheet may be brought into Excel™ using the 
clipboard. Select whatever cells are to be copied, select Copy from the 
Edit menu. Alternatively, right click with the proper cells selected and 
select Copy from the menu that appears. Paste into Excel.

The contents of an Excel spreadsheet may be brought into Spartan. 
Copy whatever information is to be transferred to the clipboard, move 
into Spartan, then click on the appropriate cell and select Paste from the 
Edit menu (or right click on the appropriate cell and select Paste from 
the menu that appears). Note, that information on the clipboard that goes 
beyond the number of rows in Spartan’s spreadsheet will be ignored.

Plots...

Plots may be constructed from data in a spreadsheet and a variety of 
simple curves fit to these data. Selection of Plots... from the Display 
menu leads to the Plots dialog.

A tab at the top of the dialog selects between XY Plot (two 
dimensions) or XYZ Plot (three dimensions). Common to both is 
the Plot Type menu.
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This distinguishes between plots based on the entire set of molecules 
in a document (By Molecule), to those based on the atoms in a single 
molecule (By Atom). The latter is the mode used to plot calculated 
IR, Raman and NMR spectra. The third choice (Free Form) is used 
to construct single molecule plots, for example, calculated, UV/
vis spectra as well as plots of experimental IR, Raman, NMR and 
UV/visible spectra. This is normally done automatically from the 
appropriate spectra dialog (see discussion earlier in this chapter).

By atom and free form plots make use of vector capabilities in 
Spartan’s spreadsheet. See the FAQ Vector Spreadsheet Operations 
available under Help from the Help menu (Chapter 22).

Also common to both is the Properties checkbox at the bottom 
left of the dialog. Unchecked, this provides access for the X-Axis 
(X-Axis and Y-Axis for an XYZ plot) menu and Y-Axes (Z-Axes 
for an XYZ plot) only to quantities that have been entered in the 
spreadsheet. Checked, it provides access to all quantities in the 
Spartan’s Property Archive.

XY Plots

The XY Plot incorporates an X Axis menu designating the 
molecular property to be displayed among the X (horizontal) 
axis, and a list of properties to be displayed along the Y (vertical) 
axis. These properties correspond one to one to the columns in 
the associated spreadsheet. To construct a 2D plot, select an item 
from the X Axis menu, then click on one or more items from 
the Y Axes list and finally click on OK. (Repeated clicking on 
a property in the Y Axes turns the list on and off.) The dialog is 
removed from the screen and a plot appears.
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The plot may be moved about the screen. Select (click on) either the 
frame or on one of the curves (it will turn gold in response), then hold 
down the right mouse button and drag the mouse. The plot may also 
be scaled (expanded or shrunk) by first selecting either the frame 
or one of the curves and dragging the mouse while holding down 
both the right button and the Shift key. The plot may not be rotated.

XYZ Plots

The XYZ Plot is reached by clicking on the XYZ Plot tab at the 
top of the dialog. This leads to a new dialog.

This is very similar to the XY Plot, except that it incorporates X Axis 
and Y Axes menus to designate quantities to be displayed along 
the X and Y axes, respectively, as well as a list of properties to be 
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displayed along the Z axis. To construct a 3D plot, select one item 
from each of the X Axis and Y Axis menus, then click on one or more 
items from the Z Axes list and finally click on OK. A plot appears.

The plot can be moved about the screen. Select (click on) either 
the frame or on one of the curves (it will turn gold in response), 
then hold down the right mouse button and drag the mouse. The 
plot may also be scaled (expanded or shrunk) by first selecting 
either the frame or one of the curves and dragging the mouse while 
holding down both the right button and the Shift key. Finally, 3D 
plots (unlike 2D plots discussed earlier) may be rotated, by first 
selecting either the frame or one of the curves and dragging the 
mouse while holding down the left button.

Plots initially presented connect the data points with cubic 
splines. A variety of curve fits (linear, least squares, Fourier, etc.) 
as well as a variety of different presentation formats are available 
under the Plot Properties and associated dialogs (see Properties 
earlier in this chapter).

A plot may be deleted by first selecting (clicking on) Delete 
from the Build menu, or clicking on , or holding down the 
Delete key, and then clicking on either the plot frame or on 
an individual curve. Clicking on the frame removes it and all 
associated curves, while clicking on a curve removes only this 
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curve. However, the last curve deleted also deletes the frame. IR, 
Raman, NMR and UV/vis spectral plots may also be removed 
from the corresponding Spectra dialog.

Similarities...

The results of a similarity analysis based either on selected atoms in 
a structure or on a set of CFD’s as a template may be viewed using 
the Similarities dialog.

The box at the right of the dialog identifies each hit in terms of the 
identity of the Template Molecule, the Library Molecule, and in 
the case where a library molecule has been expanded in terms of a set 
of diverse conformers, the identity of the conformer. It also provides 
a score* and, in the case where excluded volume CFD’s are present 
in the template, the number of collisions between these elements and 
the library molecule. Finally, it indicates whether the enantiomer for 
the molecule included in the library has been inverted. Entries in the 
dialog may be sorted by score or number of collisions (as well as by 
the names of the template and library molecules) by clicking on the 
appropriate column header at the top of the box.

* The score is defined as [(1-R2)/N]-penalty, where R2 is the root mean square distance 
between template and library molecule centers and N is the number of similarity centers. 
Whereas molecule alignment as a prelude to similarity scoring is based on atomic, CFD 
and pharmacophore centers only, penalties are given for alignments that lead to unfavorable 
steric interactions between template and library entries or (in the case of molecule alignment 
by CFD’s) to incorrect orientation of hydrogen bond donor or acceptor CFD’s. These are 
subtracted from the score based on R2. 1 is a perfect score.
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A minimum score can be set from the Minimum Score menu at the 
bottom right of the dialog. The number of matches that satisfy this 
minimum is reported.

As hits are selected by clicking on them in the box, the library entry 
superimposed onto the template will be displayed in the window 
at the left of the dialog. This graphic may be manipulated (rotated, 
translated, scaled) with the usual mouse/keyboard commands (the 
cursor needs to be positioned inside the window). The display style 
cannot be altered, nor can any measurements be made.

The library entry associated with a particular hit may be retrieved 
(brought into Spartan’s main window) by first selecting it and then 
clicking on the Retrieve button at the bottom of the Similarities 
dialog. The template cannot be retrieved. Retrieval can either be 
to a New Document or to the Current Document depending on the 
setting in the Retrieve Options dialog accessed by clicking on  to 
the right of the Retrieve button.

 
Retrieval to the Current Document (that with the template) allows 
both the template and one or more hits from the library to be 
displayed simultaneously, with a full range of model styles and 
display options. 

The Similarities dialog is closed by clicking on the Done button.

Reactions...

Data entered in a Spartan document may be used to caculate reaction 
energies including activation energies.

∆E  =  Eproduct1  +  Eproduct2  –  Ereactant1  +  Ereactant2

Selection of Reactions... from the Display menu leads to the 
Reactions dialog.
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Two menus under Reactants: and two menus under Products: 
identify the reactants and products of reaction. They correspond to 
the labels (identifiers) of the molecules in the document, plus a null 
entry <none>.  Note that the overall reaction is mass balanced.

The Use menu identifies the source of the energies to be used in the 
reaction energy calculation.

SMD Database or SSPD Database refers to energies drawn from 
entries in the Spartan Molecular Database (SMD), or Spartan 
Spectra and Properties Database (SSPD), Current Document 
refers to energies in document and Current Document (aq) refers 
to energies in the document that have been empirically corrected for 
aqueous solvent using the SM5.4 model.

Selection of SMD Database or SSPD Database (from the Use 
menu) requires specification of theoretical models. This is made 
from the Theoretical Model menu.
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Note that while T1 is not included in either SMD or SSPD, T1 heats 
of formation have been made available.

The Units menu allows for selection of units.

A reaction energy is computed by clicking on Compute Energies at 
the bottom left of the dialog.

Substituted molecules can be used in place of real molecules as 
reactants and products. By accessing SMD or SSPD, this means that 
the energies for a series of related (by substitution) reactions can be 
computed at once.*

The results of a reaction energy calculation may be printed by right 
clicking inside the display area of the Reactions dialog and selecting 
Print from the menu that results.

The Reactions dialog is closed by either clicking on OK or on .

* An example is provided in the tutorial Positional Selectivity of Substituted Naphthalenes  
in Chapter 5.
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Chapter 19
The Search Menu

Functions available under the Search menu provide for defining 
structure and reaction queries to be used in searches of databases 
attached to Spartan. These include the Cambridge Structural Database 
(CSD) of experimental X-ray structures, the Spartan Molecular 
Database (SMD) of calculated structures, energies, and properties, 
the Spartan Spectra and Properties Database (SSPD) of calculated 
spectra, properties, QSAR descriptors and thermodynamic quantities, 
the Spartan Infrared Database (SIRD) of calculated infrared spectra 
and the Spartan Reaction Database (SRD) of calculated transition 
states. CSD and SRD are searchable by substructure, whereas SMD 
and SSPD are searchable by substructure, name, formula, molecular 
weight and isomer and SIRD is searched based on matching to 
an unknown infrared spectrum. The Search menu also accesses 
procedures for automatically guessing transition states for reactions 
based on their similarity to transition states in SRD, for identifying 
tautomers, and for extracting ligands from PDB files.

Define Structure Query ( )

This designates one or more free valances on a structure as attachment 
points. Clicking on the free valence marks it with an orange cone and 
designates it as an attachment point. This means that anything directly 
bonded to the valence (including hydrogen) is an acceptable hit for a 
search on a database. For example, clicking on the para free valence 
in toluene designates that any para-substituted toluene (including 
toluene itself) is an acceptable hit. Clicking on both free valences 
of hydrogen peroxide means that all peroxides (including hydrogen 
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peroxide and all hydroperoxides) are acceptable hits. Free valences 
not designated as attachment points are assumed to be hydrogens. 
Clicking on a free valence previously designated as an attachment 
point removes the cone and its designation as an attachment point.

Define Reaction Query ( )

This serves either to identify the product or products of a chemical 
reaction from the reactants to be used for mining the Spartan Molecular 
Database or Spartan Spectra and Properties Database, or to provide 
an entry into the Spartan Reaction Database in order to access a 
previously calculated transition state, or to identify a similar transition 
state. All three functions make use of a set of curly arrows familiar 
to generations of organic chemists and formally corresponding to the 
movement of a pair of electrons.

source of 
electron pair

destination of
electron pair

There are two possible sources of an electron pair and three possible 
destinations, leading to six combinations:
lone pair → lone pair move lone pair
lone pair → bond use lone pair to increase bond order
lone pair → space between atoms use lone pair to create new (single) 

bond
bond → lone pair decrease bond order to make lone 

pair
bond → bond decrease order of one bond to increase 

order of another bond
bond → space between atoms decrease order of one bond to make 

a new (single) bond

The first of these is a null operation, and its inclusion has no effect.

The reaction query procedure presently does not distinguish between a 
lone pair and a radical center. Examples are provided at the end of this 
section.



Chapter 19 365

Selecting Define Reaction Query results in a message at the bottom 
left of the screen.

The tail of the arrow corresponds to the source of the electron pair. If 
the source is a lone pair, then select the atom that holds the lone pair. 
If the source is a bond, then select the bond. Clicking on an atom or 
bond highlights (colors gold) the atom or bond and leads to a new 
message at the bottom left of the screen.

The head of the arrow corresponds to the destination of the electron 
pair. If the destination is an atom (leading to a lone pair), then select 
the atom that will hold the lone pair. If the destination is an existing 
bond (leading to an increase in bond order from single → double or 
double → triple), then select the bond. If no bond presently exists, 
press the Shift key and select the two atoms that will become bonded 
upon reaction. These operations result in a curved arrow being drawn 
on the reactant structure. This extends from an atom, or the center of 
a bond to an atom, or the center of a bond, or the center of a dotted 
line that has been drawn between atoms that are to be bonded. The 
original message returns to the bottom left of the screen.

Note that the head and tail do not need to reside on atoms or bonds on 
the same fragment. Also the tail may involve atoms of two detached 
fragments.

The process (tail selection followed by head selection) is repeated  
as necessary to fully define the reaction. Incorrect reaction arrows may 
be removed by selecting Delete from the Build menu ( ) followed 
by clicking on the arrow to be deleted. You need to again select 
Define Reaction Query ( ) in order to continue arrow selection. 
More simply, click on the arrow(s) to be deleted while holding down 
the Delete key.

Once defined, reaction queries can be used to relate the properties of the 
products of chemical reactions to those of the products for the purpose 
of mining the Spartan Molecular Database or Spartan Spectra and 
Properties Database. Full discussion is provided in Open Databases 
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later in this chapter. Reaction queries can also be used to search the 
Spartan Reaction Database for transition-state structures associated 
with the defined reaction (also discussed in Open Databases). In 
both of these cases, structure queries (discussed in Define Structure 
Query earlier in this chapter) will also normally be employed. Finally, 
reaction queries may be employed to automatically provide a guess 
at a transition state based on similarity to an entry in the Spartan 
Reaction Database (see discussion in Guess Transition State later 
in this chapter). Here, no structure queries would be defined.

Examples of Reaction Queries

Diels-Alder reaction of 1,3-butadiene and ethylene

c

a

b

a, b. double bond to empty space leading to single bond and single 
bond

c. double bond to single bond leading to single bond and double bond

SN2 reaction of chloride and methyl iodide

a b
C I Cl C l–Cl–

a. lone pair on Cl– to empty space leading to ClC bond 
c. CI bond leading to lone pair on I

Ene reaction of 1-pentene

a
H H

+
cb

a. CH bond to empty space leading to CH bond
b. double bond to single bond leading to single bond and double bond
c. single bond to single bond leading to empty space and double bond
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Ring closure of 1-hexenyl radical to methylcyclopentyl radical

b

a
•

•

a. radical center to empty space (between C2 and C6) leading to single 
bond

b. double bond to terminal carbon leading to single bond and radical 
center

Open Databases ( )

This provides access to the Cambridge Structural Database (CSD) 
of experimental X-ray crystal structures, the Spartan Molecular 
Database (SMD) of calculated structures, energies, spectra and 
molecular properties, the Spartan Spectra and Properties Database 
(SSPD) of spectra, properties and QSAR descriptors, the Spartan 
Reaction Database (SRD) of calculated transition states and the 
Spartan Infrared Database (SIRD) of calculated infrared spectra.* 
CSD, SMD and SRD may be searched based on substructure. SMD 
and SSPD may also be  searched by name, formula, molecular weight 
and isomer. If a selected molecule on screen exists in SMD and/or 
in SSPD, it may be replaced by a database entry and, even if it is not 
replaced, the molecule name in SMD may be used. SIRD is searched 
by comparison with an input infrared spectrum.

Cambridge Structural Database (CSD)

The Cambridge Structural Database (CSD) is a collection of more 
than 500,000 experimental X-ray crystal structures for organic 
and organometallic molecules.** It is maintained by the Cambridge 
Crystallographic Data Centre (CCDC) and grows approximately 10% 
per year. CSD not only contains information about the molecular 

* Databases may be located on the local machine or on a remote server. Setup details are provided in 
Appendix G for CSD and in Preferences under the Options menu in Chapter 20 for SMD, SSPD, 
SRD and SIRD.

** CSD is not included with Spartan but is available by subscription from CCDC (http://www.ccdc.
cam.ac.uk/). For installation instructions, see Appendix G.
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geometry, but also about the manner in which molecules pack in 
the solid state*. In short, the CSD represents a gold mine of detailed 
experimental structural information, and also serves to identify 
molecules that can be (and have been) synthesized and purified 
through crystallization. 

Access to the data in CSD is via a substructure searching procedure. 
A molecule is first constructed and one or more attachment points 
are identified. Clicking on the CSD tab at the top of the Database 
dialog leads to the CSD dialog.

This contains a window at the left for previewing structures, a box at 
the right for listing hits on CSD and buttons at the bottom to control 
aspects of the search and subsequent transfer of CSD data into the 
file system. Both the preview window and the text box may be scaled 
independently. A substructure search is set up by specifying one or 
more of the following**:

(i) Attachment Points
 A free valence is designated as an attachment point by first 

selecting Define Structure Query from the Search menu 
and then clicking on it. It will be marked with an orange 
cone. Clicking again removes the designation and the cone. 

* Spartan’s interface to CSD accesses only molecular information. Additional information related to 
packing in the crystal may be accessed using CCDC’s program ConQuest, that is supplied as part of 
the CSD subscription.

** If nothing is specified, a search for an exact match is carried out assuming that all atoms and bonds 
are exactly as given in the query and that all free valences are assumed to be hydrogens.
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Anything may be grown off an attachment point (including 
hydrogen), although substituents are not permitted. Free 
valences not designated as attachment points are assumed to 
be hydrogens.

(ii) Wild-Card Atoms
 An atom may be designated as a wild-card (meaning that element 

type is unimportant) by first selecting Define Structure Query 
from the Search menu and then clicking on it. An orange ball 
will surround the atom. Clicking again removes the wild-card 
designation and the ball. Use of wild-card atoms will result in 
structures that incorporate variants of the original substructure 
with different atoms at designated positions. For example, wild-
card designation of an unsubstituted position of a substituted 
benzene will allow substituted pyridines to be located.

(iii) Wild-Card Bonds 
 A bond may be designated as a wild-card (meaning that bond 

type is unimportant) by first selecting Define Structure Query 
from the Search menu and then clicking on it. An orange 
cylinder will be drawn around it. Clicking on this cylinder 
removes the wild-card designation and the cylinder. This is  
important in certain heterocycles where bond typing may be 
ambiguous.

To limit a CSD search either to organic molecules (about half the total 
collection) or to molecules containing transition metals, lanthanides 
or actinides, bring up the Search Options dialog by clicking on  
to the right of the Search button at the bottom right of the dialog, 
and select Organics or Inorganics respectively.
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After a substructure has been specified, a search of CSD is initiated 
by clicking on the Search button at the bottom right of the dialog. If 
there are hits to be found, these will appear in the scroll box at the right 
of the dialog. The search can be terminated at any time by clicking 
on  to the right of the Search button at the bottom of the dialog. 
Once completed (or stopped), the CSD reference codes (REFCODE) 
and the names for the hits are displayed in the box and the number of 
hits is indicated immediately below. Structural data are available only 
for entries preceded by a filled yellow circle, although experimental 
references are available for all entries (see Output under the Display 
menu; Chapter 18). A ball-and-wire model for any entry for which 
a structure is available may be displayed in the window at the left of 
the dialog by clicking on its name in the box.

The model can be manipulated (rotated, translated, scaled) inside 
the window with the usual mouse/keyboard commands (you need to 
position the cursor inside the window).

The structure is exactly as it appears in CSD. In particular, it may 
contain two or more different molecules, two or more different 
conformations of the same molecule and/or extraneous molecules 
(most commonly solvent molecules and counterions). Hydrogens will 
be present only where they have been assigned in the experimental 
structure. The structure may also contain errors in bonding due to 
uncertainties in the original data. Modifications to the CSD entry to 
address these issues may be made prior to transfer to the file system 
using the Retrieve Options dialog. This is accessed by clicking on  
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to the right of the Retrieve button at the bottom of the CSD dialog.

(i) Delete Extraneous Fragments
 If checked, deletes any detached molecules that do not contain 

the search query.

(ii) Identify Ligands
 Identifies ligands in structures that are returned from CSD 

(primarily for organometallic compounds) and replace whatever 
bonding is supplied by a representation in which a dashed line 
is drawn between the geometric center of the ligand and the 
atom to which it connects.

(iii) Repair Bonds
 If checked, attempts to fix bonding errors based on the actual 

geometry in CSD and on normal valence rules.

(iv) Grow Hydrogens
 If checked, adds hydrogens wherever they appear to be missing, 

based on the actual geometry and on normal valence rules. 
This function is also available under Grow Hydrogens in the 
Molecule Utilities dialog (Chapter 18).

(v) Freeze Heavy Atoms
 If checked, freezes all atoms except for hydrogens. This 

allows experimental X-ray hydrogen positions that are often 
poorly determined, to be refined using molecular mechanics 
or quantum chemical methods, while maintaining the heavy 
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atom skeleton.*

(vi) Retrieve to:
 Selection of New Document means that the search results 

are to be stored in a new document and leads to a request for 
a document name, whereas selection of Current Document 
results in the retrieved molecules being appended to the end 
of the current document.

The Retrieve Options dialog is dismissed with all changes to existing 
settings maintained by clicking on OK. Clicking on Cancel or on  
also dismissed the dialog but any changes to settings are lost.

Retrieval is accomplished by first selecting (clicking on) one or more 
hits in the scroll box and then pressing the Retrieve button at the 
bottom of the CSD dialog. The Shift and Ctrl keys may be used in 
the usual way to specify retrieval of multiple hits. Retrieval can be 
stopped at any time by clicking on  to the right of the Retrieve 
button at the bottom of the CSD dialog.

Spartan Molecular Database (SMD) and Spartan Spectra and 
Properties Database (SSPD)

Spartan connects to two different collections of molecules for 
which quantum chemical calculations have already been performed 
and the results of these calculations are available. The first is the 
Spartan Molecular Database (SMD). This comprises more than 
500,000 records of calculations performed using one or more of 
the following quantum chemical models: Hartree-Fock with 3-21G, 
6-31G*,  6-311+G** basis sets, B3LYP and EDF1 density functional 
and MP2 with 6-31G* and 6-311+G** basis sets and G3(MP2). 
The LACVP pseudopotential is used in place of the 6-31G* basis 
set for main-group elements heavier than krypton and for second 
and third-row transition metals. Thus, a B3LYP/6-31G* calculation 
on benzene tungsten tricarbonyl (C6H6WCO3) uses the LACVP 

* Hydrogen positions may be refined using molecular mechanics using Minimize under 
the Build menu; Chapter 16. Refinement using quantum chemical models is specified in 
the Calculations dialog (Calculations... under the Setup menu; Chapter 17) by way of 
Frozen Atoms (Freeze Center under the Geometry menu; Chapter 15).
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pseudopotential for tunsgten and the 6-31G* basis set for hydrogen, 
carbon and oxygen.  Except for the G3(MP2) entries, the geometry 
of each molecule has been optimized, assuming the best (lowest-
energy) conformer  obtained from the MMFF molecular mechanics 
model. G3(MP2) entries use MP2/6-31G* equilibrium geometries. 
Included in the SMD entry is the geometry, the energy, the energy 
corrected empirically for aqueous solvation, the dipole moment and 
Mulliken, natural and electrostatic atomic charges. Properties related 
to geometry (area, volume and polar surface area) are calculated on-
the-fly from the geometry. Also included, wherever it is available, is 
the heat of formation obtained from the T1 thermochemical model 
(see discussion in Chapter 17).

The following recipe has been used to create the individual entries in 
SMD:

1. Identify the lowest-energy conformer using the MMFF molecular 
mechanics model. Molecules with fewer than 200-300 conformers 
are searched systematically (guaranteeing that the global minimum 
will be found), while Monte-Carlo sampling is used for molecules 
with more conformers.

2. Starting from the best conformer, perform a geometry optimization 
using the appropriate quantum chemical model. This implies that all 
quantum chemical  models for a particular molecule will refer to the 
same conformer.

The Spartan Spectra and Properties Database (SSPD) presently 
comprises approximately 70,000 molecules. The next release of 
SSPD is scheduled for early Summer 2011 and will include upwards 
of 120,000 molecules. SSPD differs from SMD in several important 
ways. The first difference is that all calculations have been obtained 
from a single theoretical model, specifically the EDF2/6-31G* 
density functional model. This represents a credible attempt to get 
around the commonly-asked and difficult to answer question “which 
model is best to use?”. The EDF2/6-31G* density functional model 
consistently yields reliable structures, reaction energies, spectra and 
properties, yet is simple enough to be routinely applied to reasonable-
size molecules, that is, up to 300-500 amu. 
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The second difference is that, wherever possible, SSPD entries use 
the best conformation assigned from the T1 thermochemical recipe 
rather than from MMFF molecular mechanics. T1 has been shown 
to reliably account for conformational energy differences in small 
molecules (where experimental data are available),  which in turn 
suggests that it should be able to reliably identify the lowest-energy 
conformer. Note, however, that T1 is presently defined only for 
uncharged, closed-shell molecules incorporating H, C, N, O, F, Si, 
P, S, Cl and Br. The conformations of molecules outside of these 
limits (perhaps 2% of the entries in SSPD) use the MMFF method 
for assigning the lowest-energy conformer.

The following recipe has been used to create the individual entries in 
SSPD:

1. Identify a set of up to 100 diverse conformers using the PM3 semi-
empirical model. This is done with the so-called restricted systematic 
search algorithm described under Calculations in the Setup menu 
(Chapter 17).

2. Perform T1 calculations on all conformers and select the one with 
the lowest (T1) heat of formation. 

3. Starting from this conformer, perform a geometry optimization 
using the EDF2/6-31G* model.

A simpler and automated procedure for providing T1 heats of formation 
for conformationally flexible molecules has previously been described 
in Chapter 17.

The third difference is that the vast majority of SSPD entries include 
both the infrared and (proton and 13C) NMR spectra. (The future 
plan is for some entries to also include the Raman spectrum.) The 
vibrational motions associated with selected lines in the calculated 
infrared spectrum can be animated. In addition, COSY, HSQC and 
HMBC NMR spectra (2D spectra) can be generated on-the-fly from 
the information in SSPD.

The fourth difference is that, in addition to the properties available 
from SMD, each SSPD entry includes information useful for QSAR 
type analyses, specifically,  information based on electrostatic potential 
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and local ionization potential maps and a variety of thermochemical 
quantities. Each SSPD entry also includes the heat of formation 
obtained from the T1 model (as does each SMD entry). 

The fifth difference is that each SSPD entry includes the wavefunction, 
allowing on-the-fly generation of any graphical surface and property 
maps available to Spartan. 

Because of inclusion of the wavefunction (and to a lesser extent 
inclusion of  the vibrational motions), SSPD has a significantly larger 
disk footprint than SMD (3Gb vs. 1.5 Gb). However, the in-memory 
footprint of SSPD is actually smaller than that for SMD (because 
there are fewer records in total).

SMD and SSPD are configured separately (Paths from Preferences 
under the Options menu; Chapter 20), and can either  be used 
independently or in concert. SMD facilitates comparisons among 
different models, whereas SSPD provides simple access to a wide 
selection of data from a single high quality model. 

Accessing and Processing Data From SMD and SSPD

There are two ways to access data from SMD and SSPD. The first way 
is to replace a structure that has been built (or read in) with a matching 
database entry. (Note that it is possible to replace all structures in list 
of molecules for which there are matches in SMD or SSPD in a single 
operation.) The second  way is to search SMD or SSPD for entries 
that share particular structural features.

Molecule Replacement

For the purpose of molecule replacement, SMD and SSPD are treated 
as independent databases. This gives the user the choice between the 
diversity of theoretical models represented in SMD and the simplicity 
brought on by the single model in SSPD. Selection is made from the 
menu to the left of the  at the bottom of Spartan’s main screen. 
Once selected, the existence of the selected molecule in SMD or in 
SSPD is evidenced by its name appearing to the right of .
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Both collections may be placed under either the SMD or SSPD heading. 
See Paths from Preferences under the Options menu; Chapter 20.

The structure of any SMD or SSPD entry can be seen by clicking on 
. This brings up a dialog with a viewing screen on the left and a 

list of quantum chemical models for which database entries exist on 
the right. The  changes to a .

By default, the SMD entry of a 6-31G* calculation (if available) is 
checked and a ball-and spoke model of its structure appears in the 
viewing screen. A different SMD entry (corresponding to a different 
quantum chemical model) may be selected by checking the box to the 
left of the name of the model in the dialog. Note, that there is only 
one entry corresponding to the EDF2/6-31G* model for SSPD. The 
model in the viewing window may be manipulated using the usual 
mouse/keyboard commands (you need to position the cursor inside 
the viewing area). Model style may not be changed. 

The selected model may be replaced by the selected database entry 
by clicking on Replace at the bottom of the dialog. (Replacement 
can be undone by selecting Undo from the Edit menu; Chapter 13.) 
Replacement destroys all information except the molecule identifier 
(leftmost column of the spreadsheet (see Spreadsheet under the 
Display menu; Chapter 18). If desired, the molecule identifier can be 
changed to the molecule name (from the database) by first bringing up 
the spreadsheet, clicking on Label (the header cell corresponding to the 
leftmost column), right clicking and selecting Rename Selected from 
SMD or Rename Selected from SSPD from the menu that results.

Some SMD entries also include structures for higher-energy 
conformers (in addition to that for the lowest-energy conformer). 
These entries are designated by a  to the left of the check box in the 
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preview dialog, clicking on which leads to an expanded entry. This 
accesses a higher-energy conformer and provides their energies (in 
kJ/mol) relative to the best conformer. Higher-energy conformers are 
generally not available for SSPD entries.

Entries are selected as before, after which they may be examined in 
the viewing screen and used to replace the on-screen molecule.

In the event that the selected (on-screen) molecule is part of a multi-
molecule document, it is possible to replace all molecules in the 
document for which database entries for the specified theoretical 
model are available.* This is accomplished by clicking on Replace 
All instead of Replace. A warning message is provided prior to the 
replacement. Note that the lowest-energy conformer for all other 
(non-selected) molecules in the document is used, even though a 
higher-energy conformer may be indicated for the selected molecule. 
(Replacement of document entries with non-lowest energy conformers 
needs to be done one-by-one using Replace instead of Replace All.) 
Molecules in the document for which there are no database entries 
at the specified theoretical model are not affected. As with single 
molecule replacement, all information except the molecule identifier 
is replaced by that in the database. Molecule names from the selected 
database for all molecules in a document may be substituted for the 
original molecule identifiers by clicking on Label (the header cell of 
the leftmost column in the spreadsheet) right clicking and selecting 
Rename Selected from SMD or Rename Selected from SSPD from 
the menu that results.

The Wikipedia button at the bottom right of the database preview 
dialog brings up a Wikipedia page based on the name of the selected 
molecule.

* For 32 bit implementation, the practical replacement limit is 1,500-2,000 molecules for 
SMD and 500-800 molecules for SSPD.
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Substructure and Other Modes of Searching SMD and SSPD

Access to data from SMD and SSPD follows selecting Open 
Databases, and then clicking on either the SMD or SSPD tab (at the 
top left of the resulting window). (Aside from the title, the resulting 
displays are identical.)  Each comprises three different panels, Search, 
Plot and Analysis, selection of which is controlled by tabs at the 
bottom left of the window. A search of SMD or SSPD is carried out 
from the Search panel, plotting of the search results from the Plot 
panel and regression analysis of search results from the Analysis panel.

Substructure searching of SMD and SSPD is similar to that already 
described for substructure searching of the Cambridge Structural 
Database (CSD). The only required input is a three-dimensional 
structure. While one or more growth points (see Define Structure 
Query earlier in this chapter) will normally be specified, they are 
optional and in their absence an exact search will be carried out. Wild-
card atoms and bonds used in searches of CSD are not supported. One 
or more substituents may  be attached to the structure (see Substituent 
Model Kit under the Build menu; Chapter 16), in effect allowing 
multiple starting structures. (This capability is not available for CSD 
seasrches.) Name searching requires a name (or partial name), formula 
searching requires an exact formula, weight searching requires a 
molecular weight and isomer searching requires a three-dimensional 
structure without any growth points.

Clicking on the Search tab leads to the Search dialog.

This contains a box on the right for listing the search hits and 
providing values for any requested properties (at the outset only the 
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molecule name is provided), and a window on the left for viewing 
and manipulating the individual hits. Controls along the bottom right 
access the Search Options dialog which specifies the databases to 
be searched, the kind of search, and (for SMD only) the theoretical 
model(s) to be searched. They are also used to initiate and terminate 
a search and to designate the location for any results that are retrieved 
from the search.

With the SMD tab selected, clicking on  to the right of the Search 
button leads to the Search Options dialog.

Using Directories lists the collections that make up SMD. SMD 
(sample) is the sample of ~5000 molecules supplied with all copies 
of Spartan while SMD is the full collection. If SMD is installed, 
SMD (sample) should be removed (Paths from Preferences under 
the Options menu; Chapter 20). Method Filters specifies the 
theoretical models to be included in the search. Other accesses data 
with models that are not explicitly listed. Search By designates the 
type of search: Structure, Name, Formula, Weight or Isomer. Limit 
Search to Entries with designates information that must be in the hit.

(i) Name
 Selection followed by clicking on OK in the Search Options 

dialog leads to a box By Name at the bottom right of the 
dialog. The search will return all entries that contain the string 
that is entered into the box. For example, typing toluene will 
not only result in toluene, but also in molecules such as para-
toluenesulfonic acid and 4-chloro-2-fluorotoluene.
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(ii) Formula
 Selection followed by clicking on OK in the Search Options 

dialog leads to a box By Formula at the bottom right of 
the dialog. A formula of the form CcHhHett, where “Het” 
corresponds to elements other than carbon and hydrogen 
(each element needs to be specified explicitly). c, h, t are 
integers and are required. For example, the formula for 
nitrobenzene needs to be written as C6H5N1O2. The order of 
atoms is irrelevant. The search will return all entries with this 
formula. For example, the formula C6H5N1O2 will return not 
only nitrobenzene but also molecules such as phenyl nitrite 
and pyridine-4-carboxylic acid.

(iii) Weight
 Selection followed by clicking on OK in the Search Options 

dialog leads to a box By Weight at the bottom right of the 
dialog. The search will contain all entries with the specified 
molecular weight ± 0.05 amu.

(iv) Isomer
 Selection followed by clicking on OK in the Search Options 

dialog specifies that all isomers of the selected molecule 
will be returned. The result is the same as specification of a 
molecular formula.

Clicking on OK removes the Search Options dialog with all settings 
maintained. Clicking on Cancel or  removes the dialog without 
maintaining the settings.

The Search Options dialog associated with SSPD is simpler in that 
the Methods Filters and Limit Search fields are missing. Only 
a single theoretical model (the EDF2/6-31G* density functional 
model) is available, most entries contain both calculated IR and 
NMR spectra, and none contain UV spectra. Using Directories lists 
the collections that make up SSPD. SSPD (sample) is the sample of 
~5000 molecules supplied with all copies of Spartan while SSPD is 
the complete collection. If SSPD is installed, then SSPD (sample) 
should be removed (Paths from Preferences under the Options 
menu; Chapter 20). The same search methods available for SMD 
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are available here.

A search on either SMD or SSPD is carried out by clicking on the 
Search button at the bottom right of the (SMD or SSPD) search 
dialog, following which hits will appear at the right. The search 
may be terminated at any time by clicking on  to the right of the 
Search button. Any hits that have already been identified will be 
kept. A ball-and spoke model of a hit may be examined at any time 
by clicking on its name in the box. It may be manipulated in usual 
way, although the model style cannot be changed. 
Properties may be added to the hit list by dragging them (names not 
numerical values) from one of the properties dialogs (see Properties 
under the Display menu; Chapter 18), the formula editor (Formulas 
under the Display menu; Chapter 18) or from the main Spartan 
screen, primarily entries associated with the Geometry menu; 
Chapter 15. The hit list can be sorted using the property, by right 
clicking on the column header cell and selecting Sort from the menu.

The results of a search on SMD or SSPD as well as any subsequent 
plotting and analyses are saved in the Spartan document  
corresponding to the original structure query or to the blank document 
that was used for a name or spectra query. This behavior is different 
from previous versions of Spartan.

Plotting Data Resulting from an SMD or SSPD Search
Data resulting from a search on SMD or SSPD may be displayed 
either as a histogram (property value vs. number of occurrences) or 
as a 2D scatter plot (property value vs. property value). Access to 
plotting is via the Plot tab at the bottom left of the dialog.
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Selection of plot type and variable ranges is from the Plot Options 
dialog accessible from  to the right of the Plot button.

Default plot ranges are from minimum to maximum property 
values. Checking Linear Least Squares Fit (Scatter Settings) fits 
a straight line to the data. (A more general multi-variable regression 
analysis can be carried out from Analysis; see discussion following.) 
Number of Intervals (Histogram Settings) sets the number of 
bars in the histogram. Clicking on OK removes the dialog with all 
settings maintained. Clicking on Cancel or  removes the dialog 
without maintaining the settings.

A plot is drawn by clicking on the Plot button at the bottom left of 
the dialog. The points will not appear instantaneously as the data 
need to be extracted from disk. Plotting may be terminated at any 
time by clicking on  to the right of the Plot button. If a least-
squares line has been requested, it will be based on the accumulated 
data. At anytime, the name of the molecule associated with a point 
on a scatter plot can be displayed by positioning the cursor over that 
point. The point can be deleted by right clicking and selecting Delete 
from the resulting menu. The plot will rescale as appropriate.
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Regression Analysis of Data Resulting from an SMD or SSPD 
Search

A regression analysis of data resulting from a search may be carried 
out by selecting the Statistics tab at the bottom left of the dialog.

The name (not the numerical value) of the property to be fit is dragged 
from one of the properties dialogs, the formula editor or from the main 
Spartan screen, into the box to the right of Fit.  The names of one or 
more properties to be used in the fit are dragged into the box to the 
right of Using. The fitting procedure (singular value decomposition) 
will use only variables that have been selected (clicked on) from 
among the list, up to a maximum number of independent variables 
(the most important in terms of their contribution to the fit from 
among this list) specified in the menu at the bottom right of the 
dialog. Note that the number of variables actually used in the fit 
may be smaller than the maximum number selected (from the 
menu at the lower right of the dialog), as variables that are linearly 
dependent and/or do not contribute significantly to the fit will be 
discarded. The analysis is started by clicking on the Analysis button 
at the bottom left of the dialog. As with plotting, this does not occur 
instantaneously as the underlying data needs to be extracted from 
the disk. Analysis  may be terminated at any time by clicking on  
to the right of the Analysis button, following which results from a 
fit to a portion of the data will be displayed.
Upon completion, or upon stopping, the fit function will be displayed 
at the lower left of the dialog. This can be copied to the clipboard 
(right click and select Copy from the menu) and then pasted (right 
click and select Paste from the menu) in the Plot dialog. 
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Relationships Involving Chemical Reactions

We have previously discussed how the formula editor may be used 
to construct relationships among properties for a single molecule 
(see Formulas under the Display menu; Chapter 18). The formula 
editor can also be employed to construct relationships between the 
reactants and the products of a chemical reaction of the reaction. 
This is possible because the products of a reaction are completely 
and unambiguously defined given the structure of the reactant (or 
reactants) and a set of curly arrows (see Define Reaction Query 
earlier in this chapter). Note that the same information can also be 
used to guess a transition state for the reaction (see Guess Transition 
State later in this chapter).

For example, consider the difference in energies between 
2,4-cyclohexadieneone and phenol. Whereas the normal preference 
is for keto forms be favored over enols, here the reverse is certainly 
true as phenol benefits from aromatic stabilization. Three steps are 
needed to use SMD or SSPD to ask to what extent substituents alter 
this preference. First, a structure query (the reactant) must be built, 
arrows placed to designate the product of reaction and one or more 
growth points added to define the limits of the search. For example, 
use 2,4-cyclohexadieneone and limit substituents to the 4 position.

O

H

O

H

O

H

Next, a formula for the energy of reaction needs to be constructed. 
Inclusion of arrows extends the formula from the query itself (a 
4-substituted 2,4-cyclohexadieneone), to the product of reaction (a 
para-substituted phenol) and to the difference between product and 
reactant. Selection of which is to be employed in the formula follows 
from the Applied to menu under Context in the formula editor 
(highlighted only if arrows are present). In this case, the choices 
are (R) 2,4-cyclohexadieneone, (P1) phenol or (P-R) reaction. The 
formula for the reaction energy, @energy*@hart2kj, appears in the 
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box at the center of the dialog following selection of (P-R) reaction 
from the Applied to menu and clicking on E under Energies. The 
default name may be changed by editing the text inside the box to the 
left of the formula. Clicking on Enter enters the (renamed) formula @
rea(@energy*@hart2kj) into the list at the top of the formula editor. 

A search may now be carried out (click on the Search button inside 
the SMD or SSPD Search dialog). After it has completed, dragging 
the formula for the reaction energy onto an empty header cell of the 
hit list inside the SMD or SSPD Search dialog will result in reaction 
energies for all entries to appear.

As a second example, consider the energy for addition of hydrogen 
fluoride to  propene, leading to 1-fluoropropane. Here there are two 
reactants (hydrogen fluoride and propene), but only the latter will be 
provided growth points*.  Thus, the query is for information about the 
energy of HF addition as a function of substitution on the alkene. 

The query starts from an intramolecular complex of propene and 
hydrogen fluoride, oriented such that the C=C and H–F bonds 
parallel with fluorine on the unsubstituted side of the alkene. Two 
arrows, one from the CC bond to the space between the unsubstituted 
carbon and fluorine and the other from the HF bond to the space 
between the substituted carbon and hydrogen, define the product 
(1-fluoropropane). Growth points attached to all three open valences 
extend the search to all available substituted propenes (for which 
analogous substituted 1-fluoropropanes are also available).

H3CH3CH3C

H F H F H F

A formula for the energy of reaction may be constructed using the 
same sequence as in the previous example, selecting (P-R) reaction 
from the Applied to menu under Context in the formula editor, 
clicking on E, changing the default name and clicking on Enter.

* While there can be two or more reactants, only one can be provided growth points, that is, 
all other reactants need to be specific molecules.
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Following a search using the query, dragging the formula for the 
reaction energy onto an empty header cell of the hit list inside the 
SMD or SSPD Search dialog adds a column of reaction energies to 
the list.

It is possible to apply different queries to the same set of search 
results, for example, to ask about the energy of addition of HCl 
(instead of HF) to a substituted propene. Whereas the query changes 
(the reaction of HCl and propene rather than of HF and propene), the 
underlying search (on propene) does not. The result is two sets of 
energies. (Results designated No DB Entry indicate that the required 
information is not available.)

A plot of HCl vs. HF reaction energies from the SMD or SSPD Plot 
dialog shows the extent to which they are actually correlated.
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Retrieving Data from an SMD or SSPD Search

Prior to retrieval, it is necessary to specify a destination from the 
Retrieve Options dialog. Click on  to the right of the Retrieve 
button.

Selection of New Document results in request for a file name; 
selection of Current Document results in the retrieved molecules 
being appended to the end of the current document. The Retrieve 
Options dialog is dismissed by clicking on OK. Clicking on Cancel or 
on  also dismisses the dialog but any changes to settings are lost.

To retrieve, select (click on) one or more hits in the box and press 
the Retrieve button. The Shift and Ctrl keys may be used to specify 
retrieval of multiple hits. Retrieval may be stopped at any time by 
clicking on  to the right of the Retrieve button.

Spartan Reaction Databases (SRD)

The Spartan Reaction Database (SRD) is a collection of transition 
states for approximately 1,500 organic and organometallic reactions 
obtained from one or more of the following theoretical models: AM1, 
PM3, HF/3-21G and HF/6-31G*. Each entry contains the infrared 
spectrum, which should be characterized by a single imaginary 
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frequency corresponding to the reaction coordinate.

An entry in SRD is in terms of a three-dimensional structure 
(corresponding to the reactants or the product), together with an 
appropriate set of curly arrows (connecting the reactants to the product 
or vice versa) and designation of theoretical model. 

Instructions for drawing reaction arrows has been provided earlier in this 
chapter (Define Reaction Query).

For example, an entry for the Diels-Alder reaction of cyclopentadiene 
and acrylonitrile is given on the left, while that for the corresponding 
retro Diels-Alder is given on the right.

Note, that stereoisomers are distinguished by the way the reactants 
are positioned. For example, reactions leading to endo and exo Diels-
Alder adducts are distinct.

SRD is open-ended and users may construct their own data collections 
with additional reactions and/or results from additional theoretical 
models on existing reactions (Appendix H).

Substructure Searching

Substructure searching from SRD is very similar to that from SMD 
and SSPD. Access to SRD is provided by clicking on the SRD tab at 
the top of the Database dialog. This gives rise to the SRD dialog.
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The SRD dialog contains a window on the left for previewing 
structures and a box on the right for listing hits on SRD, as well 
as buttons at the bottom to control various aspects of the search 
and subsequent transfer of data into Spartan’s file system.

A substructure search is set up by specifying one or more attachment 
points on the reactant structure (see Define Structure Query earlier 
in this chapter) that has been augmented with reaction arrows (see 
Define Reaction Query earlier in this chapter). Prior to starting 
the actual search, it is necessary to specify which theoretical model 
or set of models are to be included. This is done from the Search 
Options dialog, and is reached by clicking on  to the right of the 
Search button at the bottom right of the dialog.

Using Directories indicates the libraries to be searched. One is 
supplied with Spartan and the users are free to replace or supplement 
this with their own collections (see Appendix H). Checking one 
or more boxes under the Method Filters specifies the theoretical 
model(s) to be searched. Clicking on OK removes the dialog. 
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(Clicking on Cancel or  also removes the dialog, but selections 
are not made.)

Following specification of structure/reaction arrows, attachment 
points and designation of theory level(s), a search on SRD is carried 
out by clicking on the Search button at the bottom right of the dialog. 
If there are hits, they will begin to appear in a few seconds in the box 
at the right of the dialog. The search may be terminated at any time 
by clicking on  to the right of the Search button at the bottom 
right of the dialog. Because the SRD is small, it may be difficult to 
stop the search before it has actually completed.

Database hits are displayed in the box at the right of the dialog. They 
may be sorted by name, molecular weight and theoretical model by 
clicking on the appropriate tab. A 3D structure for a particular hit 
may be previewed by clicking on its name in the box. A ball-and-
wire model of the transition state with bonding consistent with the 
reactant and associated reaction arrows is displayed in the window 
at the left of the dialog, and its name appears immediately below the 
window. The model may be manipulated inside the window in the 
usual way, but the model style cannot be changed.

Retrieving Data from an SRD Search

Prior to retrieval of one or more database hits, it is necessary to specify 
a destination. This is accomplished with the Retrieve Options dialog, 
brought up by clicking on  to the right of the Retrieve button.



Chapter 19 391

Selection of New Document results in request for a file name; 
selection of Current Document results in the retrieved molecules 
being appended to the end of the current document. The Retrieve 
Options dialog is dismissed by clicking on OK. Clicking on Cancel or 
on  also dismisses the dialog but any changes to settings are lost.

Retrieval is accomplished by first selecting (clicking on) one or more 
hits in the box and then pressing the Retrieve button at the bottom 
of the SMD dialog. The Shift and Ctrl keys may be used to specify 
retrieval of multiple hits. Retrieval may be stopped at any time by 
clicking on  to the right of the Retrieve button.

Spartan Infrared Database (SIRD)

The Spartan Infrared Database (SIRD) is actually a second access 
point into the Spartan Spectra and Properties Database (SSPD) 
discussed earlier in this chapter. It comprises infrared spectra for 
~70,000 molecules* calculated from the EDF2/6-31G* model and 
(where the T1 model is defined) based on the lowest-energy conformer 
from T1. Unlike the other databases of calculated information attached 
to Spartan, SIRD is searched not on substructure but rather on a 
measured (or calculated) infrared spectrum. This is input in JCAMP 
format (.dx).** The search is carried out in two steps: a fast search on 
the full database is performed first to identify a small set of possible 
matches which are then examined more thoroughly.

* As with SMD, a small subset of ~5,000 molecules from SSPD is provided with Spartan.  
The full database, which is expected to grow to ~120,000 molecules by Summer of 2011, 
may be separately licensed.

** A sample .dx file is provided in Appendix J.
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Spectra Searching 

Access to SIRD is provided by clicking on the SIRD tab at the 
top of the Database dialog. A Spartan document must be open 
even if it is an empty document (New from the File menu). This 
gives rise to the SIRD dialog. 

While this dialog is quite unlike those associated with other 
databases accessible from Spartan, it does, share two aspects 
with these dialogs, a window at the lower left for examining 
the 3D structure of the selected hit and a box at the lower right 
for listing all hits. It also contains a window at the top right for 
examining the match between the unknown (measured) infrared 
spectrum and that of a hit in the database, as well as boxes at the 
top left listing the frequencies and intensities for both unknown 
and database spectra. Finally, buttons at the bottom of the dialog 
access the unknown spectrum, provide (optional) filters for its 
search against spectra in the database and control transfer of any 
search results into Spartan’s file system. 

A search is initiated by clicking on Select Spectrum at the bottom 
right of the dialog. This leads to a file browser that has been set up 
to recognize only .dx files. Selection of a file in the usual manner 
followed by clicking on Open (or double clicking on the name of 
the .dx file) leads to the display of the unknown spectrum in the 
window at the top right of the dialog.
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The name of the (.dx) file is provided underneath the window. The 
unknown spectrum has been fit on-the-fly to a Lorentzian function 
to allow extraction of a set of vibrational frequencies and intensities. 
These are displayed in the box marked Unknown: immediately to 
the left of the spectrum, along with the corresponding intensities. 
Features in the unknown spectrum with very low intensity cannot 
be fit. 

Filters 

Conditions under which the search is carried out may be specified 
by clicking on the Filters button at the bottom of the dialog. (This 
step is optional.) 
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The Filters dialog contains a window for constructing a 
substructure filter on the left, a listing of common functional 
groups in the middle, and controls to limit the molecular formula 
of hits on the database on the top right. Controls at the bottom 
right govern the number of preliminary hits that are moved from 
the first pass of the search to the (more costly) second pass and 
the number of hits that are finally kept.

This allows a substructure to be constructed (or edited from the 
currently selected molecule) and used as a substructure filter. To 
build a substructure, click on Edit below the (empty) Substructure 
Filter window at the top left of the screen. Alternatively, you can 
start with the currently selected molecule by clicking on Copy 
Current Molecule prior to clicking on Edit. A builder panel appears.

This contains most of the functionality in the organic model kit 
(see Chapter 16) and in addition, the ability to define one or more 
attachment points (see Define Structure Query earlier in this 
chapter). Whatever substructure is built needs to be in the hit. Note 
that if no attachment points are designated, the molecule that is 
built is the only acceptable hit. Click on OK to exit the build panel.

Functional Group Filters allow the search to be restricted to 
molecules that incorporate one or more of the functional groups. 
Check to select and uncheck to deselect.

Formula Filter allows selection of the minimum and maximum 
molecular formula (or both) to be considered in the search. The 
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format of the input is CcNnOo ..., where C, N, O, etc. are atomic 
symbols and c, n, o are the number of each of the designated 
atoms. Neither hydrogens nor any elements that are not explicitely 
designated are considered. 

Keep Following Pass 1 controls the number of entries that are kept 
following the initial pass of Spartan’s spectra matching algorithm. 
The larger the number, the more computer time will be needed, but 
the more likely it will be to produce a good hit (assuming that the 
unknown or a closely-related molecule is actually in the database). 

Keep Following Pass 2 controls the number of hits that are 
returned to the user. Does not affect the time required for the search.

Clicking on OK exits the dialog. Clicking on Cancel or  also 
dismisses the dialog but any changes to the settings are lost.

In addition, the search may be restricted to a specific frequency 
range. This is controlled by the two grey slider bars displayed inside 
the dialog containing the spectrum of the unknown. Frequencies 
below 500-600 cm-1 (which typically correspond to torsional 
motions and therefore may depend on conformation) require 
special instrumentation to measure and are seldom reported. 
While the experimental spectrum is usually recorded and reported 
to 4500 cm-1, the region beyond ~2800 cm-1 is dominated by CH 
stretching vibrations and may be too crowded to be of value in 
spectral searching. A reasonable range is from 700-2200 cm-1, but 
this will depend on the details of the unknown spectrum.  

A search on the reference spectrum restricted by whatever 
conditions are specified in the Search Options dialog is carried out 
by clicking on the Search button at the bottom of the SIRD dialog. 
The search is carried out in two passes. The first pass may require 
several tens of seconds depending on the size of the database and 
the filters that have been set. The second pass may require several 
minutes (depending on the number of hits kept following the initial 
pass as specified in the Search Options dialog). Searching may be 
stopped at any time by clicking on ( ) to the right of the Search 
button at the bottom of the SIRD dialog. However no results will 
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be returned if the search is stopped prematurely.

When the search has completed a listing of hits (the number 
of which is specified by Keep Following Pass 2 in the Search 
Options dialog) ordered by their fit errors (lowest is best) appears 
in the box at the right of the SIRD dialog. As each hit is selected 
(clicked on in the list), its spectrum will be superimposed onto the 
spectrum of the unknown.

Calculated vibrational frequencies and intensities for the hit are 
displayed in a box at the top left of the dialog (to the left of the 
corresponding values for the unknown). Clicking inside the box to 
the left of a (calculated) frequency animates the vibrational motion.

Retrieving Data from an SIRD Search

Prior to retrieval on one or more database hits, it is necessary to 
specify a destination. This is accomplished with the Retrieve 
Options dialog, brought up by clicking on  to the right of the 
Retrieve button.

Selection of destination is accomplished by toggling between 
New Document and Current Document. Selection of the former 
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creates a new document which will need to be named later, 
while selection of the latter results in the retrieved molecules 
being appended to the end of the current document. The dialog 
is dismissed by clicking on OK. Clicking on Cancel or  also 
dismisses the dialog but any changes are lost. 

Retrieval is accomplished by first selecting (clicking on) one or 
more hits in the box and then pressing the Retrieve button at the 
bottom of the SIRD dialog. The Shift and Ctrl keys may be used 
to specify retrieval of multiple hits. Retrieval may be stopped at 
any time by clicking on ( ) to the right of the Retrieve button. 

Whichever database dialog is open may be closed by clicking on 
, or alternatively by selecting Close Databases (that has replaced 

Open Databases) in the Search menu.

Guess Transition State ( )

Spartan provides a facility for automatically guessing transition 
state geometries based on the similarity with one or more entries in 
Spartan’s reaction database*. An exact hit replaces the guess with 
transition state for the same reaction with the particular theoretical 
model entered in the database**. More commonly, Spartan will 
attempt to provide as close a match as possible with a database 
entry. This will generally involve a less substituted system or one 
in which substituents differ. Here, those parts of the structure of the 
transition state in the database that are common will be used, and 
the remaining parts will be optimized using molecular mechanics. 
No conformational searching is performed. Note that it may be 
essential for the reactants to be properly oriented to reflect the desired 
stereochemical outcome of the reaction.

Where a reaction is completely unknown to the database, a fallback 
technique similar to the linear synchronous transit method is 
automatically invoked.

* The Spartan Reaction Database (SRD) may also be directly searched by substructure. See 
discussion earlier in this chapter.

** At the present time, the majority of database entries derive from very simple (semi-
empirical and Hartree-Fock) quantum chemical models.
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Input to Spartan’s transition-state guessing procedure will be familiar 
to organic chemists, in that it is based on curly arrows, where each 
arrow identifies the movement of one electron pair. The difference 
is that arrows are superimposed onto a three-dimensional structure 
rather than a two-dimensional drawing. The procedure has already 
been described and illustrations provided in Define Reaction Query 
earlier in this chapter.

After all reaction arrows have been properly designated, clicking on 
 at the bottom right of the screen replaces the reactant with a guess 

at the transition state. In the event that the guess is unreasonable, this 
operation may be undone (select Undo from the Edit menu). This 
allows you to review your assignment of arrows and make changes 
as needed.

Identify Tautomers ( )

Spartan provides a facility to automatically identify tautomers, that is, 
isomers arising from labile transfer of hydrogens among heteroatoms. 
Tautomer identification is especially important in dealing with 
heterocyclic compounds where two or more different tautomers may 
exist in equilibrium and the identity of the dominant tautomer may 
not be obvious. For example, while 2-hydroxypyridine is an aromatic 
molecule and would be expected to be unusually stable, the non-
aromatic 2-pyridone molecule is actually thermodynamically favored.

H
NN OH

2-hydroxypyridine

O

2-pyridone

This, of course, has consequences in trying to locate a particular molecule 
in a database where it may be represented by a different tautomer.

In contrast, Spartan almost always recognizes different ways to draw the 
same structure. The most important example is benzene, which can be 
represented as one of two structures with alternating double and single 
bonds or a single delocalized structure in which all bonds are the same 
and intermediate in length between single and double bonds.
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oror

All of these translate into the same molecule.

The procedure incorporated into Spartan is limited to tautomers 
involving nitrogen, oxygen, phosphorous and sulfur. Tautomers 
involving carbon have intentionally been excluded (there are too 
many of them and inclusion would swamp the more likely heteroatom 
tautomers). Also excluded are zwitterion tautomers, for example, 
H3N+CH2CO2

– as a tautomer of glycine. Within these limits, all 
possible tautomers will be identified.

The existence of (heteroatom) tautomers is signaled by the word 
Tautomer displayed at the bottom right of the screen. If tautomers 
exist, individual structures may be examined or a complete list of 
structures generated by selecting Tautomers from the Search menu 
(or clicking on the  icon on the top of the screen). Following this, 
clicking on the step buttons at the bottom right of the screen moves 
through the list of tautomers. Any one of these may be used in place 
of the original. The full list of tautomers may be generated by clicking 
on  (at the bottom right of the screen). This leads to a dialog.

Clicking on OK dismisses the dialog and leads to a new (unnamed) 
document containing the full list of tautomers. (The original document 
is unaffected.) Clicking on either Cancel or  dismisses the dialog 
without generating a tautomer list.

As tautomers are generated without consideration of steric crowding, it 
is important to minimize each in turn (Minimize under the Build menu; 
Chapter 16) prior to using them for quantum chemical calculations.
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Extract Ligands ( )

Spartan provides a facility for extracting ligands from PDB files* 
either as molecular structures or as footprints (pharmacophores) 
that these structures leave behind. The latter is separated into three 
parts, the first two of which follow from the molecular structure of 
the ligand and the third which follows from the immediate (protein 
or nucleotide) environment:

(i) hydrogen-bond donor/acceptor sites and positive/negative 
ionizable sites

(ii) hydrophobes
(iii) excluded volumes

A pharmacophore can be constructed by requiring (i) to account for 
hydrogen-bonded and electrostatic interactions and (optionally) either 
(ii) or (iii) to account for steric interactions. Selection of (ii) leads to 
a pharmacophore that is visually simpler, but selection of (iii) may 
provide a more realistic picture.

Selection of Extract Ligands leads to a message at the bottom of 
the screen.

Ligands in PDB files are represented as a transparent space-filling 
model. Clicking on a ligand selects it and displays the PDB HET 
name** at the bottom of the screen (if a HET name is available). 
Multiple ligands may be selected if desired by holding down on the 
Ctrl key. All ligands may be selected by clicking on the Select All 
Ligands button at the bottom right of the screen. After one or more 
ligands have been selected, clicking on the Extract Ligands button 
at the bottom right of the screen brings up the Extract Ligands 
dialog.

* This capability is not restricted to files in PDB, but extends to files written in PDB format.
** This is the code given to small molecules that are associated with proteins/nucleotides in 

PDB files.
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This allows selection of whether Ligand Structures or one or more 
pharmacophore elements (HBA/HBD and +/- Centers, Hydrophobe 
Centers including aromatic centers, Excluded Volume Centers) 
or both structure and one or more pharmacophore elements are to 
be abstracted from the PDB file, and whether amino acid and/or 
nucleotide residues in close hydrogen-bonding or charge-charge 
contact with the ligand (Environmental Structures) are to be 
identified. It also allows the Protein/Nucleotide Structure (minus 
all ligands) to be extracted.

In the case of extraction of Ligand Structures, the Extract Ligands 
dialog also provides a set of utilities:

(i) Grow Hydrogens
 If checked, adds hydrogens wherever they appear to be missing, 

based on the actual geometry and on normal valence rules. 
This function is also available under Grow Hydrogens in the 
Molecule Utilities dialog (Properties under the Display menu; 
Chapter 18).

(ii) Repair Bonds
 If checked, attempts to fix bonding errors based on the actual 

geometry in the PDB entry and on normal valence rules.

Clicking on OK at the bottom of the Extract Ligands dialog extracts 
the ligand(s) or pharmacophore(s), placing them in a single new 
(unnamed) document. Clicking on Cancel dismisses the dialog 
without ligand (pharmacophore) extraction.
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Chapter 20
The Options Menu

Functions under the Options menu* set default colors, fonts, user 
preferences and van der Waals radii, locate databases, identify 
remote servers, engage parallel computing, set program queue’s, set 
icon displays and identify/change URL’s for on-line accesses. They 
also allow for changing default colors and fonts and for monitoring 
executing jobs. 

Preferences...

This sets up preferences relating to the graphical user interface 
(Settings), and to molecule displays (Molecules). It permits changes 
to default van der Waals radii used for space-filling models as well 
as for calculating molecular surface areas and volumes (VDW 
Radii). It also specifies the locations of databases (Paths), identifies 
remote servers (Hosts), sets job queues (Jobs), (optionally) specifies 
parallel operations (Parallel), specifies platform dependent features 
(X-Platform), specifies which icons are to be displayed (Toolbars) 
and specifies URL’s (URL’s) for on-line connections. Selection results 
in one of ten dialogs, depending on which tab has been selected in 
the previous entry. Clicking on a tab brings up the associated dialog. 

* Preferences are also under the Spartan’10 menu on the Macintosh version.
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To exit a Preferences dialog click on OK. Clicking on Cancel or  
exits the dialog without instituting any changes.

Settings

(i) View:  Orthogonal/Perspective
 Controls the view of structural models and graphics.

(ii) Toolbar Style: text/small icons/medium icons/large 
icons

 Controls presentation style (text vs. icons) and size of the icons.

(iii) Stereo: off/red-cyan
 Turns red-cyan stereographic display on and off.

(iv) Global Rotate:  screen ctr./molecule ctr.
 Screen ctr. rotates all molecules about a common center; 

while molecule ctr. rotates each molecule about its own 
center.

(v) Animation Speed
 A slider bar controls the maximum speed for animations. 

This has become an important control as the performance 
of graphics cards has increased.
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(vi) Pin New Documents
 If checked, defaults to display of any new documents (from 

building or brought in from the File menu) irrespective of 
whether or not they are selected. Does not affect the status of 
existing documents. Pin New Documents has no meaning 
unless Show Document Tabs (see discussion following) 
is checked.

(vii) Show Document Tabs
 If checked, this displays a tab at the bottom of the screen for 

each open document. Only if the box to the left of the tab is 
checked will the molecule display (if it is not the selected 
document). If Show Document Tabs is not checked, the 
display corresponds to previous versions of Spartan.

(viii) Split-Tubes
 If checked, the tubes in tube and ball-and-spoke models are 

split to designate multiple bonds.

(ix) CSD Interface
 If checked, displays the CSD tab in the Database dialog 

(Database under the Search menu; Chapter 19). Uncheck 
if CSD is not installed.

(x) Auto-Gen Graphics
 If checked, graphics calculations will be performed in the 

interface (without having to submit the job). Does not pertain 
to orbital displays initiated from Orbital Energies under 
the Display menu. Note, however, that graphics calculations 
on documents containing more than 25 molecules will not 
be performed in the interface irrespective of this setting.

(xi) Tumble
 If checked, allows automatic tumbling of molecule. To 

tumble a molecule, select it, press the left mouse button, 
move the mouse and release the button. To stop tumbling, 
left click.
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(xii) Keep Verbose
 If checked, keeps extended (verbose) output. Normally 

discarded upon successful completion, this may be useful for 
identifying the source of problems for calculations that have 
not successfully completed or have led to suspicious results. 
(Verbose output is automatically kept for a job that has 
abnormally terminated.) Note that keeping verbose output 
significantly increases the size of the Spartan document.

(xiii) Conformer Rules
 Chooses between rule sets for conformational searching. 

Normal should be used for Equilibrium Conformer and 
Conformer Distribution where Monte Carlo methods are 
involved. Trimmed eliminates less important degrees of 
conformational freedom and should be used for Conformer 
Library where systematic searches are carried out. 

(xiv) PDB Water Filter
 If checked, removes water molecules from imported PDB 

files. 

(xv) MDL Water Filter
 If checked, removes water molecules from SD files.

(xvi) MDL HCl Filter
 If checked, removes HCl molecules from SD files.

(xvii) Max-Ligand Distance
 Set maximum distance (in Å) for an amino acid in a protein 

to be recognized as bonded to a ligand.

(xviii) Polar Area Range
 Set potential (in kJ/mol) for calculating polar area from 

elecrostatic potential map. Values > | range | contribute to 
polar area. Default is 100 kJ/mol.

(xix) Accessible Area Radius
 Set sphere radius (in Å) for determining accessible area. 

Default is 1.0.
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Molecule

This specifies default settings for model appearance. These settings 
may be overridden for a specific molecule (or list of molecules) 
using entries under the Model menu and for specific portions of a 
molecule using Utilities/Style dialogs associated with Properties 
dialogs (Properties under the Display menu; Chapter 18).

(i) Model:  Wire/Ball and Wire/Tube/Ball/Spoke/Space 
Filling/Line

 Controls default model style.

(ii) Show: Constraints/Frozens/Points/Planes/Peaks/
Reactions/CFD’s/Images/Annotations

 If checked, constraints and frozen markers, points and planes, 
reaction arrows and CFD’s will always be shown as part 
of the model. Otherwise, they will be shown only in the 
appropriate mode.

(iii) Atom Labeling: Label/Element/Mass Number/Mulliken 
Charge/Electrostatic Charge/Natural Charge/Strand: 
Residue/Label/R/S/Exposed Area/Chem Shift/Custom

 Controls default label type. Custom allows the user to enter 
an expression designating a label. These are of the same 
form as used in the spreadsheet. See the section on User-
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Defined Expressions under Spreadsheet in the Display 
menu (Chapter 18).

(iv) Bond Labels
 If checked, bond labels will be shown.

(v) Point Labels
 If checked, point labels will be shown.

(vi) Plane Labels
 If checked, plane labels will be shown.

(vii) Constraint Labels
 If checked, constraint labels will be shown.

(viii) Residue Labels
 If checked, residue labels will be shown.

(ix) Reaction Labels
 If checked, reaction arrow labels will be shown.

(x) CFD Labels
 If checked, CFD labels will be shown.

VDW Radii

This provides a list of van der Waals radii
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To order the list by element name click on Element, and by atomic 
radius click on VDW Radius. Individual entries may be changed 
from default values by first clicking on the entry and then entering 
a new value. The currently selected entry may be returned to its 
default radius by clicking on Reset Selected at the bottom of the 
dialog, and the full set of radii may be returned to their default 
values by clicking on Reset All at the bottom of the dialog.

Paths

This allows setting up of paths for SMD, SSPD/SIRD and SRD 
database directories.

 

Molecular Database Directories defines the content of SMD, 
SSPD/SIRD and SRD in terms of one or more directories. Multiple 
directories can be accessed at once. Specification of which 
directory (or directories) is to be searched in the Search Options 
dialogs associated with SMD, SSPD, SIRD and SRD (Databases  
under the Search menu; Chapter 19). Note that SIRD is the 
same database as SSPD, and only the method of access (spectral 
matching vs. substructure matching) are different.

All copies of Spartan are shipped with ~5,000 molecule subsets 
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of both SMD and SSPD databases (referred to as SMD (sample) 
and SSPD (sample), respectively. The full databases (SMD and 
SSPD) are available from Wavefunction. To avoid duplicates, the 
sample databases should be removed upon installation of the full 
SMD and/or SSPD databases.

Other collections may be added, for example, collections of diverse 
conformations for use in similarity analyses, or user-supplied 
collections. Appendix H discusses creation of user-defined 
databases.

Hosts

This allows specification of one or more computers that may act 
as servers.

To add a new host, click on the New... button and follow the 
directions provided in the Host dialog that appears.
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Jobs

This allows setting of job limits.

Maximum Concurrent Jobs designates the maximum number of 
jobs that can be run at one time and Memory and Scratch Disk 
Space maximum amounts of memory and disk for a job.

You need to use caution that the maximum number of jobs does 
not significantly exceed the number of processors (cores) on your 
computer and also that you have sufficient memory to support this 
maximum number.
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Parallel

This controls the use of a multi-core machine. The number of 
available cores is indicated at the top of the dialog.

(i) Core Allocation Method
 Toggles between Automatic and Manual. Automatic will 

assign all available cores to a single molecule (single molecule 
inside a Spartan document) if there is only one molecule in 
the document and will divide the cores among the molecules 
in the document if there is more than one. Manual will follow 
settings under Manual Limits.

(ii) Manual Limits
 Concurrent Molecules Per Job sets the number of jobs 

(molecules inside a Spartan document) that will run 
simultaneously and Cores Per Molecule sets the number of 
cores used on a single molecule.

If you are simultaneously working with two or more documents, 
you need to use caution in specifying more than one core/job. It is 
very easy (and, depending on available memory, potentially very 
inefficient) to demand more cores than are actually available. This 
is not an issue if you are working only with a single document even 
if it contains more than one molecule.
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X-Platform

Items here refer to cross-platform applications and should not be 
of concern to users of a single platform.

(i) Document Style
 Toggles between File Based and Directory Based. The 

latter is for compatibility between Windows and previous 
Macintosh and Unix/Linux versions of Spartan.

(ii) Output/Spreadsheet Window
 Toggles between allowing the output window and the 

spreadsheet to be Free (able to move outside the main 
Spartan window) or Confined (restricted to move inside 
the main Spartan window). Previous versions of Spartan 
confined these windows.

(iii) Dialog Buttons
 Menu selects between several dialog formats: Windows, 

Macintosh, and KDE and Gnome Linux. Default uses 
the style associated with the machine on which Spartan is 
installed.

(iv) Data Compression Options
 Allows compression of text files (Gzip text files) and switches 

to binary for archive storage (Use binary archive).



414 Chapter 20

Toolbars

A listing of all icons available for entries in the File, Geometry, 
Build, Display and Search menus is provided. If checked, the 
icon will appear at the top of the Spartan screen.

URL’s

Lists URL’s for access to experimental structural and spectral 
databases and to Wikipedia.
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Colors

This alters default colors. Selection leads to the Colors dialog.

After selecting an object, its color may be set by choosing from 
the palette, moving the cursor inside the window of colors, or by 
selecting  either a set of hue, saturation and values, or red, green and 
blue settings. The default color may be reset by clicking on Restore 
Default Color. Color selection applies to all objects of the same type, 
for example, all carbon atoms, and not just to the selected carbon. 
Further control of colors is available from Utilities/Style dialogs 
associated with Properties dialogs (Properties under the Display 
menu; Chapter 18). Clicking on  removes the dialog.

Fonts/Graphic Fonts

This selects fonts, style and size of labels attached to molecules 
(Labels and Configure... under the Model menu; Chapter 14), and 
plots (Plots... under the Display menu; Chapter 18). Selection leads 
to the Fonts dialog.
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Selections are made from the Font, Font Style and Size menus. 
Clicking on OK dismisses the dialog with selections kept. Clicking 
on Cancel or on  dismisses the dialog but selections are lost.

Monitor

This provides a listing of all executing/queued jobs and their status. 
To see accumulated output for an executing job, click on its name. A 
ball-and-spoke model of the selected (executing) job will be displayed 
in a window to the right of the dialog. It can be manipulated using 
the usual mouse commands (you need to position the cursor inside 
the window). Model style cannot be changed. Note that (except for 
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molecular mechanics and semi-empirical calculations) the structure 
is updated throughout an equilibrium geometry of transition state 
optimization, and bond lengths, angles and dihedral angles can be 
queried. 

To kill a job, click on its name, and then select Terminate from the 
Actions menu at the top of the dialog (or right click on its name and 
select Terminate from the menu that appears). To start a queued job 
(irrespective of the imposed queue limits; see previous discussions 
under Jobs and Parallel), click on its name and select Start from 
the Actions menu (or right click on its name and select Start from 
the menu that appears).

The Monitor may be removed either by selecting Exit from the File  
menu or by clicking on  at the top of the dialog.

Calculator

Selection brings up a Calculator.

This functions the same way as a normal pocket calculator. The 
Calculator is removed by clicking on .

Model Kit

If checked, this signifies that a model kit (organic, inorganic, peptide, 
nucleotide or substituent) is to remain on screen. Does not apply to 
ChemDraw.
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File Toolbar, Geometry Toolbar, Build Toolbar, Display Toolbar, 
Search Toolbar

If checked, this provides display of toolbars that access functions 
contained in the File, Build, Geometry, Display and Search menus, 
respectively.

Cascade, Tile

Arranges open windows in a cascade or as tiles on top of Spartan’s 
main window (NAM).
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Chapter 21
The Activities Menu

The Activities menu permits on-screen display of the full set of Spartan 
tutorials and a series of topics of practical relevance to molecular 
modeling. It also allows a Wikipedia page to be brought up (external 
to Spartan).

Tutorials/Topics

Selection of Tutorials or Topics brings up a dialog with either the 
Tutorials or Topics tab selected (Tutorials tab shown).

Selection of a Chapter (in this case, corresponding to a chapter in this 
User’s Guide) from the upper half of the dialog, followed by clicking 
on Open leads to a scrollable window containing the appropriate text. 
This may be moved about the screen but may not be sized.
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Topics are specified by name only (in the upper half of the dialog).

Note that the full User’s Guide is available as a PDF under the Help 
menu (see next chapter).

Look Up in Wikipedia...

Selection results in a dialog.

Entering a query followed by clicking on OK leads to a Wikipedia 
page. This occupies a window that is external to Spartan.
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Chapter 22
The Help Menu

This chapter describes help.

Help

This provides information relating to application of computational 
methods available in Spartan, as well as technical details regarding 
the program’s operation.

A number of topics are dealt with under Help; including Mouse/
Keyboard Functions, General Operating Features, Units, 
Differences between Spartan’08 and ’10, Selecting a Theoretical 
Model, Relative Computational Times, Memory Usage, Calculation 
Options, and a number of FAQ documents (Energy Questions, 
Convergence Questions, Questions about Basis Sets, Problems 
with Memory, Questions about the Property Module, Questions 
about Conformations and Energy Profiles, MMFF94 Compliance, 
Units) related to computational questions. Help also provides a link to 
Wavefunction’s website. Help files are HTML documents and require 
that Internet Explorer is installed to access them.

The Spartan Tutorial and User’s Guide (this document) and A Guide 
to Molecular Mechanics and Quantum Chemical Calculations are 
also available (as PDF files) under Help.

Finally, note that several dialogs, in particular, the Calculations dialog 
incorporate imbedded help messages. Clicking on  at the upper 
right, followed by clicking on a menu, button, etc. in the dialog gives 
rise to a brief informative message about the object queried.
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About...*

Provides information about the user’s release of Spartan.

* About is located under the Spartan 10 menu on the Macintosh version.
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Appendix A
Topics

This appendix is made up of 12 short essays addressing topics that 
are important to molecular modeling in general and to modeling 
applications of Spartan in particular. These are also available from 
Topics under the Activities menu. 

The first two essays  are the most fundamental.  Potential Energy 
Surfaces relates two of the quantities that directly result from a 
quantum chemical calculation, geometry and energy. Theoretical 
Models outlines the steps made in moving from the Schrödinger 
equation to practical techniques and broadly outlines the  scope of 
these techniques. 

The next two essays (Finding and Verifying Equilibrium 
and Transition-State Geometries and Total Energies and 
Thermodynamic and Kinetic Data) provide specifics about the 
relationship between geometry and energy in the context of practical 
quantum chemical models. A fifth essay (Calculating Accurate 
Heats of Formation) details what actually needs to be done to 
reliably reproduce the experimental measure of energy.

The next two essays discuss molecules that may not be adequately 
described in terms of a single conformer. Dealing with 
Conformationally-Flexible Molecules describes what needs to 
be done in order to identify the lowest-energy conformer and more 
generally to establish a Boltzmann energy distribution among 
different conformers. Interpreting Conformational Preferences 
shows how information resulting from calculating an energy profile 
for rotation about a single bond may be associated with familiar 
chemical notions. 

The next two essays deal with spectroscopy. Calculating Infrared 
Spectra shows how the “raw data” resulting from a quantum chemical 
calculation may be combined with two empirical parameters to 
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produce accurate infrared spectra. Calculating NMR Spectra 
shows how a more complex parameterization scheme is needed to 
bring 13C spectra into close agreement with experiment. 

The last four essays deal with graphical models. Atomic and 
Molecular Orbitals outlines the model that is certainly the most 
familiar to chemists. It illustrates how molecular orbitals arise from 
atomic orbitals in the context of the practical quantum chemical 
models introduced previously, and the information that can be drawn 
from them.  While molecular orbitals are themselves not observable 
quantities, the square of the molecular orbitals (the electron density) 
corresponds to what is actually measured in an X-ray diffraction 
experiment. Electron Densities: Sizes and Shapes of  Molecules 
connects this quantity to familiar notions about chemical bonds 
and about the space that molecules occupy (“sterics”). The electron 
density model underpins the three property maps described in the final 
two essays. Electrostatic Potential Maps: Charge Distributions 
describes a model that uses color to map the value of the electrostatic 
potential (the energy of a positive point charge with the nuclei 
and electrons of a molecule) and, in so doing, distinguish neutral, 
positively charged and negatively-charged regions on a sterically 
accessible surface. Local Ionization Potential Maps and LUMO 
Maps: Electrophilic and Nucleophilic Reactivities show how 
maps colored using two other quantities (the energy of ionization 
and the absolute value of the lowest-unoccupied molecular orbital) 
as a function of location on an electron density surface, may be used 
to account for electrophilic and nucleophilic reactivity. 
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POTENTIAL ENERGy SURFACES

One Dimensional Energy Surfaces

Every chemist has encountered a plot depicting the change in energy 
of ethane as a function of the angle of torsion (dihedral angle) around 
the carbon-carbon bond.
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Full 360° rotation leads to three identical energy minima in which the 
hydrogens are staggered, and three identical energy maxima in which 
the hydrogens are eclipsed. The difference in energy between eclipsed 
and staggered structures of ethane, termed the barrier to rotation, 
is known experimentally to be 12 kJ/mol. Note, that any physical 
measurements on ethane pertain only to its staggered structure, 
or more precisely the set of three identical staggered structures. 
Eclipsed ethane does not exist in the sense that it cannot be isolated 
and characterized. Rather, it can only be imagined as a structure in 
between equivalent staggered forms.

Open ethane rotation in the topics directory. The image which appears is 
one frame in a sequence depicting rotation about the carbon-carbon bond 
in ethane. Click on the  and  keys at the bottom left of the screen to 
look at other frames. Verify that the staggered structures correspond to 
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minima on the energy plot and that the eclipsed structures correspond 
to maxima. Click on the  key to animate the sequence. Close ethane 
rotation when you are finished.

Somewhat more complicated but also familiar is a plot of energy 
vs. the dihedral angle involving the central carbon-carbon bond in  
n-butane.
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This plot also reveals three energy minima, corresponding to staggered 
structures, and three energy maxima, corresponding to eclipsed 
structures. In the case of n-butane, however, the three structures in 
each set are not identical. Rather, one of the minima, corresponding 
to a dihedral angle of 180° (the anti structure), is lower in energy and 
distinct from the other two gauche minima (dihedral angles around 60° 
and 300°), which are identical. Similarly, one of the energy maxima 
corresponding to a dihedral angle of 0°, is distinct from the other 
two maxima (with dihedral angles around 120° and 240°), which are 
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identical. As with ethane, eclipsed forms of n-butane do not exist, and 
correspond only to hypothetical structures in between anti and gauche 
minima. Unlike ethane, which is a single compound, any sample of 
n-butane is made up of two distinct compounds, anti n-butane and 
gauche n-butane. The relative abundance of the two compounds as a 
function of temperature is given by the Boltzmann equation (see the 
topic Total Energies and Thermodynamic and Kinetic Data).

Open n-butane rotation in the topics directory. The image which appears 
is one frame of a sequence depicting rotation about the central carbon-
carbon bond in n-butane. Click on the  and  keys at the bottom left 
of the screen to look at other frames. Verify that the staggered structures 
correspond to minima on the energy plot and that the eclipsed structures 
correspond to maxima. Also, verify that the anti structure is lower in 
energy than the gauche structure. Click on  to animate the sequence. 
Close n-butane rotation when you are finished.

The important geometrical coordinate in both of the above examples 
may clearly be identified as a torsion involving one particular carbon-
carbon bond. This is an oversimplification, as bond lengths and angles 
no doubt change during rotation around the carbon-carbon bond.

Quantum chemical models available in Spartan are able to account 
for the subtle changes in bond lengths and angles which result from 
changes in conformation. Open n-butane geometry changes in the topics 
directory. The two plots depict the variation in central CC bond distance 
and in CCC bond angle as a function of the CCCC torsional angle. The 
variation in energy is superimposed on each plot. Note how closely the 
bond distance and energy changes parallel each other. Note also that the 
bond angle is insensitive to conformation except in the region of the syn 
(0° torsional angle) structure where it has opened up by several degrees. 
Close n-butane geometry changes when you are finished.
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Many Dimensional Energy Surfaces

It will usually not be possible to identify a simple geometrical 
coordinate to designate a chemical transformation. A good example 
of this is provided by the potential energy surface for ring inversion 
in cyclohexane.

reaction coordinate

transition
state

transition
state

twist boat
chair chair

energy

In this case, the geometrical coordinate connecting stable forms is 
not specified in detail (as it was in the previous two examples), but 
is referred to simply as the reaction coordinate. The two energy 
maxima have been designated as transition states to indicate that their 
structures may not be simply described (as are the energy maxima 
for rotation in ethane and n-butane).

The energy surface for ring inversion in cyclohexane, like that for  
n-butane, contains three distinct energy minima, two of lower energy 
referred to as  chair forms, and one of higher energy refered to as 
a twist boat form. In fact, the energy difference between the chair 
and twist boat structures is sufficiently large (around 23 kJ/mol) 
that only the former can be observed at normal temperatures. For a 
discussion, see the topic Total Energies and Thermodynamic and 
Kinetic Data.

All six carbons are equivalent in the chair form of cyclohexane, 
but the hydrogens divide into two sets of six equivalent equatorial 
hydrogens and six equivalent axial hydrogens.
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Haxial

Hequatorial

However, only one kind of hydrogen can normally be observed, 
meaning that equatorial and axial positions interconvert via some 
low-energy process. This is the ring inversion process just described, 
in which one side of the ring is bent upward while the other side is 
bent downward.

H*
H

H*

H

As shown in the potential energy diagram on the previous page, the 
overall ring inversion process appears to occur in two steps, with a twist 
boat structure as a midway point (an intermediate). The two (equivalent) 
transition states leading to this intermediate adopt structures in which 
five of the ring carbons lie (approximately) in one plane.

The energy profile for ring inversion in cyclohexane may be 
rationalized given what we have already said about single-bond 
rotation in n-butane. Basically, the interconversion of the reactant 
into the twist-boat intermediate via the transition state can be viewed 
as a restricted rotation about one of the ring bonds.

Correspondingly, the interconversion of the twist boat intermediate 
into the product can be viewed as rotation about the opposite ring 
bond. Overall, two independent bond rotations, pausing at the high-
energy (but stable) twist-boat intermediate effect conversion of one 
chair structure into another equivalent chair, and at the same time 
switch axial and equatorial hydrogens.
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Open cyclohexane ring inversion in the topics directory. The image 
which appears is one frame in a sequence depicting ring inversion in 
cyclohexane. Click on the  and  keys at the bottom left of the screen 
to look at other frames. Verify that the three minima on the energy plot 
correspond to staggered structures and that the two maxima correspond 
to eclipsed structures. Also, verify that the twist boat structure is higher 
in energy than the chair structures. Click on  to animate the sequence. 
Note that the overall ring inversion appears to occur in two steps, one 
step leading up to the twist boat and the other step leading away from it. 
Close cyclohexane ring inversion when you are finished.

Ethane, n-butane and cyclohexane are all examples of the types 
of motions which molecules may undergo. Their potential energy 
surfaces are special cases of a general type of plot in which the 
variation in energy is given as a function of reaction coordinate.

energy

reaction coordinate

transition state

reactant

product

Diagrams like this provide essential connections between important 
chemical observables - structure, stability, reactivity and selectivity 
- and energy. 

The positions of the energy minima along the reaction coordinate give 
the equilibrium structures of the reactant and product. Similarly, the 
position of the energy maximum gives the structure of the transition 
state. Both energy minima (which correspond to stable molecules) and 
the energy maximum (which may correspond to a transition state) are 
well defined. However, the path connecting them (reaction coordinate) 
is not well defined, in the sense that there are many possible paths. 
Liken this to climbing a mountain. The starting and ending points are 
well defined as is the summit, but there can be many possible routes.
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transition state
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energy

reaction coordinate

equilibrium structures

transition state structure

reactant

As previously commented, the reaction coordinate for some processes 
may be quite simple. For example, where the “reaction” is rotation 
about the carbon-carbon bond in ethane, the reaction coordinate may 
be thought of as the HCCH torsion angle, and the structure may be 
thought of in terms of this angle alone. Thus, staggered ethane (both 
the reactant and the product) is a molecule for which this angle is 60° 
and eclipsed ethane is a molecule for which this angle is 0°.
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A similar description applies to “reaction” of gauche n-butane leading 
to the more stable anti conformer. Again, the reaction coordinate may 
be thought of as a torsion about the central carbon-carbon bond, and 
the individual reactant, transition state and product structures in terms 
of this coordinate.
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Equilibrium structure (geometry) may be determined from experiment, 
given that the molecule can be prepared and is sufficiently long-lived 
to be subject to measurement. On the other hand, the geometry of 
a transition state may not be experimentally established. This is 
simply because a transition state is not an energy well which can 
trap molecules. Therefore, it is impossible to establish a population 
of molecules on which measurements may be performed. 

Both equilibrium and transition-state structures may be determined 
from quantum chemical calculations. The fact that a molecule may 
not be stable enough to be detected and characterized (or even exist) 
is not important. It would seem from our discussion that equilibrium 
and transition-state structures can be distinguished from one another 
simply by inspecting the shape of the potential energy surface in the 
vicinity of the structure. In practice, such a surface cannot actually 
be visualized for a system with more than one or at most two degrees 
of freedom. A better (more general) indicator is the set of frequencies 
associated with the vibrational motions around the structure, the same 
quantities measured by infrared spectroscopy. Structures for which all 
frequencies are real numbers correspond to stable molecules (energy 
minima), while structures which have one (and only one) vibrational 
frequency which is an imaginary number may be transition states. 
The coordinate (vibrational motion) associated with this imaginary 
frequency is the reaction coordinate. Further discussion is provided 
in the topic Calculating Infrared Spectra. 



Appendix A 433

TheoreTical Models

A wide variety of different procedures based on quantum mechanics 
(so-called quantum chemical models) have been developed to 
calculate molecular structure and properties and infrared, NMR and 
UV/visible spectra. All follow from a deceptively simple looking 
Schrödinger equation first written down in 1927.

HΨ = εΨˆ

Ĥ (the Hamiltonian or more precisely Hamiltonian operator) is 
the only known. It describes the kinetic energies of the particles that 
make up a molecule and the Coulombic interactions between the 
individual particles. Positively-charged nuclei repel other nuclei, 
and negatively-charged electrons repel other electrons, but nuclei 
attract electrons. Ψ (the wavefunction) is a function of the Cartesian 
coordinates, and ε (the energy) is a number. The goal in solving the 
Schrödinger equation is to find a function that when operated on by 
the Hamiltonian yields the same function multiplied by a number. 
Note that there are many (actually an infinite number of) solutions to 
the Schrödinger equation. These correspond to the ground and various 
excited states of an atomic or molecular system.

The energy of a molecule can be measured. While the wavefunction 
itself has no physical meaning, the square of the wavefunction times 
a small volume element gives the probability of finding an electron 
inside the volume. This is what is measured in an X-ray diffraction 
experiment.

The Schrödinger equation can be solved exactly for the hydrogen 
atom (a one-electron system), where the wavefunctions are familiar 
to chemists as the s, p, d, ... atomic orbitals. These correspond to the 
ground and excited states of the hydrogen atom.

s orbital p orbital d orbital

Although the Schrödinger equation may easily be written down for 
many-electron atoms as well as for molecules, it cannot be solved, 
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even for a something as simple as the helium atom with only two-
electrons. Approximations need to be made.

Hartree-Fock Molecular Orbital Models

Hartree-Fock molecular orbital models or more simply molecular 
orbital models were the first practical quantum chemical  models to 
be formulated. They result from making three approximations to the 
Schrödinger equation: 

1. Separate nuclear and electron motions. The Born-Oppenheimer 
approximation says that “from the point of view of the electrons”, 
the nuclei are stationary. This eliminates nuclear motion and leads 
to an electronic Schrödinger equation which can be solved for 
the H2

+ molecule, but cannot be solved for molecules with more 
than one-electron.

2. Separate electron motions. The Hartree-Fock approximation 
eliminates the need of having to simultaneously account for the 
motions of several electrons. It leads to a much simpler set of 
equations in which the motion of each electron in an environment 
made up of the nuclei and all the other electrons is sought. 

3. Represent each one-electron solution or molecular orbital 
by a linear combination of atom-centered functions or atomic 
orbitals. The LCAO (Linear Combinations of Atomic Orbitals) 
approximation reduces the problem of finding the best functional 
form for the molecular orbitals to the much simpler problem of 
finding the best set of linear coefficients. As the number and 
complexity of the atomic orbitals increases, the energy and other 
properties approach limiting values. However, computational 
cost also increases. The goal is to provide as few functions as 
possible to yield a value for the property of interest that adequately 
reflects its limit. Note, that the limiting values of properties are 
not expected to be same as experimental values, but rather reflect 
the behavior of the Hartree-Fock model. 

Taken together, these three approximations lead to a set of equations 
known as the Roothan-Hall equations that can actually be solved 
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for molecules with molecular weights in the range of 300-500 amu. 
In practice, the resulting models increase in computational cost as 
the cube of the size (number of basis functions). Note, however, that 
calculated atomic and molecular properties will not exactly match 
the corresponding experimental quantities.

Basis Sets

All practical molecular orbital calculations utilize Gaussian 
functions. These are polynomials in the Cartesian coordinates times 
an exponential in the square of the distance from the origin, and 
are closely related to the exact solutions of the hydrogen atom 
(exponential functions in the distance). Functions are labeled 1s, 
2s, 2p, ... , the same nomenclature used to describe hydrogen atom 
solutions. 

A minimal basis set includes only sufficient functions to hold all 
the electrons on an atom and to maintain its spherical shape. This 
involves a single 1s orbital for each hydrogen atom, and a set of five 
orbitals (1s, 2s, 2px, 2py and 2pz) for each carbon atom. Because a 
minimal basis set incorporates only one set valence p functions, the 
components of which are the same size, atoms in nearly spherical 
environments will be better described than atoms in aspherical 
environments. A split-valence basis set addresses the problem by 
providing two different sets of valence p functions, one compact 
set and one loose set. This allows different linear combinations 
for different directions. For example, the compact p orbital can be 
emphasized to construct a σ bond while the loose p orbital can be 
emphasized to construct a π bond.

ps  =  inner                  +  outer

pp  =  inner                   +  outer

Because the functions in a minimal or split valence basis set 
are centered on the atoms, they may have difficulty describing 
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electron distributions that fall in between atoms (that is, bonds).  A 
polarization basis sets addresses the problem by providing a set of 
d-type functions (polarization functions) on main-group elements, 
and (optionally) a set of p-type functions on hydrogen. The resulting 
combinations can be thought of as hybrid orbitals, for example, the 
pd and sp hybrids shown below.

+  λ

+  λ

The so-called 6-31G* basis set will be used for the infrared and NMR 
calculations described in this chapter. The number “6” to the left of the 
“-” in the name  indicates that 6 functions are used to describe each 
inner-shell (core) atomic orbital. The numbers,  “31” to the right of the 
“-” indicate that two groups of 3 and 1 functions are used to describe 
each valence-shell atomic orbital. “*” designates that polarization 
functions are supplied for non-hydrogen atoms. Were two stars to be 
present (as in 6-31G**) this would indicate that p-type  polarization 
functions would also be placed on hydrogen atoms. 

Hartree-Fock models increase in computational cost as the cube of 
the total number of basis functions, and can easily be applied to 
molecules incorporating 50-100 heavy (non- hydrogen) atoms.

Beyond Hartree-Fock Models

According to the Hartree-Fock approximation, electrons “move 
independently”, which means that both the electron-electron 
repulsion energy and the total energy will be too large. The limiting 
Hartree-Fock energy is therefore higher (less negative) than the 
experimental energy. Electron correlation is the term give to describe 
the coupling or correlation of electron motions. The correlation 
energy is defined as the difference between the Hartree-Fock energy 
and the experimental energy.
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There are two conceptually different approaches for calculating 
the correlation energy, and numerous specific models arising from 
each of these approaches. One way is to combine the Hartree-Fock 
wavefunction with wavefunctions formed by promoting electrons 
from molecular orbitals that are occupied to molecular orbitals that 
are unoccupied. You can think of this as combining the ground-state 
and wavefunction with wavefunctions arising from different excited 
states.

unoccupied molecular orbitals

electron promotion

occupied molecular orbitals

It can be shown that the energy corresponding to a wavefunction 
Ψ, formed by combining the Hartree-Fock wavefunction Ψo and 
wavefunctions resulting from all possible electron promotions Ψs, 
is identical to that obtained from exact solution of the Schrödinger 
equation. 

s > o
Σ asΨsaoΨoΨ =

This is referred to as full configuration interaction. Such a 
procedure is not practical (possible) simply because the number 
of excited states is infinite. Practical methods follow by reducing 
the number of electron promotions (excited states), for example, by 
limiting  promotions to involve only one electron, only two electrons, 
etc. Collectively these are referred to as limited configuration 
interaction. CID (Configuration Interaction Doubles) and CISD 
(Configuration Interaction Singles and Doubles) are two practical 
limited configuration interaction methods.
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An alternative to configuration interaction is Møller-Plesset theory. 
This assumes that the Hartree-Fock energy E0 and wavefunction 
Ψ0 are solutions to an equation involving a Hamiltonian, Ĥ0, that is 
very close to the exact Schrödinger Hamiltonian, Ĥ. This being the 
case, Ĥ can be written as a sum of Ĥ0 a small correction, V. λ is a 
dimensionless parameter.

H = H0 + λVˆ ˆ ˆ

Expanding the exact energy in terms of a power series of the Hartree-
Fock energy yields:

E = E(0) + λE(1) + λ2E(2) + λ3E(3) + ...

Substituting this expansion into the Schrödinger equation and 
collecting terms in powers of λ leads to an explicit expression for 
the energy correction. The sum of E(0) and E(1) is the Hartree-Fock 
energy. Including the next term gives rise to the so-called MP2 
(second-order Møller-Plesset) model. This has largely replaced CID 
and CISD models in practical applications.

Both (the simplest) limited configuration interaction and the MP2 
models increase in computational cost as the fifth power of the total 
number of basis functions. In practice, this limits them to molecules 
incorporating 20-25 heavy (non-hydrogen) atoms at most.

A completely different approach to these two procedures is based on 
the fact that the hydrogen atom is not the only problem for which 
the Schrödinger equation can be solved exactly (albeit numerically). 
Another is an so-called free electron gas (a box of non-interacting 
electrons), solution of which leads to a functional form for a term 
that accounts for electron correlation. This term, that depends on the 
electron density as well as the gradient of the density, is then added 
to the Hartree-Fock Hamiltonian.

Such a procedure is referred to as a density functional model. Actual 
implementation requires introduction of parameters and because 
of this, many different functionals (combinations of functional 
form and parameters) have been proposed, and each can be used in 
conjunction with a variety of different basis set. 
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Density functional models increase in computational cost as the cube 
of the total number of basis functions (the same dependence seen for 
Hartree-Fock models). In practice, they are 50% more costly but 
can easily be applied to molecules incorporating 50-75 heavy (non- 
hydrogen) atoms.

semi-empirical Molecular orbital Models

The principal disadvantage of Hartree-Fock, density functional and 
MP2 models is their computational cost. It is possible to introduce 
further approximations in order to significantly reduce cost while 
still retaining the underlying quantum mechanical formalism. Semi-
empirical molecular orbital models follow in a straightforward way 
from Hartree-Fock models: 

1. Elimination of overlap between functions on different atoms 
(the NDDO approximation). This is rather drastic but reduces 
the computation effort by more than an order of magnitude over 
Hartree-Fock models.

2. Restriction to a minimal valence basis set of atomic functions. 
Inner-shell (core) functions are not included explicitly, and 
because of this, the cost of doing a calculation involving a second-
row element, e.g., silicon, is no more than that incurred for the 
corresponding first-row element, e.g., carbon.

3. Introduction of adjustable parameters to reproduce specific 
experimental data. This is what distinguishes the various semi-
empirical models currently available. Choice of parameters, more 
than anything else, appears to be the key to formulating successful 
semi-empirical models.

Molecular Mechanics Models

The alternative to quantum chemical models are molecular mechanics 
models. These do not start from the Schrödinger equation, but 
rather from a simple but chemically reasonable picture of molecular 
structure, a so-called force field. In this picture, just as with a Lewis 
structure, molecules are made up of atoms (as opposed to nuclei and 
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electrons), some of which are connected (bonded). Both crowding 
(van der Waals) and charge-charge (Coulombic) interactions between 
atoms are then considered, and atom positions are adjusted to best 
match known structural data (bond lengths and angles). 

Molecular mechanics is much simpler than solving the Schrödinger 
equation, but requires an explicit description of chemical bonding, 
as well as a large amount of information about the structures of 
molecules. This biases results and seriously limits the predictive value 
of molecular mechanics models. Nevertheless, molecular mechanics 
has found an important role in molecular modeling as a tool to establish 
equilibrium geometries of large molecules, in particular, proteins and 
equilibrium conformations of highly-flexible molecules.

choosing a Theoretical Model

No single method of calculation is likely to be ideal for all applications. 
A great deal of effort has been expended to define the limits of different 
molecular mechanics and quantum chemical models, and to judge 
the degree of success of different models. The latter follows from the 
ability of a model to consistently reproduce known (experimental) 
data. Molecular mechanics models are restricted to determination 
of geometries and conformations of stable molecules. Quantum 
chemical models also provide energy data, which may in turn be 
directly compared with experimental thermochemical data, as well as 
infrared spectra and properties such as dipole moments, which may 
be compared directly with the corresponding experimental quantities. 
Quantum chemical models may also be applied to transition states. 
While there are no experimental structures with which to compare (see 
the topic Potential Energy Surfaces), experimental kinetic data may 
be interpreted to provide information about activation energies (see 
the topic Total Energies and Thermodynamic and Kinetic Data).

Success is not an absolute. Different properties, and certainly different 
problems may require different levels of confidence to actually be of 
value. Neither is success sufficient. A model also needs to be practical 
for the task at hand. Were this not the case, there would be no reason 
to look further than the Schrödinger equation itself. The nature and 
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size of the system needs to be taken into account, as do the available 
computational resources and the experience and patience of the 
practitioner. Practical models usually share one common feature, in that 
they are not likely to be the best possible treatments which have been 
formulated. Compromise is almost always an essential component of 
model selection. Continued advances in both digital computers and 
computer software will continue to raise the bar higher and higher. 
There is much to be done before fully reliable models will be routinely 
applicable to all chemical systems of interest.

The table below provides an overview of the performance of the MMFF 
molecular mechanics model and five of the most popular quantum 
chemical models selected from the many available in Spartan, for 
the calculation of equilibrium and transition-state geometries and 
thermochemistry. The performance of the T1 recipe for the calculation 
of thermochemistry will be discussed in the topic Accurate Heats of 
Formation. The ability of these models to account for conformational 
energy differences and for infrared and NMR spectra will be dealt with 
in later topics (Dealing with Conformationally Flexible Molecules 
and Calculating Infrared Spectra and Calculating NMR Spectra).

Three different grades have been assigned: G is good, C is good with 
cautious application and P is poor. NA signifies not applicable.

 molecular  PM3 semi- Hartree-Fock B3LYP/ MP2/
task mechanics empirical 3-21G 6-31G* 6-31/G 6-31G*
geometry
(organic) C G G G G G
geometry
(metals) NA G P P G P
transition-state
geometry NA C G G G G
thermochemistry  NA P C G G G

computation time   low -----------------------------------------------------> high
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in Terms of Task

i) All models provide a good account of equilibrium geometries 
for organic and main-group inorganic molecules and, where they 
are applicable, of transition-state geometries. (Transition-state 
geometries cannot be judged by comparison with experimental 
data but only with the results of very good quantum chemical 
calculations.) Molecular mechanics and semi-empirical models 
only rarely yield very poor geometries. HF/3-21G, HF/6-31G* 
and MP2/6-31G* models do not provide a reliable account of the 
geometries of compounds incorporating transition metals, but the 
B3LYP/6-31G* model (and density functional models in general) 
provides a good account. Note that the PM3 semi-empirical 
model available in Spartan has been especially parameterized 
for this task and also generally provides a reasonable account of 
the geometries of transition metal inorganic and organometallic 
compounds. 

 ii) The HF/6-31G* model generally provides an acceptable account 
of the energetics of reactions which do not involve bond making 
or breaking. The HF/3-21G model is not as satisfactory. Neither 
Hartree-Fock models provide an acceptable account of the 
energetics of reactions which involve bond breaking. Both 
B3LYP/6-31G* and MP2/6-31G* models generally provide good 
accounts of the energetics of all types of chemical reactions.

 Neither Hartree-Fock models provide an acceptable account 
of absolute activation energies, but both models generally 
provide an excellent description of relative activation energies. 
Both B3LYP/6-31G* and MP2/6-31G* models properly 
account for both absolute and relative activation energies.

 The PM3 semi-empirical model is unsatisfactory in describing 
the energetics of all types of processes. 
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in Terms of Model

The MMFF molecular mechanics model is restricted to the description 
of equilibrium geometry where it performs reasonably well.

The PM3* semi-empirical model is appropriate for: 

i) Equilibrium geometry determinations for large molecules. 

ii) Transition-state geometry determinations. 

iii) Equilibrium and transition-state geometry determinations 
involving transition metals. 

The PM3 semi-empirical model is unsuitable for: 

i) Calculation of reaction energies. 

The HF/3-21G and HF/6-31G* models are appropriate for: 

i) Equilibrium and transition-state structure determinations of 
organic and main-group inorganic molecules (except molecules 
with transition metals).

ii) Calculation of reaction energies (except reactions involving 
bond making or breaking). 

The HF/3-21G and HF/6-31G* models are unsuitable for: 

i) Calculation of reaction energies which involve bond making 
or breaking and calculation of absolute activation energies. 

ii) Equilibrium and transition-state structure determinations for 
transition-metal inorganic and organometallic molecules.

The B3LYP/6-31G* model is appropriate for: 

i) Equilibrium and transition-state structure determinations for 
molecules incorporating transition metals. 

ii) Calculation of all types of reaction energies.

The MP2/6-31G* model is appropriate for: 

i) Equilibrium and transition-state structure determinations except 

* The PM3 model in Spartan has been extended to transition metals.
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for molecules including transition metals. 

ii) Calculation of all types of reaction energies.

The MP2/6-31G* model is unsuitable for: 

i) Equilibrium and transition-state structure determinations for 
transition-metal inorganic and organometallic molecules.

ii) Calculation of reaction and activation energies where transition-
metals are involved. 
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Finding and VeriFying equilibriuM and 
TransiTion-sTaTe geoMeTries

The energy of a molecule depends on its geometry. Even small changes 
in structure can lead to quite large changes in total energy. Proper 
choice of molecular geometry is therefore quite important in carrying 
out modeling studies. Experimental geometries, where available, would 
certainly be suitable. While experimental equilibrium geometries are 
available for many stable molecules*, the problem is that many, many 
more have not been determined. Also, experimental data for reactive 
or otherwise short-lived molecules are scarce, and data for transition 
states are completely lacking. In the final analysis, there is no alternative 
to obtaining geometries from calculation. Fortunately, this is not 
difficult, although it may be demanding in terms of computer time.

Determination of geometry (geometry optimization) is an iterative 
process. The energy and energy gradient (first derivatives of the energy 
with respect to all geometrical coordinates) are calculated for the initial 
geometry, and this information is then used to project a new geometry. 
This process continues until three criteria are satisfied. First, the 
gradient must closely approach zero. This insures that the optimization 
is terminating in a flat region of the potential surface (either the 
bottom of an energy well in the case of equilibrium geometry or the 
top of an energy hill in the case of transition-state geometry). Second, 
successive iterations must not change any geometrical parameter by 
more than specified (small) value. Third, successive iterations must 
not change the total energy by more than a specified (small) value.

equilibrium geometries

In order for a geometry to correspond to an energy minimum, the 
curvature of the energy surface must be positive, that is, the structure 
must lie at the bottom of an energy well. The surface’s curvature is 
defined by the Hessian (the matrix of second derivatives of the energy 
with respect to geometrical coordinates).

* The vast majority of experimental structures derive from X-ray crystallography on 
crystalline solids and may be different from gas-phase geometries due to requirements of 
crystal packing.
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What is actually done is to transform from the original coordinates to 
a new set of geometrical coordinates (normal coordinates) for which 
the Hessian will be diagonal, that is, all off-diagonal elements will be 
zero. In this representation, all (diagonal) elements must be positive for 
the geometry to correspond to an energy minimum. Normal coordinate 
analysis, as it is termed, is required for the calculation of vibrational 
frequencies, which relate directly to the square root of the elements of 
the (diagonal) Hessian. Positive Hessian elements yield real frequencies; 
negative Hessian elements yield imaginary frequencies.

Geometry optimization does not guarantee that the final structure has a 
lower energy than any other structure of the same molecular formula. All 
that it guarantees is a local minimum, that is, a geometry with a lower 
energy than that of any similar geometry. This may not be the lowest 
energy geometry possible for the molecule. Finding the absolute or 
global minimum requires repeated optimization starting with different 
initial geometries. Only when all local minima have been located is 
it possible to say with certainty that the lowest energy geometry has 
been identified. This process is termed conformational analysis.

In principle, geometry optimization carried out in the absence of 
symmetry, that is, with C1 symmetry, must result in a local minimum. 
On the other hand, imposition of symmetry may result in a geometry 
which is not a local minimum. For example, optimization of ammonia 
constrained to a planar trigonal geometry (D3h symmetry) will result in 
a structure which corresponds to an energy maximum in the direction 
of motion toward a puckered trigonal geometry (C3v symmetry). 
This is the transition state for inversion at nitrogen in ammonia. 
The most conservative tactic is always to optimize geometry in the 
absence of symmetry. If this is not done, it is always possible to verify 
that the structure located indeed corresponds to a local minimum 
by calculating the vibrational frequencies on the final (optimized) 
structure. If one or more frequencies are imaginary, then the geometry 
does not correspond to an energy minimum.
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Transition-state geometries

Chemists recognize a transition state as the structure that lies at the 
top of a potential energy surface connecting reactant and product (see 
the topic Potential Energy Surfaces).

transition state

reactant

product

Energy

reaction coordinate

More precisely, a transition state is a point on the potential energy 
surface for which the gradient is zero (just as it is for an equilibrium 
geometry; see preceding discussion), but for which the diagonal 
representation of the Hessian has one and only one negative element, 
corresponding to the reaction coordinate (see diagram above). All 
the other elements are positive. In other words, a transition state is 
a structure that is an energy minimum in all dimensions except one, 
for which it is an energy maximum. Mathematically, such a structure 
is referred to as a first-order saddle point.

The geometries of transition states on the pathway between reactants 
and products are not as easily anticipated as the equilibrium 
geometries of the reactants and products themselves. This is not to 
say that transition-state geometries do not exhibit the same systematic 
behavior as equilibrium geometries, but rather that there is not 
sufficient experience to identify what systematics do exist, and more 
importantly how to capitalize on structural similarities. It needs to 
be recognized that transition states cannot even be detected let alone 
characterized experimentally, at least not directly. While measured 
activation energies relate to the energies of transition states above 
reactants, and while activation entropies and activation volumes as 
well as  kinetic isotope effects may be interpreted in terms of transition-
state structure, no experiment can actually provide direct information 
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about the detailed geometries and/or other physical properties of 
transition states. Quite simply, transition states do not exist in terms of 
a stable population of molecules on which experimental measurements 
may be made. Experimental activation parameters may act as a guide, 
although here too it needs to be pointed out that their interpretation is 
in terms of transition state theory, which assumes that all molecules 
proceed over a single transition state (the high point along the reaction 
coordinate) on their way to products. Even then, experiments tell little 
about what actually transpires in going from reactants to products. 

Lack of experience about “what transition states look like” is one 
reason why their detailed geometries are more difficult to obtain than 
equilibrium geometries. Other reasons include:

i) Algorithms for locating transition states are less well developed 
than procedures for finding equilibrium structures. After all, 
minimization is an important task in many diverse fields of 
science and technology, whereas saddle point location has few 
if any important applications outside of chemistry.

ii) It is likely that the potential energy surface in the vicinity of a 
transition state is more flat than the surface in the vicinity of a local 
minimum. After all, transition states represent a delicate balance 
of bond breaking and bond making, whereas overall bonding 
is maximized in equilibrium structures. As a consequence, the 
potential energy surface in the vicinity of a transition state is 
likely to be less well described in terms of a simple quadratic 
function (assumed in all common optimization procedures) than 
the surface in the vicinity of a local minimum.

iii) To the extent that transition states incorporate partially (or 
completely) broken bonds, it might be anticipated that very 
simple theoretical models will not be able to provide entirely 
satisfactory descriptions.

In time, all of these problems will be overcome, and finding transition 
states will be as routine as finding equilibrium geometries is today. 
Chemists can look forward to the day when reliable tools become 
available for the elucidation of reaction mechanisms.
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The same iterative procedure previously described for optimization 
of equilibrium geometry applies as well to transition states. However, 
the number of steps required for satisfactory completion is likely to be 
much larger. This is due to the factors discussed above. Note, however, 
that the task of transition state determination may be completely 
automated and needs no more human intervention than that involved 
in locating equilibrium geometries.

Having found a transition-state geometry, two tests need to be 
performed in order to verify that it actually corresponds to a proper 
transition state, and further that it actually corresponds to the transition 
state for the process of interest, that is, it smoothly connects energy 
minima corresponding to reactant and product:

i) Verify that the Hessian yields one and only one imaginary 
frequency. This requires that a normal mode analysis be carried 
out on the proposed transition-state geometry. The imaginary 
frequency will typically be in the range of 400-2000 cm-1, quite 
similar to real vibrational frequencies. In the case of flexible 
rotors, for example, methyl groups or floppy rings, the analysis 
may yield one or more additional imaginary frequencies  with 
very small (<100 cm-1) values. While these can usually be 
ignored, make certain to verify what motions these small 
imaginary frequencies actually correspond to (see discussion 
following) before doing so. Be wary of structures that yield 
only very small imaginary frequencies. This suggests a very low 
energy transition state, which quite likely will not correspond to 
the particular reaction of interest.

ii) Verify that the normal coordinate corresponding to the imaginary 
frequency smoothly connects reactants and products. A simple way 
to do this is to animate the normal coordinate corresponding to the 
imaginary frequency, that is, to walk along this coordinate without 
any additional optimization. This does not require any additional 
calculations beyond the normal mode analysis already performed. 
“Incorrect” transition states located by calculation, that is, transition 
states that do not link the reactant to the expected product, 
may indicate new chemistry. Don’t discard them so quickly!
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reactions Without Transition states

It may come as a surprise that not all chemical reactions have transition 
states, and that the rates of some reactions depend only on the speed 
with which reactants diffuse into one another (so-called, diffusion 
controlled reactions). In fact, reactions without energy barriers are 
quite common. Two radicals will typically combine without activation, 
for example, two methyl radicals to form ethane.

H3C•  +  •CH3 H3C CH3

Radicals will often add to paired-electron species with no (or very 
small) activation, for example, methyl radical and ethylene forming 
1-propyl radical.

H3C–CH2–CH2
•H3C•  +  H2C CH2

Exothermic ion-molecule reactions may have an activation energy in 
solution, but probably not in the gas phase. Any complex of an ion and 
a neutral molecule is likely to be lower in energy than the separated 
species and the entire reaction coordinate for an ion-molecule reaction 
might lie below the energy of the separated reactants for example, 
nucleophilic attack by OH– on CH3Cl to give CH3OH and Cl–.

Failure to find a transition state, and location instead of what appears to 
be a stable intermediate or even the final product, does not necessarily 
mean failure of the theoretical model (nor does it rule this out). It 
may simply mean that there is no transition state! Unfortunately it is 
very difficult to tell which is the true situation.

calculations using approximate geometries

Given that semi-empirical models and even molecular mechanics 
models generally provide geometries that are quite close to those 
obtained from Hartree-Fock, density functional and MP2 models, it 
is legitimate to ask whether or not structures from these techniques 
may be used as the basis for energy and property calculations. It 
would be of great help were this the case as geometry optimization 
is a major cost in any modeling investigation. In fact, the answer 
depends on what property is being calculated and the level of 
confidence required. Experience suggests that, except for molecules 
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where parameterization has not been provided, use of either semi-
empirical or molecular mechanics geometries has very little effect on 
relative energetics. Errors in reaction energies of 4-10 kJ/mol, which 
may arise from the use of approximate geometries, must be balanced 
against the large savings in computer time. Other properties such as 
dipole moments, may show greater sensitivity to choice of structure, 
and use of appropriate geometries may lead to unacceptable errors.

Semi-empirical techniques are not as successful in reproducing the 
results of Hartree-Fock models for transition-state geometries as 
they are for equilibrium geometries. However, the energy surface is 
typically very flat in the vicinity of the transition state, and any errors 
(in energy) incurred because of the use of approximate transition-state 
geometries may be manageable. (The magnitude of errors for other 
quantities are not predictable.) Molecular mechanics techniques are 
not applicable to the description of transition states.

“Exact” geometries must be used for frequency (infrared spectra) 
calculations. The reason for this is that frequencies are related to 
the first finite term in a Taylor series expansion of the energy (as a 
function of geometry). This is (assumed to be) the second-derivative 
term, which will not be true if the first-derivative term (the gradient) 
is not precisely zero. Frequencies evaluated at non-equilibrium (or 
non-transition-state) geometries are meaningless.
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ToTal EnErgiEs and ThErmodynamic and KinETic 
daTa

In addition to molecular geometry, one of the most important quantities 
to come out of molecular modeling is the energy. Energy can be used 
to reveal which of several isomers is most stable, to determine whether 
a particular chemical reaction will have a thermodynamic driving 
force (an exothermic reaction) or be thermodynamically uphill (an 
endothermic reaction), and to ascertain how fast a reaction is likely 
to proceed. Other molecular properties, such as dipole moment, and 
infrared, UV/visible and most importantly NMR spectra are also of 
great interest, but the energy plays a special role.

There is more than one way to express the energy of a molecule. Most 
common to chemists is the heat of formation, ∆Hf. This is the heat 
of a hypothetical chemical reaction that creates a molecule from the 
well defined but arbitrary standard states of each of its constituent 
elements. For example, ∆Hf for ethylene is the energy required to 
create the molecule from graphite and H2, the standard states of carbon 
and hydrogen, respectively. Note that the heat of formation, which 
most commonly assumes a value between -1,000 and +500 kJ/mol, 
cannot be directly measured, but must be obtained indirectly. 

An alternative, total energy, is the heat of a hypothetical reaction that 
creates a molecule from a collection of separated nuclei and electrons. 
Like the heat of formation, total energy cannot be measured directly, 
and is used solely to provide a standard method for expressing and 
comparing energies. Total energies are always negative numbers and, 
in comparison with the energies of chemical bonds, are very large. 
By convention, they are expressed in so-called atomic units* or au, 
but may be converted to other units as desired:

1 au = 2625 kJ/mol

It makes no difference which reference reaction (heat of formation or 
total energy) is used to calculate the thermochemistry of a balanced 
chemical reaction (reactant 1 + reactant 2 + . . . → product 1 + product 
2 + . . .):

* The exact energy of hydrogen atom is -0.5 atomic units.
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E(reaction) = Eproduct 1 + Eproduct 2 + … – Ereactant 1 - Ereactant 2 – …

Total total energies will be used in the discussion that follows. A 
negative ∆E indicates an exothermic (thermodynamically favorable) 
reaction, while a positive ∆E an endothermic (thermodynamically 
unfavorable) reaction.

A special case involves differences in isomer stability. This is the 
energy of a chemical reaction involving only two molecules, in which 
the reactant and product are isomers:

E(isomer) = Eisomer 2 + Eisomer 1

A negative ∆E means that isomer 2 is more stable than isomer 1.

Total energies may also be used to calculate activation energies, ∆E‡:
E‡  =  Etransition state  – Ereactant 1  –  Ereactant 2  –  …

Here, Etransition state is the total energy of the transition state. Activation 
energies will always be positive numbers*, meaning that the transition 
state is less stable that reactants.

Reaction and activation energies are sufficient to know whether a 
reaction is exothermic or endothermic or whether it proceeds with 
small or large activation barrier. There are, however, other situations 
where energies need to be replaced by Gibbs energies in order to take 
proper account of the role of entropy. For example, a proper account 
of the equilibrium concentrations of reactants and products requires 
calculation of the equilibrium constant, Keq, which according to 
the Boltzmann equation, is related to the Gibbs energy of reaction, 
∆Grxn:

Keq = exp(–  Grxn/RT)

Here R is the gas constant and T is the temperature (in K). At room 
temperature (298K) and for ∆Grxn in au, this is given by:

Keq = exp(–1060   Grxn)

* As commented in a previous topic (Finding and Verifying Equilibrium Transition-State 
Geometries) some reactions proceed with zero activation energy, meaning that there is no 
transition state.
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∆Grxn has two components, the enthalpy of reaction, ∆Hrxn, and the 
entropy of reaction, ∆Srxn. These are defined as follows:

  Grxn  =    Hrxn  – T  Srxn

  Hrxn ≈   Erxn = Eproduct 1 + Eproduct 2 + … – Ereactant 1 – Ereactant 2 – …

  Srxn  =  Sproduct 1 + Sproduct 2 + … – Sreactant 1 – Sreactant 2 – …

Although ∆Grxn depends on both enthalpy and entropy, there are many 
reactions for which the entropy contribution is small, and can be 
neglected. Further assuming that ∆Hrxn ≈ ∆Erxn, equilibrium constants 
can then be estimated according to the Boltzmann equation:

Keq ≈ exp(–  Erxn/RT) ≈ exp(-1060   Erxn)  .

This Boltzmann equation may also be used to establish the equilibrium 
composition of a mixture of isomers:

Isomer 1 Isomer 2 Isomer 3 . . .

% Isomer i  =
100 exp (-1060 EIsomer i)

k
Σ exp (-1060 EIsomer k)

Isomer energies, Eisomer, are given in atomic units relative to the 
energy of the lowest-energy isomer. An important special case is that 
involving an equilibrium between two isomers:

Isomer 1 Isomer 2

=  exp [-1060 (Eisomer1 – Eisomer2)][ Isomer 1 ]
[ Isomer 2 ]

Reaction rate constants, krxn, are also related to Gibbs energies. As 
before, if entropy contributions can be neglected, the rate constant 
can be obtained directly from the activation energy, ∆E‡, according 
to the Arrhenius equation:

krxn ≈ (kBT/h)[exp(-  E‡/RT)]

Here kB and h are the Boltzmann and Planck constants, respectively. 
At room temperature and for ∆E‡ in au, krxn is given by:
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krxn  =  6.2x1012 exp(-1060   E‡)

Another way to describe reaction rates is by half-life, t1/2, the amount 
of time it takes for the reactant concentration to drop to one half of 
its original value. When the reaction follows a first-order rate law, 
rate = -krxn[reactant], t1/2 is given by:

t1/2  =  ln2/krxn  =  0.69/krxn

It is useful to associate reaction energies and reaction rates with 
potential energy diagrams (see the topic Potential Energy Surfaces). 
The connections are actually quite simple.

The thermodynamics of reaction is given by the relative energies of 
the reactant and product on the potential surface.

energy

reaction coordinate

"thermodynamics"

transition state

reactant

product

In the case of bond rotation in ethane (see the topic Potential Energy 
Surfaces), the reactant and product are the same and the reaction is 
said to be thermoneutral. This is also the case for the overall ring-
inversion motion in cyclohexane (see the topic Potential Energy 
Surfaces).

The most common case is, as depicted in the above diagram, where 
the energy of the products is lower than that of the reactants. This kind 
of reaction is said to be exothermic, and the difference in stabilities 
of reactant and product is simply the difference in their energies. 
For example, the “reaction” of gauche n-butane to anti n-butane 
is exothermic (see the topic Potential Energy Surfaces), and the 
difference in stabilities of the two conformers is simply the difference 
in the energies (3.8 kJ/mol).
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Chemical reactions can also be endothermic, which give rise to a 
reaction profile.

transition state

reactant

product
energy

reaction coordinate

In this case, there would eventually be more reactant than product.

Where two or more different products may form in a reaction, 
thermodynamics tells us that if we wait long enough, the product 
formed in greatest abundance will be that with the lowest energy 
irrespective of pathway.

reaction coordinate

energy

thermodynamic product

In this case, the product is referred to as the thermodynamic product 
and the reaction is said to be thermodynamically controlled.

The energy of the transition state above the reactants (the activation 
energy) provides the connection with reaction rate (kinetics).
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energy

reaction coordinate

"kinetics"

transition state

reactant

product

While absolute reaction rates also depends on the concentrations of 
the reactants and on such factors as the likelihood that encounters 
between molecules will actually lead to reaction (the so-called pre-
exponential or A factor), generally speaking, the lower the activation 
energy, the faster the reaction.

The product formed in greatest amount in a kinetically controlled 
reaction (the kinetic product) is that proceeding via the lowest energy 
transition state, irrespective of whether or not this is lowest energy 
product (the thermodynamic product).

reaction coordinate

energy

kinetic product

Kinetic product ratios show dependence with activation energy 
differences which are identical to thermodynamic product ratios with 
difference in reactant and product energies.
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CalCulating aCCurate Heats of formation

One of the most fundamental properties of a molecule is its internal 
energy. This is most commonly reported as a heat of formation, 
defined as the enthalpy at 298.15K of a hypothetical chemical 
reaction in which the molecule is transformed into a set of products 
that correspond to the most stable forms of its constituent pure 
elements at room temperature. For example, the heat of formation of 
ethylene corresponds to the enthalpy of a reaction to yield graphite 
and molecular hydrogen.

C2H4 → 2C (graphite) + 2H2

Differences in heats of formation between the products and reactants 
(reaction enthalpies) indicate the extent to which the reaction will 
be favorable (exothermic) or unfavorable (endothermic), and allow 
thermodynamic product distributions to be established. 

Heats of formation are most commonly obtained from heats of 
combustion. For example, the heat of formation of ethylene would 
likely be established from its reaction with oxygen to produce carbon 
dioxide and water.

C2H4 + 3O2 → 2CO2 + 2H2O

Experimental heats of formation are available for ~2000 compounds. 
While much of the data is accurate to within 4-8 kJ/mol, a significant 
portion is subject to greater uncertainty. The most egregious source 
of error is that the reported heat does not correspond to the reported 
structure. Other more common sources of error include incomplete 
combustion and poorly characterized combustion products. In this 
regard, hydrocarbons and oxycarbons present fewest problems 
as combustion leads only to carbon dioxide and water. However, 
combustion of molecules with other elements may give rise to a 
complex mixture of products and greater uncertainty, with nitrogen 
compounds being particularly problematic. Despite their fundamental 
importance, heats of formation are not routinely determined for new 
compounds. The reason for this is obvious. While the combustion 
experiment is straightforward and does not require particularly 
expensive instrumentation, accurate measurements may require (and 
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destroy) significant quantities of compound. Very few chemists are 
willing to part with hundreds of mg of a compound that they have 
just spent weeks or months preparing.

Because of the lack of experimental data and serious concerns over 
the accuracy of part of the data that do exist, considerable attention 
has been directed at the use of quantum chemical calculations to 
obtain heats of formation. However, this has not proven to be simple 
for moderate-size organic molecules (molecular weight <400-500 
amu) within experimental accuracy (<4-8 kJ/mol). Among the most 
successful procedures in terms of overall accuracy are the GX recipes. 
These combine the results of several different quantum chemical 
models in order to get reliable estimates of what enhancements 
in treatment of electron correlation (beyond the MP2 model) and 
increases in the size of the basis set are likely to do. However, 
even the simplest of these, G3(MP2), is limited in practice to small 
molecules. It scales as the seventh power of size and is generally not 
applicable to molecules  with molecular weights that exceed 150 amu. 

the t1 thermochemical  recipe

The T1 recipe has been formulated in attempt to maintain the accuracy 
of the G3(MP2) recipe but at significantly reduced computation cost. It 
is presently limited to uncharged, closed-shell molecules comprising 
H, C, N, O, F, Si, P, S, Cl and Br. T1 substitutes the MP2/6-31G* 
geometry used in G3(MP2) by a HF/6-31G* geometry, eliminates 
both the HF/6-31G* frequency and the QCISD(T)/6-31G* energy 
calculations and approximates the MP2 energy calculation with 
the G3MP2 large basis set by an analogous calculation using dual 
basis set RI-MP2 techniques. Taken together, these changes reduce 
computation time by 2-3 orders of magnitude, and  T1 calculations 
on molecules in the molecular weight range of 400-500 amu are 
now practical. 

The T1 recipe, unlike G3(MP2), involves several parameters, 
specifically atom counts, Mulliken bond orders and HF/6-31G* 
and RI-MP2 energies. These have been determined using linear 
regression as a best fit to G3(MP2) (not experimental) heats of 
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formation for >1100 small molecules. It reproduces these values with 
mean absolute and RMS errors of 1.8 and 2.5 kJ/mol, respectively. 
A plot is shown below.

Performance of t1 for Heat of formation Calculations 

The T1 recipe reproduces experimental heats of formation for a set 
of >1800 diverse organic molecules from the NIST thermochemical 
database with mean absolute and RMS errors of 8.5 and 11.5 kJ/
mol, respectively.  The plot provided below covers the majority of 
the data from -1000 to +500 kJ/mol.

treatment of Conformationally-flexible molecules 

As a consequence of their high computation cost, the GX recipes 
are in practice limited to rigid molecules or to molecules with 
only one or two degrees of conformational freedom. This means 
that it is necessary to guess the conformation of most molecules. 
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This in turn may lead to heats of formation that are too large by 
10 kJ/mol or more. On the other hand, T1 can routinely be applied 
to molecules with several degrees of conformational freedom. This 
makes it possible to establish energy differences among conformers 
(Boltzmann weights). A more modest goal is to identify the lowest-
energy conformer, and to assume that the heat of formation of the 
molecule is the heat of formation of this conformer. In practice, the 
lowest-energy conformer is identified by examining all conformers 
for molecules with fewer than 100 conformers and by examining 
a random sample of 100 conformers for molecules with more than 
100 conformers. 

Database of t1 Heats of formation

The Spartan Spectra and Properties Database (SSPD) is based on 
calculations performed using the EDF2/6-31G* density functional 
model starting from the best conformer assigned from the T1 recipe. 
T1 heats of formation are included as a property in SSPD, which 
presently contains ~60,000 entries (including ~2000 molecules for 
which experimental data are available). This number is expected to 
double by the end of 2011.
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Dealing with Conformationally flexible 
moleCules

Very few molecules are rigid and likely to be adequately described in 
terms of a single conformer. More commonly, two or more distinct 
conformers resulting from rotation around single bonds or changes in 
flexible rings are likely to exist. For example and as already discussed 
in the topic Potential Energy Surfaces, three conformers result from 
rotation around the central carbon-carbon bond in n-butane, one anti 
conformer (CCCC dihedral angle = 180o) and two (equivalent) gauche 
conformers (CCCC dihedral angle = ± ~60o). Two chair conformers 
result from ring inversion in methylcyclohexane, one with the 
methyl group equatorial and the other with it axial. Because energy 
barriers to single-bond rotation and to ring inversion are generally 
very small (on the order of <10-20 kJ/mol), the different conformers 
will be in equilibrium and the influence of any particular conformer 
on the properties of the molecule will depend on its energy and on 
the temperature. As a consequence, experimental measurements will 
either reveal the presence of the individual conformers or result from 
a weighted average of conformers. For example, the IR spectrum of 
a flexible molecule will show features due to individual conformers, 
whereas the NMR spectrum of the same molecule will show an average. 
The different behavior may be traced to the different timescales of 
the two experiments; IR is “fast” whereas NMR is “slow”.

What is required to calculate the properties of a flexible molecule? 
At the very least, the lowest-energy conformer needs to be 
identified and used for calculation of the property of interest. How 
well do calculations identify this conformer? It turns out that the 
answer is not obvious. While much is known about the preferred 
conformation of molecules in the solid (crystalline) state, most of 
it from X-ray diffraction, there is actually very little known about 
preferred conformation of isolated molecules. Furthermore, there is 
very little overlap between gas and solid-phase structures because 
small molecules tend not to crystallize and larger molecules that 
do crystallize are not easily investigated by gas-phase techniques 
such as microwave spectroscopy. This means that it is difficult to 
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separate inherent (gas-phase) conformational preferences from those 
associated with the requirements of crystal packing.

A more thorough, and also more costly (in terms of computation), 
procedure is to identify all low-energy conformers, estimate their 
relative energies and construct a (Boltzmann) average of the 
property of interest. There is even less known about the relative 
energies of  different conformers than there is about the identity 
of the best conformer. What is known comes primarily from 
microwave spectroscopy and is restricted to molecules with a single 
degree of conformational freedom. A summary of mean absolute 
errors (in kJ/mol) associated with a number of theoretical models 
for conformational energy differences for simple (one degree of 
freedom) molecules is provided below. Semi-empirical models as 
well as Hartree-Fock models with minimal and split-valence basis 
sets have been excluded as they provide a very non-uniform account 
of conformational energy differences and are likely to lead to very 
poor results. In total the comparisons span about 30 molecules, 
covering perhaps half of the molecules for which experimental data 
of “reasonable” quality are actually available. The comparisons 
are separated into acyclic molecules, such as n-butane and 
1,3-butadiene, and cyclic molecules, such as methylcyclohexane 
and N-methylpiperidine, to allow an honest assessment of the 
MMFF molecular mechanics model. Most of the molecules in the 
acyclic set were actually used to parameterize MMFF, whereas only 
a few of the cyclic molecules were used. The difference is striking. 
For acyclic molecules, MMFF is not only the least costly method it 
is also the best (along with the T1 thermochemical recipe). On the 
other hand, MMFF is the worst for cyclic molecules. This result 
should not come as a surprise as purely empirical methods such as 
MMFF cannot be expected to yield good results outside the range 
of their parameterization. With the exception of T1, there is little 
to distinguish among the quantum chemical models. In particular, 
results from Hartree-Fock, density functional and MP2 methods 
are all qualitatively similar and do not improve with increase in the 
size of the basis set. While there is considerable uncertainty in the 
experimental data, the T1 recipe appears to be the most reliable of 
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the procedures considered here. Also to be noted is that T1 is not the 
most costly of the methods considered. 

 acyclic molecules cyclic molecules  relative “cost”
T1 1.1 1.1  1
HF/6-31G* 2.3 2.1  0.5
B3LYP/6-31G* 1.7 2.1  2
B3LYP/6-311+G** 1.4 2.9  10
MP2/6-31G* 2.7 1.7  10
MP2/6-311+G** 1.9 2.1  100
MMFF 1.1 3.3  <0.01

systematic vs. monte-Carlo Conformational searching

There are two fundamentally different techniques available for 
searching conformation space. The obvious thing to do is to “look 
everywhere”, that is, walk through all possible single-bond rotations 
and ring twists. A systematic search guarantees that the lowest-
energy conformer (the so-called global minimum) will be found, 
and provides a proper basis for calculation of the correct Boltzmann 
distribution. To see why systematic searching rapidly becomes 
impractical, we need to know how many different conformers may 
actually exist for a flexible molecule. While a precise number may 
be hard to come by, a few rules allow a rough estimate to be made. 
The best-known rule is that a chain of four or more (N) sp3 centers 
will lead to 3N-3 conformers. Thus n-butane (N=4) will have three 
conformers, n-pentane will have nine conformers, n-hexane will have 
27 conformers and so forth. Not all the conformers will be distinct, 
for example, only two the three conformers of n-butane are unique 
and only five of the nine conformers of n-pentane are unique. Bonds 
between sp3 and sp2 centers will generally lead to similar conformer 
counts, whereas bonds between two sp2 centers will generally lead 
to two (syn and anti) and not three conformers. The number of 
conformers for rings is more difficult to estimate. Four and five-
member rings can all be thought of in terms of a single conformer 
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and six-member rings in terms of two low-energy conformers 
(higher-energy twist-boat conformers may usually be ignored), 
but seven-member and larger rings typically have a larger number 
of conformers. Molecules with several flexible bonds and one or 
more six-member or larger rings may easily have several hundred or 
several thousand distinct conformers. Looking everywhere quickly 
becomes impractical and an alternative searching technique is needed.

Many detailed alternative procedures (algorithms) have been 
formulated  but all come down to the idea of replacing a systematic 
search by a so-called stochastic or random search. The procedure 
used in Spartan is referred to as the Monte-Carlo algorithm. It moves 
randomly in a single (randomly chosen) dimension in conformation 
space deciding to abandon the move (returning to the starting point 
for another random move) or keep the move (using  it for the starting 
point for the next random move) based on the energy relative to that 
of the lowest-energy conformer yet found. Without getting into the 
detailed mathematics, suffice it to say that the criterion used to decide 
whether to accept or reject a move has been chosen to guarantee that 
the proper Boltzmann distribution will be approached as the number 
of random moves is increased. In practice, a Monte-Carlo search 
will nearly always find the lowest-energy conformer (or at least 
something very close to it) in 5-10% of the time that would be required 
for a systematic search.  Thus, Monte-Carlo searching is likely to 
be an order of magnitude or more faster than systematic searching.

all Conformational searches are not alike

The obvious reason to conduct a conformational search (other than 
to be able to see what a molecule looks like) is to calculate the value 
of a particular property. At the very least, this requires finding the 
lowest-energy (equilibrium) conformer. This procedure, referred to 
as Equilibrium Conformer, would be expected to be satisfactory 
in the important case where the property of interest is the energy 
itself. The energy of the best conformer is necessarily lower (more 
negative) than the energy that would be obtained from a proper 
Boltzmann distribution, but only by a few kJ/mol at most. However, 
the value of some properties obtained based on the lowest-energy 
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conformer will not necessarily properly reflect the Boltzmann 
average. For example, n-butane has a small but finite dipole moment, 
despite the fact that the dipole moment of the lowest-energy (anti) 
conformer is rigorously zero. This is due to the small contributions 
made by the two equivalent gauche conformers. In cases such as 
this, it is necessary to identify all low-energy conformers and then 
to construct a proper Boltzmann average. This procedure, referred to 
as Conformer Distribution, is exactly the same as the search for the 
equilibrium conformer, except that it results in a set of low-energy 
conformers. In the case of a systematic search, this is a Boltzmann 
distribution; in the case of a Monte-Carlo search, this mirrors the 
correct Boltzmann distribution assuming that a sufficient number of 
random moves have taken place.

An entirely different reason to conduct a conformational search is to 
find a selection of diverse conformers, irrespective of their energy. 
This procedure, referred to as Conformer Library, is needed in order 
to decide to what extent two molecules are similar, or the extent 
to which a molecule “fits” into a particular molecular environment. 
Because energy is not considered (although very high-energy 
conformers are removed), there is no guarantee (or even likelihood) 
that the best conformer will actually be found. At present, only 
the MMFF molecular mechanics model is available in Spartan to 
generate a conformer library, and this library is available only for 
the purpose of similarity analysis. It is stored as a single molecule 
(corresponding to the lowest-energy conformer located), but includes 
the coordinates of the non-hydrogen atoms (only) for all the other 
conformers in the library.

The following recipe is used to generate a conformer library:

1. Systematically step through all possible single-bond and ring 
conformers and calculate structures and energies for each 
using the MMFF model. Eliminate duplicates and very high 
energy conformers. A limit may be placed on the total number 
of conformers examined by first calculating the fraction of 
conformers that are to be kept (number of conformers to be kept/
total number of conformers possible from a systematic search), 
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and then randomly deciding to examine or skip each conformer 
in a systematic search in order to enforce this fraction. Such a 
procedure is different from a Monte-Carlo search in that it seeks 
to span all possible conformers open to a flexible molecule 
without consideration of energy.

2. For each conformer, place spheres on each nitrogen and oxygen 
atom and at the center of each hydrophobic region.

3. Find the smallest set of conformers for which the spheres do 
not overlap, that is, eliminate any conformer for which all of its 
spheres overlap to a predefined extent with the corresponding 
spheres on another conformer.
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InterpretIng ConformatIonal preferenCes

Rotation about single bonds is periodic, retracing itself every 360°. 
Therefore, any function that seeks to describe the energy of internal 
rotation must also repeat itself every 360°. In fact it is possible to 
write a general energy function, Etorsion, as a combination of simpler 
functions, Vn, each of which repeats n times in a 360° interval.

Etorsion (w) = V1 (w) + V2 (w) + V3 (w)

V1, V2, and V3
 are independent functions of the torsion angle w that 

repeat every 360°, 180°, and 120°, respectively. These functions are 
referred to as one-fold, two-fold, and three-fold potentials.

The different n-fold potentials are useful because each can be 
associated with a particular chemical phenomenon. For example, 
a one-fold potential describes the different energies of anti and syn 
conformers of dimethylperoxide, while a two-fold potential describes 
the different energies of planar and perpendicular conformers of 
benzyl cation. Three-fold potentials, which are more familiar to 
chemists, describe the difference between staggered and eclipsed 
conformers in molecules like ethane.
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While rotation in a symmetric molecule might be described using 
only one potential or a combination of two potentials, less symmetric 
molecules require more complex combination of potentials. This is 
illustrated by fluoromethylamine.
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C N
F

HH
H H FCN: = 0°

The heavy solid line in the figure describes Etorsion for rotation about 
the CN bond, while the light solid line, the dashed line and the dotted 
line correspond to the one-fold, two-fold and three-fold components, 
respectively. There are two distinct minima.
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The lower (global minimum) arises when the CF bond and the nitrogen 
lone pair are anti, while the higher and much more shallow minimum 
is almost, but not precisely, a gauche structure (FCN: dihedral angle 
~45°). Also, note that one of the two energy maxima (FCN: dihedral 
angle ~115°) does not exactly correspond to an eclipsed structure.

The unusual behavior of Etorsion becomes clear when it is resolved into 
its components (in this case, the sum of these components provides a 
virtually perfect fit of Etorsion). The one-fold term reflects a clear and 
very strong preference for the CF bond and the nitrogen lone pair to 
be anti and not syn. This preference might be electrostatic since the 
anti structure arranges the dipoles associated with the CF bond and 
nitrogen lone pair in opposite directions.
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FCN: = 180°
dipoles subtract
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The three-fold term is also easy to explain. It reflects the preference 
for staggered over eclipsed structures. This term contributes much 
less to E torsion than either of the one-fold or two-fold terms, consistent 
with the low steric demands of the CH2F and NH2 groups.

What is most interesting, perhaps, and what might not have been 
anticipated without this type of analysis, is the large contribution made 
by the two-fold potential. This potential reflects a strong preference for 
a planar arrangement of FCN:, and can be attributed to stabilization 
resulting from donation of the lone pair orbital on nitrogen into low-
energy unfilled molecular orbital associated with the CF bond. Such 
an interaction requires that the molecule adopts either a syn planar or 
anti planar conformation and not a perpendicular conformation.

C N

F

syn planar

C N

F

anti planar

C N

F

perpendicular

X

Most of the popular features of Etorsion can now be attributed to either 
V1, V2. V1

 accounts for the anti geometry being the global minimum. 
V2, however, is responsible for the position of the maximum and the 
shift in the higher-energy minimum to smaller dihedral angles.

It is important to note that the terms that contribute to Etorsion are 
completely independent of each other, and each may be treated as one 
part of a larger picture. Thus, the observation that electron donation 
from the nitrogen lone pair into the empty orbital associated with the 
CF bond is optimal when the two groups are planar is independent 
of the observation that cis coplanar structure is destabilized, relative 
to the anti structure, by dipole-dipole interactions.
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CalCulating infrared SpeCtra

The infrared spectrum of a molecule arises because of transitions 
between vibrational energy levels. Each line in an infrared spectrum 
is characterized by a frequency (energy) and an intensity. In one 
dimension (a diatomic molecule), the frequency is proportional to the 
square root of the ratio of the second-derivative term and the reduced 
mass (the product of the masses of the two atoms divided by their sum).

vibrational frequency a √ [(d2E(x)/dx2/)reduced mass]

Calculation of the frequency involves expansion of the energy in a 
Taylor series.

E(x) = E(x0) + (dE(x)/dx) x + (d2E(x)/dx2) x2 + higher-order terms

E(x0) is a constant and dE(x)/dx (the gradient) is assumed to be zero. 
The latter implies that the underlying structure corresponds precisely 
to a minimum (or a maximum) on the potential energy curve. Were 
this not the case, the first derivative would be non zero and the 
calculated frequency would be meaningless. All practical calculations 
are based on the harmonic model and ignore cubic and higher-order 
terms (anharmonic terms), leaving only the  second derivative term 
(the force constant). The frequency may be interpreted as the relative 
ease or difficulty of stretching the bond away from its equilibrium 
position, that is, the curvature of the energy surface at the minimum. 
Where distortion away from the equilibrium position is easy, the result 
is a low frequency; where it is difficult the result is a high frequency. 
High (reduced) mass leads to a low frequency while low mass leads 
to high frequency.

The expression for vibrational frequency qualitatively accounts for mass 
effects on reaction energies (equilibrium isotope effects). Even at 0K 
molecules vibrate, giving rise to the so-called zero-point vibrational 
energy (or simply zero-point energy). Zero-point energy is directly 
proportional to the sum of the vibrational frequencies and decreases with 
increasing mass. For example, the zero-point energy of HCl is lowered 
upon  replacement of hydrogen by deuterium. Thus, the measured energy 
(enthalpy) decreases with increasing mass and the energy of DCl is smaller 
(more negative) than that for HCl.
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Because the  potential energy has been approximated by a quadratic 
function, calculated frequencies will almost always be larger than 
measured frequencies. This is because a quadratic function goes to 
infinity with increase in distance rather than going asymptotically to 
a constant (separated atoms). This suggests that the potential curve 
will be too steep.

It is possible to extract the harmonic frequency by measuring the 
spacing of the energy levels associated with the ground and excited 
states of a particular vibration. (The lines would be evenly spaced 
were the potential quadratic.) However, such an analysis is possible 
only for diatomic and very simple polyatomic molecules.

Generalization from a diatomic to a polyatomic molecule is 
straightforward. The energy of displacement away from the 
equilibrium position is expanded in the same way as before, the only 
difference being that a vector quantity, x, replaces a scalar quantity, x.
E(x) = E(x0) + Σi(∂E(x)/∂xi)xi + ½Σij(∂2E(x)/∂xi∂xj)xixj + higher-order terms

For a molecule with N atoms, the dimension of x is 3N (x,y,z 
Cartesian coordinates for each atom), although there are only 3N-6 
(3N-5 for a linear molecule) vibrational frequencies. Six dimensions 
(five for a linear molecule) correspond to translation away from and 
rotation around the center of mass. 

The first (and only computationally expensive) step involved in 
calculating the vibrational spectrum of a polyatomic molecule is 
evaluation of the full set of second energy derivatives in Cartesian 
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coordinates. These then need to be mass weighted. Diagonal terms 
(∂2E(x)/∂xi

2) are divided by the mass of the atom associated with xi, 
and off-diagonal terms (∂2E(x)/∂xi∂xj) are divided by the product 
of the square root of the masses of the atoms associated with xi and 
xj. These expressions reduce to that already provided for the one-
dimensional case. 

The second step involves replacing the Cartesian coordinates by 
a new set of coordinates ζ, such that the matrix of mass-weighted 
second derivatives is diagonal. δij is the Kronecker delta function (1 
if i=j; 0 otherwise).

[∂2E(ζ)/∂ ζi∂ ζj]/(√Mi√Mj) = δij [∂2E(ζ)/∂ ζi
2]/Mi

These new coordinates are referred to as normal coordinates. While 
the normal coordinates for some vibrations may be described in terms 
of stretching of one bond or bending of one angle, more commonly 
they will be made up of mixtures of several bond stretches, angle 
bends and other motions. 

The third step involves removing the six coordinates corresponding 
to the three translations and three rotations, leaving 3N-6 vibrational 
coordinates. 

Obtaining an infrared spectrum also means having to account for 
the intensity of absorption, which is proportional to the change in 
the dipole moment along the vibrational coordinate. If there is no 
change in dipole moment, the infrared intensity is zero. For example, 
it is zero for both N2 and O2, the two major components of the earth’s 
atmosphere. Neither molecule will absorb in the infrared. However, 
two of the four vibrational motions of CO2, the third most common 
but very minor molecular component in the atmosphere, have non-
zero infrared intensities.  As a result, carbon dioxide absorbs radiation 
reflected from the earth’s surface thereby trapping heat and leading 
to an increase in temperature (the so-called greenhouse effect).

Lack of a line in the infrared spectrum does not mean that the 
molecule does not vibrate or that the vibrational energy for this 
line does not contribute to the zero-point energy. Rather, it means 
that absorption of radiation does not occur leading to a change in 
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vibrational energy state. It should also be noted that a particular line 
that is infrared inactive might be visible in the Raman spectrum (an 
alternative form of vibrational spectroscopy based on reflectance 
rather than absorption). Here the intensity is related to the change in 
the polarizability rather than the change in dipole moment. 

The application of quantum chemical models to infrared spectroscopy 
requires calculation of the second energy derivatives and first 
dipole moment derivatives with regard to changes in geometrical 
coordinate. The second derivative calculation dominates and scales 
as the fifth power of the size (number of basis functions). Infrared 
spectra may be calculated using semi-empirical molecular orbital 
models, for example, the popular AM1 and PM3 models, Hartree-
Fock molecular orbital models, density functional models and MP2 
models. Broadly speaking, semi-empirical models provide a poor 
account, Hartree-Fock models provide a reasonable account and 
density functional and MP2 models with polarization or larger basis 
sets. Density functional models are the obvious choice for infrared 
spectra calculations, offering better results than Hartree-Fock 
models at comparable cost, and comparable results at much lower 
cost than MP2 models. (A major factor contributing to the high cost 
of MP2 models is that second energy derivatives are not calculated 
analytically as they are for Hartree-Fock and density functional 
models, but rather are obtained from numerical differentiation of 
analytical first derivatives.) 

The EDF2/6-31G* density functional model was specifically 
formulated to reproduce measured infrared frequencies. It is simple 
enough to be applicable to the calculation of infrared spectra of 
organic molecules of moderate size (up  to 400-500 amu). There are 
two major deficiencies with infrared spectra obtained directly from 
the EDF2/6-31G* model. The first is that calculated frequencies are 
almost always too large, typically by 3-5%. This can be directly 
traced to the harmonic approximation and to a potential energy curve 
that is too steep.
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Other density functional models and the MP2 model show similar 
behavior. Vibrational frequencies obtained from Hartree-Fock models 
show an even larger systematic error in the same direction (frequencies 
too large), typically by 12-14%. Here two factors contribute. The first is 
the insistence on a quadratic potential, the same problem associated with 
density functional and MP2 models. The second is due to the fact that 
bond dissociation is improperly described by Hartree-Fock models, as 
evidenced by the the fact that Hartree-Fock bond lengths are uniformly 
shorter than experimental distances. This suggests that the potential 
energy surface will be too steep and the frequency will be too large.

The second and perhaps more conspicuous deficiency is that the 
lines in an infrared spectrum measured at finite temperature are  
broadened due primarily to rotational structure, whereas the lines in 
a calculated spectrum are sharp in that they correspond to an isolated 
molecule at 0K. There may be other differences, such as the absence 
of overtones, that is, vibrational transitions originating from excited 
vibrational states and, more importantly, lack of solvent. These 
differences are more difficult to quantify and will be ignored.

It is straightforward to correct the calculated spectrum to account 
for the two major deficiencies. First the spectrum may be uniformly 
scaled (multiplied by a parameter in the range of 0.95-0.97 for 
density functional models). Second, the calculated frequencies and 
intensities may be fit to a Lorentzian function with peak width and 
half peak height being treated as a second parameter. 

Quality of Calculated infrared Spectra 

An infrared spectrometer records frequencies in the range 500-
4500 cm-1. Frequencies below this range (which may require special 
instrumentation to measure) typically correspond to torsional motions 
and may depend strongly on conformation. It should be noted that the 
region beyond ~2800 cm-1 is dominated by CH stretching vibrations 
and may be too crowded to be of value.

Although the focus here is on the EDF2/6-31G* model, the comments 
broadly apply to other density functional models with polarization 
and larger basis sets. The EDF2/6-31G* model in particular has also 
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proven to be successful in providing accurate molecular geometries 
and heats of reaction, and it may fairly be described as a workhorse. 
That is, it is both reliable and simple enough to be routinely applied 
to molecules with molecular weights <500 amu. This places routine 
applications squarely in the range of organic molecules that can 
conveniently be synthesized.

Calculated infrared spectra that have been scaled to account for 
the systematic error in frequency and broadened to account for 
finite temperature are visually quite similar to the corresponding 
experimental spectra (taken from the NIST database). The four 
examples shown below, benzamide, (dimethylmethylidene)
cyclopentadiene, 1,2-epoxy-cis-4-vinylcyclohexane and camphor 
are typical of the ~1000 comparisons that have been made.

benzamide

(dimethylmethylidene)cyclopentadiene

1,2-epoxy-cis-4-vinylcyclohexane
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camphor

Even though scale and line-broadening parameters have been 
individually adjusted for these four examples, the values of the 
parameters are quite similar. Default  parameters could have been 
substituted with little change.

database of infrared Spectra

The Spartan Spectra and Properties Database (SSPD), which includes 
infrared spectra as well as proton and 13C NMR spectra, is based on 
calculations performed using the EDF2/6-31G* density functional 
model starting from the best conformer assigned from the T1 recipe.* 
SSPD presently comprises ~70,000 entries. This number is expected 
to approach ~120,000 entries by the time of the next update in June 
2011. SSPD can be searched for match to an unknown experimental 
infrared spectrum.

* This is strictly true for neutral, closed-shell molecules containing only the elements, H, C, 
N, O, F, Si, P, S, Cl and Br. Otherwise, best conformer is based on the MMFF molecular 
mechanics model.
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CalCulating nMR SpeCtRa

introduction

There are several reasons why NMR spectroscopy, in particular 13C 
NMR, is the most important analytical technique for characterizing 
organic molecules. The experiment is straightforward and can be 
carried out rapidly. It requires relatively small samples and is non 
destructive. The resulting (proton decoupled) spectrum is simple, 
comprising a single line (“resonance”) for each and every unique 
carbon. Despite its simplicity (or perhaps because of it), associating 
an 13C spectra to a particular molecular structure can be problematic 
and prone to error, in particular, where alternative structures might be 
very similar. Three-bond HH and CH coupling constants that depend 
on 3D geometry, as well as a variety of so-called “2D spectra” that 
combine chemical shifts and coupling constants (most notably, COSY 
and HMBC spectra) are more and more commonly employed to assist 
in assignment.

A routine and reliable method to predict 13C chemical shifts as a 
function of three-dimensional structure would clearly be of value 
in helping to assign experimental NMR spectra or, at the very least, 
confirming or refuting a proposed assignment. One might argue that 
such a method already exists in the form of NMR spectral databases. 
An exact match to an existing spectrum provides a definitive structure, 
while one or more “close matches” to entries in a database suggest 
what types of structures are reasonable. Of course, “new compounds” 
will never give exact matches, simply because the spectrum is not 
in the database. Closely related are empirical relationships obtained 
from fitting previously assigned (and presumed correctly assigned) 
spectra. While these can achieve some degree of success, the fact that 
NMR chemical shifts (in addition to three-bond coupling constants) 
are sensitive to conformation means that molecules that have very 
similar 2D structures may give rise to entirely different spectra. 

An alternative to databases and purely empirical schemes would 
be to calculate chemical shifts a priori using quantum mechanics. 
In so doing, differences in structure and conformation are directly 
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taken into account. The underlying methodology has been available 
for several decades, and both Hartree-Fock and density functional 
models have been shown to provide reasonable accounts of chemical 
shifts for simple molecules. However, calculations have only 
rarely been used to actually assist in the interpretation of spectra, 
and very few chemists are aware that accurate quantum chemical 
calculations are now possible (and practical) for “real molecules”. 
Those who are aware, are confronted and all too often stymied with 
what must seem to be an endless list of methods. We believe that 
the full potential of quantum chemical calculations as assists to 
assigning NMR spectra will only be realized after a small number 
of alternatives or “standard models” are elaborated and their limits 
and reliability clearly defined. Stated differently, chemists need to 
approach quantum chemical calculations much in the same way that 
they now approach a spectrometer. 

underlying theory

Some but not all nuclei have a non-zero magnetic moment. Where 
they do, application of an external magnetic field causes the nuclear 
spins to align either parallel or antiparallel to the field. The difference 
in energy (ΔE) between nuclear spin states is given by.

ΔE = γħB0

γ is the gyromagnetic ratio, a constant that depends on the nucleus, 
ħ is Planck’s constant/2π and B0 is the strength of the magnetic field 
at the nucleus. What makes nuclear magnetic resonance (NMR) 
spectroscopy interesting to chemists is that the magnetic field felt at 
the nucleus is slightly different for each chemically distinct nucleus 
in a molecule. This is because the applied magnetic field is slightly 
weakened by electrons around the nucleus and the extent of this 
weakening depends on the detailed chemical environment. Nuclei 
that are well shielded by the electron cloud experience a lesser field 
than those that are poorly shielded and, as a result, show a smaller 
energy splitting. The splitting, relative to a standard, is termed a 
chemical shift.
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As commented above, not all nuclei have a magnetic moment and 
can give rise to an NMR signal.  In particular, the dominant isotope 
of carbon (12C) does not have a magnetic moment and is transparent 
to an NMR spectrometer.  Fortunately 13C does have a magnetic 
moment, although it makes up only about 1% of the total. The 
low natural abundance of 13C  certainly slowed the application of 
carbon NMR to organic chemistry by several decades (waiting for  
magnet and spectrometer  technology to catch up). However, the 
low abundance of 13C is a blessing in disguise in that a carbon NMR 
spectrum is much simpler (and easier to interpret) than a proton 
NMR spectrum. Whereas nearby protons interact (couple) leading to 
splitting of the individual lines in the proton NMR spectrum, the very 
low probability (1% x 1%) that two 13C nuclei will be adjacent all but 
eliminates carbon-carbon coupling. Proton-13C coupling can occur 
but can be (and nearly almost always is) “removed”. The result is 
that the 13C NMR spectrum contains only one line per unique carbon. 

From the perspective of the experiment, the fact that the difference 
in energy between nuclear spin states (and ultimately the ability of 
an NMR spectrometer to distinguish chemically-different nuclei) is 
directly proportional to the magnetic field strength is disheartening. 
Magnets used in NMR spectrometers are now approaching practical 
limits, and a mere 10-20%  increase in field strength (translating to 
an equivalent increase in resolution) can mean more than doubling 
the cost of the spectrometer. Without a major breakthrough in magnet 
technology, the prognosis for greatly improved resolution over what 
is now possible (practical) is bleak. On the other hand, computer 
performance continues to double every few years (anticipated by 
Moore’s law), and NMR spectra calculations on larger and ever 
more complex molecules continue to become more routine.

the eDF2/6-31g* Density Functional Model for 13C Chemical 
Shift Calculations

Whereas Spartan can calculate NMR chemical shifts using Hartree-
Fock as well as a wide range of density functional models and with a 
variety of basis sets, the focus here is on a single model, specifically, 
the EDF2/6-31G* density functional model. Considerable experience 
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indicates that density functional models provide a significantly 
better account of chemical shifts than Hartree-Fock models, and 
furthermore that the results are not very sensitive to the exact choice 
of functional. For example, results based on the EFD2 functional are 
quite similar to those obtained from the popular B3LYP functional. 
Indeed our choice of EDF2 was primarily based on a desire to 
maintain compatibility with calculations of other spectra, in  particular 
infrared spectra, where the EDF2 functional is consistently superior 
to the B3LYP functional. The choice of the 6-31G* basis set  over a 
larger, more flexible basis set, while due in large part out to practical 
concerns, is supported by calculations that show that increased 
valence-shell splitting and addition of polarization function and/
or diffuse functions does not significantly alter chemical shifts. 
It allows the calculations to easily be extended to moderate size 
organic molecules in the molecular weight range of 400-600 amu.

assessment of the eDF2/6-31g* Density Functional Model for 
13C Chemical Shift Calculations
13C shift calculations were performed on a collection of ~3000 
small organic molecules containing ~15,000 unique carbons for 
which experimental data are available. The majority of these are 
rigid molecules or molecules which exhibit a strong preference for 
a single conformer. The shift calculations are based on equilibrium 
geometries from the EDF2/6-31G* model starting from the best 
conformation established from the T1 thermochemical recipe.

Use of the T1 recipe to establish best conformer is limited to closed-shell, 
uncharged molecules containing the elements H, C, N, O, F, Si, P, S and 
Br only. Molecules incorporating other elements use the best conformer 
assigned from the MMFF molecular mechanics model.

Uncorrected, the calculations yield a RMS error of 5.5 ppm. A plot 
of EDF2/6-31G* vs. experimental 13C shifts over the range of -50 to 
300 ppm reveals a number of significant outliers.
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A few simple but nevertheless “real problems” serve to calibrate 
utility of the EDF2/6-31G* model as an assist to assigning measured 
spectra. These have been drawn from a broader selection of problems 
that we have investigated, and are not intended to show situations 
where calculations may be particularly valuable, but simply illustrate 
a variety of different applications. The central question that needs to 
be answered is whether or not the “raw data” from EDF2/6-31G* 
calculations are good enough to be value in assigning the NMR 
spectra of unknown molecules.

The first example typifies a situation where NMR is used to distinguish 
between two alternatives that are structurally very different. The 
observed 13C spectrum of cyclopentenebromonium ion contains 
lines at 18.8, 31.8 and 114.6 ppm. These could  either correspond 
to a structure with bromine bonded to both sp2 carbons (bridged) or 
from an equilibrium between a pair of equivalent structures with 
bromine attached only to one carbon (open). 

H HBr
bridged

+ H
HBr

open

+

The calculated spectrum for the bridged ion shows resonances at 
20, 33 and 117 ppm, while that obtained by averaging the two open 
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ions shows lines at 28, 51 and 193 ppm. The former is a reasonable 
fit to the experimental spectrum whereas the latter is a poor fit. The 
“assignment” of a cyclic structure for cyclopentenebromonium ion 
is consistent with crystal structures for related ions.

Actually, the open ion is not an energy minimum according to the  
EDF2/6-31G* model, and collapses without barrier to the cyclic ion. 
The NMR calculations were performed using a geometry for the open 
ion obtained from the analogous Hartree-Fock model (where it is an 
energy minimum).

The second example involves the use of 13C NMR to distinguish 
structural isomers, specifically to distinguish between γ and δ forms 
of valerolactone and caprolactone. Experimentally, the 13C shift for 
the carbonyl carbon in the γ isomer of valerolactone is 5.8 ppm larger 
than that for analogous carbon in the δ isomer. The calculations show 
the proper ordering and a difference of 7.5 ppm. The same trend is 
found for the comparison of γ and δ caprolactone. Experimentally, the 
13C shift of the carbonyl carbon is 4.6 ppm larger for the compound 
with the 5-membered ring than it is for that with the 6-membered 
ring, compared to a calculated difference of 7.4 ppm. 

O O
O O O OO O

γ-valeroactone δ-valeroactone γ-caprolactone δ-caprolactone

The third example examines an even more subtle situation where 
the alternatives are stereoisomers and therefore structurally 
nearly identical. Consider the choice between equatorial or axial 
stereochemistry in a rigid ring where equilibration cannot take place, 
for example, in trans decalin. EDF2/6-31G* calculations show that 
the 13C shift for the methyl group in equatorial trans-2-methyldecalin 
is 3.7 ppm smaller than that for methyl in the axial compound, in 
reasonable accord with both the direction and magnitude (4.9 ppm) 
found experimentally.
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Me

Me

equatorial-trans-2-methyldecalin axial-trans-2-methyldecalin

The fourth example is similar to the previous example in that it uses 
NMR to distinguish between stereoisomers, in this case, between the 
endo or exo stereoiosmers of  2-norbornylmethanol. The calculated 
shift for C7 (the methylene bridge) is larger than the experimental 
value for both stereoisomers, but both the direction (the shift in the 
exo isomer is smaller) and the magnitude of the difference (5.1 ppm 
vs. 4.6 ppm experimentally) are reproduced.

CH2OH

CH2OH
exo-2-norbornylmethanol endo-2-norbornylmethanol

The calculations are successful for cyclopentenebromonium ion 
presumably because the chemical shifts for the alternative structures 
are sufficiently different that even sizable errors in the individual 
calculated 13C chemical shifts can be tolerated. Success in properly 
assigning the structural isomers of valerolactone and caprolactone, 
the equatorial and axial stereoisomers of trans-2-methyldecalin and 
endo and exo stereoisomers of 2-norbornylmethanol is on the other 
hand most likely due to the fact that the alternatives are very similar 
and that the calculations are benefiting from  cancellation of errors.  

What happens for the intermediate situation where  the alternatives 
may not be different enough to be easily distinguished and may not 
be similar enough to benefit from error cancellation? Consider, for 
example, an attempt to use calculations to decide which of eight 
possible C13H8O5 products arise from a biosynthesis related to the 
known pathway for lambertellol. This is the kind of “difficult” 
case where calculations were they reliable would be of real value. 
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Regrettably, neither the overall spectral pattern nor the detailed 
values 13C shifts obtained from the EDF2/6-31G* model for either 
closely matches the experimental data. 13C spectra for two of the 
eight structures including the correct structure (the top one) are 
shown below; the methyl resonance is off scale.

OO

O

OH

O

H3C

OO

OH

O

H3C

O

empirically Corrected 13C Chemical Shifts

Successes and failures typified by the examples described above 
(drawn from a much more extensive list) have led to the development 
of a hybrid  approach for calculating 13C shifts. Our first scheme, 
implemented in Spartan’08, corrected carbon shifts obtained from 
the B3LYP/6-31G* density functional model based only on the 
number and kinds of directly-bonded atoms. A total of 29 parameters 
was involved in a linear  regression to an experimental dataset 
made up of ~800 sp3 carbons, ~1500 sp2 and aromatic carbons and 
~100 sp carbons. Note that this correction scheme depends only on 
topography and not on three-dimensional structure. This means that 
changes in chemical shifts between stereoisomers obtained from the 
B3LYP/6-31G* model are unaffected.

A second scheme has now been developed and implemented in 
Spartan’10. It changes the underlying quantum chemical model to 
EDF2/6-31G* (in part to avoid confusion with the previous correction 
scheme), replaces the previous scheme based only on bond counts to 
one which also make use of bond orders, and “special cases” several 
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common (sp2 and sp) centers. This scheme involves 43 independent 
parameters for the general case and a similar number of parameters  
for the special cases. The dataset used for the linear regression is 
much larger, comprising ~8000 sp3 carbons, ~6200 sp2 carbons 
(including aromatic carbons) and ~450 sp carbons. 

The general case formula is:
13Ci = 13Ci•Scale + Σk [X(0)

k  + X(1)
k(Qi,k - 1) + X(2)

k(Qi,k - 1)2]
13C is the corrected chemical shift and13C is the uncorrected chemical 
shift and Scale is a scaling factor. Summation is carried out over all 
bonds (1 or 2 for sp carbons, 3 for sp2 carbons and 4 for sp3 carbons). 
X(0)

k , X(1)
k and X(2)

k are parameters that depend on the atom bonded 
to carbon (H, C, N, O, F, Si, P, S, Cl or Br) and Qi,k are natural 
bond orders. Different expressions apply to sp, sp2 and sp3 carbons. 
The equation for sp carbon involves four X(0)parameters, four X(1) 
parameters and one X(2) parameter (11 parameters in total), that for sp2 
carbon involves all ten X(0) parameters, six X(1) parameters and four X(2) 

parameters (21 parameters in total), and that for sp3 carbon involves 
all ten X(0) parameters but no X(0)or X(1) parameters (11 parameters in 
total).  As there are no special cases for sp3 carbons, this means that 
the new correction scheme for sp3 carbons, like the previous scheme, 
depends only on topography and not on three-dimensional structure. 
Changes in chemical shifts between stereoisomers involving sp3 
centers obtained from the EDF2/6-31G* model are unaffected.

A plot of 13C shifts obtained from the general correction formula 
over the range of -50 to 300 ppm is shown below provides RMS 
error is  1.8 ppm (vs. 5.5 ppm for the uncorrected shifts) with no 
significant outliers.
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The corrected scheme does a much better job for the type of situation 
illustrated previously for the C13H8O5 isomers. The first of the two 
spectra below is a reasonable match to what is observed, whereas 
the second (and the other six) are not.

OO

O

OH

O

H3C

OO

OH

O

H3C

O

The corrected spectra also properly account for the types of problems 
that were previously successful (the correction did no harm). A few 
(DEPT) spectra for natural products show the quality that can be 
expected.
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Atomic And moleculAr orbitAls

Chemists have developed a variety of methods for describing electrons 
in molecules. Lewis structures are the most familiar. These drawings 
assign pairs of electrons either to single atoms (lone pairs) or pairs 
of atoms (bonds)*. The quantum mechanical equivalents are atomic 
and molecular orbitals which arise from solution of (approximate) 
Schrödinger equations for atoms and molecules, respectively. 
Molecular orbitals are spread throughout the entire molecule, that is, 
they are delocalized. Because of this, they are typically more difficult 
to interpret than Lewis structures.

orbital surfaces 

Molecular orbitals provide important clues about chemical reactivity, 
but before we can use this information we first need to understand 
what molecular orbitals look like. The following figure shows two 
representations, a hand drawing and a Spartan-generated image of 
an unoccupied molecular orbital of hydrogen molecule, H 2.

H H

unoccupied molecular orbital in hydrogen

Open hydrogen empty in the topics directory. Note that except for the 
colors (sign of the orbital) the two sides of the graphic are identical. 
The junction between red and blue regions is where the value of the 
orbital is zero. Close hydrogen empty when you are finished.

The familiar hand drawing shows the orbital as two circles and a 
dashed line. The circles identify regions where the orbital takes on a 
significant value, either positive (shaded) or negative (unshaded). The 
dashed line identifies locations where the orbital’s value is exactly 
zero (a node). The drawing is useful, but it is also limited. We only 

*  Treatment here is limited to molecules in which all electrons are paired. Molecules with one 
or more unpaired electrons (radicals, triplet states, etc.) may also be treated.
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obtain information about the orbital in two dimensions, and we only 
learn the location of significant regions and not how the orbital builds 
and decays inside and outside of these regions.

The Spartan-generated image depicts the same orbital as a surface 
of constant value. The surface is accurate in that it is derived from 
an authentic (but approximate) calculated solution to the quantum 
mechanical equations of electron motion. Equally important, the 
image is three-dimensional, and can be manipulated and looked at 
from a variety of different perspectives. Note that an orbital surface 
actually consists of two distinct surfaces represented by different 
colors. The two surfaces have the same meaning as the two circles in 
the orbital drawing. They identify regions where the orbital takes on a 
significant value, either positive (blue) or negative (red). The orbital 
node is not shown, but we can guess that it lies midway between the 
two surfaces (this follows from the fact that the orbital’s value can 
only change from positive to negative by passing through zero).

Atomic orbitals

Atomic orbitals (descriptions of atoms) are the fundamental building 
blocks from which molecular orbitals (descriptions of molecules) are 
assembled. The familiar atomic orbitals for the hydrogen atom are in 
fact exact solutions of the Schrödinger equation for this one electron 
system. They form an infinite collection (a complete set), the lowest-
energy member representing the best location for the electron, and 
higher-energy members representing alternative locations. Orbitals 
for real many-electron atoms are normally assumed to be similar in 
form to those of hydrogen atom, the only difference being that, unlike 
hydrogen, more than the lowest-energy atomic orbital is utilized. 
In practical quantum chemical calculations, atomic orbitals for 
many-electron atoms are made up of sums and differences of a finite 
collection of hydrogen-like orbitals (see the topic Theoretical Models).

It is common practice to divide the full set of atomic orbitals into core 
and valence orbitals, and further to ignore the former. Valence orbitals 
for an element in the first long row of the Periodic Table are 2s, 2px, 
2py and 2pz, and for the second long row are 3s, 3px, 3py and 3pz. In 
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the case of first-row elements, a single orbital, 1s, lies underneath (is 
a core orbital) while in the case of second-row elements, a set of five 
orbitals, 1s, 2s, 2px, 2py and 2pz, lie underneath.

Open fluoride and chloride in the topics directory. On the top row are 
the four valence orbitals of fluoride anion and on the bottom row the four 
valence orbitals of chloride anion. You can select among them by clicking 
(left mouse button) on each in turn. First note that the three 2p orbitals 
in fluoride are identical except for the direction in which they point. The 
same is true for the three 3p orbitals in chloride. Next, note that the valence 
orbitals in chloride are larger than those in fluoride. Atoms further down 
in the Periodic Table are generally larger than analogous atoms further 
up. Close fluoride and chloride when you are finished.

orbitals and chemical bonds

Although molecular orbitals and Lewis structures are both used to 
describe electron distributions in molecules, they are used for different 
purposes. Lewis structures are used to count the number of bonding 
and non-bonding electrons around each atom. Molecular orbitals are 
not useful as counting tools, but orbitals and orbital energies are useful 
tools for describing chemical bonding and reactivity. This section 
describes a few common orbital shapes and illustrates their use.

Molecular orbital surfaces can extend over varying numbers of atoms. 
If the orbital surface (or surfaces) is confined to a single atom or to 
atoms which are not close together, the orbital is regarded as non-
bonding. If the orbital contains a surface that extends continuously 
over two neighboring atoms, the orbital is regarded as bonding with 
respect to these atoms. Adding electrons to such an orbital will 
strengthen the bond between these atoms and cause them to draw 
closer together, while removing electrons will have the opposite 
effect. Two different kinds of bonding orbitals are depicted below. 
The drawing and surface on the left correspond to a σ bond while the 
drawing and surface on the right correspond to a π bond.
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A B

     

A B

 σ bonding  p bonding

Open nitrogen bonding in the topics directory. The image on the left 
corresponds to the σ bonding orbital of N2, while that on the right 
corresponds to one of two equivalent π bonding orbitals. Switch to a 
transparent or mesh model to see the underlying molecular skeleton. 
Note that the σ orbitals is drawn in a single color (insofar as NN bonding 
is concerned) while the π orbital is made up of red and blue parts. This 
indicates a node or a break in the latter, although not involving the NN 
bond. Close nitrogen bonding when you are finished.

It is also possible for an orbital to contain a node that divides the 
region between two neighboring atoms into separate atomic regions. 
Such an orbital is regarded as antibonding with respect to these 
atoms. Adding electrons to an antibonding orbital weakens the bond 
and pushes the atoms apart, while removing electrons from such an 
orbital has the opposite effect. The following pictures show drawings 
and orbital surfaces for two different kinds of antibonding orbitals. 
As above, the left and right-hand sides correspond to σ and π type 
arrangements, respectively.

node

A B

     

node

A B

 σ antibonding  p antibonding

Open nitrogen antibonding in the topics directory. The image on the 
left corresponds to the σ antibonding (σ*) orbital of N2 while that on the 
right corresponds to one of the two equivalent π antibonding (π*) orbitals. 
Switch to a mesh or transparent surface to see the underlying molecular 
skeleton. Note that the σ* orbital has a single node (change in color from 
red to blue) in the middle of the NN bond, while the π* orbital has two 
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nodes (one in the middle of the NN bond and to the other along the bond). 
Close nitrogen antibonding when you are finished.

Bonds can be strengthened in two different ways, by adding electrons 
to bonding orbitals, or by removing electrons from antibonding 
orbitals. The converse also holds. Bonds can be weakened either by 
removing electrons from bonding orbitals or by adding electrons to 
antibonding orbitals. 

singlet methylene

Molecular orbitals in molecules which contain many atoms are 
typically spread throughout the molecule (they are delocalized). 
Delocalized orbitals have complicated shapes and contain multiple 
interactions that may be bonding, non-bonding, antibonding, or any 
mixture of all three. Nevertheless, these shapes can still be broken 
down into two-atom interactions and analyzed using the principles 
outlined earlier. This process is illustrated for a triatomic molecule, 
singlet methylene, CH2. (Singlet refers to the fact that the eight 
electrons in this highly reactive molecule are organized into four 
pairs, and that each pair of electrons occupies a different molecular 
orbital. The lowest-energy state of methylene is actually a triplet with 
three electron pairs and two unpaired electrons.)

The lowest energy molecular orbital of singlet methylene is not very 
interesting in that it looks like a 1s atomic orbital on carbon. The 
electrons occupying this orbital restrict their motion to the immediate 
region of the carbon nucleus and do not significantly affect bonding. 
Because of this restriction, and because the orbital’s energy is very 
low, this orbital is referred to as a core orbital and its electrons are 
referred to as core electrons.

core orbital for methylene
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The next orbital is much higher in energy. It consists of a single 
surface that is delocalized over all three atoms. This means that it is 
simultaneously (σ) bonding with respect to each CH atom pair.

core orbital for methylene

The next higher energy orbital is described by two surfaces, a positive 
(blue) surface that encloses one CH bonding region and a negative 
(red) surface that encloses the other CH bonding region*. Since each 
surface encloses a bonding region, this orbital is also (σ) bonding with 
respect to each CH atom pair. This reinforces the bonding character of 
the previous orbital. The node that separates the two surfaces passes 
through the carbon nucleus, but not through either of the CH bonding 
regions, so it does not affect bonding.

core orbital for methylene

Thus, the two CH bonds in the Lewis structure for singlet methylene 
are replaced by two bonding molecular orbitals.

The highest-occupied molecular orbital (the HOMO) is also described 
by two orbital surfaces. One surface extends into carbon’s non-bonding 
region opposite the two hydrogens. The other surface encompasses the 
two CH bonding regions. Although it is hard to track the exact path 
of the orbital node in this picture, it happens to pass almost exactly 
through the carbon. This means that this particular orbital possesses 
only weak CH bonding character (it is H---H bonding). It turns out that 
the non-bonding character of the orbital is much more important than 

*  While the absolute signs (colors) of a molecular orbital are arbitrary, the relative signs 
(colors) indicate bonding and antibonding character.
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the bonding character, in that it leads to the fact that singlet methylene 
is able to behave as an electron-pair donor (a nucleophile).

core orbital for methylene

The above analysis shows that while the occupied orbitals of singlet 
methylene are spread over all three atoms, they are comprehensible. 
The orbitals divide into two groups, a single low-energy core orbital 
and three higher-energy valence orbitals. The latter consist of two CH 
bonding orbitals and a non-bonding orbital on carbon. There is no one-
to-one correspondence between these orbitals and the Lewis structure. 
The bonding orbitals are not associated with particular bonds, and the 
non-bonding orbital contains bonding interactions as well.

Open methylene bonding in the topics directory. Four images appear 
corresponding to the core and three valence orbitals of singlet methylene. 
Switch to a mesh or transparent surface to see the underlying molecular 
skeleton. Close methylene bonding when you are finished.

Singlet methylene also possesses unoccupied molecular orbitals. The 
unoccupied orbitals have higher (more positive) energies than the 
occupied orbitals, and these orbitals, because they are unoccupied, 
do not describe the electron distribution in singlet methylene.* 
Nevertheless, the shapes of unoccupied orbitals, in particular, the 
lowest-unoccupied orbital (LUMO), is worth considering because it 
provides valuable insight into the methylene’s chemical reactivity.

The LUMO in methylene has non-bonding character, and looks like 
a 2p atomic orbital on carbon. This suggests that singlet methylene 
should be able to behave as an electron-pair acceptor (an electrophile). 
Note, however, that were the molecule to accept electrons, these would 

*  Because Lewis structures describe electron pair bonds and non-bonding electron pairs, they 
may not be related to unoccupied molecular orbitals.
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go into non-bonding orbital; carbon would become more electron-rich, 
but the CH bonds would not be much affected.

LUMO of methylene

Open methylene LUMO in the topics directory and switch to a mesh 
or transparent surface to see the underlying skeleton. Close methylene 
LUMO when you are finished.

Frontier orbitals and chemical reactivity

Chemical reactions typically involve movement of electrons from 
an electron donor (base, nucleophile, reducing agent) to an electron 
acceptor (acid, electrophile, oxidizing agent). This electron movement 
between molecules can also be thought of as electron movement 
between molecular orbitals, and the shapes and energies of orbitals 
that act as electron donors or electron acceptors may provide 
considerable insight into chemical reactivity.

The first step in constructing a molecular orbital picture of a chemical 
reaction is to decide which orbitals are most likely to act as electron 
donors and acceptors. It is obvious that an electron-donor orbital must 
be drawn from the set of occupied orbitals, and an electron-acceptor 
orbital must be an unoccupied orbital, but there are many orbitals in 
each set to choose from.

Orbital energy is usually the deciding factor. The highest-energy 
occupied orbital (the HOMO) is most commonly assumed to be the 
relevant electron-donor orbital and the lowest-energy unoccupied 
orbital (the LUMO) is most commonly assumed to be the relevant 
electron-acceptor orbital. For example, the HOMO and LUMO of 
singlet methylene (σ and π non-bonding orbitals, respectively) would 
serve as the donor and acceptor orbitals. The HOMO and LUMO are 
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collectively referred to as the frontier orbitals, and most chemical 
reactions involve electron movement between them. In this way, the 
energy input required for electron movement is kept to a minimum.

Energy
LUMO

HOMO

frontier 
molecular 
orbitals

unoccupied
molecular
orbitals

occupied
molecular
orbitals

Closely related to chemical reactivity (reaction rate) is chemical 
selectivity. The relevant question is, where more than one combination 
of reagents can react, which combination will react first? The answer 
can often be found by examining the energies of the frontier orbitals. 
Consider ranking the rates of a series of reagents, where chemical 
reaction requires electron donation from the donor’s HOMO. It is 
reasonable to expect that the donor with the highest energy HOMO 
will give up its electrons most easily and be the most reactive. 
Electron-acceptor reagents should follow the opposite pattern. The 
reagent with the lowest energy LUMO should be able to accept 
electrons most easily and be the most reactive. For a mixture of several 
donor and acceptor reagents, the fastest chemical reaction would be 
expected to involve the reagent combination that yields the smallest 
HOMO-LUMO energy gap. 

A related selectivity question arises when a molecule has multiple 
reactive sites. In this case, the energy of the orbital is useless as a guide 
to site selectivity, but the shape of the relevant orbital is important. 
For example, the enolate of ethyl acetate shown below might react 
with an electrophile (E+) at two different sites.

H2C

E

OEt
C

H2C OEt
C

E
OO

E+ E+

H2C OEt
C

O–

H2C OEt
C
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Because the anion acts as an electron donor, we can find clues to its 
reactivity preferences by examining the shape of its HOMO. Even 
though the HOMO is delocalized over several sites, the largest 
contribution clearly comes from the terminal carbon atom. Therefore, 
we expect electron movement and bond formation to occur at this 
carbon, and lead to the product shown on the left.

HOMO for enolate of ethyl acetate

Open ethyl acetate enolate HOMO in the topics directory, and switch to 
a mesh or transparent surface to see the underlying skeleton. Note that the 
orbital is most heavily concentrated on carbon, meaning that electrophilic 
attack will likely occur here. Close ethyl acetate enolate HOMO when 
you are finished.

the Fukui-Woodward-Hoffmann rules

In certain cases, multiple frontier orbital interactions must be 
considered. This is particularly true of so-called cycloaddition 
reactions, such as the Diels-Alder reaction between 1,3-butadiene 
and ethylene.

+

The key feature of this reaction is that the reactants combine in a 
way that allows two bonds to form simultaneously. This implies two 
different sites of satisfactory frontier orbital interaction (the two new 
bonds that form are sufficiently far apart that they do not interact 
with each other during the reaction). If we focus exclusively on the 
interactions of the terminal carbons in each molecule, then three 
different frontier orbital combinations made up of upper and lower 
components can be imagined. 
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individual interactions 
reinforce

individual interactions 
cancel

The “upper” orbital components are the same sign in all three 
combinations, meaning that their overlap is positive. In the two 
cases on the left, the lower orbital components also lead to positive 
overlap. Thus, the two interactions reinforce, and the total frontier 
orbital interaction is non zero. Electron movement (chemical reaction) 
can occur. The right-most case is different. Here the lower orbital 
components lead to negative overlap (the orbitals have opposite signs 
at the interacting sites), and the total overlap is zero. No electron 
movement and no chemical reaction can occur in this case.

As it happens, the frontier orbital interactions in the Diels-Alder 
cycloaddition shown above correspond to those found in the middle 
drawing, that is, the upper and lower interactions reinforce and the 
reaction proceeds. 

Open 1,3-butadiene+ethylene in the topics directory. The image on 
top is the LUMO of ethylene while that on the bottom is the HOMO 
of 1,3-butadiene. They are properly poised to interact, but you can 
manipulate them independently. Close 1,3-butadiene+ethylene when 
you are finished.

The same arguments suggest that cycloaddition of two ethylene 
molecules is unlikely to occur. This is because it involves a frontier 
orbital interaction like that found in the right drawing.

+ X

Open ethylene+ethylene in the topics dirctory. The image on top 
corresponds to the LUMO of one ethylene while that on the bottom 
corresponds to the HOMO of the other ethylene. You can manipulate them 
independently or in concert (hold down on the ctrl key while you carry out 
rotation and translation). Note, that in this case, the two individual atom-
atom interactions cancel. Close ethylene+ethylene when you are finished.
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The importance of orbital overlap in determining why certain chemical  
reactions proceed easily while other similar reactions do not go at 
all was first advanced by Fukui and then beautifully elaborated by 
Woodward and Hoffmann, and collectively their ideas are now known 
as the Fukui-Woodward-Hoffmann rules. 
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ElEctron DEnsitiEs: sizEs anD shapEs of 
MolEculEs

How big is an atom or a molecule? Atoms and molecules require a 
certain amount of space, but how much? A gas can be compressed 
into a smaller volume but only so far. Liquids and solids cannot be 
easily compressed. While the individual atoms or molecules in a gas 
are widely separated and can be pushed into a much smaller volume, 
the atoms or molecules in a liquid or a solid are already close together 
and cannot be squeezed much further.

space-filling Models

Chemists have long tried to answer the size question by using a special 
set of molecular models known as space-filling or CPK models. The 
space-filling model for an atom is simply a sphere of fixed radius. 
A different radius is used for each element, and this radius has been 
chosen to reproduce certain experimental observations, such as the 
compressibility of a gas, or the spacing between atoms in a crystal. 
Space-filling models for molecules consist of a set of interpenetrating 
atomic spheres. This reflects the idea that the chemical bonds that hold 
the molecule together cause the atoms to move very close together. 
Interpenetration can be used as a criterion for chemical bonding. If 
two atomic spheres in a space-filling model strongly interpenetrate 
then the atoms must be bonded.

space-filling models for ammonia (left), trimethylamine (center) and 
1-azaadamantane (right)

Space-filling models for ammonia, trimethylamine and  
1-azaadamantane show how big these molecules are, and also show 
that the nitrogen in ammonia is more exposed than the corresponding 
nitrogen atoms in trimethylamine and 1-azaadamantane.
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Open amines space filling in the topics directory. Space-filling models 
for ammonia, trimethylamine and 1-azaadamantane all appear on screen. 
Carbon atoms are colored dark grey, hydrogen atoms white and nitrogen 
blue. Note that the models clearly reveal the extent to which the nitrogen 
is exposed. Close amines space filling when you are finished.

Electron Density surfaces

An alternative technique for portraying molecular size and shape relies 
on the molecule’s own electron cloud. Atoms and molecules are made 
up of positively-charged nuclei surrounded by a negatively-charged 
electron cloud, and it is the size and shape of the electron cloud that 
defines the size and shape of an atom or molecule. The size and shape 
of an electron cloud is described by the electron density (the number 
of electrons per unit volume). Consider a graph of electron density 
in the hydrogen atom as a function of distance from the nucleus.

distance from nucleus

electron
density

The graph brings up a problem for chemists seeking to define atomic 
and molecular size, in that the electron cloud lacks a clear boundary. 
While electron density decays rapidly with distance from the nucleus, 
nowhere does it fall to zero. Therefore, when atoms and molecules 
rub up against each other, their electron clouds overlap and merge 
to a small extent.

electron density
for second molecule

molecular 
"boundary"

electron density
for first molecule
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This means that it is really not possible to say how big a molecule is. 
The best that can be done is to pick a value of the electron density, 
and to connect together all the points that have this value. The criteria 
for selecting this value is the same as that for selecting atomic radii 
in space-filling models, the only difference being that only a single 
parameter (the value of the electron density) is involved. The result 
is an electron density surface which, just like a space-filling model, 
is intended to depict overall molecular size and shape.

electron density surfaces for ammonia (left), trimethylamine (center)  
and 1-azaadamantane (right)

Open amines electron density in the topics directory. Electron density 
surfaces for ammonia, trimethylamine and 1-azaadamantane all appear 
on screen. Switch to a mesh or transparent surface in order to see the 
underlying skeletal model. Click on one of the surfaces, and select 
Mesh or transparent from the menu which appears at the bottom right 
of the screen. With mesh selected, change the model to space filling 
(Model menu). This allows you to see how similar the electron density 
representation is to that offered by a simple space-filling model. Close 
amines electron density when you are finished.

Both space-filling and electron density models yield similar molecular 
volumes, and both show differences in overall size among molecules. 
Because the electron density surfaces provide no discernible boundaries 
between atoms, the surfaces may appear to be less informative than 
space-filling models in helping to decide to what extent a particular 
atom is exposed. This raises an important point. Electrons are 
associated with a molecule as a whole and not with individual atoms. 
The space-filling representation of a molecule with its discernible 
atoms does not reflect reality.
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Bond Density surfaces

Another useful surface, termed the bond density surface, is one that 
marks points corresponding to a much higher value of the electron 
density*. Since points of high electron density are located much closer 
to the atomic nuclei, bond density surfaces enclose relatively small 
volumes, and do not give a correct impression of molecular size. On 
the other hand, bond density surfaces identify regions corresponding 
to bonding electron density, and the volume of these surfaces may 
be roughly correlated with the number of electrons that participate 
in bonding. In this sense, bond density surfaces are analogous to 
conventional line drawings and skeletal models.

The bond density surface for hex-5-ene-1-yne clearly shows which  
atoms are connected, although it does not clearly distinguish single, 
double and triple carbon-carbon bonds.

C CH C

C

H
H

CH
H

H

C H

H
bond density surface for hex-5-ene-1-yne

Open hex-5-ene-1-yne bond density in the topics directory, and switch to 
a mesh or transparent surface to see the connection between the chemical 
bonds in a conventional model and the electron density. Close hex-5-
ene-1-yne bond density when you are finished. 

The usefulness of the bond density surface is more apparent in the 
following model of diborane. The surface clearly shows that there is 
relatively little electron density between the two borons. Apparently there 
is no boron-boron bond in this molecule. This is information extracted 
from the bond density surface model, and has been obtained without 
reference to any preconceived ideas about the bonding in diborane.

* An even higher value of the electron density leads to a surface in which only nearly spherical 
regions of electron density around the non-hydrogen atoms are portrayed. This serves to 
locate the positions of these atoms and is the basis of the X-ray diffraction experiment.
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H
B

H
B

H

H

H

H

bond density surface for diborane

Open diborane bond density in the topics directory, and switch to a mesh 
or transparent surface to see how few electrons actually accumulate in 
the region between the two borons. Close diborane bond density when 
you are finished. 

Bond density surfaces can also be informative in describing changes 
in bonding in moving from reactants to products through a transition 
state in a chemical reaction. For example, heating ethyl formate causes 
the molecule to fragment into two new molecules, formic acid and 
ethylene. A line drawing can show which bonds are affected by the 
overall reaction, but it cannot tell us if these changes occur all at once, 
sequentially, or in some other fashion.

O OH
+

O

H
O O

H

O

On the other hand, the bond density surface is able to provide 
quantitative information.

bond density surfaces for the reactant, ethyl formate (left), pyrolysis transition 
state (center) and for the products, formic acid and ethylene (right)

Compare the bond density surface in the pyrolysis transition state 
to those of the reactant and the products. The CO single bond of the 
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reactant is clearly broken in the transition state. Also, the migrating 
hydrogen seems more tightly bound to oxygen (as in the product) than 
to carbon (as in the reactant). It can be concluded that the transition 
state more closely resembles the products than the reactants, and this 
provides an example of what chemists refer to as a late (product-like) 
transition state.

To see the smooth change in electron density throughout the course of 
the ethyl formate pyrolysis reaction, open pyrolysis bond density in the 
topics directory. Click on  at the bottom left of the screen to animate 
the graphic (click on  to stop the animation). Switch to a mesh or 
transparent surface to follow the change in bonding. Close pyrolysis bond 
density when you are finished. 
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ElEctrostatic PotEntial MaPs: chargE 
Distributions

The charge distribution in a molecule can provide critical insight into 
its physical and chemical properties. For example, molecules that are 
charged, or highly polar, tend to be water-soluble, and polar molecules 
may stick together in specific geometries, such as the double helix 
in DNA. Chemical reactions are also associated with charged sites, 
and the most highly-charged molecule, or the most highly-charged 
site in a molecule, is often the most reactive. The sign of the charge 
is also important. Positively-charged sites in a molecule invite attack 
by bases and nucleophiles, while negatively-charged sites are usually 
targeted by acids and electrophiles.

One way to describe a molecule’s charge distribution is to give a 
numerical atomic charge for each atom. A particularly simple and 
familiar recipe yields so-called formal charges directly from Lewis 
structures. Unfortunately, formal charges are arbitrary. In fact, all 
methods for assigning charge are arbitrary and necessarily bias the 
calculated charges in one way or another. This includes methods 
based on quantum mechanics.

An attractive alternative for describing molecular charge distributions 
makes use of a quantity termed the electrostatic potential. This is 
the energy of interaction of a point positive charge with the nuclei 
and electrons of a molecule. The value of the electrostatic potential 
depends on the location of the point positive charge. If the point 
charge is placed in a region of excess positive charge (an electron-
poor region), the point charge-molecule interaction is repulsive and 
the electrostatic potential will be positive. Conversely, if the point 
charge is placed in a region of excess negative charge (an electron-rich 
region), the interaction is attractive and the electrostatic potential will 
be negative. Thus, by moving the point charge around the molecule, 
the molecular charge distribution can be surveyed.

Electrostatic potentials can be depicted in various ways. For example, 
it is possible to make an electrostatic potential surface by finding all 
of the points in space where the electrostatic potential matches some 
particular value. A much more useful way to show molecular charge 



Appendix A 507

distribution is to construct an electrostatic potential map. This is done 
first by constructing an electron density surface corresponding to 
a space-filling model (see the topic Electron Densities: Sizes and 
Shapes of Molecules). The electrostatic potential is then mapped onto 
this surface using different colors to represent the different values of 
the electrostatic potential. Mapping requires an arbitrary choice for 
a color scale. Spartan uses the rainbow.  Red, the low energy end 
of the spectrum, depicts regions of most negative (least positive) 
electrostatic potential, and blue depicts the regions of most positive 
(least negative) electrostatic potential. Intermediate colors represent 
intermediate values of the electrostatic potential, so that potential 
increases in the order: red < orange < yellow < green < blue.

The connection between a molecule’s electron density surface, 
its electrostatic potential surface, and an electrostatic potential 
map is illustrated below for benzene. The electron density surface 
defines molecular shape and size. It performs the same function 
as a conventional space-filling model by indicating how close two 
benzenes can get in a liquid or in a crystal.

 
	 space-filling	model	 electron	density	surface
	 for	benzene	 for	benzene

Open benzene electron density in the topics directory. Two different 
images, a space-filling model and an electron density surface, appear side 
by side. You can switch between the two models (in order to manipulate 
them) by clicking on each in turn. Notice how similar they are. To get an 
even clearer impression, switch to a mesh surface. Click on the graphic 
and select Mesh from the menu which appears at the bottom right of the 
screen. Switch to a space-filling model (space Filling from the Model 
menu). The two are now superimposed. Close benzene electron density 
when you are finished.
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The electrostatic potential corresponding to points where the potential 
is negative shows two different surfaces, one above the face of the 
ring and the other below. Since the molecule’s π electrons lie closest 
to these surfaces, we conclude that these electrons are responsible 
for the attraction of a point positive charge (or an electrophile) to the 
molecule. An electrostatic potential surface corresponding to points 
where the potential is positive has a completely different shape. It is 
disk-shaped and wrapped fairly tightly around the nuclei. The shape 
and location of this surface indicates that a point positive charge is 
repelled by this region, or that a point negative charge (a nucleophile) 
would be attracted here.

	negative	(left)	and	positive	(right)	electrostatic	potential	surfaces	for	benzene

Open benzene electrostatic potential in the topics directory. Two different 
images appear side by side. The one on the left depicts a surface of 
constant negative potential, while the one on the right depicts a surface 
of equal positive potential. You can switch between the two models (in 
order to manipulate them) by clicking on each in turn. Close benzene 
electrostatic potential when you are finished.

Next, combine the electron density and electrostatic potential surfaces 
to produce a so-called electrostatic potential map. The map for benzene 
conveys both the molecule’s size and shape as well as its charge 
distribution in a compact and easily interpretable manner. The size and 
shape of the map are, of course, identical to that of the electron density 
surface, and indicate what part of the molecule is easily accessible to 
other molecules (the outside world). The colors reveal the overall charge 
distribution. The faces of the ring, the π system, are red (electron rich), 
while the plane of the molecule and especially the hydrogens are blue 
(electron poor).
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	 electrostatic	potential	map	for	benzene

Open benzene electrostatic potential map in the topics directory. 
Manipulate the image to convince yourself that the red regions are on 
the π faces and the blue regions are around the edges. Close benzene 
electrostatic potential map when you are finished.

Electrostatic potential maps have made their way into mainstream 
general and (especially) organic chemistry textbooks as a means 
of displaying charge distributions in molecules. In addition, they 
have found application as a natural step beyond steric models for 
interpreting and predicting the way in which molecules fit together. A 
good example of this follows from the electrostatic potential map for 
benzene, which recall is negative on the π faces and positive around 
the periphery. The benzene dimer would, therefore, be expected to 
exhibit a perpendicular geometry, to best accomodate Coulombic 
interactions, instead of a parallel arrangement.

	 electrostatic	potential	maps	for	parallel	(left)	and	perpendicular	(right)	
benzene	dimers
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Open benzene dimer electrostatic potential map in the topics directory. 
Note that the parallel arrangement forces the negative region of one 
benzene onto the negative region of the other, while the perpendicular 
structure associates the negative region of one benzene with a positive 
region of the other. Close benzene dimer electrostatic potential map 
when you are finished.

Of greater interest is the structure of benzene in solid state. Intuition 
suggests a parallel stack. Afterall, benzene is flat and flat things (plates, 
pancakes, hamburgers) make stacks. However, Coulombs law favors 
a perpendicular arrangement.

perpendicularparallel

The experimental X-ray crystal structure shows a perpendicular 
arrangement, but in three dimensions. There are two lessons here. 
Intermolecular interactions go beyond steric interactions and sometimes 
our simple one-dimensional view of the world will lead us astray.
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	 X-ray	crystal	structure	of	benzene

Open benzene crystal in the topics directory. Manipulate in order to see 
the packing of benzene molecules. Close benzene crystal when you are 
finished.

Electrostatic potential maps may also be used to describe in great 
detail the workings of chemical reactions. For example, a map may be 
used to show the transfer of negative charge during the Sn2 reaction 
of cyanide with methyl iodide.

N C N C CH3  +  ICH3 I– –

Open Sn2 cyanide+methyl iodide in the topics directory. One frame of a 
sequence of electrostatic potential maps for the Sn2 reaction will appear. 
Animate by clicking on  at the bottom left of the screen (stop the 
animation by clicking on ). Note that the negative charge (red color) 
flows smoothly from cyanide to iodide during the reaction. Note also, that 
cyanide (as the reactant) is more red than iodide (as the product). Iodide is 
better able to carry negative charge, that is, it is the better leaving group. 
Switch to mesh or transparent map to see the making and breaking of 
bonds. Close Sn2 cyanide+methyl iodide when you are finished.
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L o c a L  I o n I z a t I o n  P o t e n t I a L  M a P s 
a n d  L U M o  M a P s :  e L e c t r o P h I L I c  a n d  
nUcLeoPhILIc reactIvItIes

The Hammond Postulate states that the transition state in a (one-step) 
reaction will more closely resemble the side of the reaction that is 
higher in energy. Thus, the transition state of an endothermic reaction 
will more closely resemble the products. Conversely, the transition 
state of an exothermic reaction will resemble the reactants. One way  
to rationalize the Hammond postulate is to suggest that similarity in 
energy implies similarity in structure. That is, the transition state will 
resemble whichever reactants or products to which it is closer in energy. 
As seen in the reaction coordinate diagrams below this is the product 
in an endothermic reaction and the reactants in an exothermic reaction.

Energy

reaction coordinate reaction coordinate

reactant

product reactant

product

transition state transition state

Energyendothermic reaction exothermic  reaction

The Hammond Postulate provides a conceptual basis both for the Fukui-
Woodward-Hoffmann rules (see the topic Atomic and Molecular 
Orbitals) and for the use of graphical models. Both consider the 
properties of reactants as an alternative to direct calculations of 
transition states and reaction pathways as a way to assess chemical 
reactivity and selectivity. In this context, two models stand out as being 
particularly useful: the local ionization potential map for electrophilic 
reactions and the LUMO map for nucleophilic reactions.

Local Ionization Potential Maps and electrophilic reactivity

The local ionization potential provides a measure of the relative ease 
of electron removal (ionization) at any location around a molecule. 
For example, a surface of low local ionization potential for sulfur 
tetrafluoride demarks the areas which are most easily ionized, and is 
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clearly recognizable as a lone pair on sulfur.

	 local	ionization	potential	for	sulfur	tetrafluoride

The local ionization potential by itself is not generally a useful model. 
However, a map of the local ionization potential onto an electron 
density surface is a useful model, in that it reveals those regions from 
which electrons are most easily ionized. 

"electron density"

Local ionization potential maps may be employed to reveal sites which 
are susceptible to electrophilic attack. For example, they show both 
the positional selectivity in electrophilic aromatic substitution (NH2 
directs ortho/para, and NO2 directs meta), and the fact that π-donor 
groups (NH2) activate benzene while electron-withdrawing groups 
(NO2) deactivate benzene.

NH2 NO2

 local ionization potential maps for benzene (left), aniline (center) 
and nitrobenzene (right)
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Open benzene, aniline, nitrobenzene local ionization potential maps 
in the topics directory. Here, the color red corresponds to regions of 
lowest ionization potential (most accessible to electrophiles). Note, that 
the π system in aniline is more accessible than the π system in benzene 
(the standard) and that the ortho and para positions are more accessible 
than meta positions. Note also, that the π system in nitrobenzene is less 
accesible than the π system in benzene and that here the meta positions 
are more accessible than the ortho and para positions, in accord with 
observation. Close benzene, aniline, nitrobenzene local ionization 
potential maps when you are finished.

LUMo Maps and nucleophilic reactivity

As elaborated in the topic Atomic and Molecular Orbitals, the 
energies and shapes of the frontier molecular orbitals may anticipate 
chemistry of a molecule. Molecular orbital maps may also lead to 
informative models. The most common of these is the so-called 
LUMO map, in which the (absolute value) of the LUMO is mapped 
onto an electron density surface. This anticipates where an electron 
pair (a nucleophile) might attack.

"electron density"

LUMO
electron pair

A good example is provided by the LUMO map for cyclohexenone.

O

α

β

LUMO map for cyclohexenone showing positions for nucleophilic attack in blue

The LUMO shows which regions of a molecule are most electron 
deficient, and hence most subject to nucleophilic attack. In this case, 
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one such region is over the carbonyl carbon, consistent with the 
observation that carbonyl compounds undergo nucleophilic addition 
at the carbonyl carbon. Another region is over the β carbon, again 
consistent with the known chemistry of α,β-unsaturated carbonyl 
compounds, in this case conjugate or Michael addition.

OCH3HO

CH3

carbonyl addition Michael addition

O

CH3Li (CH3)2CuLi

The buildup of positive charge on the β carbon leading to possibility 
of Michael addition could have been anticipated from resonance 
arguments, although the LUMO map, like an experiment, has the 
advantage of showing the result (“you don’t have to ask”).

Open cyclohexenone LUMO map in the topics directory and click on 
the resulting surface. Switch to a mesh or transparent surface in order to 
see the underlying skeletal model. On Windows, click on the graphic and 
select Mesh or transparent from the menu which appears at the bottom 
right of the screen. On the Mac, position the cursor over the graphic, hold 
down on either the left or right button and select from the menu which 
appears alongside. Orient the molecule such that the two “blue regions” 
are positioned over the appropriate carbons and then switch back to a solid 
surface. Close cyclohexenone LUMO map when you are finished.
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Appendix B
Capabilities and Limitations

Molecular Mechanics Models1

The molecular mechanics module calculates the energy (a combination 
of strain energy and intramolecular interaction energy), equilibrium 
geometry and vibrational frequencies, as well as provides for 
conformational searching**. SYBYL (Tripos, Inc.) and MMFF (Merck 
Pharmaceuticals) force fields are available. Energies from the latter 
may be corrected for the effects of aqueous solvent (MMFFaq). 
Structures are unaffected. There are no atom limits.

Semi-Empirical Models1

The semi-empirical module calculates the heat of formation, 
wavefunction, equilibrium and transition-state geometries and 
vibrational frequencies, as well as provides for conformational 
searching. MNDO, AM1, RM1, PM3** and PM6 models are supported. 
MNDO/d replaces MNDO for second-row (and heavier) main-group 
elements. MNDO has been parameterized for H, He, Li-F, Al-Cl, Ca, 
Zn, Ge, Br, Cd, Sn, I, Hg and Pb; AM1 for H, B-F, Al-Cl, Zn, Ge, Br, Sn 
and I; RM1 for H, C–F, P, S, Cl, Br and I; PM3 for H-Ne, Mg-Ar, Ca, Ti-
Br, Zr, Mo-Pd, Cd-I, Hf-Pt and Hg-Bi and Gd; PM6 for H–Bi except for 
Ce–Yb. All semi-empirical models involve a minimal valence basis set.

Preset limits for semi-empirical calculations are 300 atoms.

Hartree-Fock Models1-3

The Hartree-Fock module calculates the energy and wavefunction, 
equilibrium and transition-state geometries and vibrational frequencies, 
as well as provides for conformational searching. Both closed-shell 

* MMFF is the only method available for generation of conformer libraries.
** The published version of PM3 has been implemented and parameterized for transition  

metals. Except for Zn, Cd and Hg, these include d-type orbitals in the basis set.
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and open-shell (either ROHF or UHF) calculations are supported. 
Available basis sets are enumerated later in this appendix. Hartree-
Fock models have been implemented for use on multi-core processors. 

Preset limits for Hartree-Fock calculations are 200 atoms and 2,000 
basis functions. Calculations on molecules with up to 100 atoms are 
practical.

Density Functional Models1,2

The density functional module calculates the energy and wavefunction, 
equilibrium and transition-state geometries and vibrational frequencies, 
as well as provides for conformational searching. The module supports 
local density calculations and a wide variety of gradient corrected and 
hybrid functionals. Only a few functionals are provided in the menu of 
functionals, but other selections can be entered into the Options line 
of the Calculations dialog (Setup menu; Chapter 17). The Options 
line may also be used to specify combinations of exchange and 
correlation components to be used in building a total functional. For 
example, the line EXCHANGE=SLATER:0.9,BECKE:0.1 indicates 
a combination of 9 parts Slater exchange and 1 part Becke exchange. 
Similarly, the line CORRELATION=VWN:0.19,LYP:0.81 indicates 
a combination of 19 parts VWN and 81 parts LYP correlation.

A full listing of available functionals (including exchange and 
correlation functions to be used as components in construction of 
custom functionals) is provided in Table B-1. Available basis sets are 
enumerated later in this appendix. Density functional models have 
been implemented for use on multi-core processors.

Preset limits for density functional calculations are 200 atoms and 
2,000 basis functions. Calculations on molecules with up to 100 
atoms are practical.

Møller-Plesset Models1,2

The Møller-Plesset module calculates the energy and wavefunction 
and equilibrium and transition-state geometries as well as provides for 
conformational searching using either the MP2 or RI-MP2 models. 



Appendix B 519

Table B-1: Available Exchange, Correlation and Combination Functionals

exchange functionals

 HF Fock exchange
 Slater Slater (Dirac 1930)
 Becke Becke (1988)
 Gill96 Gill (1996)
 GG99 Gilbert, Gill (1999)
 B (EDF1) Becke (uses EDF1 parameters)
 PW91 Perdew, Burke, Ernzerhof (1996)

correlation functionals

 VWN Vasko, Wilk, Nusair #5
 LYP Lee, Yang, Parr
 PW91 GGA91, Perdew
 LYP (EDF1)
 P86 Perdew (1986)
 PZ81 Perdew, Zungner
 PBE Perdue, Burke, Ernzerhof (1996)

combination functionals

 B3PW91
 B3LYP
 B3LYP5 (Gaussian’s version of B3LYP)
 EDF1
 EDF2
 BMK
 M05
 M052X
 M06
 M062X
 M06HF
 M06L
 wB97
 wB97X
 wB97XD
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Vibrational frequencies are also available from both models, but 
require numerical differentiation of analytical gradients. Available 
basis sets are enumerated later in this appendix. RI-MP2 models (only) 
have been implemented for use on multi-core processors.

Depending on basis set, practical considerations limit application 
of these techniques to molecules comprising 20-30 heavy (non-
hydrogen) atoms, although program limits are set much larger.

MP3 and MP4 models are available for energy calculations only and 
are supported under Advanced Correlated Models.

Advanced Correlated Models1,2

The advanced correlated module calculates only the energy using 
the MP3, MP4, CCSD, CCSD(T), CCSD(2), OD, OD(T), QCISD, 
QCISD(T), QCCD and QCCD(2) correlated models. Only a few 
models are provided in the menu and the others need to be entered into 
the Options line in the Calculations dialog (Setup menu; Chapter 
17). Available basis sets are enumerated later in this appendix.

Depending on the specific model and basis set, practical considerations 
limit application of these techniques to molecules comprising 10-20 
heavy (non-hydrogen) atoms, although program limits are set much 
larger.

Thermochemical Recipes

The G2, G3 and G3(MP2) recipes are available for highly-accurate 
heat of formation calculations. Practical considerations generally limit 
application of the first two recipes to molecules comprising less than 
10 heavy atoms and the G3(MP2) recipe to molecules comprising 
less than 15 heavy atoms.

The T1 recipe4 has been developed to closely reproduce G3(MP2) heats 
of formation. It makes use of an HF/6-31G* geometry, instead of the 
MP2/6-31G* geometry, replaces the large basis set MP2 calculation 
in G3(MP2) by a dual-basis set RI-MP2 calculation, eliminates both 
the QCISD(T) calculation and the vibrational frequency calculation 
(needed to obtain zero-point energy and to correct the energy for finite 



Appendix B 521

temperature) and introduces an empirical correction based on the 
atom counts and Mulliken bond orders. The result is that T1 requires 
2-3 orders of magnitude less computation time than G3(MP2). 
Calculations on molecules with 30-50 heavy atoms are practical.

T1 is limited to closed-shell, uncharged molecules comprising H, C, 
N, O, F, Si, P, S, Cl and Br only, and that can be properly described 
in terms of a conventional valence structure. A “T1 like” recipe for 
transition states is under development.

Excited-State Models

Two classes of models are available for calculations of excited states: 
configuration interaction (CI) models and time-dependent density 
functional (TDDFT) models. The former comprises three models: CIS 
(configuration interaction singles), CISD (configuration interaction 
singles with doubles correction) and RI-CIS(D), while the latter 
supports the same functionals or combinations of functionals available 
for ground state density functional calculations. At the present time, 
only the CIS and RI-CIS(D) models are available for geometry 
optimization and frequency calculations, all other models being 
restricted to energy calculations. Available basis sets are enumerated 
later in this appendix.

Preset limits for excited-state calculations are 200 atoms and 2,000 
basis functions. Depending on the specific model and basis set, 
practical considerations limit applications to molecules comprising 
20-30 atoms.

Basis Sets and Pseudopotentials

Available basis sets for Hartree-Fock, density functional, MP2 
(RI-MP2) and advanced correlated models for ground states and 
CIS, CISD (RI-CIS(D)) and time-dependent density functional 
(TDDFT) models for excited states include the full range of Pople 
basis sets: minimal STO-3G, split-valence 3-21G, 6-31G, 6-311G 
and polarization 6-31G*, 6-31G**, 6-311G* and 6-311G**. These 
may be supplemented with additional polarization functions and/or 
with diffuse functions. Also available are the cc-pVDZ, cc-pVTZ, 
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cc-pVQZ, cc-pV5Z and aug-cc-pCVQZ basis sets and the G3Large 
basis set.

STO-3G is available for H–I, 3-21G for H–Cs, 6-31G and basis sets 
built on it for H–Kr, 6-311G and basis sets built on it for H–Kr and I, 
cc-pVDZ, cc-pVTZ, cc-pVQZ, and G3 Large for H–Ca and Ge–Kr 
and aug-cc-pCVQZ for H–Ar.

Use of minimal and split-valence basis sets for any but Hartree-Fock 
calculations generally leads to poor results and is not recommended.

Dual-basis set techniques (mixing small and large basis sets) are 
supported for ground-state energy and equilibrium and transition-
state geometry calculations for Hartree-Fock, density functional and 
MP2 models. These can be up to an order of magnitude faster than 
single-basis set calculations, depending on choice of small and large 
basis sets.

Pseudopotentials are available for calculations on molecules 
incorporating heavy atoms (for which all-electron basis sets are not 
available). Their use is automatic in Spartan’10 (a change from the 
need for explicit specification in earlier versions).

Solvent Models

Spartan’10 supports two different empirical solvation models. The 
simpler is the SM5.4 model5 (available for H, C–F, S–Cl, Br and 
I) which estimates only the aqueous solvation energy. This in turn 
may be added to the gas-phase energy obtained from any molecular 
mechanics or quantum chemical model. Because the computational 
cost of SM5.4 is very low (on the order of that for an energy 
using a semi-empirical model), this solvent correction is provided 
automatically for all quantum chemical calculations and is reported 
as a molecular property.

The SM8 model6 (available for H, C–F, S–Cl, Br and I) is applicable 
only to Hartree-Fock and density functional models. It leads to a 
change in the wavefunction. This means that, in addition to energy, 
equilibrium or transition-state geometry, properties, infrared spectra 
and graphical displays may be obtained in the presence of solvent. 
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SM8 has been parameterized for water as well as a variety of organic 
solvents. A few common solvents may be specified in a menu (acetone, 
diethyl ether, DMF, DMSO, ethanol, methylene chloride, THF and 
toluene) while others may be specified using the Solvent keyword 
in the Calculations dialog (Setup menu; Chapter 17). Available 
solvents are listed in Appendix D. The computational cost of SM8 
is roughly that of an energy with the corresponding Hatree-Fock or 
density functional model.

Properties and Spectra

The properties module is automatically invoked following completion 
of a molecular mechanics or quantum chemical calculation. By 
default, it provides for text output printing, population analyses and 
atomic charge calculation (Mulliken, natural bond orbital and based 
on fits to electrostatic potentials), evaluation of thermodynamic 
quantities (heat capacity, enthalpy, entropy and free energy) as well 
as the zero-point energy if vibrational frequencies are available, and 
calculation of the dipole moment. 

Several properties based on graphical displays have been implemented 
for the first time in Spartan’10. These include the area, exposed 
area and volume of an electron density surface, the polar area of an 
electrostatic potential map  for cutoff values of 75, 100 and 125 kJ/
mol, the maximum and minimum values of the electrostatic potential 
on an electrostatic potential map and the minimum value of the local 
ionization potential on a local ionization potential map. These require 
calculation of the respective surfaces and property maps, but only a 
small set of numerical values and not the surfaces and maps themselves 
are actually stored. These properties need to be explicitly requested by 
checking the QSAR box inside the Calculations dialog (Calculations 
under the Setup menu; Chapter 17). They are either available from 
the QSAR tab of the Molecule Properties dialog (Properties under 
the Display menu; Chapter 18) or from the Formula Editor dialog 
(Formulas under the Display menu; Chapter 18).

The properties module is also responsible for calculating quantities 
related to infrared/Raman spectra (vibrational frequencies and infrared/
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Raman intensities), NMR spectra (chemical shifts) and UV/visible 
spectra (excited-state transition energies and intensities). IR spectra 
calculations may be carried out with molecular mechanics models, 
semi-empirical models, Hartree-Fock models, density functional 
models and MP2 and RI-MP2 models. Note, however, that MP2 and 
RI-MP2 infrared calculations need to be performed using numerical 
differentiation and are in practice limited to small molecules. NMR 
and Raman spectra calculations are limited to Hartree-Fock and 
density functional models and UV/visible spectra calculations are 
limited to Hartree-Fock models (CIS for excited states) and density 
functional models (TDDFT for excited states).

Graphical Models

The graphics module provides for data preparation associated with the 
display as surfaces, property maps and slices of molecular orbitals, 
electron densities, spin densities, electrostatic potentials, and local 
ionization potentials. The sizes of electron density surfaces (and 
property maps based on electron density surfaces) may be chosen 
either using a specific value of the density or a value that encloses 
a specific percentage of the total number of electrons. Accessible 
and inaccessible regions may be distinguished for electron density 
surfaces and all property maps based on electron density surfaces.

Spartan’10 displays an orbital energy diagram (up to 12 highest-
occupied molecular orbitals and the 2 lowest-unoccupied molecular 
orbitals). Molecular orbital graphics may be generated on-the-fly, 
given that a wavefunction is available.

Similarity Analysis

The similarity analysis module evaluates and quantifies the extent to 
which molecules are similar based either on selected atomic centers  
(structure) or on selected chemical function descriptors (CFD’s). In 
addition, it quantifies the degree of fit of a molecule into a chemical 
environment (a pharmacophore). Similarity analyses are carried out 
between one or more molecules or pharmacophores in a document 
(the template) and one or more molecules or pharmacophores in one 
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1. For a general discussion and assessment of the techniques and methods available in Spartan, 
see: W.J. Hehre, A Guide to Molecular Mechanics and Quantum Chemical Calculations, 
Wavefunction, Inc., Irvine, CA 2003. This is available as a PDF under the Help menu.

2. For a review of the quantum chemical methods utilized in Spartan (except for semi-empirical 
methods) with emphasis on recent developments, see: Y. Shao, L.F. Molnar, Y. Jung, J. 
Kussmann, C. Ochsenfeld, S.T. Brown, A.T.B. Gilbert, L.V. Slipchenko, S.V. Levchenko, 
D.P. O’Neill, R.A. DiStasio Jr., R.C. Lochan, T. Wang, G.J.O. Beran, N.A. Besley, J.M. 
Herbert, C.Y. Lin, T. Van Voorhis, S.H. Chien, A. Sodt, R.P. Steele, V.A. Rassolov, P.E. 
Maslen, P.P. Korambath, R.D. Adamson, B. Austin, J. Baker, E.F.C. Byrd, H. Dachsel, R.J. 
Doerksen, A. Dreuw, B.D. Dunietz, A.D. Dutoi, T.R. Furlani, S.R. Gwaltney,  A. Heyden, 
S. Hirata, C-P. Hsu, G. Kedziora, R.Z. Khalliulin, P. Klunzinger, A.M. Lee, M.S. Lee, W.Z. 
Liang, I. Lotan, N. Nair, B. Peters, E.I. Proynov, P.A. Pieniazek, Y.M. Rhee, J. Ritchie, E. 
Rosta, C.D. Sherrill, A.C. Simmonett, J.E. Subotnik, H.L. Woodcock III, W. Zhang, A.T. Bell, 
A.K. Chakraborty, D.M. Chipman, F.J. Keil, A.Warshel, W.J. Hehre, H.F. Schaefer, J. Kong, 
A.I. Krylov, P.M.W. Gill and M. Head-Gordon, Phys. Chem. Chem. Phys., 8, 3172 (2006).

3. For an older account see: W.J. Hehre, L. Radom, P.v.R. Schleyer and J.A. Pople, Ab Initio 
Molecular Orbital Theory, Wiley, New York, 1986.

4. W.S. Ohlinger, P.E. Klunzinger, B.J. Deppmeier, W.J. Hehre; J. Phys. Chem. A., 113, 10, 2165 (2009).
5. C.C. Chambers, G.D. Hawkins, C.J. Cramer and D.G. Truhlar, J. Phys. Chem., 100, 16385 (1996).
6. A.V. Marenich, R.M. Olsen, C.P. Kelly, C.J. Cramer and D.G. Truhlar, J. Chem. Theory 

Comput., 3, 2011 (2007).

or more documents (the library). Molecules in the library (only) may 
either correspond to single conformers or to collections of diverse 
conformers.
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Appendix C
Menus

Spartan Screen

File

New Brings up a model kit for molecule building 
or substitution

Open... Opens (imports) a molecule or set of molecules
Close Closes a molecule or set of molecules
Save Saves (exports) a molecule  
Save As... Saves a molecule as a Spartan document 

under a user-specified name; creates files 
for use in the Spartan Molecular Database, 
Spartan Reaction Database, Spartan Infrared 
Database and Spartan Spectra and Properties 
Database

New Molecule Adds a molecule to an existing list; brings 
up a model kit for molecule building or 
substitution

Delete Molecule Deletes a molecule (or molecules) from a list
Append Molecule(s)... Appends molecules to an existing list
Access PDB Online... Accesses the online Protein Data Bank (PDB)
Print... Prints on-screen display; also prints contents 

of output window and the Spreadsheet 
Embedded Data Associates external files with a Spartan 

document, either at molecule or document 
level (or both)

Start/Stop QuickTime
Recording Starts and stops QuickTime recording of 

contents of main Spartan screen (only)
Exit Exits Spartan
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Edit

Undo Undoes previous operations
Cut Moves the current molecule or contents of the 

selection box to the clipboard
Copy Copies the current molecule or contents of 

the selection box to the clipboard
Paste Pastes contents of the clipboard to the screen
Select All Selects all atoms in the selected molecule
Find... Locates a text string in the output dialog or 

an on-screen molecular fragment
Find Next Locates next occurrence of a text string or 

molecular fragment
Center Centers the molecule on screen; applies to all 

molecules in a document
Clear Clears the selected molecule

Model  

Wire Displays structure as wire-frame model 
Ball and Wire Displays structure as ball-and-wire model
Tube Displays structure as tube model
Ball and Spoke Displays structure as ball-and-spoke model
Space Filling Displays structure as space-filling model
Line Displays structure as a line drawing
Hide Hides structure model from view
Global Model Applies model type and labels of current 

molecule to all molecules in the document
Coupled Couples motions of all molecules in the 

document
Hydrogens Toggles hydrogens on and off
Labels Toggles labels on and off
Ribbons Toggles ribbons on and off
Ramachandran Plot Display a Ramachandran plot for a protein 

that has been brought in from the Protein Data 
Bank (PDB)
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Hydrogen Bonds Toggles hydrogen bonds on and off
CFD’s Toggles chemical function descriptors 

(hydrophobes, hydrogen-bond donors/
acceptors, positive/negative centers) on and 
off

Configure... Labels atoms, bonds, etc., provides information 
about polypeptides/polynucleotides residues 
and designates ribbon displays

Geometry

Measure Distance Displays and/or sets bond distance
Measure Angle  Displays and/or sets bond angle
Measure Dihedral Displays and/or sets dihedral angle
Freeze Center Freezes selected atomic positions
Set Torsions Selects bond rings for conformational searching
Set Similarity Centers Identifies atoms /CFD’s for similarity analyses
Constrain Distance Constrains bond distance
Constrain Angle Constrains bond angle
Constrain Dihedral Constrains dihedral angle
Define Point Defines a point as a geometric mean of a set 

of atoms; defines ligand point as a position 
that is perpendicular to the centroid of a plane 
made by three or more atoms

Define Plane Defines a plane made by three or more atoms
Define CFD Defines the location of a CFD
Align Aligns molecules in a document according to 

selected atoms, structure, or CFD’s

Build

View Removes the model kit (unless designated for 
permanent display)

Add Fragment Brings up a model kit that contains libraries 
of atomic fragments, functional groups, 
rings,  ligands and substituents; accesses 
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user-defined libraries; provides access to 
ChemDraw (NAL, NAM)

Delete  Deletes atoms, bonds, points, planes, etc.
Make Bond Makes bonds between free valences or atoms
Break Bond Breaks a bond
Minimize Performs energy minimization using MMFF 

molecular mechanics

Setup

Calculations... Sets up molecular mechanics and quantum 
chemical calculations and similarity analyses; 
specifies calculation of IR, NMR and UV/vis 
spectra

Surfaces Sets up generation of and displays graphical 
surfaces

Submit Submits job to the execution queue

Display

Output Displays text output
Properties  Displays molecule ,  bond and atom 

properties as well as information about 
CFD’s, geometrical constraints, graphical 
surfaces, plots (including spectral plots) and 
statistical analyses

Orbital Energies Displays an orbital energy diagram and allows 
on-the-fly generation and display of molecular 
orbitals 

Surfaces Sets up generation of and displays graphical 
surfaces (same as entry in Setup menu)

Spectra Displays IR, Raman, NMR and/or UV/visible 
spectra, animates vibrational modes (IR and 
Raman), and accesses on-line experimental 
spectral databases; fits calculated spectra to 
experimental spectra and (for IR and Raman) 
to reference spectrum
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Formulas Constructs expressions for use in spreadsheet 
and database searching/mining operations

Spreadsheet Displays spreadsheet
Plots... Creates plots from the data in the spreadsheet
Similarities Displays results of similarity analyses
Reactions Calculates reaction (activation) energies using 

data either from current document or from the 
Spartan Molecular Database

Search

Define Structure Query Add growth points to a structure defining an 
underlying substructure

Define Reaction Query Add curly arrows to structure query (the 
reactant) in order to relate it to the product of 
a chemical reaction or to the transition state 
leading to that product

Open/Close Databases Performs substructure search on Cambridge 
Structural Database (CSD), Spartan Molecular 
Database (SMD) and Spartan Reaction 
Database (SRD); performs spectral search 
of the Spartan Infrared Database (SIRD)

Guess Transition State Provides transition-state guess based on 
reaction database or, lacking a database 
entry, based on linear synchronous transit

Identify Tautomers Identifies tautomers
Extract Ligands Extracts ligands and pharmacophores based 

on protein-ligand binding from PDB files

Options

Preferences... Sets various run-time and labeling preferences 
and specifies execution preferences and run-
time queue; invokes parallel calculation; sets 
up icon displays; establishes url’s for on-line 
access
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Colors Sets screen and model colors
Fonts... Sets fonts for labels and plot displays
Graphics Fonts... Sets fonts for graphical displays
Monitor Monitors and allows for killing executing jobs 

and bypassing queue to start jobs
Calculator Pocket calculator
Model Kit Keeps a model kit on screen
File, Build, Geometry, Toggles toolbars on and off
Search Toolbar 
Cascade Arranges open windows in a cascade
Tile Arranges open windows as tiles (NAL, NAM)

Activities

Tutorials Brings up Spartan’10 tutorials
Topics Brings up selection of topics relevant to 

calculations performed in Spartan.
Problems Brings up a selection of problems suitable for 

Spartan’10
Look up in Wikipedia Brings up an html page pointing to a Wikipedia 

page

Help

Help Provides information about the performance 
and timing of computational methods in 
Spartan; provides information about using 
graphical models in Spartan; bulletin board 
for FAQs about Spartan

About... Provides program version information for 
citation and support
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Contextual

Main Screen

Copy Copies selected molecule to the clipboard
Paste  Pastes the contents of the clipboard into the 

selected document
Delete Selected Deletes selected molecule from document
Properties Brings up the Molecular Properties dialog

Spreadsheet

Copy Copies text of selected cell or cells to the 
clipboard. If leftmost cell (or cells) selected, 
copies molecule(s) to the clipboard

Paste  Pastes the contents of the clipboard into 
selected cells. If leftmost cell (or cells) 
selected, either pastes text or molecule(s) 
depending on menu choice

Add Brings up the Add dialog (spreadsheet) 
for adding calculated quantities into the 
spreadsheet 

Sort Sorts the column from low to high. Pressing 
the Shift key prior to menu selection sorts 
from high to low

Format Selected Formats selected cell(s), selected column(s) 
if selection is in a header cell, or entire 
spreadsheet if selection is header cell of 
leftmost column

Delete Selected Deletes selected molecule(s) from document
Append Appends the contents of Spartan document(s) 

to the spreadsheet (corresponding to the 
selected document)

Rename Selected Rename selected molecule(s) with names in the
Using SMD/SSPD Spartan Molecular Database or Spartan 

Spectra and Properties Database; appears only 
when leftmost cell(s) selected
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Properties Brings up the Molecular Properties dialog

Substituent Model Kit

Copy Copies selected molecule(s) from a custom 
library onto the clipboard

Paste  Pastes molecule(s) from the clipboard into a 
custom library

Delete Deletes selected molecule(s) from the custom 
library

Append Appends the contents of Spartan document(s) 
to the custom library; brings up a file browser

Reactions

Copy Copies selected text to the clipboard
Print  Prints selected text

Output Window

Copy Copies selected text to the clipboard
Print  Prints selected text

Database
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Appendix D
Commonly-Used 
Program Options

This appendix describes a number of commonly-used program 
options. These are specified using keywords input into the Options 
box in the Calculations dialog (Setup menu). In addition to the 
above, any method, functional or combination of functionals and/
or basis set supported in Spartan (and not included explicitly in the 
menus) may be typed into the Options box. For example, typing 
EDF2 6-311G(2df,2pd) will result in density functional calculation 
using the EDF2 functional and the 6-311G(2df,2pd) basis set. (See 
Chapter 17 for further details.)

Keywords are case insensitive. An equals sign (=) separates a 
keyword from its integer, real or character string value. Keywords 
may either be single words or expressions. Keyword=N indicates 
an integer argument, keyword=C indicates a character argument, 
and keyword=F indicates a floating point argument. Real values 
can optionally include an eNN or e-NN (floating point power of ten). 
Default values for keywords are indicated in bold, and alternative 
values in italics.

Conformational Search
 keyword value description

 SearchMethod C conformational searching method employed; 
overrides default choice which depends on 
complexity of system may be overridden with 
one of the following:

   Systematic use systematic method
   MonteCarlo use Monte-Carlo method
   Sparse use systematic method but 

randomly eliminate conformers 
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to stay within set conformer 
limits. Used in conformer library 
generation.

 MaxEnergy F sets the maximum energy (in kJ/mol) at which 
a conformer will be kept to (minimum energy 
+ F), where minimum energy is the energy of 
the lowest energy conformer encountered at that 
point in the search; default is 40 kJ/mol

 StartTemperature F sets initial temperature (in K) for a Monte 
Carlo search (only) to F; high temperatures will 
result in the molecule further exploring global 
space, while low temperatures will result in the 
molecule further exploring local space; default 
is 5000K

Similarity Analysis
 keyword value description

 SingleEnantiomer – Limits similarity analysis to the enantiomer actually 
in specified library documents. The default is to 
consider both enantiomers

 QuitSimilarity N Quit similarity analysis involving a conformer 
list (in the graphical user interface) and/or one or 
more conformer libraries when N good matches 
have been identified; default is 1

 QuitCriterion F R2 criterion for a good match; default is 0.9

Geometry Optimization
 keyword value description

 GeometryCycle N set maximum number of equilibrium and 
transition-state geometry optimization cycles to 
N; default is number of independent variables 
+20 for equilibrium geometry optimization 
and 3x number of independent variables for 
transition-state geometry optimization

 GradientTolerance F set convergence criterion in equilibrium and 
transition-state) geometry optimization for the 
maximum gradient component (in hartrees/bohr) 
to F; default is 3 x 10-4 
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 DistanceTolerance F set convergence criterion in equilibrium and 
transition-state geometry optimization for the 
maximum change in a bond length (in Å) to F; 
default is 1.2 x 10-3

 Hess C Choose Hessian (matrix of second derivatives) 
for start of geometry (transition-state geometry) 
optimization (in the absence of a Hessian from 
a previous calculation, the default is MMFF 
molecular mechanics for geometry optimization 
and PM3 semi-empirical for transition-state 
geometry optimization; may be overridden with 
one of the following:

   unit unit matrix
   MMFF MMFF molecular mechanics 

AM1 AM1 semi-empirical
   STO-3G STO-3G Hartree-Fock
   3-21G 3-21G Hartree-Fock
   6-31G* 6-31G* Hartree-Fock

Molecular Mechanics Calculations
 keyword description

 MMFF94s Use MMFF94s method insted of MMFF94. 
The only significant difference between the two 
is that MMFF94 forces nitrogens attached to 
aromatic rings to be planar (as in aniline). While 
this is widely perceived to be the case, in fact 
the nitrogen in aniline and related molecules are 
pyramidal not planar.

Quantum Chemical Calculations
 keyword value description

 Diis N switch on diis all the time in SCF procedure. N 
is the size of the iterative subspace; it should be 
an integer between 2 and 10; default is 5

 NoDiis  turn off diis SCF convergence accelerator
 ScfCycle N set maximum number of SCF iterations to N; 

default is 50
 Guess C choose initial wavefunction guess; in the absence 

of a guess from a previous calculation, the 
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default is either sad or PM3 depending on the 
calculation type, and may be overridden with 
one of the following:

   core diagonalize the core Hamiltonian
   sad superposition of atomic densities
   PM3 PM3 semi-empirical
 Scf C SCF procedure; default is restricted for closed-

shell systems and unrestricted for open-shell 
systems, either of which may be specified for 
both closed and open-shell systems

 SmallBasis C specifies the small basis set to be used in dual 
basis set calculations. The large basis set is that 
indicated in the menu.

 Core C use of frozen core approximation in Møller-
Plesset and advanced correlated calculations; 
default is frozen which may be changed to 
thawed

 ScfTolerance C control of all tolerances in SCF procedure and 
to affect the precision of the algorithm; default 
is normal which may be changed to high or 
veryhigh

  F set SCF energy convergence criterion (in 
hartrees) to F; default is 1.0 x 10-6

 BigGrid – uses very large grid in density functional 
calculations

 Mix – specifies that α and β HOMO’s in the guess 
wavefunction should be constructed according 
to:

   useful for generating a guess wavefunction for 
singlet diradical

 Exchange E specifies custom exchange functional or 
combination of exchange functionals for density 
functional calculation. See Appendix A for 
details.

HOMOα =
HOMO + LUMO

√2

HOMOβ =
HOMO - LUMO

√2



Appendix D 539

 Correlation C specifies custom correlation functional or 
combination of correlation functionals for 
density functional calculation. See Appendix 
A for details.

 EnergyOnly  skips calculation of the density matrix for an MP2 
energy calculation, reducing the time by 50%

Semi-Empirical Calculations
 keyword value description

 NoAmideFix – turns “off” molecular mechanics amide correction 
in PM3 calculations 

 hh C turns “on” and “off” hydrogen-hydrogen 
repulsion term in PM3 calculations; default is 
on only where transition metals are involved and 
off otherwise

 Polarizability – calculates and prints polarizabilities and 
hyperpolarizabilities

Property and Spectra Calculations
 keyword value description

 NBO C specify details of NBO population analysis; 
default is normal which may be overridden for 
ionic and 3C (three center) systems

 NoElCharge – turns “off” calculation of electrostatic charges
 ElCharge N adjusts size of grid used to calculate charge from 

electrostatic potential; default is 1 point/atomic 
unit

 Temperature F temperature (in K) used in calculation of 
thermodynamic properties; default is 298°K

 TEMPRANGE Fi,Fj,Fk temperature range applied to thermodynamic 
properties when IR frequencies are calculated, 
where i=starting temperature, j=ending 
temperature, and k=increment, all values in K

 Pressure F pressure (in atm) used in calculation of 
thermodynamic properties; default is 1 atm

 Moments – calculates and prints principal moments of 
inertia
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 NoSolvent – turns “off” calculation of aqueous solvation 
energy using SM5.4 model

 Solvent C specifies solvent for SM8 model beyond those 
included in menu. See FAQ (Properties) 
available under Help (Help menu; Chapter 19) 
for a list of available solvents. This will replace 
the menu entry.

 NoAreaVolume – turns “off” calculation of surface area and volume
 MaxPropWeight N sets limit of molecular weight for electrostatic 

charge, solvent and area/volume calculations; 
default is 500 amu

 Polarizability F calculates and prints either static (F not specified) 
or frequency dependent (frequency F in cm-1) 
polarizabilities and hyperpolarizabilities

 FreqScale F scales calculated vibrational frequencies by F; 
default is 1

 NumericalFreq – uses numerical differentiation (of analytical 
gradients) for frequency calculation

 UVstates N specifies number of states to be examined in 
UV/visible spectra calculation; default is 5

 IRCSteps N maximum number of steps allowed in constructing 
IRC; default is 40

 IRCStepSize N maximum step size (in mass-weighted atomic 
units x 100) for IRC; default is 150

 IncludeTriplets  include excited triplet states in a UV spectra 
calculation where the ground state is a singlet. 
Ignore where the ground state is a triplet.

 DropVibs N ignore all vibrational modes with frequencies 
below N cm-1 in calculating thermodynamic 
products

 ClampThermo  do not allow individual vibrational contributions 
to the temperature correction to the enthalpy to 
exceed 1/2 RT, to the entropy to exceed 1/2 R, 
and for the heat capacity to exceed 1/2 R.

 AvgMass  use average mass instead of mass of 
dominant isotope in calculating thermodynamic 
properties
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Miscellaneous and Printing
 keyword value description

 3DPlot – treat dynamic constraints independently (rather 
than in concert). This allows data for 3D (XYZ) 
plot to be collected. Two dynamic constraints 
only.

 Execute C either skip execution (skip) or force execution 
regardless of history (force)

 PrintVibCoords – print coordinates corresponding to normal mode 
vibrational frequencies

 PrintCoords – prints Cartesian coordinates
 PrintLev C print level; default is normal which may be 

changed to verbose
 PrintOrbE – print energies of molecular orbitals
 PruneVirtual N,C keep N virtual orbitals; default is 10; None keeps 

all virtual orbitals
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Appendix E
Units

Geometries

Cartesian coordinates are given in Ångstroms (Å), and in atomic 
units (au).

Bond distances are given in Å and in au. Bond angles and dihedral 
angles are given in degrees (°).

Surface areas, accessible surface areas and polar surface areas are 
available in Å2 and volumes in Å3, and in au2 (au3).

1 Å = 0.1 nm=1.889762 au

Energies, Heats of Formation and Strain Energies, Zero-Point 
Energies, Enthalpies and Gibbs Energies and Entropies

Total energies from Hartree-Fock calculations are available in au, 
kcal/mol, kJ/mol and electron volts (eV).

Experimental heats of formation as well as those from semi-empirical 
calculations and from thermochemical recipes are available in kJ/
mol, au, kcal/mol and eV.

Strain energies from molecular mechanics calculations are available 
in kJ/mol, au, kcal/mol and eV.

Energies, heats of formation and strain energies corrected empirically 
for the effects of aqueous media are given in the same units as the 
corresponding gas-phase quantities.

Zero-point energies, enthalpies and Gibbs energies available in kJ/
mol, kcal/mol and au/mol. Entropies are available in kJ/mol•degree, 
kcal/mol•degree and au/mol•degree. 

Orbital Energies

Orbital energies are available in eV, kcal/mol, kJ/mol and au.
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Energy Conversions

 au kcal/mol kJ/mol eV

1 au - 627.5 2625 27.21
1 kcal/mol 1.593 (-3) - 4.184 4.337 (-2)
1 kJ/mol 3.809 (-4) 2.390 (-1) - 1.036 (-2)
1 eV 3.675 (-2) 23.06 96.49 -
a) exponent follows in parenthesis, e.g., 1.593 (-3) = 1.593 x 10-3

Electron Densities, Spin Densities, Dipole Moments, Charges, 
Electrostatic Potentials and Local Ionization Potentials

Electron densities and spin densities are given in electrons/au3.

Dipole moments are given in debyes.

Atomic charges are given in electrons.

Electrostatic and hydride potentials are given in kJ/mol.

Local ionization potentials are given in eV.

Vibrational Frequencies, Infrared and Raman Intensities

Vibrational frequencies are given in wavenumbers (cm-1). Intensities 
are given relative to the most intense peak.

Chemical Shifts, Coupling Constants

Chemical shifts are given in parts-per-million (ppm) relative to appropriate 
standards: hydrogen, tetramethylsilane; carbon, tetramethylsilane; 
nitrogen, nitromethane; fluorine, fluorotrichloromethane; silicon, 
tetramethylsilane, phosphorous, phosphoric acid. These are available 
for Hartree-Fock, BP, BLYP, B3LYP, EDF1 and EDF2 models with 
the 6-31G*, 6-31+G*, 6-31G**, 6-31+G**, 6-311G, 6-311+G*, 
6-311+G** and 6-311++G** basis sets. Coupling constants are in ppm.

UV/visible Spectra

λmax is given in wavenumbers (cm-1).
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Appendix F
Citation

The proper citation for Spartan’10 is as follows:

Spartan’10
Wavefunction, Inc.

Irvine, CA

Except for molecular mechanics and semi-empirical models, the 
calculation methods used in Spartan have been documented in: Y. 
Shao, L.F. Molnar, Y. Jung, J. Kussmann, C. Ochsenfeld, S.T. Brown, 
A.T.B. Gilbert, L.V. Slipchenko, S.V. Levchenko, D.P. O’Neill, R.A. 
DiStasio Jr., R.C. Lochan, T. Wang, G.J.O. Beran, N.A. Besley, J.M. 
Herbert, C.Y. Lin, T. Van Voorhis, S.H. Chien, A. Sodt, R.P. Steele, 
V.A. Rassolov, P.E. Maslen, P.P. Korambath, R.D. Adamson, B. 
Austin, J. Baker, E.F.C. Byrd, H. Dachsel, R.J. Doerksen, A. Dreuw, 
B.D. Dunietz, A.D. Dutoi, T.R. Furlani, S.R. Gwaltney,  A. Heyden, 
S. Hirata, C-P. Hsu, G. Kedziora, R.Z. Khalliulin, P. Klunzinger, A.M. 
Lee, M.S. Lee, W.Z. Liang, I. Lotan, N. Nair, B. Peters, E.I. Proynov, 
P.A. Pieniazek, Y.M. Rhee, J. Ritchie, E. Rosta, C.D. Sherrill, A.C. 
Simmonett, J.E. Subotnik, H.L. Woodcock III, W. Zhang, A.T. Bell, 
A.K. Chakraborty, D.M. Chipman, F.J. Keil, A.Warshel, W.J. Hehre, 
H.F. Schaefer, J. Kong, A.I. Krylov, P.M.W. Gill and M. Head-Gordon, 
Phys. Chem. Chem. Phys., 8, 3172 (2006).

A discussion and assessment of commonly-used calculation methods 
is found in: W.J. Hehre, A Guide to Molecular Mechanics and 
Quantum Chemical Calculations, Wavefunction, Inc., Irvine, CA, 
2003. This is available as a PDF under the Help menu.
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Appendix G
Installing the  

Cambridge Structural Database
Access to the Cambridge Structural Database (CSD) from Spartan 
should be automatic, following successful installation of the ConQuest 
program (supplied with CSD) according to the detailed instructions 
provided. If access is denied, the following steps need to be taken:

Windows:

(i) Click on Config near the bottom right of the dialog. This brings 
up the Configure CSD Interface dialog,

 
	 This	will	list	any	files	which	are	missing.	Click on Setup Paths 

at the bottom of the dialog to bring up the CSD File Paths 
dialog,

 This dialog may show one or more red lights.

(ii)	 Make	certain	that	the	path	to	ConQuest	is	correctly	specified.	The	
most common error will be that the version number is not current. 
(At the time of writing, the current version is 1.12.) You can get 
the current version number from your installation of ConQuest.
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(iii)	 Given	the	proper	version	number	for	ConQuest,	update	the	file	
names in the boxes below MSK file, TCD file, IND file and INV 
file.	You	can	get	the	current	file	names	from	your	installation	of	
ConQuest.	As	you	enter	the	current	file	names,	the	red	lights	turn	
to green lights. When all lights are green, click on OK to dismiss 
the CSD File Paths dialog and then click on OK to dismiss the 
Configure CSD dialog.

Linux:

(i) CSD HOME	must	be	defined	in	order	for	Spartan to locate the 
CSD program.

(ii) Please refer to the Cambridge Structural Database System 
Release and Installation Notes for instructions on setting up 
CSD HOME.
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Appendix H
Constructing Custom 

Databases
Custom collections may be added to SMD, SIRD and SRD. These 
may either include the geometry, energy (heat of formation, strain 
energy), HOMO and LUMO energies, dipole moment, atomic charges, 
chemical shifts and vibrational frequencies obtained from quantum 
chemical calculations, or (for SMD and SIRD only) conformer 
libraries generated from molecular mechanics calculations. Entries for 
SRD (transition states) need to derive from Spartan’s transition state 
guessing facility (Guess Transition States under the Search menu; 
Chapter 19) in order that they include the original set of reaction arrows.

Molecules (or lists of molecules) that are to be placed in a user 
database are first saved using Save As under the File menu with Save 
as type set to Spartan Database. This results in two files, a .spentry 
and a .spindex file for each molecule (or list). These should then be 
put in a single directory, the path to which must be entered into the 
Paths Preferences dialog under Preferences... in the Options menu 
(Chapter 20).

Note that it is important to specify a label for each molecule. Label 
specification is done either in the Molecule Properties dialog 
(see Properties under the Display menu in Chapter 18) or in the 
spreadsheet (see Spreadsheet under the Display menu in Chapter 18).
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Appendix I
Pharmacophore Input

The following file format is used for input of a pharmacophore 
(illustrated for a pharmacophore with four hydrophobes and one 
positive ionizable center) :

Blank line
Blank line
Blank line 
ENDCART
BEGINCFD
HPHOBE|RING_AROM 8.050 -4.180 -0.400 0 2.000 1.000 1
HPHOBE|RING_AROM 9.630 -0.640 -3.590 1 2.000 1.000 1
HPHOBE|RING_AROM 10.280 -0.380 3.200 2 2.000 1.000 1
HPHOBE|RING_AROM 8.130 -2.300 4.330 3 2.000 1.000 1
POS 14.370 -1.700 0.280 4 3.000 1.000 1
ENDCFD

The lines between BEGINCFD and ENDCFD define the individual 
pharmacophore elements (one line/element):

type1|type2… (| separates types for multiple definitions), Cartesian 
(X,Y,Z) coordinates (in Angstroms), unique number, radius of 
element (in Angstroms), weight of element in fit, use the element in 
fit (1) or ignore the element (5)

The following element types are available:
HPHOBE hydrophobe
RING_AROM aromatic ring
POS positive ionizable center
NEG negative ionizable center
HBA_CENTER hydrogen bond acceptor
HBD_CENTER hydrogen bond donor
EXCL_VOL      excluded volume
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Appendix J
Input of Experimental Spectra

The databases of infrared and UV/visible spectra accessible on-
line from Spartan are in JCAMP format. Specification of both and 
examples can be found at the NIST website (NIST.gov).

The database of 13C spectra is in CML (Chemical Markup Language) 
format. A description may be found at http://www.ch.ic.ac.uk/omf/
cml. A sample file is provided below.
<?xml version="1.0" encoding="ISO-8859-1"?>
<cml>
 <spectrum type="NMR">
  <metadataList>
   <metadata name="nmr:OBSERVENUCLEUS" content="13C"/>
  </metadataList>
  <peakList>
   <peak xValue="125.1399993896484" peakHeight="0.458" />
   <peak xValue="128.4499969482422" peakHeight="0.558" />
   <peak xValue="129.0099945068359" peakHeight="0.658" />
   <peak xValue="21.64999961853027" peakHeight="0.758" />
   <peak xValue="137.8399963378906" peakHeight="0.858" />
  </peakList>
 </spectrum>
</cml>Blank line

This contains five shifts (xValue) and five associated intensities 
(peakHeight).
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Appendix K
Installing a Network HASP

Multiple licenses of Spartan’10 can be licensed with a network key 
that is installed on a computer that can act as a server. Installation is 
required for both the server and client computers.

On the Server:

1.  Install Sentinel HASP Run-time from one of the following two 
places:

 a. C: \Program Fi les \Wavefunct ion\Spartan10vXXX\
HASPUserSetup.exe

 b. http://www3.safenet-inc.com/support/hasp-srm/enduser.aspx

2. Plug in the red HASP key and ensure the light is on and NOT blinking.

3. Ensure the key can be seen by the network by navigating a web 
browser to http://localhost:1947 and clicking on the “HASP Keys” 
tab in the menu on the left. In the HASP Keys window, under the 
Actions column should be a “Products” button. Click this to open 
the window and confirm the software is what you ordered.

On Each Client Computer:

1. During installation of Spartan’10 select “Local HASP” and 
Sentinel HASP Run-time will be installed. It can also be installed 
from the links listed in the section above.

2. If client machines are on the same subnet as the license server, 
installation is complete. If clients are on a separate subnet or you’re 
having difficulty obtaining a license, see next step.

3. When the license server and client computers are on separate 
subnets, you must enter the IP address of the license server in 
the “Specify Search Parameters” field on the “Access to Remote 
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License Managers” tab. If the client computers are unable to 
obtain a license, navigate a web browser to http://localhost:1947 
and select “Configuration” from the menu on the left. Under the 
“Access to Remote License Managers” tab make sure “Allow 
Remote Access to Remote Licenses” is checked, along with 
“Aggressive Search for Remote Licenses”.

On a Macintosh:

It is normal to get a “server not found” on the first couple of 
attempts.  It may take the HASP drivers several minutes to perform 
a retry cycle and make a successful initial connection to the remote 
license server, especially if the server is on a different subnet. You 
may click “Next” in the Spartan’10 licensing window periodically 
(wait several seconds between attempts!) until the “Licensing was 
successful” window appears.

Also, if you leave the <http://localhost:1947> web browser window 
open, you can monitor the progress of the connection to the remote 
server. Click “HASP Keys” in the left sidebar- when you see a line in 
the table referencing the remote server you entered in step 4 (instead 
of “table empty”), the connection should be ready to retrieve a 
license.

Need additional help? Visit the Windows or Macintosh FAQs, www.
wavefun.com, support section.
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Appendix L
NMR Chemical Shift 

Standards
Chemical shifts are given in parts-per-million (ppm) relative to 
standard absolute shifts for H, C, Si, N, F, and P. The following 
molecules were used for these standards: tetramethylsilane for H, C, 
and Si; nitromethane for N; flurotrichloromethane for F; phosphoric 
acid for P. Relative shifts for the above elements are available for 
Hartree-Fock, BP, BLYP, B3LYP, EDF1 and EDF2 models with 
the 6-31G*, 6-31+G*, 6-31G**, 6-31+G**, 6-311G, 6-311+G*, 
6-311+G** and 6-311++G** basis sets. Chemical shifts for other 
elements, or originating from computational models other than those 
specified above will be reported as absolute shifts. Calculated absolute 
chemical shifts used for generation of relative shifts are provided in 
tables L1-L6 (below).

Table L-1: Hartree-Fock Absolute Shifts

Hartree-Fock H Shift C Shift Si Shift N Shift F Shift P Shift

STO-3G 33.75 249.43 578.63 -99.31 368.54 499.28
3-21G 33.62 213.20 509.04 -251.19 279.80 502.35
6-31G 33.68 208.21 484.52 -276.20 222.53 373.95
6-31G* 32.90 201.72 450.15 -160.15 269.37 423.69
6-31+G* 32.82 201.84 446.67 -159.56 261.09 415.36
6-31G** 32.33 203.15 448.40 -160.31 269.46 423.18
6-31+G** 32.27 203.07 444.64 -159.71 261.08 415.04
6-311G* 32.83 195.90 395.63 -177.34 246.96 368.32
6-311+G* 32.78 195.85 395.63 -184.59 246.58 366.51
6-311G** 32.45 195.84 396.77 -177.72 247.09 366.86
6-311+G** 32.45 195.84 396.78 -184.74 246.59 365.63
6-311++G** 32.44 196.11 395.36 -184.93 246.59 365.82
6-311+G(2d,p) 32.43 194.60 385.75 -182.29 246.86 360.08
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Table L-2: BP Absolute Shifts

DFT BP H Shift C Shift Si Shift N Shift F Shift P Shift

STO-3G 32.51 228.67 497.36 82.76 199.05 429.14
3-21G(*) 32.26 200.10 458.99 -91.21 125.28 415.00
6-31G 32.31 192.40 420.60 -131.18 67.09 280.33
6-31G* 31.75 188.06 406.39 -97.02 142.42 354.67
6-31+G* 31.63 188.69 401.96 -98.81 139.93 348.16
6-31G** 31.35 190.01 405.10 -96.82 142.47 353.99
6-31+G** 31.24 190.64 397.97 -98.60 139.86 347.91
6-311G* 31.86 182.93 341.14 -121.41 115.79 282.11
6-311+G* 31.81 182.60 339.59 -129.46 116.87 282.59
6-311G** 31.58 182.86 344.64 -121.50 115.77 280.59
6-311+G** 31.55 182.27 331.33 -129.33 116.83 281.43
6-311++G** 31.53 182.78 335.01 -129.41 116.85 280.91
6-311+G(2d,p) 31.51 181.96 328.71 -131.01 121.34 278.31

Table L-3: BLYP Absolute Shifts

DFT BLYP H Shift C Shift Si Shift N Shift F Shift P Shift

STO-3G 32.56 226.40 494.72 72.65 189.07 416.05
3-21G(*) 32.43 196.65 453.33 -103.69 115.48 408.58
6-31G 32.44 188.17 415.17 -144.48 54.82 268.06
6-31G* 31.89 184.00 402.47 -108.00 134.31 351.31
6-31+G* 31.76 185.08 397.77 -111.60 130.36 344.57
6-31G** 31.49 186.28 402.25 -107.73 134.30 350.90
6-31+G** 31.38 187.38 392.99 -111.40 130.28 344.08
6-311G* 32.04 179.01 328.60 -136.04 104.77 270.09
6-311+G* 32.01 178.66 321.18 -145.29 107.86 268.61
6-311G** 31.78 179.04 331.95 -136.14 104.42 268.70
6-311+G** 31.74 178.38 323.18 -145.33 107.84 267.70
6-311++G** 31.73 178.76 323.24 -145.10 107.99 268.84
6-311+G(2d,p) 31.71 178.23 316.64 -146.87 110.39 267.59
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Table L-4: B3LYP Absolute Shifts

DFT B3LYP H Shift C Shift Si Shift N Shift F Shift P Shift

STO-3G 32.85 233.15 514.53 47.28 243.04 445.12
3-21G(*) 32.76 201.74 467.32 -127.61 169.62 436.23
6-31G 32.78 194.32 432.37 -166.13 112.81 297.20
6-31G* 32.18 189.64 413.69 -117.78 180.14 370.93
6-31+G* 32.06 190.69 408.24 -120.16 173.50 362.45
6-31G** 31.75 191.73 411.90 -117.69 180.31 369.52
6-31+G** 31.65 192.51 405.92 -119.98 173.46 361.87
6-311G* 32.29 184.22 338.75 -143.78 152.21 294.95
6-311+G* 32.25 184.02 338.30 -152.42 153.86 293.26
6-311G** 32.00 184.39 340.32 -143.96 152.18 293.07
6-311+G** 31.98 183.89 339.26 -152.42 153.83 292.10
6-311++G** 31.97 184.04 338.23 -152.48 153.84 292.23
6-311+G(2d,p) 31.94 183.30 328.27 -153.23 156.59 289.07

Table L-5: EDF1 Absolute Shifts

DFT EDF1 H Shift C Shift Si Shift N Shift F Shift P Shift

STO-3G 32.59 228.15 503.09 83.02 202.43 436.41
3-21G(*) 32.54 200.17 457.32 -88.49 133.22 419.76
6-31G 32.59 192.73 417.71 -127.37 75.28 283.76
6-31G* 32.02 188.19 402.88 -93.22 150.05 355.97
6-31+G* 31.91 189.08 398.06 -94.63 147.59 348.68
6-31G** 31.61 190.38 402.17 -93.05 149.93 355.26
6-31+G** 31.51 191.16 394.11 -94.38 147.68 348.45
6-311G* 32.11 183.62 344.87 -115.65 125.33 290.57
6-311+G* 32.08 183.24 343.95 -123.52 126.45 290.81
6-311G** 31.83 183.63 348.73 -115.75 125.27 289.19
6-311+G** 31.80 183.12 340.18 -123.37 126.51 289.67
6-311++G** 31.79 183.59 339.39 -123.18 126.51 289.15
6-311+G(2d,p) 31.76 182.85 332.45 -125.00 131.18 286.59
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Table L-6: EDF2 Absolute Shifts

DFT EDF2 H Shift C Shift Si Shift N Shift F Shift P Shift

STO-3G 32.81 233.92 514.31 56.08 243.30 451.91
3-21G(*) 32.69 202.36 468.45 -116.04 171.72 438.44
6-31G 32.73 195.08 431.57 -154.86 114.27 303.65
6-31G* 32.13 190.37 412.47 -110.60 180.76 368.82
6-31+G* 32.01 191.37 406.85 -112.66 175.50 360.99
6-31G** 31.71 192.44 410.69 -110.45 180.83 368.08
6-31+G** 31.60 193.19 404.63 -112.47 175.35 360.36
6-311G* 32.24 184.75 337.33 -136.98 153.88 294.65
6-311+G* 32.20 184.53 336.81 -145.16 155.29 293.22
6-311G** 31.96 184.90 338.92 -137.08 154.05 292.80
6-311+G** 31.93 184.39 337.76 -145.18 155.36 291.93
6-311++G** 31.92 184.54 336.89 -145.24 155.37 292.10
6-311+G(2d,p) 31.89 183.77 326.52 -146.02 158.36 288.31

13C Chemical Shifts calculated with B3LYP or EDF2 density 
functional models include additional empirical corrections for sp3, 
sp2, aromatic, and sp carbons. For correction scheme details, please 
refer to the Calculating NMR Spectra section in Appendix A.
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Glossary and
Glossary-Based Index
This glossary addresses nomenclature (“jargon”) used throughout the 
guide and, more generally, in applications of molecular modeling. 
Some of the terms, such as Basis Set, will be familiar to the modeling 
community but foreign to the broader community, while other terms, 
such as Kinetic Product, may be foreign to the modeling community 
and familiar to the broader community. Terms such as Entropy should 
be familiar to all and are generally avoided. A number of terms from 
both categories have been defined “in the context” of their use in 
molecular modeling rather than more generally. For example, the 
term NOE has been defined in terms of providing information about 
which pairs of (non-bonded) atoms are inside a specified cutoff 
distance (information that is useful in the restricting the limits of  a 
conformational search) rather than the nature of the phenomenon 
which produces this information.

References are provided following each entry. References in bold 
correspond to the first page of a tutorial.

3-21G. A Split-Valence Basis Set in which each Core Basis 
Function is written in terms of three Gaussians, and each Valence 
Basis Function is split into two parts, written in terms of two and 
one Gaussians, respectively. 3-21G basis sets have been determined 
to yield the lowest total Hartree-Fock Energies for atoms. The 
nomenclature 3-21G implies use of the 3-21G(*) basis set on 
molecules incorporating second-row (and heavier) main-group 
elements. [179,283,521]

3-21G(*). The 3-21G Basis Set supplemented by d-type Gaussians 
for each second-row and heavier main-group elements only. This is 
required in order to get good equilibrium geometries. Without the 
added functions, the 3-21G basis set is not recommended for use 
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for molecules incorporating second-row (and heavier) main-group 
elements.

6-31G. A Split-Valence Basis Set in which each Core Basis 
Function is written in terms of six Gaussians, and each Valence 
Basis Function is split into two parts, written in terms of three and 
one Gaussians, respectively. 6-31G basis sets have been determined 
to yield the lowest total Hartree-Fock Energies for atoms. The 
6-31G basis set is rarely used alone but rather is supplemented by one 
or more sets of Polarization Functions and/or Diffuse Functions. 
[521]

6-31G*, 6-31G**. The 6-31G Basis Set in which non-hydrogen 
atoms are supplemented by d-type Gaussians and (for 6-31G**) 
hydrogen atoms are supplemented by p-type Gaussians (Polarization 
Functions). 6-31G* and 6-31G** are Polarization Basis Sets 
[81,283,521].

6-31+G*, 6-31+G**. Basis Sets that are identical to 6-31G* and  
6-31G** except that all non-hydrogen atoms are supplemented by 
diffuse s and p-type Gaussians (Diffuse Functions). 6-31+G* and 
6-31+G** are supplemented Polarization Basis Sets.

6-311G. A Split-Valence Basis Set in which each Core Basis 
Function is written in terms of six Gaussians, and each Valence 
Basis Function is split into three parts, written in terms of three, 
one and one Gaussians, respectively. 6-311G basis sets have been 
determined to yield the lowest total MP2 Energies for atoms. The 
6-311G basis set is rarely used alone but rather is supplemented 
by one or more sets of Polarization Functions and/or Diffuse 
Functions.

6-311G*, 6-311G**. The 6-311G Basis Set in which non-hydrogen 
atoms are supplemented by d-type Gaussians and (for 6-311G**) 
hydrogen atoms are supplemented by p-type Gaussians (Polarization 
Functions). 6-311G* and 6-311G** are Polarization Basis Sets.

6-311+G*, 6-311+G**. Basis Sets that are identical to 6-311G* 
and 6-311G** except that non-hydrogen atoms are supplemented 
by diffuse s and p-type Gaussians (Diffuse Functions). 6-311+G* 
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and 6-311+G** are supplemented Polarization Basis Sets.

Ab Initio Models. The general term used to describe methods 
seeking approximate solutions to the many-electron Schrödinger 
Equation, but which do not involve empirical parameters. Ab initio 
models include Hartree-Fock Models, Møller-Plesset Models and 
Density Functional Models. [440]

Acidity. The energy required to break an XH bond into X- and H+, 
that is, to undergo Heterolytic Bond Dissociation. Acidities in the 
gas phase are very large positive numbers (producing isolated ions 
is highly unfavorable), whereas they are much smaller (and of either 
sign) in solution. [92]

Activation Energy. The energy of a Transition State above that of 
reactants. Activation energy is related to reaction rate by way of the 
Arrhenius Equation. [125,454]

AM1. Austin Method 1. A Semi-Empirical Model. [129,517]

Anharmonic Frequency Correction. Non-quadratic contributions 
to a Vibrational Frequency. Because calculated frequencies 
are harmonic, that is, assume that the potential is quadratic, they 
are typically ~5% larger than measured frequencies, which 
include anharmonic corrections. Frequencies can be corrected for 
anharmonicity but, due to high computational cost, this is seldom 
done for any but very small molecules. [471]

Anion. An atom or molecule with a Total Charge of -1. [129]

Antibonding Molecular Orbital. A Molecular Orbital which is 
antibonding between particular atomic centers. The opposite is a 
Bonding Molecular Orbital. [491]

Arrhenius Equation. An equation governing the rate of a chemical 
reaction as a function of the Activation Energy and the temperature. 
[454]

Atomic Orbital. A Basis Function centered on an atom. Atomic 
orbitals typically take on the form of the solutions to the hydrogen 
atom (s, p, d, f... type orbitals). [489]
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Atomic Units. The set of units which remove all of the constants 
from inside the Schrödinger Equation. The Bohr is the atomic unit 
of length and the Hartree is the atomic unit of energy. [543]

Atomization Energy. The energy of dissociation of an atom or 
molecule into separated nuclei and electrons. This is another term 
for Total Energy. [452]

B3LYP Model. A Hybrid Density Functional Model which 
improves on the Local Density Model by accounting explicitly 
for non-uniformity in electron distributions. It incorporates the 
Exchange Energy from the Hartree-Fock Model and involves 
three adjustable parameters. The B3LYP model is perhaps the most 
widely used density functional model and provides a solid account 
of equilibrium geometries (including the geometries of molecules 
incorporating transition metals), vibrational frequencies and reaction 
energies. [84,519]

Basicity. The energy gained from adding a proton to an atom 
or molecule. Basiscities in the gas phase are very large negative 
numbers, whereas they are much smaller (and of either sign) in 
solution. [300]

Basis Functions. Functions usually centered on atoms which are 
linearly combined to make up the set of Molecular Orbitals. Except 
for Semi-Empirical Models where basis functions are Slater type, 
basis functions are Gaussian type. [435]

Basis Set. The entire collection of Basis Functions. [287,435,521]

Becke-Lee-Yang-Parr Model. See BLYP Model, B3LYP Model. 
[291,519]

Becke-Perdew Model. See BP Model. [291,519]

BLYP Model. A Density Functional Model which improves on the 
Local Density Model by accounting explicitly for non-uniformity 
in electron distributions. [291,519]

Bohr. The Atomic Unit of length. 1 bohr = 0.529167Å.

Boltzmann Distribution. The equilibrium distribution of products 
in a Thermodynamically-Controlled Reaction. A special (and very 
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important) case involves the equilibrium distribution of Conformers 
of a flexible molecule. [98]

Boltzmann Equation. The equation governing the distribution of 
products in Thermodynamically-Controlled Reaction. [121,454]

Bonding Molecular Orbital. A Molecular Orbital which is bonding 
between particular atom centers. The opposite is an Antibonding 
Molecular Orbital. [491]

Bond Order. A measure of the number of electrons shared between 
“bonded” atoms. [295]

Bond Separation Reaction. An Isodesmic Reaction in which a 
molecule described in terms of a conventional valence structure 
is broken down into the simplest (two-heavy-atom) molecules 
containing the same component bonds. [284]

Bond Density Surface. A Density Surface used to elucidate the 
bonding in molecules. The value of the density is typically taken as 
0.1 electrons/bohr.3 [125,129,299,503]

Born-Oppenheimer Approximation. An approximation based on 
the assumption that nuclei are stationary. Applied to the Schrödinger 
Equation, it leads to the Electronic Schrödinger Equation. [434]

BP Model; A Density Functional Model which improves on the 
Local Density Model by accounting explicitly for non-uniformity 
in electron distributions. [291,519]

Cambridge Structural Database. A collection of >525,000 
experimental structures for organic and organometallic compounds 
almost entirely from X-ray crystallography. Structures lacking 
carbon are excluded as are biopolymers (the latter are available from 
the Protein Data Bank). [60,367]

Cartesian Coordinates. x, y, z spatial coordinates. [450]

CAS Number [314]

Cation. An atom or molecule with a Total Charge of +1. [187]
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cc-pV5Z. A Polarization Basis Set which has been developed 
specifically for use with Correlated Models. The Valence has been 
split into five parts, and functions though g have been included. May 
be supplemented with Diffuse Functions. [292,521]

cc-pVDZ. A Polarization Basis Set which has been developed 
specifically for use with Correlated Models. The Valence has been 
split into two parts. May be supplemented with Diffuse Functions. 
[292,521]

cc-pVQZ. A Polarization Basis Set which has been developed 
specifically for use with Correlated Models. The Valence has been 
split into four parts, and functions though g have been included. 
May be supplemented with Diffuse Functions. [292,521]

cc-pVTZ. A Polarization Basis Set which has been developed 
specifically for use with Correlated Models. The Valence has been 
split into three parts, and functions though f have been included. 
May be supplemented with Diffuse Functions. [292,521]
13C Spectrum; see also NMR Spectrum [115,117,119,198,334]

CCSD/CCSD(T) Models. Coupled Cluster Singles and Doubles 
optionally with a triples correction. Correlated Models. [520]

Chemical Function Descriptors. A set of locations each indicating 
specific “chemical behavior”, for example, a location indicating 
its possible role as a hydrogen-bond donor or acceptor. Chemical 
function descriptors may either be used without reference to atomic 
centers (the collection being termed a Pharmacophore) or attached 
to atoms. [152,155,173,296]

Chemical Shift. The difference in the energies of nuclear spin states 
for a nucleus in a molecule caused by an external magnetic field. 
This is the fundamental quantity measured in NMR spectroscopy.
[110,479]

Chiral Molecule. A molecule with a non-superimposible mirror 
image. Most commonly (but not necessarily) a chiral molecule will 
incorporate one or more R/S centers. [68,228]
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CID Model. Configuration Interaction Doubles. A limited 
Configuration Interaction scheme in which only double excitations 
from occupied to unoccupied molecular orbitals are considered. 
[437]

CIS Model. Configuration Interactions Singles. A limited 
Configuration Interaction scheme in which only single excitations 
from occupied to unoccupied molecular orbitals are considered. 
This is perhaps the simplest method available to the description of 
Excited States of molecules. [521]

CISD Model. Configuration Interaction, Singles and Doubles. A 
limited Configuration Interaction scheme in which only single and 
double excitations from occupied to unoccupied molecular orbitals 
are considered. [437]

Closed Shell. An atom or molecule in which all electrons are paired. 
[517]

Configuration Interaction. Provides an account of Electron 
Correlation by way of explicit promotion (excitation) of electrons 
from occupied molecular orbitals into unoccupied molecular 
orbitals. Full configuration interaction (all possible promotions) is 
not a practical method and limited schemes, for example, CIS, CID 
and CISD Models, need to be employed. [284,437]

Conformation. The arrangement about single bonds and of flexible 
rings. [80,121]

Conformational Analysis. One of several different procedures to 
deal with molecules that are not properly described in terms of a 
single Conformer. Determination of Equilibrium Conformer or 
establishing a Conformer Distribution or a Conformer Library 
are examples of conformational analysis. [169,446]

Conformer; See Conformation. 

Conformer Distribution. A selection of Conformers based on their 
relative energies, in the limit comprising a Boltzmann Distribution. 
[87,278,279,466]
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Conformer Library. A selection of Conformers based on their 
diversity. [152,155,466]

Core. Electrons which are primarily associated with individual 
atoms and do not participate significantly in chemical bonding (1s 
electrons for first-row elements, 1s, 2s, 2px, 2py, 2pz electrons for 
second-row elements, etc.). [492]

Core Electrons; See Core [492]

Core Orbital. A Molecular Orbital that is primarily involved with 
the Core rather than with the Valence.[492]

Correlated Models. Models which take implicit or explicit account 
of the Correlation of electron motions. Møller-Plesset Models, 
Configuration Interaction Models and Density Functional 
Models are correlated models. [436]

Correlation. The coupling of electron motions not explicitly taken 
into account in Hartree-Fock Models. [436]

Correlation Energy. The difference in energy between the Hartree-
Fock Energy and the experimental energy. [436]

Correlation Functional. A function of the Electron Density and 
perhaps as well the gradient of the Electron Density. The functional 
form derives from “exact” solution of the Schrödinger Equation for 
an idealized many-electron problem. Used in Density Functional 
Models. [519]

COSY Spectrum; See also NMR Spectrum. [110]

Coulomb Energy. The electron-electron repulsion energy according 
to Coulomb’s law. [277,433]

Coulombic Interactions. Charge-charge interactions which follow 
Coulomb’s law. Stabilizing when charges are of opposite sign and 
destabilizing when they are of the same sign. [277,433]

Coupling Constant. A measure of the extent to which nuclear spins 
on neighboring atoms interact (couple) with each other, causing 
splitting of the lines in an NMR spectrum. [112,293]
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CPK Model.  A molecular model in which atoms are represented 
by spheres, the radii of which correspond to van der Waals Radii. 
Intended to portray molecular size and shape. Also known as a space-
filling model. [223,500]

CSD; See Cambridge Structural Database. [60,367]

Curtin-Hammett Principle. The idea that reactive conformer in 
a Kinetically-Controlled Reaction is not necessarily the lowest-
energy conformer. The rationale is that the energy barriers separating 
conformers are typically much smaller than barriers to chemical 
reaction, and that any reactive conformers will be replenished.

Density; See Electron Density. [299,304,501]

Density Functional Models. Methods in which the energy is evaluated 
as a function of the Electron Density. Electron Correlation is 
taken into account explicitly by incorporating into the Hamiltonian 
terms which derive from exact solutions of idealized many-electron 
systems. [438]

DEPT Spectrum; See also NMR Spectrum. [115]

Diffuse Functions. Functions added to a Basis Set to allow 
description of electron distributions far away from atomic positions. 
Important for descriptions of anions. [521]

Diffusion-Controlled Reactions. Chemical reactions without 
Transition States (or energy barriers), the rates of which are 
determined by the speed in which molecules encounter each other 
and how likely these encounters are to lead to reaction. [450]

Dipole Moment. A vector indicating the magnitude, sign and 
direction of the overall distribution of charge in a molecule based on 
the combination of nuclear and electron charges. Most commonly 
only the magnitude of the dipole moment is known experimentally. 
[49]

Doublet. A molecule with one unpaired electron, another name for 
which is a radical. [65,294]

Dual Basis Set. A technique whereby the converged wavefunction 
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resulting from a calculation using a small basis set is passed on for a 
single SCF cycle using a large basis set. This closely approximates 
the energy and wavefunction that would have resulted from a 
full calculation using the large basis set but with 5-10 times less 
computation. [522]

EDF1 Model. A Density Functional Model which improves on the 
Local Density Model by accounting explicitly for non-uniformity 
in electron distributions. [291,519]

EDF2 Model. A Density Functional Model which improves on the 
Local Density Model by accounting explicitly for non-uniformity in 
electron distributions. EDF2 was explicitly formulated to reproduce 
experimental vibrational frequencies (infrared spectra), and it was for 
this reason (together with practical concerns) that the EDF2/6-31G* 
model was chosen for use in the Spartan Spectra and Properties 
Database (SSPD). [291,519]

Electron Affinity. The energy gained as a result of adding an 
electron to an atom or molecule. May be calculated as the (negative 
of) the difference in energies between the atom/molecule and it 
corresponding radical anion. Note that not all atoms/molecules have 
positive electron affinities, that is, bind an electron.

Electron Correlation. See Correlation. [436]

Electron Density. The number of electrons per unit volume at a 
point in space. This is the quantity which is measured in an X-ray 
diffraction experiment. [299,304,501]

Electron Density Surface. A surface of constant Electron Density. 
May be used to elucidate bonding (Bond Density Surface) or to 
characterize overall moelcular size and shape. [501]

Electronic Schrödinger Equation. The equation which results 
from incorporation of the Born-Oppenheimer Approximation to 
the Schrödinger Equation. [434]

Electrostatic Charges. Atomic charges chosen to best match the 
Electrostatic Potential at points surrounding a molecule, subject to 
overall charge balance. [49,88]
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Electrostatic Potential. A function describing the energy of 
interaction of a positive point charge with the nuclei and fixed 
electron distribution of a molecule. [300,304,506]

Electrostatic Potential Map. A graph that shows the 
value of Electrostatic Potential on an Electron Density 
Isosurface corresponding to a van der Waals Surface. 
[29,49,92,129,149,300,508]

Electrostatic Potential Surface. It may be used to elucidate regions 
in a molecule which are particularly electron rich and subject to 
electrophilic attack and those which are particularly electron poor, 
subject to nucleophilic attack. [508]

Energy Profile. A plot of energy vs. change in geometrical coordinate, 
for example, change in bond length of in dihedral angle. [278]

Enthalpy. The heat of a chemical reaction. Related to energy 
by a pressure-volume that is insignificant at normal pressures. 
[33,277,285]

Equilibrium Conformer. The lowest-energy Conformer. 
[63,278,279,465] 

Equilibrium Geometry. A Local Minimum on a Potential Energy 
Surface. [49,57,425]

Equilibrium Isotope Effect. The effect on the heat of reaction due 
to a change in nuclear mass of one or more atoms. The most common 
(and largest) isotope effects arise from substitution of deuterium for 
hydrogen [471] 

Exchange Functional. A function of the Electron Density and 
perhaps as well the gradient of the Electron Density. The functional 
form derives from “exact” solution of the Schrödinger Equation for 
an idealized many-electron problem. Used in Density Functional 
Models. [519]

Exchange Energy. An “attractive” (negative) component of the 
electron-electron interaction energy. Arises due to an overestimation 
of the “repulsive” (positive) component or Coulomb energy.
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Excited State. An electronic state for an atom or molecule which is 
not the lowest-energy or Ground State. [40,274,281]

Force Constant. For a diatomic molecule, the second derivative of 
the energy with regard to change in bond length. For a polyatomic 
molecule, the second derivative of the energy with regard to a change 
in Normal Coordinate. [103,471]

Force Field. The set of rules underlying Molecular Mechanics 
Models. Comprises terms which account for distortions from ideal 
bond distances and angles and for Non-Bonded van der Waals and 
Coulombic Interactions. [439]

Fourier Series. An expansion of a periodic (in 360o rotation) in 
terms of powers of the cosine of the torsion angle. [84]

Frontier Molecular Orbitals. The HOMO and LUMO. [495]

Fukui-Woodward-Hoffmann Rules; See Woodward-Hoffmann 
Rules. [497]

Functional; See Correlation Functional, Exchange Functional. 
438]

G2, G3 Models. “Recipes” which combine a series of Hartree-
Fock and Correlated Models to properly account for Atomization 
Energies of atoms and molecules. Useful for providing accurate 
thermochemical data. G3 is a more recent implementation of G2. 
[282,520]

G3(MP2). A “simplified” version of the G3 Model. Reproduces 
experimental Heats of Formation with an RMS errors of ~8 kJ/
mol, but applicable to molecules comprising 10-15 atoms at most.
[282,459,520]

Gaussian. A function of the form xlymzn exp (αr2) where l, m, n are 
integers (0, 1, 2 . . .) and α is a constant. Used in the construction of 
Basis Sets for Hartree-Fock, Density Functional, MP2 and other 
Correlated Models. [435]

Gaussian Basis Set. A Basis Set made up of Gaussian Basis 
Functions. [435]
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Gaussian Function; See Gaussian. [435]

Global Minimum. The lowest energy Local Minimum on a 
Potential Energy Surface. [279,446, 464]

Gradient Corrected Density Functional Models; See Non-Local 
Density Functional Models. [291,519]

Ground State. The lowest energy electronic state for an atom or 
molecule. [281]

Hamiltonian. An operator which accounts for the kinetic and 
potential energy of an atom or a molecule. [433]

Hammond Postulate. The idea that the Transition State for an 
exothermic reaction will more closely resemble reactants than 
products. This provides the basis for “modeling” properties of 
Transition States in terms of the properties of reactants. [512]

Harmonic Frequency. A Vibrational Frequency which has been 
corrected to remove all non-quadratic (anharmonic) components. 
Calculated Vibrational Frequencies correspond to harmonic 
frequencies. The corrections require data on isotopically-substituted 
systems and are typically available only for small molecules. [472]

Hartree. The Atomic Unit of energy. 1 hartree = 627.47 kcal/mol. 
[544]

Hartree-Fock Approximation. Separation of electron motions in 
many-electron systems into a product form of the motions of the 
individual electrons. [283,434]

Hartree-Fock Energy. The energy resulting from Hartree-Fock 
Models.

Hartree-Fock Equations. The set of differential equations resulting 
from application of the Born-Oppenheimer and Hartree-Fock 
Approximations to the many-electron Schrödinger Equation.

Hartree-Fock Models. Methods in which the many-electron 
wavefunction in written terms of a product of one-electron 
wavefunctions. Electrons are assigned in pairs to functions called 
Molecular Orbitals. [282,434,517]
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Hartree-Fock Wavefunction. The simplest quantum-mechanically 
correct representation of the many-electron wavefunction. Electrons 
are treated as independent particles and are assigned in pairs to 
functions termed Molecular Orbitals. Also known as Single-
Determinant Wavefunction.

Heat of Formation. The Enthalpy at 298 K of a balanced chemical 
reaction in which a molecule is converted into the most stable form 
of the each element, for example, hydrogen molecule for hydrogen 
and graphite for carbon. [277,452]

Hessian. The matrix of second energy derivatives with respect 
to geometrical coordinates. The Hessian together with the atomic 
masses lead to the Vibrational Frequencies of molecular systems. 
[445]

Heterolytic Bond Dissociation. A process in which a bond is 
broken and a cation and anion result. The number of electron pairs 
is conserved, but a non-bonding electron pair has been substituted 
for a bond.

HMBC Spectra; See NMR Spectra.

HOMO. Highest Occupied Molecular Orbital. [25,73]

Homolytic Bond Dissociation. A process in which a bond is 
broken and two radicals result. The number of electron pairs is not 
conserved.  

HOMO-LUMO Gap. The difference in energies between the 
HOMO and LUMO. [73]

HOMO Map. A graph of the absolute value of the HOMO on an 
Isodensity Surface corresponding to a van der Waals Surface.

HSQC Spectra; See NMR Spectra.

Hybrid Density Functional Models. Density Functional Models 
which incorporate the Exchange Energy from the Hartree-Fock  
Model. The B3LYP Model is a hybrid density functional model. 
[291,519]
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Hydrogen-Bond Acceptor. An electronegative element (typically, 
nitrogen, oxygen or halogen) with one or more lone pairs able to 
“accept” a hydrogen from a Hydrogen-Bond Donor. [297]

Hydrogen-Bond Donor. A hydrogen bonded to an electronegative 
element (typically nitrogen or oxygen) that can be donated to a 
Hydrogen-Bond Acceptor. [297]

Hydrophobe. A non polar region of a molecule. [297]

Hypervalent Molecule. A molecule containing one or more main-
group elements in which the normal valence of eight electrons has 
been exceeded. Hypervalent molecules are common for second-row 
and heavier main-group elements but are uncommon for first-row 
elements. [179]

Imaginary Frequency. A frequency which results from a negative 
element in the diagonal form of the Hessian. Equilibrium Geometries 
are characterized by all real frequencies while Transition States are 
characterized by one imaginary frequency. [125,134]

Infrared Spectrum. Spectrum resulting from transitions between 
vibrational energy levels. Infrared intensities depend on the change 
in dipole moment associated with the vibration. [29,103,291]

Internal Coordinates. A set of bond lengths, bond angles and 
dihedral angles (among other possible variables) describing 
molecular geometry. The Z Matrix is a set of internal coordinates.

Intrinsic Reaction Coordinate. The name given to procedures 
with seek to “walk” in a smooth pathway connecting reactant and 
product.

Ionization Potential. The energy required to completely eject an 
electron from an atom or molecule. May be calculated as the difference 
in energies between the atom/molecule and its corresponding radical 
cation. May be approximated from Koopman’s Theorem as the 
negative of the HOMO Energy.

Isodesmic Reaction. A chemical reaction in which the number of 
formal chemical bonds of each type is conserved. [284]
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Isosurface. A three-dimensional surface defined by the set of points 
in space where the value of the function is constant.

Isotope Effect; See Equilibrium Isotope Effect, Kinetic Isotope 
Effect.

Isovalue Surface; See Isosurface.

Kinetically-Controlled Reaction. Refers to a chemical reaction 
which has not gone all the way to completion, and the ratio of 
products is not related to their thermochemical stabilities, but rather 
inversely to the heights of the energy barriers separating reactants to 
products. [457]

Kinetic Isotope Effect. The effect on the rate of reaction due to a 
change in nuclear mass of one or more atoms. The most common 
(and largest) isotope effects arise from substitution of deuterium for 
hydrogen [471] 

Kinetic Product. The product of a Kinetically-Controlled 
Reaction. [140,457]

kJ/mol. The unit commonly used to express chemical energy 
differences, replacing kcal/mol. 1 kJ/mol = 0.239 kcal/mol = 
0.000381 au. [544]

Kohn-Sham Equations. The set of equations obtained by applying 
the Local Density Approximation to a general multi-electron 
system. An Exchange/Correlation Functional which depends on 
the electron density has replaced the Exchange Energy expression 
used in the Hartree-Fock Equations. The Kohn-Sham equations 
become the Roothaan-Hall Equations if this functional is set equal 
to the Hartree-Fock Exchange Energy expression.

Koopman’s Theorem. Relates the Ionization Potential to the 
negative of the HOMO Energy. 

LCAO Approximation. Linear Combination of Atomic Orbitals 
approximation. Approximates the unknown Hartree-Fock 
Wavefunctions (Molecular Orbitals) by linear combinations 
of atom-centered functions (Atomic Orbitals) and leads to the 
Roothaan-Hall Equations. [434]
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LACVP*, LACVP**. Pseudopotentials which include not only 
Valence s and p-type orbitals (s, p and d-type for transition metals) 
but also the highest set of Core orbitals, and in which non-hydrogen 
atoms are supplemented by d-type Gaussians and (for LACVP**) 
hydrogen atoms are supplemented by p-type Gaussians. [187,275]

Ligand. This term has two meanings in the context of molecular 
modeling. It denotes a molecular fragment that is (viewed as) 
non-covalently bonded to a transition metal in an inorganic or 
organometallic compound. For example, both carbon monoxide and 
benzene are said to be ligands in benzene chromium tricarbonyl. 
[256] It also denotes a molecule that is “associated” (non-covalently 
bonded) to a protein. [400]

Linear Synchronous Transit. The name given to procedures which 
estimate the geometries of transition states based on “averages” of 
the geometries of reactants and products, sometimes weighted by 
the overall thermodynamics of reaction. [397]

LMP2 Model. An MP2 Model in which the Hartree-Fock orbitals 
are first localized. Not supported in Spartan.

Local Density Models. Density Functional Models which are 
based on the assumption that the Electron Density is constant (or 
slowly varying) throughout all space.

Local Ionization Potential. A function of the relative ease of 
electron removal (ionization) from a molecule. [300,512]

Local Ionization Potential Map. A graph of the Local Ionization 
Potential on an Isodensity Surface corresponding to a van der 
Waals Surface. [29,45,302,513]

Local Minimum. Any Stationary Point on a Potential Energy 
Surface for which all elements in the diagonal representation of the 
Hessian are positive. [446]

Local Spin Density Models; See Local Density Models.

LogP. An empirical measure of the extent to which a molecule 
partitions between water and octanol. [294]
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Lone Pair. A Non-Bonded Molecular Orbital which is typically 
associated with a single atom.

LUMO. Lowest Unoccupied Molecular Orbital. [29,57]

LUMO Map. A graph of the absolute value of the LUMO on an 
Isodensity Surface corresponding to a van der Waals Surface. 
[29,57,302,304,514]

Mechanics Models; See Molecular Mechanics Models.

Mechanism. The sequence of steps connecting reactants and products 
in an overall chemical reaction. Each step starts from an equilibrium 
form (reactant or intermediate) and ends in an equilibrium form 
(intermediate or product). [428,431,447]

Merck Molecular Force Field; See MMFF94.

Minimal Basis Set. A Basis Set which contains the fewest functions 
needed to hold all the electrons on an atom and still maintain spherical 
symmetry. STO-3G is a minimal basis set. [435]

Minimal Valence Basis Set. A  Minimal Basis Set from which 
Core Orbitals have been removed. Semi-Empirical Models make 
use of a minimal valence basis set [439]

MM2, MM3, MM4. A series of Molecular Mechanics Force Fields 
developed by the Allinger group at the University of Georgia.

MMFF94. Merck Molecular Force Field. A Molecular Mechanics 
Force Field for organic molecules and biopolymers developed by 
Merck Pharmaceuticals. [517]

MNDO. Modified Neglect of Differential Overlap. A Semi-
Empirical Model. [517]

MNDO/d. An extension of the MNDO Semi-Empirical Model in 
which second-row (and heavier) main-group elements are provided 
a set of d-type functions. [517]

Molecular Mechanics; See Molecular Mechanics Models.

Molecular Mechanics Models. Methods for structure, conformation 
and strain energy calculation based on bond stretching, angle bending 
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and torsional distortions, together with Non-Bonded Interactions, 
and parameterized to fit experimental data. [282,439,517]

Molecular Orbital. A one-electron function made of contributions 
of Basis Functions on individual atoms (Atomic Orbitals) and 
delocalized throughout the entire molecule. [490]

Molecular Orbital Models. Methods based on writing the many-
electron solution of the Electronic Schrödinger Equation in terms 
of a product of one-electron solutions (Molecular Orbitals).

Møller-Plesset Energy. The energy resulting from Møller-Plesset 
Models terminated to a given order, e.g., the MP2 energy is the 
energy of the second-order Møller-Plesset Model (or MP2).

Møller-Plesset Models. Methods which partially account for 
Electron Correlation by way of the perturbation theory of Møller 
and Plesset. [284,438,518]

Monte-Carlo Conformation Search. A limited search of 
Conformers resulting from a random sampling of all torsional angles 
(including constrained torsions associated with flexible rings) while 
satisfying the requirements imposed by the Boltzmann Equation. 
[279,465]

MP2 Energy. The energy resulting from MP2 Models.

MP2 Model. A Møller-Plesset Model terminated to be second order 
in the energy. [438,519]

MP3 Model. A Møller-Plesset Model terminated to be third order 
in the energy. [520]

MP4 Model. A Møller-Plesset Model terminated to be fourth order 
in the energy. [520]

Mulliken Charges. Atomic charges obtained from a Mulliken 
Population Analysis. [49,523]

Mulliken Population Analysis. A partitioning scheme in which 
electrons are shared equally between different Basis Functions. 
[523]
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Multiplicity. The number of unpaired electrons (number of electrons 
with “down” spin) +1. 1=singlet; 2=doublet; 3=triplet, etc. [294]

Natural Charges. Atomic charges obtained from a Natural 
Population Analysis. [49,523]

Natural Popluation Analysis. [523]

NDDO Approximation. Neglect of Diatomic Differential Overlap 
approximation. The approximation underlying all present generation 
Semi-Empirical Models. It says that two Atomic Orbitals on 
different atoms do not overlap. [439]

NIST Chemistry Web Book (National Institutes of Standards 
and Technology). On-line source of experimental Infrared and 
UV/visible spectra. [191,332]

NMR Spectrum. Spectrum resulting from transitions between 
nuclear spin states under the influence of an external magnetic 
field. Both 1D spectra (most important, proton and 13C) and 2D 
spectra (most important COSY, HMBC and  HSQC) are available. 
[29,110,115,117,119,478]

NOE (Nuclear Overhauser Effect). An NMR experiment that leads 
to identifying pairs of (non-bonded) atoms separated by less than a 
specified distance (typically 4-5Å). [237]

Non-Bonded Interactions. Interactions between atoms which are 
not directly bonded. van der Waals Interactions and Coulombic 
Interactions are non-bonded interactions.

Non-Bonded Molecular Orbital. A molecular orbital which does 
not show any significant Bonding or Antibonding characteristics. 
A Lone Pair is a non-bonded molecular orbital.

Non-Local Density Functional Models. Density Functional 
Models such as the  BLYP, BP, EDF1, EDF2 and B3LYP Models 
which explicitly take into account electron inhomogeneities. 
[291,519]

Normal Coordinates. Coordinates that lead to a diagonal Hessian, 
and which correspond to vibrational motions in molecules. 
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[103,446,473]

Normal Mode Analysis. The process for calculating Normal 
Coordinates leading to Vibrational Frequencies. This involves 
diagonalizing the Hessian and accounting for atomic masses.

Octet Rule. The notion that main-group elements prefer to be 
“surrounded” by eight electrons (going into s, px, py, pz orbitals).

OD/OD(T). Correlated Models. [520]

Orbital Energy. The energy of a Molecular Orbital.

Orbital Energy Diagram. A diagram listing Orbital Energies from 
most negative at the bottom. Usually restricted to occupied Valence 
Orbitals and the few lowest unoccupied orbitals. [29]

Orbital Symmetry Rules; See Woodward-Hoffmann Rules.

Open Shell. An atom or molecule in which one or more electrons 
are unpaired. [517]

Pharmacophore.  Collection of Chemical Function Descriptors 
which characterizes a molecular environment. A pharmacophore 
may serve as a target for Similarity Analysis. [152,155]

PM3. Parameterization Method 3. A Semi-Empirical Model. 
[187,517]

PM6. Parameterization Method 6. A Semi-Empirical Model. 
[517]

Polar Area. The area of an Electrostatic Potential Map that is either 
more positive or more negative than some preset value (typically 
between 80-120 kJ/mol). [149]

Polarization Basis Set. A Basis Set which contains functions of 
higher angular quantum number (Polarization Functions) than 
required for the Ground State of the atom, e.g., d-type functions for 
main-group elements and p-type functions for hydrogen. 6-31G*, 
6-31G**, 6-311G*, 6-311G**, cc-pVDZ, cc-pVTZ and cc-pVQZ 
are polarization basis sets. [436,521]
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Polarization Functions. Functions of higher angular quantum than 
required for the Ground State atomic description. Added to a Basis 
Set to allow displacement of Valence Basis Functions away from 
atomic positions. [436,521]

Polarization Potential. A function describing the energy of electronic 
relaxation of a molecular charge distribution following interaction 
with a point positive charge. The polarization potential may be added 
to the Electrostatic Potential to provide a more accurate account of 
the interaction of a point-positive charge and a molecule.

Polar Surface Area. The area of a space-filling (CPK) model due 
to electronegative elements (typically, nitrogen and oxygen) and any 
hydrogens that are bonded to these elements. [149,315]

Pople-Nesbet Equations. The set of equations describing the best 
Unrestricted Single Determinant Wavefunction within the LCAO 
Approximation. These reduce the Roothaan-Hall Equations for 
Closed Shell (paired electron) systems.

Population Analysis; see Mulliken Population Analysis, Natural 
Population Analysis

Potential Energy Surface. A function of the energy of a molecule 
in terms of the geometrical coordinates of the atoms. [425]

Property Map. A representation or “map” of a “property” on top 
of an Isosurface, typically an Isodensity Surface. Electrostatic 
Potential Maps, and HOMO and LUMO Maps and Spin Density 
Maps are useful property maps. [506]

Proton Affinity; See Basicity.

Proton Spectrum; see also NMR Spectrum [110]

Pseudopotential. A Basis Set which treats only Valence electrons 
in an explicit manner, all other electrons being considered as a part 
of a “Core”. LAVCP (and extensions including Polarization and/or 
Diffuse Functions) are pseudopotentials. [288,522]

Pseudorotation. A mechanism for interconversion of equatorial 
and axial sites around trigonal bipyramidal centers, e.g., fluorines in 
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phosphorous pentafluoride.

QCCD/QCCD(T) Models. Correlated Models. [520]

QCISD/QCISD(T) Models. Quadratic CISD Models. Correlated 
Models. [520]

QSAR. Quantitative Structure Activity Relationships. The name 
given to attempts to relate measured or calculated properties to 
molecular structure. [293,315]

Quantum Mechanics. Methods based on approximate solution of 
the Schrödinger Equation.

Ramachandran Plot. A plot for each α carbon in a polypeptide of 
the two dihedral angles that define the conformation of the backbone. 
The points will typically cluster in two regions denoting helices and 
sheets. [170,213,225]

Raman Spectrum. Spectrum resulting from transitions between 
vibrational energy levels. Infrared intensities depend on the change 
in polarizability associated with the vibration. [292,329]

Rate Limiting Step. The step in an overall chemical reaction 
(Mechanism) which proceeds via the highest-energy Transition 
State.

Reaction Coordinate. The coordinate that connects the Local 
Minima corresponding to the reactant and product, and which passes 
through a Transition State. [447]

Reaction Coordinate Diagram. A plot of energy vs. Reaction 
Coordinate. [447]

Restricted SCF. An SCF procedure which restricts electrons 
to be paired in orbitals or permits orbitals to be singly occupied. 
[287,538]

RI-MP2. [519]

RM1. A Semi-Empirical Model. [517]

Roothaan-Hall Equations. The set of equations describing the best 
Hartree-Fock or Single-Determinant Wavefunction within the 
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LCAO Approximation. [434]

R/S. Atomic chirality markers. [68]

SCF. Self Consistent Field. An iterative procedure whereby a one-
electron orbital is determined under the influence of a potential made 
up of all the other electrons. Iteration continues until self consistency. 
Hartree-Fock, Density Functional and MP2 Models all employ 
SCF procedures.  

Schrödinger Equation. The quantum mechanical equation which 
accounts for the motions of nuclei and electrons in atomic and 
molecular systems. [433]

SDBS. Database of experimental infrared and NMR spectra from 
AIST (Advanced Industrial Science and Technology, Japan). Freely 
accessible on-line but automatic access is not permitted limiting its 
utility.

Self Consistent Field; See SCF.

Semi-Empirical Models. Quantum Mechanics methods that seek 
approximate solutions to the many electron Schrödinger Equation, 
but which involve empirical parameters. [282,439,517]

Similarity Analysis. A procedure to determine the extent to which a 
molecule is “similar” to either a standard molecule (defined in terms 
of a set of atoms or a set of Chemical Functional Groups) or by a set 
of unassociated Chemical Functional Groups (a Pharmacophore). 
[152,278,296,524]

Single-Determinant Wavefunction; See Hartree-Fock 
Wavefunction.

SIRD; see Spartan Infrared Database [106]

Size Consistent. Methods for which the total error in the calculated 
energy is more or less proportional to the (molecular) size. Hartree-
Fock and Møller-Plesset models are size consistent, while Density 
Functional Models, (limited) Configuration Interaction Models 
and Semi-Empirical Models are not size consistent. 
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Size Surface. A Density Surface used to establish overall molecular 
size and shape. The value of the density is typically taken as 0.002 
electrons/bohr3. 

Slater. A function of the form xlymzn exp (-ζr) where l, m, n are 
integers (0, 1, 2 . . .) and ζ is a constant. Related to the exact solutions 
to the Schrödinger Equation for the hydrogen atom. Used as Basis 
Functions in Semi-Empirical Models. 

Slater Determinant; See Hartree-Fock Wavefunction 

Slater Function. See Slater.

SM5.4. An empirical solvation model for water only. Furnishes only 
an energy correction to be added to the (gas-phase) energy obtained 
from any quantum chemical model. A lower (computational) 
cost variation is available for use in conjunction with Molecular 
Mechanics Models. [129,522]

SM8. An empirical solvation model applicable to Hartree-Fock 
and density functional models . Available for water and a variety of 
organic solvents. Furnishes a wavefunction in addition to an energy, 
meaning that solvated structures, infrared spectra and properties 
may be obtained. [289,522]

SMD; see Spartan Molecular Database. [155,372]

Space-Filling Model; See CPK Model. [223,500]

Spartan Infrared Database (SIRD). An alternative entry point into 
the Spartan Spectra and Properties Database (SSPD) allowing 
searching by match to an (unknown) infrared spectrum. [106]

Spartan Molecular Database (SMD). A collection of molecular 
structures and properties for >100,000 molecules obtained from up 
to nine different quantum chemical models. Searchable by structure, 
name, formula, molecular weight and isomer. [155,372]

Spartan Reaction Database (SRD). A collection of ~1500 
transition-state structures for a wide variety of simple organic and 
organometallic reactions obtained from up to five different quantum 
chemical models. Searchable by structure. [143]
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Spartan Spectra and Properties Database (SSPD). A collection 
of molecular structures, infrared and NMR spectra, molecular 
and atomic properties and QSAR descriptors for >70,000 organic 
molecules obtained from the EDF2/6-31G* density functional model 
based on the lowest-energy conformer assigned from the T1 model. 
The wavefunction is available, meaning that surfaces and property 
maps may be generated “on-the-fly”. Searchable by structure, name, 
formula, molecular weight and isomer. [191,372,461, 477]

Spin Density. The difference in the number of electrons per unit 
volume of “up” spin and “down” spin at a point in space. [65]

Spin Density Map. A graph that shows the value of the Spin Density 
on an Isodensity Surface corresponding to a van der Waals Surface 
[65,303].

Spin Multiplicity; See Multiplicity. [294]

Spin Orbital. The form of Wavefunction resulting from application 
of the Hartree-Fock Approximation to the Electronic Schrödinger 
Equation. Comprises a space part (Molecular Orbital) and one of 
two possible spin parts (“spin-up” and “spin-down”).

Split-Valence Basis Set. A Basis Set in which the Core is represented 
by a single set of Basis Functions (a Minimal Basis Set) and the 
Valence is represented by two or more sets of Basis Functions. 
This allows for description of aspherical atomic environments in 
molecules. 3-21G, 6-31G and 6-311G are split-valence basis sets. 
[283,435]

SRD; see Spartan Reaction Database [143]

SSPD; see Spartan Spectra and Properties Database. 
[191,372,461,477]

Stationary Point. A point on a Potential Energy Surface for which 
all energy first derivatives with respect to the coordinates are zero. 
Local Minima and Transition States are stationary points. 

STO-3G. A Minimal Basis Set. Each atomic orbital is written in 
terms of a sum of three Gaussian functions taken as best fits to 
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Slater-type (exponential) functions. [521]

SVWN Model. (Slater, Vosko, Wilk, Nusair) A Density Functional 
Model which involves the Local Density Approximation.

SYBYL. A Molecular Mechanics Force Field developed by Tripos, 
Inc. [517]

Systematic Conformation Search. An exhaustive search of 
Conformers resulting from stepping through all torsional angles 
(including constrained torsions associated with flexible rings). This 
is the only procedure that guarantees identification of the Global 
Minimum. [279,465]

T1. A combination of quantum chemical models and empirical 
parameters formulated to reproduce Heats of Formation obtained 
from the G3(MP2) Model using 2-3 orders of magnitude less 
computation. T1 reproduces experimental heats with an RMS error 
of ~8 kJ/mol (the same error as obtained from the G3(MP2) Model). 
[95,286, 459,520]

Tautomer. An isomer related by rearrangement of hydrogen atoms, 
for example vinyl alcohol is a tautomer of acetaldehyde. All tautomers 
are isomers but not all isomers are tautomers. [98,398]

TDDFT (Time Dependent Density Functional Theory). [521]

Theoretical Model. A “recipe” leading from the Schrödinger 
Equation to a general computational scheme. A theoretical models 
needs to be unique and well defined and, to the maximum extent 
possible, be unbiased by preconceived ideas. It should lead to 
Potential Energy Surfaces which are continuous. It is also desirable 
(but not required) that a theoretical model be Size Consistent and 
Variational. Finally, a theoretical model will be applicable for the 
problems of interest. [287]

Theoretical Model Chemistry. The set of results following from 
application of a particular Theoretical Model.

Thermochemical Recipes. Combinations of quantum chemical 
models and (in the case of T1) empirical parameters to reproduce 
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experimental (or in the case of T1) G3(MP2) Heats of Formation. 
G3(MP2) and T1 are thermochemical recipes. [285]

Thermodynamically-Controlled Reaction. A chemical reaction 
which has gone all the way to completion, and the ratio of different 
possible products is related to their thermochemical stabilities 
according to the Boltzmann Equation. [140,456]

Thermodynamic Product. The product of a reaction which is under 
Thermodynamic Control. [140,456]

Total Charge. The sum of the nuclear charges minus the total 
number of electrons. [294]

Total Energy. The energy of a balanced chemical reaction in which 
a molecule is split into single particle fragments, that is, nuclei and 
electrons. Total energy is the standard way to report energy data 
derived from quantum chemical models (except Semi-Empirical 
Models and Thermochemical Recipes). [278]

Total Electron Density; See Electron Density. [299,304,501]

Transition State. A Stationary Point on a Potential Energy Surface 
in which all but one of the elements in the diagonal representation of 
the Hessian are positive, and one element is negative. Corresponds 
to the highest-energy point on the Reaction Coordinate. [445]

Transition-State Geometry. The geometry (bond lengths and 
angles) of a Transition State. [125,133,137,143,447]

Transition State Theory. The notion that all molecules react through 
a single well-defined Transition State. [278,447]

Transition Structure; See Transition-State Geometry.

Triplet. A molecule with two unpaired electrons.

Unrestricted SCF. An SCF procedure which does not restrict 
electrons to be paired on orbitals. [287,538]

UV/visible Spectrum. The spectrum resulting between ground and 
excited electronic states. [29,293]
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Valence. Electrons which are delocalized throughout the molecule 
and participate in chemical bonding (2s, 2px, 2py, 2pz for first-row 
elements, 3s, 3px, 3py, 3pz for second-row elements, etc.).

Valence Orbital. A Molecular Orbital that is primarily involved 
with the Valence rather than the Core.

van der Waals Interactions. Interactions which account for short-
range repulsion of non-bonded atoms as well as for weak long-range 
attraction.

van der Waals Radius. The radius of an atom (in a molecule), which 
is intended to reflect its overall size. van der Waals radii are used to 
define space-filling models. [408]

van der Waals Surface. A surface formed by a set of interpreting 
spheres (atoms) with specific van der Waals radii, and which is 
intended to represent overall molecular size and shape.

Variational. Methods for which the calculated energy represents an 
upper bound to the exact (experimental) energy. Hartree-Fock and 
Configuration Interaction Models are variational while Møller-
Plesset Models, Density Functional Models and Semi-Empirical 
Models are not variational.

Vibrational Analysis; See Normal Mode Analysis. 

VWN; See Local Density Models, SVWN Models.

Vibrational Frequencies. The energies at which molecules vibrate. 
Vibrational frequencies correspond to the peaks in an infrared and 
Raman spectrum. [29] 

Wavefunction. The solution of the Schrödinger Equation. In the 
case of the hydrogen atom, a function of the coordinates which 
describes the motion of the electron as fully as possible. In the case 
of a many-electron system a function which describes the motion of 
the individual electrons. [433]

Woodward-Hoffmann Rules. A set of rules based on the symmetry 
of Frontier Molecular Orbitals on interacting molecules 
which indicate whether a particular reaction will be favorable or 
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unfavorable. These rules should more properly be referred to as the 
Fukui-Woodward-Hoffmann Rules to reflect the fundamental 
contribution of Fukui. [497]

Zero-Point Energy. The energy of molecular vibration at 0K, given 
as half the sum of the Vibrational Frequencies times Planck’s 
constant. [471]

Z Matrix. A set of internal coordinates (bond lengths, bond angles 
and dihedral angles only) describing molecular geometry. Of 
historical interest only. Not supported in Spartan.

Zwitterion. A neutral valence structure which incorporates both a 
formal positive charge and a formal negative charge. [265]
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Activity-Based Index
References to tutorials are given first and in bold. Only the first 
five (tutorial) references are provided. CSD = Cambridge Structural 
Database; PDB = Protein Data Bank; SIRD = Spartan Infrared 
Database; SMD = Spartan Molecular Database (SMD); SSPD = 
Spartan Spectra and Properties Database (SSPD); SRD = Spartan 
Reaction Database (SRD).

ACCESS
 ChemDraw ................................................................................68
 experimental infrared spectra from NIST database ...........37,104
 experimental infrared spectra from JCAMP .dx file ...37,104,107
 experimental NMR spectra from ChemShift database .............39
 experimental NMR spectra from JCAMP .dx file .............39,116
 experimental UV/visible spectra from NIST database .............41
 experimental UV/visible spectra from JCAMP .dx file ............42
 PDB ..........................................................................169,173, 212
 structures in non-Spartan file formats ....................................209
 tautomers ...................................................................................98
 topics (Appendix A) from Spartan .........................................419
 tutorials for Spartan ...............................................................419
 Wikipedia entry for molecule ............................................64,420
 X-ray crystal structures from CSD ....................................61,183

ADD
 charge labels to model ............................................................228
 chemical shift labels to model .........................................117,228
 chirality labels to model ................................................61,70,228
 hydrogens to molecular structure ............................................170
 molecule to a Spartan document ................................74,79,88,92
 numerical data to spreadsheet .........................................76,89,93
 properties to spreadsheet ..................................................131,141
 ribbons to model .....................................................................225
 spin-spin splitting to proton NMR spectrum ...................112,335
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ALIGN
 molecules based on chemical functionality ............................246
 molecules based on structure ......................................82,136,247
 molecules to a pharmacophore ...............................................247

ANIMATE
 change in surface or property map along a reaction coordinate ... 
  .............................................................128,132,507,505,511,571
 progress along a reaction coordinate ......................................128
 Quick Time .............................................................................215
 vibrational motion ..............................................................36,126

ATTACH
 data associated with molecule in Spartan document ..............214
 data associated with Spartan document ..................................214

BUILD
 conformer library ....................................................................158
 hypervalent molecules ............................................................179
 intermolecular complexes .........................................133,143,155
 inorganic and organometallic molecules ...........179,185,187,214
 molecules from mutiple fragments .........................................268
 organic molecules ..........................................49,57,60,65,69,250
 polynucleotides .......................................................................260
 polypeptides .....................................................................165,257
 substituted molecules .........................................................95,262
 substituent library ..............................................................95,264

CALCULATE
 Boltzmann distribution of conformers ...............................81,121
 bond density surface ........................................................127,132
 conformer library ....................................................................158
 dipole moment (magnitude, sign and direction) .......................54
 distribution of conformers ........................................................81
 electron density surface ............................................................70
 electrostatic potential map .....................................44,56,127,132
 energy profile for change in bond distance .............................141
 energy profile for rotation about a single bond .........................84
 enthalpy ...................................................................................316
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 entropy ....................................................................................316
 equilibrium conformer .......................................................63,171
 equilibrium geometry ................................................................51
 Gibbs energy ...........................................................................316
 heat capacity ...........................................................................316
 heat of formation from T1 model ...........................................314
 hyperpolarizability ..................................................................540
 infrared spectrum ....................................................................291
 infrared spectrum for a transition state ............................126,188
 isomer energies ..................................................................97,191
 local ionization potential map .................................................183
 lowest-energy conformer ........................................................171
 LUMO map ...................................................................45,58,183
 NMR spectrum ..................................... 111,115,117,120,292,478
 polar area and accessible polar area .................................151,315
 polarizability ...........................................................................540
 polar surface area and accessible polar surface area ........149,315
 QSAR descriptors ..............................................................89,293
 Raman spectrum .....................................................................292
 reaction energy ..............................................................79,97,139
 reaction profile ........................................................................141
 similarity based on chemical functions .....................153,160,175
 similarity based on structure .....................................153,160,175
 tautomer energies ......................................................................99
 transition-state geometry...........................................126,135,138
 UV/visible spectrum ...............................................................293
 zero-point energy ....................................................................316

CHANGE
 absolute configuration .............................................................269
 accessible area radius ..............................................................406
 animation speed ......................................................................404
 chemical function descriptor definitions .................................327
 chirality at atomic centers .......................................................269
 colors .......................................................................................415
 conformational analysis rules .................................................406
 fonts ........................................................................................415
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 isotope ..............................................................................105,135
 isovalue of surfaces ..........................................................308,320
 maximum ligand distance .......................................................406
 model style .........................................................................30,150
 molecule names using SMD or SSPD ......................................74
 polar area range .......................................................................406
 range of 13C NMR spectrum ...................................................336
 range of infrared spectrum ......................................................332
 range of proton NMR spectrum ..............................................336
 range of Raman spectrum .......................................................332
 range of UV/visible spectrum .................................................339
 resolution of surfaces and property maps ...............................308
 style of surfaces and property maps .......................44,67,150,320
 tautomer ....................................................................................98
 URL’s ......................................................................................414
 van der Waals radii ..................................................................408

CHOOSE (see SPECIFY)

DELETE
 atom ........................................................................................271
 bond ........................................................................................272
 free valence .............................................................................129
 molecule from a Spartan document .......................................212
 spectrum .............................................................271,332,336,339
 surface or property map ..........................................................308

DESIGNATE (see SPECIFY)

DETERMINE
 whether a reaction is endo or exothermic .................................80

DISPLAY
 area and accessible area of surfaces ........................................320
 atomic charges ............................................................34,181,317
 atomic properties..................................................................34,55
 bond density surface ...............................................................132
 bond orders .............................................................................318
 Boltzmann averaged NMR spectrum ......................................122
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 Boltzmann distribution for molecules (conformers) in a Spartan 
 document ............................................................................99,348
 13C NMR spectrum ...............................................39,115,199,334
 CAS number ...........................................................................314
 chemical function descriptors .................................................226
 chemical shifts ........................................................................317
 chirality of an atom .......................................................61,70,228
 contour plot ...............................................................................67 
 COSY spectrum ...............................................................113,336
 DEPT spectrum ...........................................................40,200,334
 dipole moment .......................................................34,54,314,347
 dipole moment vector ..........................................................34,54
 electron density surface ............................................................70
 electrostatic charges .............................................................34,55
 electrostatic potential map ............................................44,56,509
 electrostatic potential surface..................................................508
 energy ...................................................................................32,54
 enthalpy ...................................................................................316
 entropy ....................................................................................316
 Gibbs energy ...........................................................................316
 heat capacity ...........................................................................316
 heat of formation (experimental) .....................................191,314
 heat of formation (T1)......................................................191,314
 HH coupling constants ............................................................112
 histogram from data mined from SMD or SSPD ....................382
 hits resulting from search on CSD, SMD, SRD or SSPD ......157
 HMBC spectrum .....................................................................336
 HOMO .................................................................................43,66
 HOMO energy, ........................................................................347
 HSQC spectrum ......................................................................336
 hydrogen bonds ..................................................................31,226
 infrared frequencies and intensities .....................35,104,126,135
 infrared spectrum .................................................35,105,197,331
 legend (scale) for property map ..................................59,168,320
 local ionization potential map .....................................45,183,514
 LogP ........................................................................................315
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 LUMO .............................................................................43,45,58
 LUMO energy .............................................................43,314,347
 LUMO map ............................................................45,58,183,515
 molecular formula ............................................................314,347
 molecular orbitals ...........................................................43,45,58
 molecular properties .....................................................33,54,314
 molecular weight..............................................................314,348
 Mulliken charges ..................................................................35,55
 natural charges .....................................................................35,55
 NMR chemical shifts .......................................................110,115
 NMR spectrum ..........................................................................38
 orbital energy diagram .......................................................43,328
 output .................................................................................53,311
 ovality .....................................................................................315
 point group .........................................................................53,314
 polar area and accessible polar area .................................151,315
 polarizability ...........................................................................315
 polar surface area and accessible polar surface area ........149,315
 proton NMR spectrum .....................................................112,334
 QSAR descriptors .....................................................................89
 Ramachandran plot ...................................................170,213,225
 Raman frequencies and intensities ...................................292,329
 Raman spectrum .....................................................................331
 similarities involving chemical functions .................153,162,175
 similarities involving structure ........................................162,175
 solvation energy ......................................................................314
 spin density surface ...................................................................66
 spin density map .....................................................................303
 surface area and accessible surface area of space-filling
 model ......................................................................................315
 surface properties ....................................................................320
 symmetry ...........................................................................53,314
 thermodynamic quantities .......................................................316
 UV/visible spectrum ..........................................................41,338
 value of property on property map ...........................................59
 volume of space-filling model ................................................315
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 XY plot form data mined from SMD or SSPD .......................352
 zero-point energy ....................................................................316

DOWNLOAD (See ACCESS)

DRAW
 arrows to connect reactant and product ...........................203,384
 arrows to specify transition state .....................................125,129
 13C NMR spectrum ...............................................39,115,122,334
 COSY spectrum ...............................................................113,336
 DEPT spectrum ...........................................................40,116,334
 histogram from data mined from SMD or SSPD ....................352
 HMBC spectrum .....................................................................336
 HSQC spectrum ......................................................................336
 infrared spectrum ...............................................................36,114
 molecules using ChemDraw ..............................................68,267
 proton NMR spectrum ............................................................112
 Ramachandran plot ...................................................170,213,215
 Raman spectrum .....................................................................331
 UV/visible spectrum ..........................................................41,335
 XY or XYZ plot from data in spreadsheet ...................... 354-356
 XY plot from data mined from SMD or SSPD .......................352

ENTER
 calculated properties into spreadsheet .................................76,89
 experimental properties into spreadsheet ........................76,89,93

ESTIMATE
 acidity from electrostatic potential map....................................92
 NMR spectrum for a flexible molecule...................................122
 solvation energy .................................................................34,131

EXTRACT
 ligand from PDB file ........................................................170,174
FIND
 kinetic reaction product ...................................................140,457
 lowest-energy conformer ...................................................63,171
 molecules that fit a pharmacophore .................................152,296
 molecules with similar chemical functionality ................160,296
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 molecules with similar structure .............................................296
 thermodynamic reaction product .....................................140,456

FIT
 calculated infrared spectra to unknown spectrum...................193
 calculated infrared spectrum to experimental spectrum
  ....................................................................................38,105,333
 data in plot to Fourier series ..............................................86,325
 data in plot to least-squares line ...........................78,150,151,325
 data using multi-variable linear regression ........................90,149
 experimental infrared spectrum to Lorentzian function .........106
 molecular structure to pharmacophore ...................................175
 plot to designated function ......................................................325

GUESS
 transition-state geometry.............................125,129,134,137,187

IDENTIFY
 chiral centers ........................................................................61,70

IMPORT (See ACCESS)

MAKE
 multiple-molecule Spartan document ........................74,79,88,92

MANIPULATE
 molecular model ................................................................30,268

MATCH (See FIT)

MEASURE
 area, accessible area and volume of an electron density surface
 area, accessible area and volume of a space-filling (CPK) model
 bond lengths, angles and dihedral angles...........................32,233
 polar area and accessible polar area .................................151,315
 polar surface area and accessible polar surface area ........149,315

MINE
 SMD and SSPD ......................................................................203

MONITOR
 progress of calculation ............................................................416
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PERFORM
 multivariable regression analysis using data resulting from
 mining SMD or SSPD .....................................................149,383

PLOT
 data in spreadsheet .................................................77,94,150,151
 data resulting from mining SMD or SSPD .............................381
 energy for moving along a reaction coordinate ...............131,141
 energy of rotation about a single bond ......................................86

PRINT
 charges ....................................................................................295
 orbitals and orbital energies ....................................................294
 output ......................................................................................213
 reactions and reaction energies ...............................................361
 spreadsheet ..............................................................................353
 thermodynamic quantities .......................................................295
 vibrational modes ....................................................................295

RELATE
 electrostatic potential map to acidity ........................................92
RENAME
 molecule(s) with entry from SMD ...........................74,79,93,376
 molecule(s) with entry from SSPD ..................................122,376

REPLACE
 molecule(s) with entry from SMD ..................................64,78,93
 molecule(s) with entry from SSPD ....................................88,191

REQUEST (See CALCULATE)

RETRIEVE
 from CSD ................................................................................372
 from SIRD ..............................................................................396
 from SMD ..........................................................................64,387
 from SRD ................................................................................390
 from SSPD ..............................................................................387

SAVE/SAVE AS
 animation files: QuickTime Movie (.mov) .............................215
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 external files: MacroModel (.mac), MDL SD (.sdf), MDL TG
 (.tgf); Protein Data Bank  . (.pdb), SYBYL MOL (.mol), SYBYL  
 MOL2 (.mol2) .........................................................................211
 graphics files: BMP Files (.bmp), JPG Files (.jpg), PNG Files
 (.png) .......................................................................................211
 Spartan files: database(.spentry / .spindex), directory (.spardir); 
 document (.spartan), input (.spinput), output (.txt) .................211

SEARCH
 CSD for of experimental X-ray crystal structures ......61,184,367
 CSD, SMD, SRD and SSPD by structure ...............................378
 SIRD for match to an unknown infrared spectrum ..........107,193
 SMD for molecular structures and properties ..................156,372
 SMD and SSPD by formula ....................................................380
 SMD and SSPD by isomer .......................................192,196,380
 SMD and SSPD by molecular weight ....................................380 
 SMD and SSPD by name ........................................................379
 SRD for structures of transition states ....................................145
 SSPD for molecular structures, spectra and properties....204,372

SPECIFY
 arrows to connect reactant to transition state or to product
  .........................................................................................125,129
 atoms to be held fixed (frozen) in a geometry or transition-state 
 optimization ..............................................................135,166,234
 atoms to be used for molecule alignment of for similarity 
 analysis .........................................................82,136,160,238,245
 basis set ...................................................................................287
 bonds to be rotated about or rings to be flexed in a 
 conformational search ......................................................157,236
 charge on molecule ..........................................................188,294
 chemical functions to be used for molecule alignment or for
 similarity analysis ..............................................152,175,239,246
 databases .................................................................................409
 filters for search of SIRD .................................................108,194
 geometrical parameters (bond lengths, angles, dihedral angles) 
 to be constrained in a geometry or transition-state optimization  .
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  ......................................................................85,130,140,240,318
 job limits .................................................................................411
 molecular mechanics model...................................63,81,274,440
 NOE constraints ......................................................................237
 number of unpaired electrons on molecule ........................65,294
 options for search on CSD ......................................................369
 options for search on SMD .....................................................156
 options for search on SRD ......................................................145
 options for search on SSPD .............................................380,389
 parallel computations ..............................................................412
 pharmacophore centers to me used in alignment or for similarity
 analysis ............................................................................240,247
 product(s) to calculate reaction energy ...................................360
 pseudopotential ................................................................275,305
 quantum chemical model .......................................51,75,274,440
 reactant(s) to calculate reaction energy ..................................360
 reaction query for search on SMD, SSPD or SRD ...144,203,364
 remote compute servers ..........................................................410
 resolution for surfaces and property maps ..............................308
 sequence of structures along a reaction coordinate ................130
 solvent .....................................................................................288
 structure query for search on CSD, SMD, SSPD, SIRD or SRD 
  ....................................................................143,156,183,203,363
 substituents on molecule ................................................. 262-267
 task to be performed ...............................................................277
 URL’s ......................................................................................414

SUBMIT
 jobs for calculation....................................................................52

START
 queued jobs .............................................................................417

TERMINATE
 executing jobs .........................................................................417
 polypeptide..............................................................................165
 search of SIRD ........................................................................395
 search of SMD or SSPD .........................................................381
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 search of SRD .........................................................................391

USE
 CPK model to demark molecular size and shape ............500,507
 electron density to demark molecular size and shape ......299,501
 electron density to show bonding ....................................304,503
 electrostatic potential map to anticipate crystal packing ........510
 electrostatic potential map to assess molecular polarity
  ...........................................................................150,168,186,300
 electrostatic potential map to assess relative acidity .........92,300
 electrostatic potential surface to identify lone pairs ........300,304
 heats of formation to calculate isomer energies ...................97,99
 HOMO-LUMO gap to anticipate reactivity.......................73,496
 local ionization potential map to assess electrophilic reactivity
  .............................................................................45,183,302,514
 LUMO map to assess nucleophilic reactivity .45,58,183,302,515
 molecular orbitals to anticipate reactions .................133,304,497
 spin density map to assess radical reactivity ..........................303




